Table of Contents

Table of Contents 1
VCarve Pro Help 21
Disclaimer 22
VCarve Pro Reference Manual 23
Introduction 24
User Guides, tutorial and training 24
License Dialog 24
Online Method 24
Manual Method 26
View Controls 26
2D View Controls 27
3D View Controls 27
The View Toolbar 28
Snapping Toggle Options 28
View Controls 28
Toolpath Drawing Toggle 28
3D Drawing 28
Tile 2D & 3D View Windows 28
Two-Sided Machining 28
Rotary Machining 29
The Drawing Tab 30
File Operations 31
New, Open and Save 31
File Types 31
SketchUp Files 31
Layout of Imported Data 32
Three Views - Front, Top, Side 32
Exploded Flat Layout 33
Part Orientation 33
Auto Orientate 34
Orientate by material 34
Gap between parts 34
Create Circles / Arcs 34
Data to Import 34
Component / Group Handling 35
Group imported parts 36
Keep components starting with two underscores (__ ) together 36
Replace outer boundary (for flat jobs only!) 36
3D Toolpath Files 37
Positioning 37
Options 38
PDF Export 39
Vector(s) 39
Sheets 39
Layers 39
Options 39
Cut, Copy and Paste 39
Job Setup 40
Job Setup - Single Sided 40
Job Type 40
Job Size 40
Z Zero Position 40
XY Datum Position 41
Use Offset 41
Design Scaling 41
Modeling Resolution 41
Appearance 41
Job Setup - Double Sided 42
Job Type 42
Job Size 42
Z Zero Position 42
Zero off same side 42
Align Left/Right 82
Align Top/Bottom 82
Align Outside Left/Right 82
Align Outside Top/Bottom 82
Space Selection 82
Show common tools on drawing tab 82
The Edit Objects Tool Group 83
Object Selection Tools 83
Editing Modes 83
Vector Selection Mode 83
Vector selection methods 83
Deselecting Vectors 84
Node Editing Mode 84
Interactive Selection Mode 84
Grouping and Ungrouping 85
Group selected Objects 85
Ungroup Selection 85
Ungroup to the group’s layer 85
Measure Tool 86
Measure Between 2 Points 86
Distance 86
Angle 86
X Distance 86
Y Distance 86
First Point 86
Cursor Position 86
Span / Contour Properties 86
Type 86
Length 86
Start Point and End Point 86
Vector 86
Area 86
Perimeter 87
Num. Spans 87
Model Cross Section 87
Object Merge tools 87
Weld Vectors 87
Subtract Vectors 87
Keep Overlap of Vectors 87
Trim Objects 87
Interactive Vector Trim 88
Vector Validator 89
Marks 89
Create Fillets 90
Fillet / Tool Radius 91
Fillet Type 91
Normal fillet 91
Dog-Bone Fillet 91
T-Bone Fillet 91
Removing Fillets 92
Extend Vectors 93
Fit Curves to Vectors 94
Fitting Type... 94
Circular Arcs 94
Bezier Curves 94
Straight Lines 94
Tolerance: 94
Keep Sharp Corners 95
Replace selected vectors 95
Vector Boundary 95
Offset Boundary 95
Rubber Band Boundary 95
Edit Picture 96
Contrast 96
Brightness 96
Merge
Low
Multiply
Shape Height
Base Height
Reset Heights
Fade
Tilt
The Bake button
Appearance
Use Material
Color from Children
Highlight Selected Component
Close
Smooth Components
Smoothing
Preserve Transparency
Bake Current Smoothing
Scale Model Height
Scale Both Sides
Scale Height
Set Exact height...
Apply/OK
Close/Cancel
Slice Model
Model Slicing
Slice Thickness
Number of Slices
Create Boundary Vectors
Slice Model
Close
Toolpath Operations
Toolpaths
Prepare vectors for machining
Check the 3D data
Set up the Material
Create the Toolpaths
Preview the Toolpaths
Save the Toolpaths for the CNC machine
Additional Toolpath Tab Features
Switch to Drawing Tab
Toolpath Summary Area
Material Setup
Flat Material Setup
Thickness
XY Datum
Show detailed summary on toolpath tab
Side Z-Zero
Model Position in Material
Gap Above Model
Gap Below Model
Model Thickness
Scale Model Height
Modeling Plane Z
Rapid Z Gaps above Material
Clearance (Z1)
Plunge (Z2)
Home / Start Position
Rotary Material Setup
Diameter
XY Datum
Show detailed summary on toolpath tab
Z-Zero
Model Position in Material
Gap Outside Model
Gap Inside Model 133
Model Thickness 133
Modeling Plane Z 133
Rapid Z Gaps above Material 133
Clearance (Z1) 133
Plunge (Z2) 133
Home / Start Position 134
The Toolpath List 135
Resizing the Toolpath List 135
Basic Toolpaths 136
Profile Toolpath 136
Cutting Depths 136
Start Depth (D) 136
Cut Depth (C) 136
Tool 136
Pass Depth Control for Profiling 136
Specify Pass Depths 137
Pass Depth List Utilities 137
Machine Vectors... 137
Direction 137
Allowance offset 137
Last Pass Allowance 138
Use vector start point 138
Tabs (Bridges) 138
Add tabs to toolpath 138
Create 3D Tabs 139
Edit Tabs 139
Add Tabs 139
Constant Number 139
Constant Distance between tabs 139
First tab at machining start point 140
Dynamically positioning tabs in the 2D View 140
Profile Options 140
Ramp 140
Smooth 140
Zig Zag 140
Spiral 141
Leads 141
Straight Line Lead 141
Circular Lead 141
Order 141
Vector Selection Order 141
Left to Right 141
Bottom to Top 141
Grid 141
Shortest Path 141
Start At 142
Keep Current Start Points 142
Optimize Start Points 142
Closest on Bounding Box 142
Corners 142
Sharp External Corners 142
Sharp Internal Corners 143
Allowance for Cut out tool 143
Additional notes on Profile Machining 143
Machining Open Vectors 143
General Toolpath Settings 144
Safe Z 144
Home Position 144
Project toolpath onto 3D Model 144
Vector Selection 144
Name 144
Pocketing Toolpath 144
Cutting Depths 144
Start Depth (D) 144
Cut Depth (C)  144
Tool  144
Specify Pass Depths  144
Pass Depth List Utilities  145
Use Larger Area Clearance Tool  145
Clear Pocket  145
Offset  145
Raster  145
Raster Angle  146
Profile Pass  146
Pocket Allowance  146
Ramp Plunge Moves  146
Use Vector Selection Order  146
General Toolpath Settings  147
Safe Z  147
Home Position  147
Project toolpath onto 3D Model  147
Vector Selection  147
Name  147
Drilling Toolpath  147
Cutting Depths  147
Start Depth (D)  147
Cut Depth (C)  147
Tool  147
Peck Drilling  147
Retract above cutting start  148
Retract above the height of the previous pass  148
Dwell at the bottom of each drill pass  148
Use Vector Selection Order  148
General Toolpath Settings  148
Safe Z  148
Home Position  148
Project toolpath onto 3D Model  148
Vector Selection  148
Name  148
Quick Engraving Toolpath  149
Tool  149
Depth / Pressure  149
Strategy  149
Outline  149
Fill  150
Use Nose Cone  150
Number of Passes  150
Output Options  150
Inlay Toolpath  151
How Inlays work  151
Male Inlay (Insert)  151
Straight  151
Stepped  152
Female Inlay (Pocket / Hole)  152
Pocket  152
Hole  153
Setting Inlay Allowances  153
General Toolpath Settings  154
Safe Z  154
Home Position  154
Project toolpath onto 3D Model  154
Vector Selection  154
Name  154
Laser Toolpaths  155
Laser Cut - Fill  155
Settings  155
Select  155
Power  155
Move Speed  155
General Toolpath Settings
- Safe Z
- Home Position
- Project toolpath onto 3D Model
- Vector Selection
- Name

3D Toolpaths
- 3D Rough Toolpath
  - Tool
  - Machining Limit Boundary
  - Boundary Offset
  - Machining Allowance
  - Z Level Strategy
  - 3D Raster Strategy
  - Ramp Plunge Moves
  - Safe Z
  - Home Position
  - Vector Selection
  - Name

3D Finish Toolpath
- Tool
- Machining Limit Boundary
- Area Machining Strategy
  - Offset
  - Raster
- Stepover Retract
- Safe Z
- Home Position
- Vector Selection
- Name
- Vector Selector
  - Selection
  - Geometry Filters
  - Layer Filter

Advanced Toolpath Templates

Toolpath Editing Tools
- Edit Toolpath
- Duplicate Toolpath
- Delete Toolpath
- Recalculate All Toolpaths

The Tool Database
- Opening the tool database
- Tool List
  - Tooltip of group hierarchy
  - Adding a New Tool
  - Copying a New Tool
  - Deleting a Tool
  - Creating a new tool group
  - Importing and Exporting tools
- Tool Info
  - Name
  - Tool Type
  - Notes
  - Geometry
    - Diameter
  - Cutting Parameters
    - Pass Depth
    - Stepover
    - Final Pass Stepover
    - Clearance Pass Stepover
  - Feeds and Speed
    - Spindle Speed
    - Feed Rate
    - Plunge Rate
    - Maximum Burn Rate
Automatic Tool Changing Support 200
Error Messages 200
VTransfer 200
Getting Started 201
Initial Set-up 201
Controller Connection 201
Running a toolpath 201
Sending a toolpath directly to VTransfer from your Vectric software 201
Homing, Jogging and Origins 202
Start Homing Sequence 202
Z Touch Plate 202
Jogging 202
Setting and Resetting Origins 202
Running the Toolpath 202
Cut Now 203
Estimated Time Remaining 203
Dynamic Feedrate Override 203
Abort 203
Settings 203
The 3D Clipart Tab 204
Integrated Component Clipart 204
Library Browser 204
Online Clipart 205
Login Dialog 205
Local Files 206
Integrated Windows Explorer Thumbnail Support 206
Drag and Drop 206
Layers 207
Managing Layers 207
The Layer Control on the View Toolbar 207
The Layers Tab 207
List Item Command and Icons 207
Status Icon 208
Layer Color 208
Layer Content 208
Layer Name 208
Pop-up Menu 208
Additional Buttons and Icons 208
Show All / Hide All 208
Select All on a Layer 208
Layer Ordering Arrows 209
Add New Layer 209
Layer Name 209
Drawing Color 209
New Layer is Visible 209
New Layer is Active 209
Insert New Layer 209
Moving Layers 209
Program Options 209
Window Layout 210
3D View Settings 210
Toolpath Settings 210
General Settings 211
Rulers, Guide Lines and Snapping 211
Rulers↓ 211
←Guidelines 211
Snapping Options 212
Display Text at Cursor 212
Snap to Guides 212
Snap Guides to Geometry 212
Snap to Grid 212
Snap Distances 212
Snap to Job Center and Corners 212
Fixed Nudge Distance 213
Snapping Radius 213
Geometry Snapping 213
Smart Snapping 213
Object Bounds 214
Vertical and Horizontal Lines 214
Tangents 214
Perpendicular to Tangents 215
Connecting Lines 215
Span Geometry 215
Angular Constraints 216
Job Edges & Centre 216
Toolbar Snapping Options 216

Document Variables 218
Naming Document Variables 218
Deleting Document Variables 218
Using Document Variables 218
Accessing Document Variables 219
Calculation Edit Boxes 220
Special Calculation Characters 220

Main Menu 221
File 221
Import 221
Export 221
Printing and Print Preview 222
Edit 222
Selection 222
Model Menu 223
Toolpaths Menu 223
Toolpath Drawing sub-menu 224
View 224
Gadgets 225
Help 225

Right Mouse Click menus 227
2D View Right Mouse Menu 227
Span Editing Menu 227
Node Editing Menu 227
Bitmap Properties Dialog 227
Level Menu 227
Component Menu 228
Component Grayscale Menu 228
Component Menu in the 3D View - Selected Components 228
Component Menu in the 3D View - Non Selected Components 228
Clipart Menu 229
Toolpath List Menu 229

Gadgets 230
Gadget Shortcuts 230
Preinstalled Gadgets 230
Job Setup Sheet Editor 230
Change Logo 231
Title 231
Color options 231
Add or Remove Setup Sheet Information 231
Restore to default sheet 231
Keyhole Toolpath Gadget 231
Slot Parameters 232
Preview Drawing 232
Toolpath Parameters 232
Drag Knife Toolpath 232
Blade Offset 232
Tolerance angle 233
Cut Depth 233
Swivel Depth 233
Passes 233
Use Vector Start Points 233
Feed and Plunge Rates 233
Create Rounding Toolpath Gadget 233
Blank Size and Shape 234
Machining Method 234
Radial (around cylinder) 234
Raster (along cylinder) 234
Optimized Raster (along cylinder) 235
Wrapped Fluting Layout 235
Wrapped Spiral Layout 236
Shortcut Keys 237
General Shortcut Keys 237
Tab Navigation 237
Double Sided Job Setup 237
Mirror 238
Alignment 238
Groups 238
Arrow keys 238
Node Editing 238
Quick Keys 239
Moving Objects M 239
Rotating Objects R 240
Scaling Objects T 240
Node Editing N 240
Polyline Tool 240
Draw Circle 240
Draw Ellipse 241
Draw Rectangle 241
Draw Polygon 241
Draw Star 241
What's New in VCarve Pro 9.5 243
New Drawing Tools 243
Smart Snapping 243
Quick Keys 243
Vector Validator 243
Enhanced & Extended Drawing Tools 243
Text-Editing (V9.5) 243
The Create Text Form (V9.5) 243
Arc Text (V9.5) 244
Picture Editing & Cropping(V9.5) 244
The Edit Picture Form (V9.5) 244
The Crop Bitmap Tool (V9.5) 244
Dimensioning 245
Shape Creation 245
Creating Tangent Lines 245
Extending A Polyline (V9.5) 245
Smotherer Joining (V9.5) 245
Bitmap Background (V9.5) 246
New Modeling Tools 246
Mirror Mode 246
Enhanced & Extended Modeling Tools 246
Add Zero Plane 246
Improved Quality of Imported STL Models 246
Enhanced Toolpath Features 246
Setting Toolpath Start Point 246
Create Job Sheet Icon 246
Preserve Arcs across Toolpath Tiles 246
Helical Arc Support (V9.5) 246
General Improvements 247
Two-Sided Job Support 247
Rotary Job Support (V9.5) 247
View Toolbar 247
Snapping Toggle Options 247
View Controls 247
Toolpath Drawing Toggle 247
Tile 2D & 3D View Windows 247
Export to PDF 248
Online Clipart Access (V9.5) 248
Combine Modes
Add
Subtract
Merge
Low
Combine Modes Summary
Level Mirror Modes
Multi Sided View
Two-Sided Machining
Two-Sided Job Setup
Two-Sided Toolpath Management
Two-Sided Toolpath Previewing
Two-Sided Toolpath Saving
Rotary Machining and Wrapping
Creating a rotary job and choosing stock material
Creating a Rotary Job
XY Origin
Orientation
Z Origin
Vector Layout
Choosing stock material
Simple rotary modelling using 2D toolpaths
Creating vectors for a basic column
Creating rotary toolpaths
Simulating and saving toolpaths
Spiral toolpaths
Modelling 3D rotary projects
Elaborating 2D designs with 3D clipart pieces
Making a tapered column
Importing external models into rotary projects
Importing Full-3D models
Overview
Setting up a rotary project
Importing the file and orientating it
Scaling imported model
Finishing import
Importing flat models
Advanced modelling of 3D rotary projects
Modelling 3D spiral features
Glossary
2D View
3D View
Bitmap
Combine Mode
Component
Component Tree
Group
Ungroup
File
Grayscale
Composite Model
Modeling Tools
Shape
Short Cut Keys
Vector
- Reference Manual
- User Guide
All CNC machines (routing, engraving, and milling) are potentially dangerous and because Vectric Ltd. has no control over how the software described in this manual might be used, Vectric Ltd. or any associated Resellers cannot accept responsibility for any loss or damage to the work piece, machine or any individual, howsoever caused by misusing the software. Extreme care should always be taken and the output from the software thoroughly checked before sending it to a CNC machine.

The information in this manual may be subject to change without any prior notice. The software described in this manual is supplied under the terms and conditions of the software license agreement and may only be used in accordance with the terms of this agreement.

Vectric Ltd.
Web: www.vectric.com
Email: info@vectric.com
Phone: +44 (0) 1527 850 323
Fax: +44 (0) 1527 850 323
This manual is designed to provide a comprehensive description of all the functions, tools, menus and icons available within the VCarve Pro software package.

Access this document from VCarve Pro’s Help Menu ► Help Contents or from the VCarve Pro folder in the program section of your Windows Start menu.

At the bottom of the page you will see an area with View All Help. This will download all the Help Documentation as a single web page which is useful for searching or if you need to create a paper copy of the documentation.

User Guides, tutorial and training

Please note that this document is a Reference Manual. If you require more guidance, or are still learning how to use VCarve Pro, please ensure that you view the Getting Started Video Tutorials in the VCarve Pro Video Tutorial Browser when starting the software, or go to the User Manual section.

VCarve Pro also includes an extensive selection of video tutorials, which are accessible from the Tutorial Video Browser link when application first starts. These tutorials cover every aspect of VCarve Pro’s functionality and range in complexity from a beginner’s overview, to advanced features and principles. They are intended to be extremely accessible by level of experience or topic and use real-world examples throughout. Videos can be watched online, or installed locally.

We welcome any comments on this manual or the other training material, please email support@vectric.com with your feedback.

License Dialog

The License Dialog is used to set the details you need to activate the software. This dialog can also be used to activate optional modules. The page that initially appears will give you the option to set your license details either automatically from your V&Co account or manually.

The ‘Online Method’ section below covers the process to follow if Online is selected.

The ‘Manual Method’ section below shows the process to follow if you wish to type in your license details manually or do not have an Internet connection available.

Online Method

This method will allow you to retrieve your details automatically from your V&Co account. To use this select ‘Online’ and then click Next on the form. The online section of the form will then be displayed.

Pressing Login... on this dialog will launch a web browser which will take you to the V&Co login page if authentication is required.
After logging in with your V&Co account details another page may appear asking for permission for VCarve Pro to access your license details.

This page will only appear if you have not already granted access. If this appears you should select ‘Allow’ to enable VCarve Pro to retrieve your license details automatically.

At this point VCarve Pro should be being displayed and the dialog should be automatically populated with any licenses available on your account.

You can select any of the product licenses available and information on the type of license will be displayed in the status area. Once the license and any modules have been selected by clicking on them Next > can be pressed to activate these and proceed to the summary page.

Note: If there is only a single license available on your account the above page is skipped and the summary page (below) will already be displayed.
This page displays the selected license and module details. If you are changing current license details or adding a module a restart will be required for these to fully take effect. In this case a check box will appear allowing you to restart automatically. If this is checked then when you press Finish VCarve Pro will automatically be restarted to apply the license changes. If you do not select this option the license changes take effect the next time VCarve Pro is restarted.

**Manual Method**

The manual method allows entry of license details without requiring an Internet connection. Selecting ‘Manual’ and clicking Next> will cause the manual entry form to be displayed.

The 'Registered User Name' from your license information should be entered into the ‘Licensed To’ area of the form and the license code can either be copied and pasted into the middle row of the dialog or manually typed into the lower section if ‘Enter license code manually’ is selected. The Next> button will become available when a code of the expected length has been entered.

If the product is already licensed then a module code can be entered at this stage instead of the product code. If you wish to manually activate both a product and module code the product code should be added here and there will be an opportunity to add the module code later. Pressing Next> will set the license and display the summary screen.

The summary screen shows the current licensed user and has an Add Module button to allow additional modules to be added. Pressing this button will display the manual entry form again and allow the module details to be entered.

If the licensed user is changed or a new module is added a restart will be required for these to take full effect. In this case a check box will appear allowing you to restart automatically. If this is checked then when you press the finish button the program will automatically be restarted to apply the license changes. If you do not select this option the license changes take effect the next time the program is restarted.

**View Controls**
Your project is represented using 2D and 3D workspaces, each viewed via independent windows called the 2D View and 3D View respectively. This division usefully maps to the typical workflow in which you will initially focus on the 2D design and layout of your project before moving to the 3D stage of modeling, toolpathing and previewing your finished part.

You can switch between the views using the tabs at the top of each window. In addition the shortcut-keys F2 and F3 will toggle the display between the two windows.

It is sometimes useful to see both the 2D and 3D representations at the same time. The Page Up and Page Down keys will arrange the 2 views either horizontally or vertically so you can see both workspaces simultaneously. To return to the tabbed display, simply click on the standard Windows Maximize button in the top right corner of either view window.

Many of the controls for manipulating the view in your project are similar in both 2D and 3D.

From within each view you can also directly interact with the objects that make up your job using the Object Selection Tools.

### 2D View Controls

See also the Rulers, Guides and Snap Grid section.

- **Pan**
  - Click and hold the Left mouse button and drag the mouse about to Pan - Esc to cancel mode
  - Shortcut: Click and drag the Middle mouse button or if using a 2 button mouse, Hold Ctrl + drag with Right Mouse button.

- **Zoom**
  - Interactive: Mouse with Middle Wheel - Scroll wheel in / out
  - Mouse without Middle Wheel - Hold Shift + Push / Pull with Right Mouse button.

- **Zoom Box**
  - Click top left corner, hold mouse down and drag to bottom right corner and release. Clicking the left mouse button will zoom in, Shift + click will zoom out.

- **Zoom Extents**
  - Zooms to show material limits in the 2D window

- **Zoom Selected**
  - With objects selected
  - Zooms to the bounding box of the selection

### 3D View Controls

- **3D Twiddle**
  - Click and drag Left mouse button in the 3D window

- **Zoom**
  - Right mouse button - Push / Pull
  - Mouse with Middle Wheel - Rotate wheel

- **Pan**
  - Click and drag Right mouse button and hold Ctrl :
  - Click and drag Right and Left mouse button
  - Click Middle mouse button

- **Zoom to Fit**
  - Zooms the whole 3D part to fit within the current 3D View window

- **Isometric View**
  - Shows the model in a 3D isometric view in the 3D window

- **Plan View (Down Z)**
  - Shows the top view of the model in the 3D View looking down the Z axis.
  - Press Shift to show the bottom.

- **Side View (Along X)**
  - Shows the side view of the model in the 3D View looking along the X axis.
  - Press Shift to show the opposite side.

- **Side View (Along Y)**
  - Shows the side view of the model in the 3D View looking along the Y axis.
  - Press Shift to show the opposite side.

- **Rotate around model**
  - Rotate clockwise / anti-clockwise around the model (Available only in a Rotary project with Wrapped View on).
The View Toolbar

Above the view window is a handy toolbar that allows easier access to common tools. With the ability to create a double sided project you have easy access to switch between the Top and Bottom Sides of your project. The Layers Drop down bar has now moved from the drawing tab to the View Toolbar, making it accessible at all times. The other icons displayed in order of left to right are as follows:

Snapping Toggle Options

- Snap to geometry
- Smart Snapping
- Snap to Grid

View Controls

- Toggle Pan / Twiddle View
- Zoom to box
- Zoom to drawing
- Zoom to selection

Toolpath Drawing Toggle

- Toggle 2D Toolpath Drawing
- Toggle solid 2D Toolpath Drawing

3D Drawing

- Toggle drawing of material block

Tile 2D & 3D View Windows

- Stack 2D and 3D View windows vertically
- Stack 2D and 3D View windows horizontally

Two-Sided Machining

When you are working on a two-sided job additional icons will appear on the View Toolbar. On the left you will see an icon indicating whether the job you are working on will be flipped horizontally or vertically. This is important because the software will automatically mirror your toolpaths and geometry around different axes depending on this setting. To maintain the correct alignment of your toolpaths you must physically turn the material on your CNC machine in the same direction as you have specified during the design process.

- Turn horizontally from left to right.
- Turn vertically, end over end.

Note: This icon is just for you information and does not perform any operation; it is not clickable.

The next button indicates which side you are currently working on. It is a toggle button that can be clicked. Clicking this button swaps the active side of your job.

- Top side is active, all operations will apply to the Top side.
- Bottom side is active, all operations will apply to the Bottom side.

Note: The rulers that border the 2D View are colored to provide a handy visual indicator as to which side is currently active. An orange background indicates that the Bottom side is currently active and any drawing or toolpaths are associated with the Bottom Side of your design.

The final additional tool for two-sided job is on the right hand side of the View Toolbar and it allows you to toggle the 3D composite relief to show either the currently active side or your model only, or both sides of your model as a single solid block.
Rotary Machining

When you are working on a rotary job an additional icon will appear. This button allows you to toggle the 3D view between wrapped display mode and flat display mode.

- 🔄 Toggle Wrapped 3D view.
VCarve Pro includes drawing and editing tools that allow designs to be created and modified, which can ultimately be used directly for toolpath creation.

Commands for vector creation and editing are very easy to use and multiple design elements can also be drawn or imported, scaled, positioned and interactively edited to make a new design.

Text can also be created using any TrueType or OpenType fonts installed on your computer, or the single stroke engraving fonts supplied with the software.
File Operations

New, Open and Save

Create a New File
This option opens the Job Setup form, which is used to create a new blank job of the specified dimensions and type. The relative origins for X0, Y0 and Z0 are also specified at this point, and the measurement units can be set in either inches or metric. The Modeling Resolution and default 3D shading color/material can also be set at this stage.

Open a File
This option opens the File Open dialog window, allowing VCarve Pro files (CRV) and importable 2D vector files to be selected and opened.

Save a File
This option opens the File Save As dialog window and allows the job to be saved as a VCarve Pro file. Navigate to the required folder, enter a suitable name for the job and click the Save button.

Import Vectors
This opens the File Open dialog window and allows 2D DXF, EPS and AI and PDF files to be imported into the 2D View. The imported vectors will always be read in at the size and scale they were created in their original design software. Once open they can be scaled and edited in the same way as vectors created in VCarve Pro. All the Vector tools will be dealt with in that section of this manual.

To import toolpaths from PhotoVCarve and Cut3D (.PVC and .V3D file extensions) use File ► Import... ► Import PhotoVCarve or Cut3D Toolpaths from the main menu bar. Any Toolpath data saved as .PVC or .V3D files can be imported and will be visible in the Toolpath List.

See the 3D Toolpath Files section for detailed instructions on importing PhotoVCarve(*.pvc), Cut3D(*.v3d) or Vectric 3D Machinist(*.v3m) files.

Import Bitmap
This opens the File Open dialog window and allows image files to be selected and imported into the current open job. File types - BMP, JPG, TIF, GIF, PNG

Images are imported to sketch vectors over the top of them, generate traced vectors.

File Types

CRV Files previously created and saved in VCarve Pro will be opened and displayed in the 2D Design window. All calculated toolpaths are stored/opened from the CRV file.

DXF Files from other CAD or graphics software packages such as AutoCAD will be opened in the original size and position. The Job Setup Form is automatically opened showing the maximum X and Y dimensions of the opened design. The actual size of the material can then be specified along with the required thickness and appropriate X0, Y0 and Z0 origins.

DWG

EPS Files from typical design software such as Corel Draw can be opened. The Job Setup form will automatically be opened so the required material size can be specified. By default the EPS file will be placed with the lower left corner of the design at X0, Y0.

AI Files from typical design software such as Adobe Illustrator and Corel Draw can be opened. The Job Setup form will automatically be opened so the required material size can be specified. The AI file will be placed with the lower left corner of the design at X0, Y0.

PDF Software such as the Adobe product range can be used to convert files from other design and word processing software into the industry standard PDF file format. The text and vector content of PDF files is extracted when imported into VCarve Pro. When importing multiple page PDF documents each page is placed on a separate layer.

SKP SketchUp files with a .SKP extension (see www.sketchup.com) can be imported as 2D data suitable for machining. See the Sketchup section for detailed instructions on importing Sketchup files.

SketchUp Files
SketchUp files with a .SKP extension (see www.sketchup.com) can be imported as 2D data suitable for machining into a VCarve Pro job using the File ► Import Vectors... command from the menu bar or the import vectors icon on the Drawing tab. To import data from a SketchUp file you must already have created or opened a job to import the data into.

As a SketchUp model is usually a 3D representation of the part, the SketchUp importer offers a number of options to allow you to start manufacturing the model.

We will illustrate the two main choices for how the model will be imported using the SketchUp model shown to the left.

The model shown in the screenshots is a cabinet constructed by following the instructions in the Fine Woodworking ‘Google SketchUp guide for Woodworkers: The Basics’ DVD which is available via the Fine Woodworking site at www.finewoodworking.com. Vectric have no affiliation with Fine Woodworking, we are just using screenshots of the model constructed while following their tutorials to illustrate the process of importing a SketchUp model.

When the SketchUp model is selected from the File Import dialog, the following dialog will be displayed.

Although this initially looks complex, the dialog is divided into four logical sections which will be describe below.

**Layout of Imported Data**

In the first section there are two main choices for how the data from the model will be imported, ‘Exploded Flat Layout’ and ‘Three Views - Front, Top, Side’ as shown below.

We will describe the ‘Three Views - Front, Top, Side’ option first as it is the simplest.

**Three Views - Front, Top, Side**

This option will create an ‘engineering drawing’ style layout of the SketchUp model as shown in the screenshot below.

The size of the model is preserved and it is relatively simple to pick up dimensions for parts you are going to manufacture from the various views. The colors of the lines you see are taken from the colors of the original SketchUp layers the various parts of the model are on.
Exploded Flat Layout

This option will take each component in the model and orientate it flat ready for machining as shown in the screenshot below.

Once this option is selected a number of sub-options also become available.

Part Orientation
This section controls what VCarve Pro considers to be the 'top' face of each part.

**Auto Orientate**

If this option is selected, for each part in the model, the 'face' with the largest area based on its outer perimeter (i.e. ignoring holes etc.) is considered to be the 'top' face and the part is automatically rotated so that this face is facing upwards in Z. This strategy works very well for models which are to be manufactured from sheet goods where there are no features on particular faces which need to be on the 'top' (such as pockets).

**Orientate by material**

This option allows the user to control more explicitly the orientation of each part in the model. Within SketchUp the user can 'paint' the face of each component/group with a material/color of their choice to indicate which face will be orientated on top when the model is imported. When this option is selected simply chose the material which has been used to indicate the top face from the drop down list. If a part is found in the model which does not have a face with the specified material, that part will be oriented by making the largest face the top.

**Gap between parts**

This field lets the user specify the gap between parts when they are first imported. After importing, the nesting functions within VCarve Pro can be used to layout the parts with more control and across multiple sheets.

**Create Circles / Arcs**

SketchUp does not maintain true arc or circle information for the boundaries of its parts. This is a problem when it comes to machining as the 'polygonal' SketchUp representation can give very poor machining results. For this reason, VCarve Pro offers the option to refit circles and arcs to imported data.

![Create Circles / Arcs](image)

The screenshot above left shows the results of importing a part with a filleted corner and hole with these options unchecked. The 'fillet' is made up of a series of straight line segments and the circular 'hole' is actually a polygon made up of straight lines.

The screenshot above right shows the same part imported with both these options checked. The 'fillet' now consists of a single smooth arc and the circular 'hole' now also consists of arcs rather than straight line segments. Both these features will machine more cleanly in this form.

**Data to Import**
A SketchUp model will often contain parts that you do not wish to machine (such as hinges, knobs etc.) or data which will be cut from different thicknesses of material and hence different parts need to be imported into different VCarve Pro jobs. To allow control over what is imported you can choose to only import parts of the model which are on particular layers using this section of the dialog.

To only import data from selected layers, choose the “import visible data on selected layers” option and click the check box next to each layer to indicate if you want to import data from that layer. Note that the number of parts on each layer is displayed next to the layer name.

It is very easy to assign different parts of the model to different layers within SketchUp to help with the import process into VCarve Pro. The screenshot below shows the result of only importing data on the "Door" layer from the example.

As long as the ‘Group imported parts’ option is selected, these parts can then be easily nested ready for machining as shown in the image below (the “Group imported parts” option is explained later in this section).

Component / Group Handling
This section of the form allows advanced handling of how 'parts' within the SketchUp model are identified and treated on import.

**Group imported parts**

This option is normally selected for all but the simplest models as it allows each 'part' of the model to be selected, moved and nested easily after import. You will need to ungroup the imported data after nesting etc. to allow individual features to be machined. By default, VCarve Pro will treat each SketchUp group / component as a single part UNLESS it contains other groups or components within it, in which case each lowest level group / component will be treated as a separate part.

Items which you retain in groups can be ungrouped at any time in the usual ways.

If the right-click menu-option to **Ungroup back onto original object layers** is used (which is the default option when using the icon or shortcut) then the software will place the ungrouped items back onto the original layers they were created on in SketchUp.

**Keep components starting with two underscores (__) together**

If you have a complex model which contain 'parts' which are made up of other groups / components, you will need to do some work on your model to identify these parts for VCarve Pro. The way this is done is by setting the name of the groups / components that you wish to be treated as a single part to start with __ (two underscore characters). For example, if you had a model of a car and you wanted the wheels / tires / hub nuts to be treated as a single part even though the Tire, Wheel and other parts were separate components, you would group the parts together and name them something like __WheelAssembly in SketchUp. When this model was imported, and VCarve Pro reached the group/component with a name starting with __ it would treat all subsequent child objects of that object as being the same part.

**Replace outer boundary (for flat jobs only!)**

There is a style of 'building' with SketchUp where individual 'parts' are made up of several components 'butted' against each other. The screenshot below shows such a component.

This object is made up of many smaller components representing the tabs on the top, the connectors at the end and the support at the bottom as shown below.

Although when can treat this as a single 'part' when imported by starting its name with __ (two underscores), the imported part is still going to be difficult to machine. The screenshot below shows the part imported into VCarve Pro without the 'Replace outer boundary' option checked. The part in the image has been ungrouped and the central vector selected.

As you can see, the outer boundary is made up of separate segments for each 'feature'. VCarve Pro does have the ability to create an outer boundary for vectors but this can be time consuming if it has to be done manually. If the 'Replace outer boundary' option is checked, VCarve Pro will try to create a single outer boundary and delete all the vectors which were part of this boundary. The screenshot below shows the result of importing the same data with this option checked. This time the part has been ungrouped and the outer vector selected.

This data is now ready to be machined directly. It is important to understand the limitations of this option. It can be substantially slower. Creating robust boundaries for each part can consume a lot of processing power. Any feature which shares an edge with the boundary will be deleted. If the tabs on the top of this part were to have been machined 'thinner', this approach would not have been suitable as the bottom edge of the tabs has been removed.
The new features will help a lot of SketchUp users dramatically reduce the time it takes to go from a SketchUp design to a machinable part using VCarve Pro.

It is important to understand though that while these options provide a useful set of tools, in many cases there will still be additional editing required to ensure the part is ready to toolpath. Understanding the options and how they work will allow the part to be designed in SketchUp with these in mind and therefore help to minimize the time to machine once the data is imported.

**Note:** Sketchup files will only open in the same bit version you are running e.g. A file saved in a 32 bit version of Sketchup will only open up in a 32 bit version of VCarve Pro.

### 3D Toolpath Files

Files from Vectric’s Cut3D, PhotoVCarve and Design and Make Machinist that include 3D toolpaths can be imported into VCarve Pro using the main menu command: **File ► Import ► PhotoVCarve, Machinist or Cut3D Toolpaths.**

The 3D file must first be scaled to the required size before toolpaths are calculated, and then the complete file saved ready for importing into VCarve Pro. These files can only be moved and positioned inside VCarve Pro but cannot be scaled.

A Grayscale thumbnail of the 3D job is drawn in the 2D View with the X0 Y0 origin at the position it was set in Cut3D, PhotoVCarve or Design and Make Machinist. The associated toolpath(s) are also drawn in the 3D window and the names appear in the Toolpath list.

### Positioning

To move the 3D design toolpaths:

Open the 2D Window, Click the Left mouse Twice on grayscale image (turns light Blue to indicate it’s selected) Drag to the required position Or use the Move or Alignment tools for accurate positioning.

The toolpath(s) are automatically moved in the 3D window to the same XY position as the image.

![Origin for the 3D data at X0 Y0](image1.png) ![Grayscale image moved to middle of job](image2.png)

Toolpaths for the example above have been calculated with the X0 Y0 in the middle of the 3D design. When imported into Cut2D the data is automatically positioned using the same coordinates, which places three quarters of the design off the job. In the second image the grayscale image has been moved to the middle of the job.

The 2D mirror and rotate drawing tools can also be used to edit the 3D data set.

3D toolpaths can also be copied using the Duplicate Toolpath command on the Toolpaths Tab making it very easy to use multiple elements from a single design on a job. The thumbnail preview is also copied for each toolpath, making it very easy to position additional copies of a 3D toolpath.

For example, a single design can be copied and mirrored to create Left and Right versions of a 3D design or to place multiple copies of a decorative design in the corners of a cabinet door panel as shown below.
The 4 corner roses are all copied from a single file

Toolpaths for the 3D elements can be previewed along with the conventional Profile, Pocketing and Drilling toolpaths, and everything will be saved ready for machining.

A good example of where this functionality might be used in conjunction with PhotoVCarve is for making personalized picture frames that include the PhotoVCarve grooves plus descriptive engraved text and a decorative Profiled or Beveled border. As shown below:

As shown below:

2D window showing thumbnail previews, text and decorative border

3D window previewing the completed job

Options

Imported toolpaths can also be edited to position them inside the material or to change the cutting parameters - speeds and feed rates can be changed.

Note: When using a Design and Make Machinist file that includes multiple toolpaths, you must remember to edit the Start Depth for all of the imported 3D toolpaths.

Click the Edit toolpath icon or Double click on the toolpath name to open the edit form.

For example, after machining a half-inch deep pocket a PhotoVCarve design can then be edited to have a Start Depth = 0.5 inches and this will carve the photograph onto the base of the pocket surface.
PDF Export

The PDF Export form allows vectors within your drawings to be exported into PDF format.

Vector(s)

Selecting Export All will export all of the vectors contained on the specified sheets and layers.

Selecting Export Selected Only will export only the vectors which are currently selected and on the specified sheets and layers.

Sheets

The sheets you wish to be exported to PDF can be selected from within this section. Clicking Clear All will deselect all of the sheets and clicking Select All will cause all of the sheets to become selected. You can also manually select/deselect individual sheets by clicking on the check box to the left of the sheet name.

Note: Each sheet will be saved as a separate page within the PDF file.

Layers

The layers you wish to be exported to PDF can be selected from within this section. All the visible layers with content on them will show up in this list.

When All visible layers is chosen all of the vector layers will be selected. Only vectors on the layers selected will be exported into the PDF file. When Selected layers only is chosen individual layers can be manually selected/deselected by clicking on the check box to the left of the layer name.

Options

Export Job Bounds - If this option is selected a vector representing the boundary of the job will also be output to the PDF file.

Clicking Export will prompt you to choose a filename and location for your file and save your drawing in PDF format at that location.

Cut, Copy and Paste

The Cut, Copy and Paste functions in VCarve Pro can be used on Vectors or Bitmaps.
**Cut**

The Cut tool removes the selected objects from a design in a similar way to pressing the Delete key, but the selected objects are copied to the clipboard and can be Pasted into either the current file or a new file if required. Only one item can be Cut or Copied at a time.

**Copy**

The Copy tool copies selected objects to the clipboard, leaving the original in place and allows duplicates to be made and re-used in the design by pressing the Paste icon. Only one item can be Cut or Copied at a time.

**Paste**

This Paste option places the contents of the clipboard (created by Cut or Copy) into the design, allowing elements to be re-used in different areas of a design or in other VCarve Pro parts.

**Undo**

Clicking this option steps backwards through the design changes made by the user.

**Redo**

Clicking this option steps forward through design steps that have been Undone using the Undo command (see above) to get back to stage that the user started using the Undo function.

---

**Job Setup**

The Job Setup form is displayed whenever a new job is being created, or when the size and position of an existing job is edited. It allows to create following types of job:

- **Single Sided**
- **Double Sided**
- **Rotary**

**Job Setup - Single Sided**

The Job Setup form is displayed whenever a new job is being created, or when the size and position of an existing job is edited.

**Job Type**

**Single Sided** job type should be used when design only requires the material to be cut from one side. This is the simplest type of job to design and machine.

For more information about **Double Sided** job type see Job Setup - Double Sided.

For more information about **Rotary** job type see Job Setup - Rotary.

**Job Size**

This section of the form defines the dimensions of the material block you will be using for your project in terms of width (along the X axis), height (along the Y axis) and thickness (along the Z axis).

It also allows you to select which units of measurement you prefer to design in - either inches (Imperial/English) or millimeters (Metric).

**Z Zero Position**

Indicates whether the tip of the tool is set off the surface of the material (as shown in the diagram) or off the bed / table of the machine for Z = 0.0.
**XY Datum Position**

This datum can be set at any corner, or the middle of the job. This represents the location, relative to your design, that will match the machine tool when it is positioned at X0, Y0. When this form is open, a red square is drawn in the 2D view to highlight the datum’s position.

**Use Offset**

This option allows the datum position to be set to a value other than X0, Y0.

**Design Scaling**

*Note: This section of the form is only visible when editing an existing job, not when creating a new job.*

When editing the Job Size parameters of an existing job, this option determines whether any drawings you have already created will be scaled proportionally to match the new job dimensions. If you wish to preserve the existing size of your drawings, even after the job size has changed, leave this option unchecked. With this option checked, your drawings will be re-sized to remain in the same proportion and relative position within your new material extents when you click **OK**.

**Modeling Resolution**

This sets the resolution/quality for the 3D model. When working with 3D models a lot of calculation and memory may be required for certain operations. Setting the Resolution allows you to choose the best balance of quality and speed for the part you are working on. The better the resolution quality chosen, the slower the computer will perform.

As this is completely dependent on the particular part you are working on and your computer hardware performance, it is difficult in a document like this to recommend what the setting should be. Generally speaking, the Standard (fastest) setting will be acceptable for the majority of parts that VCarve Pro users make. If the part you are making is going to be relatively large (over 18 inches) but still has small details, you may want to choose a higher Resolution such as High (3 x slower) and for very large parts (over 48 inches) with small details then the Highest (7 x slower) setting may be appropriate.

The reason that the detail of your part needs to be taken into account is that if you were making a part with one large item in it (e.g. a fish) then the standard resolution would be OK but if it was a part with many detailed items in it (e.g. a school of fish) then the High or Highest setting would be better. As previously stated these are extremely general guidelines as on slower/older computers operations with the highest setting may take a long time to calculate.

As the Resolution is applied across your whole work area it is important to set the size of your part to just be big enough to contain the part you plan to carve. It would not be advisable to set your material to be the size of your machine - e.g. 96 x 48 if the part you plan to cut is only 12 x 12 as this would make the resolution in the 12 x 12 area very low.

**Appearance**

This sets the color or material effect which will be applied to the base 3D model. It is possible to change this at any time and also to apply different colors and materials to different Components using the Component manager.

In most cases a new job represents the size of the material the job will be machined into or at least an area of a larger piece of material which will contain the part which is going to be cut. Clicking **OK** creates a new empty job, which is drawn as a gray rectangle in the 2D View. Dotted horizontal and vertical grey lines are drawn in the 2D design window to show where the X0 and Y0 point is positioned.
Job Setup - Double Sided

The Job Setup form is displayed whenever a new job is being created, or when the size and position of an existing job is edited.

Job Type

Double Sided job type is useful when it is desired to cut both sides of your material. VCarve Pro allows you to visualise and manage the creation and cutting process of both sides of your design within a single project file.

Note: For an overview of double sided machining see Two-Sided Machining.

For more information about Single Sided job type see Job Setup - Single Sided.

For more information about Rotary job type see Job Setup - Rotary.

Job Size

This section of the form defines the dimensions of the material block you will be using for your project in terms of width (along the X axis), height (along the Y axis) and thickness (along the Z axis).

It also allows you to select which units of measurement you prefer to design in - either inches (Imperial/English) or millimeters (Metric).

Z Zero Position

Indicates whether the tip of the tool is set off the surface of the material (as shown in the diagram) or off the bed/table of the machine for Z = 0.0.

Zero off same side

This option allows Z Zero to reference the same physical location, regardless whether material is flipped or not.

XY Datum Position

This datum can be set at any corner, or the middle of the job. This represents the location, relative to your design, that will match the machine tool when it is positioned at X0, Y0. While this form is open, a red square is drawn in the 2d view to highlight the datum's position.

Use Offset

This option allows the datum position to be set to a value other than X0, Y0.

Flip Direction Between Sides

This section gives choice between horizontal and vertical flipping when changing machining side. VCarve Pro uses that information to correctly manage the alignment of the geometry relating to each side.

Design Scaling

Note: This section of the form is only visible when editing an existing job, not when creating a new job.

When editing the Job Size parameters of an existing job, this option determines whether any drawings you have already created will be scaled proportionally to match the new job dimensions. If you wish to preserve the existing size of your drawings, even after the job size has changed, leave this option unchecked. With this option checked, your drawings will be re-sized to remain in the same proportion and relative position within your new material extents when you click OK.

Modeling Resolution

This sets the resolution/quality for the 3D model. When working with 3D models a lot of calculation and memory may be
required for certain operations. Setting the Resolution allows you to choose the best balance of quality and speed for the part you are working on. The better the resolution quality chosen, the slower the computer will perform.

As this is completely dependent on the particular part you are working on and your computer hardware performance, it is difficult in a document like this to recommend what the setting should be. Generally speaking, the Standard (fastest) setting will be acceptable for the majority of parts that VCarve Pro users make. If the part you are making is going to be relatively large (over 18 inches) but still has small details, you may want to choose a higher Resolution such as High (3 x slower) and for very large parts (over 48 inches) with small details then the Highest (7 x slower) setting may be appropriate.

The reason that the detail of your part needs to be taken into account is that if you were making a part with one large item in it (e.g. a fish) then the standard resolution would be OK but if it was a part with many detailed items in it (e.g. a school of fish) then the High or Highest setting would be better. As previously stated these are extremely general guidelines as on slower/older computers operations with the highest setting may take a long time to calculate.

As the Resolution is applied across your whole work area it is important to set the size of your part to just be big enough to contain the part you plan to carve. It would not be advisable to set your material to be the size of your machine - e.g. 96 x 48 if the part you plan to cut is only 12 x 12 as this would make the resolution in the 12 x 12 area very low.

**Appearance**

This sets the color or material effect which will be applied to the base 3D model. It is possible to change this at any time and also to apply different colors and materials to different Components using the Component manager.

In most cases a new job represents the size of the material the job will be machined into or at least an area of a larger piece of material which will contain the part which is going to be cut. Clicking OK creates a new empty job, which is drawn as a gray rectangle in the 2D View. Dotted horizontal and vertical Grey lines are drawn in the 2D design window to show where the X0 and Y0 point is positioned.

**Job Setup - Rotary**

The Job Setup form is displayed whenever a new job is being created, or when the size and position of an existing job is edited.

**Job Type**

*Rotary* job type enables the use of a rotary axis (also called a 4th axis or indexer). VCarve Pro will provide alternative visualisation, simulation and tools appropriate for rotary designs.

Note: For a overview of rotary machining see Rotary Machining and Wrapping.

For more information about *Single Sided* job type see Job Setup - Single Sided.

For more information about *Double Sided* job type see Job Setup - Double Sided.

**Job Size**

**Length**

Length of the material

**Diameter**

Diameter of the material

**Units**

Whether the job units are measured in mm or inches

**Z Zero Position**

Indicates whether the tip of the tool is set off the rotation axis (as shown in the diagram) or off the surface of material for Z = 0.0. For the best accuracy using *Cylinder Axis* option is recommended

**XY Datum Position**
This datum can be set at any corner, or the middle of the job, when viewed as a flat 2D drawing. This represents the location, relative to your design, that will match the machine tool when it is positioned at X0, Y0. While this form is open, a red square is drawn in the 2D view to highlight the datum’s position.

**Use Offset**

This option allows the datum position to be set to a value other than X0, Y0.

**Orientation**

This option selects along which axis the material block will rotate.

- Selecting **Along X Axis** means that X coordinates represent movement along the cylinder, whereas Y coordinates represent the angle around the cylinder.
- Selecting **Along Y Axis** means that Y coordinates represent movement along the cylinder, whereas X coordinates represent the angle around the cylinder.

**Flip Design**

When this option is enabled, the design will be flipped when the orientation is changed.

**Design Scaling**

When editing the Job Size parameters of an existing job, this option determines whether any drawings you have already created will be scaled proportionally to match the new job dimensions. If you wish to preserve the existing size of your drawings, even after the job size has changed, leave this option unchecked. With this option checked, your drawings will be re-sized to remain in the same proportion and relative position within your new material extents when you click OK.

**Modeling Resolution**

This sets the resolution/quality for the 3D model. When working with 3D models a lot of calculation and memory may be required for certain operations. Setting the Resolution allows you to choose the best balance of quality and speed for the part you are working on. The better the resolution quality chosen, the slower the computer will perform.

As this is completely dependent on the particular part you are working on and your computer hardware performance, it is difficult in a document like this to recommend what the setting should be. Generally speaking, the Standard (fastest) setting will be acceptable for the majority of parts that VCarve Pro users make. If the part you are making is going to be relatively large (over 18 inches) but still has small details, you may want to choose a higher Resolution such as High (3 x slower) and for very large parts (over 48 inches) with small details then the Highest (7 x slower) setting may be appropriate.

The reason that the detail of your part needs to be taken into account is that if you were making a part with one large item in it (e.g. a fish) then the standard resolution would be OK but if it was a part with many detailed items in it (e.g. a school of fish) then the High or Highest setting would be better. As previously stated these are extremely general guidelines as on slower/older computers operations with the highest setting may take a long time to calculate.

As the Resolution is applied across your whole work area it is important to set the size of your part to just be big enough to contain the part you plan to carve. It would not be advisable to set your material to be the size of your machine - e.g. 96 x 48 if the part you plan to cut is only 12 x 12 as this would make the resolution in the 12 x 12 area very low.

**Appearance**

This sets the color or material effect which will be applied to the base 3D model. It is possible to change this at any time and also to apply different colors and materials to different Components using the Component manager.

In most cases a new job represents the size of the material the job will be machined into or at least an area of a larger piece of material which will contain the part which is going to be cut. Clicking OK creates a new empty job, which is drawn as a gray rectangle in the 2D View. Dotted horizontal and vertical Grey lines are drawn in the 2D design window to show where the X0 and Y0 point is positioned.
The Create Vectors Tool Group

Create Vectors

Closed Shapes
Open Shapes
Creating Text
Trace Bitmap
Dimensions

Drawing Shapes

Each tool gives you the option of dynamically drawing with the mouse in the 2D View, or entering precise data using the form. When you click on a shape tool icon its associated form will open on the Drawing tab. Here you can see the precise dimensions of the shape you are working on, which you can edit directly, as well as other options specific to the type of shape you are editing.

If you click on a shape drawing tool when nothing is selected in the 2D View, you will be able to create new shapes using the Create button. If you select a previously created shape, you will be able to modify its properties using the same form and update the shape using the Apply button.

Note: Pressing the Space-bar re-opens the last vector creation form you used. This is very useful when using other forms in between each shape you create.

Creating Text

There are a number of tools dedicated to the creation and editing of text. These can be found on the Drawing tab, below the shape creation tools.

VCare Pro can make use of any TrueType font already installed on your computer, as well as Vectric’s own single-line fonts designed specifically for CNC machining.

Use the Draw Text, or Draw Auto Text, to create text within your design. The Text selection tool then allows you to dynamically alter the text positioning, spacing or even to bend your text into an arc. For even more flexibility, use the Text on Curve tool to place your text along any vector curve or line that you have drawn. The Convert Text to Curves tool allows you to then use Node Editing to fine tune the vectors of the text to any shape required.

The text tools are accessed using the following icons:

Create Text
Auto Layout Text
Text Selection
Convert Text to Curves
Text on a Curve

Trace Bitmap

Trace Bitmap tool allows you to automatically trace imported bitmaps using a variety of options within the tool to control the vectors that are created.

Dimensions

The dimensions tool allows you to add a variety of dimensioning annotations to your vector drawing.

Draw Circle

Circles can be created interactively with the cursor and Quick Keys or by entering the exact coordinates and diameter / radius with typed input.

Note: Pressing the Space-bar re-opens the last vector creation form you used. This is very useful when using other forms in between each shape you create.

Interactive

Cursor
The default mode and the procedure for drawing circle is:
Click and drag the Left mouse to indicate the center point followed by
releasing the button at the required radius / diameter (depends on what is
set on the form).

**Note:** Holding Alt and dragging creates a circle from the middle
point.

As the cursor is dragged across the screen the radius is dynamically
updated. The increments will depend upon your snap radius and the job
size.

**Quick Keys**

The radius or diameter can be specified while dragging out a circle:
Type the value while dragging followed, by D if it’s a diameter, or R if it’s a radius:

<table>
<thead>
<tr>
<th>Keys</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2 R</td>
</tr>
<tr>
<td>2</td>
<td>R</td>
</tr>
<tr>
<td>1</td>
<td>D</td>
</tr>
</tbody>
</table>

**Exact Size**

Circles can also be drawn by entering the required XY origin, selecting either Radius or Diameter and entering the required
size on the form.

Click Create to update the circle.

**Edit**

Open the Draw Circle form and select the circle to modify.
The selected circle is displayed as a dotted magenta line. Edit the Center Point and Radius or Diameter
Click Apply to update the circle

To modify another circle without closing the form hold a Shift key down and select the next circle.

**Close the form**

To finish drawing with the tool, you can:
- Click Close on the form
- Press the Esc key
- Click the Right mouse button in the 2D View.

**Draw Ellipse**

Ellipse / ovals can be created interactively with the cursor and Quick Keys or by
entering the exact coordinates for the center point, height and width with typed input.

**Interactive - Cursor**

The quickest and simplest way to draw an ellipse is:
- Click and drag the left mouse button in the 2D View to begin drawing the ellipse from its corner.
- While holding the left mouse button, drag to the required size.
- Releasing the left mouse button.
Quick Keys

Instead of releasing the left mouse button when you have dragged your shape to the required size, you can also type exact values during the dragging process and set properties precisely.

- Left-click and drag out your shape in the 2D View.
- With the left mouse button still pressed, enter a quick key sequence detailed below.
- Release the left mouse button.

Default

By default, two values separated by a comma, will be used to set width and height of your ellipse. One value will create a circle with the given diameter. While you are dragging out the ellipse, type \textit{Width Value, Height Value Enter} or \textit{Diameter Enter} to create an ellipse with the specified dimensions.

Example

<table>
<thead>
<tr>
<th>Keys</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.5, 1 Enter</td>
<td>Creates ellipse with a width of 2.5 and a height of 1.</td>
</tr>
</tbody>
</table>

Specifying Further Properties

By using specific letter keys after your value, you can also indicate precisely which property it relates to.

<table>
<thead>
<tr>
<th>Quick Keys</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value X</td>
<td>Creates an ellipse at the current dragged height, but with the width set to the entered value.</td>
</tr>
<tr>
<td>Value Y</td>
<td>Creates an ellipse at the current dragged width, but with the height set to the entered value.</td>
</tr>
<tr>
<td>Value W Value H</td>
<td>Creates an ellipse with a specified width (W) and height (H).</td>
</tr>
</tbody>
</table>

Examples

<table>
<thead>
<tr>
<th>Keys</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 X</td>
<td>Current dragged height with width (X) of 1.</td>
</tr>
<tr>
<td>1 Y</td>
<td>Current dragged width and height (Y) of 1.</td>
</tr>
<tr>
<td>1 W 2 H</td>
<td>A width (W) of 1 and height (H) of 2.</td>
</tr>
</tbody>
</table>

Note: These key combinations must be pressed whilst dragging with the mouse to create the ellipse.

Exact Size

Accurate ellipses can also be drawn by entering the required XY origin point with the Width and Height of the oval. Click \textit{Apply} to create the ellipse.

Edit

- Select the ellipse to modify and open the \textit{Draw Ellipse} form.
- The selected shape is displayed as a dotted \textit{magenta} line.
- Edit the Width and Height values.
- Click \textit{Apply} to update the ellipse.

To modify another ellipse without closing the form hold a \texttt{Shift} key down and select the next ellipse.

Close the form
To finish drawing with the tool, you can:

- Click Close on the form
- Press the Esc key
- Click with the Right-mouse button in the 2D View

### Draw Rectangle

Rectangles can be created by using the Draw Polyline tool or using the Draw Rectangle Tool. The Draw Rectangle Tool allows rectangles to be created interactively with the cursor and Quick Keys or by entering the exact coordinates, type of corners (square, internal or external radius) and Width and Height using typed input.

**Note:** Pressing the Space-bar re-opens the last vector creation form you used. This is very useful when using other forms in between each shape you create.

#### Interactive - Cursor

The quickest and simplest way to draw a rectangle is:

- Click and drag the left mouse button in the 2D View to begin drawing the rectangle from its first corner.
- While holding the left mouse button, drag to the required size.
- Releasing the left mouse button.

**Note:**

- Holding Alt and dragging creates a rectangle from the middle point.
- Holding Ctrl and dragging creates a square.

As the cursor is dragged across the screen so the XY size is dynamically updated. The increments will depend upon your snap radius and the job size.

#### Quick Keys

Instead of releasing the left mouse button when you have dragged your shape to the required size, you can also type exact values during the dragging process and set properties precisely.

- Left-click and drag out your shape in the 2D View.
- With the left mouse button still pressed, enter a quick key sequence detailed below.
- Release the left mouse button.

**Default**

By default, two values separated by a comma, will be used to set width and height of your rectangle. **One value** will create a square with that side length. While you are dragging out the rectangle corner, type Width Value, Height Value to create a rectangle with the specified width and height.

**Example**

<table>
<thead>
<tr>
<th>Keys</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1, 2, 5 Enter</td>
<td>Creates rectangle with a width of 1 and a height of 2.5.</td>
</tr>
</tbody>
</table>

**Specifying Further Properties**

By using specific letter keys after your value, you can also indicate precisely which property it relates to.
<table>
<thead>
<tr>
<th>Quick Keys</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value X</td>
<td>Creates a rectangle at the current dragged height, but with the width set to the entered value.</td>
</tr>
<tr>
<td>Value Y</td>
<td>Creates a rectangle at the current dragged width, but with the height set to the entered value.</td>
</tr>
<tr>
<td>Value R Value X</td>
<td>Creates a rectangle with a radius (R) and width (X) set by the two entered values, but using the currently dragged height.</td>
</tr>
<tr>
<td>Value R Value Y</td>
<td>Creates a rectangle with a radius (R) and height (Y) set by the two entered values, but using the currently dragged width.</td>
</tr>
<tr>
<td>Value W Value H</td>
<td>Creates a rectangle with a specified width (W) and height (H). No radiused corners.</td>
</tr>
<tr>
<td>Value R Value W Value H</td>
<td>Create a rectangle with radius (R), width (W) and height (H) all specified by the entered values.</td>
</tr>
</tbody>
</table>

**Note:** When specifying multiple properties with quick keys, it is still important that they are entered in the order indicated in the table above.

### Examples

<table>
<thead>
<tr>
<th>Keys</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 X</td>
<td>Current dragged height with width (X) of 1.</td>
</tr>
<tr>
<td>1 Y</td>
<td>Current dragged width and height (Y) of 1.</td>
</tr>
<tr>
<td>0 . 1 R 1 X</td>
<td>A corner radius (R) of 0.1, a width (X) of 1 and the current dragged height.</td>
</tr>
<tr>
<td>0 . 1 R 1 Y</td>
<td>A corner radius (R) of 0.1, a height (Y) of 1 and the current dragged width.</td>
</tr>
<tr>
<td>1 W 2 H</td>
<td>A width (W) of 1 and height (H) of 2, no corner radius.</td>
</tr>
<tr>
<td>0 . 1 R 1 W 2 H</td>
<td>A corner radius (R) of 0.1, width (W) of 1 and height (H) of 2</td>
</tr>
</tbody>
</table>

**Note:** These key combinations must be pressed whilst dragging with the mouse to create the rectangle.

### Exact Size

Rectangles can also be drawn by entering the required XY origin point with the Width and Height of the rectangle.

### Corner Type

Corners of the rectangle can be **Square**, **Radiused Externally** or **Radiused Internally**.

![Corner Types](image)

### Edit

- Select the rectangle to modify and open the **Draw Rectangle** form.
- The selected shape is displayed as a dotted magenta line. 
- Edit the Width and Height values.
- Click **Apply** to update the rectangle.

To modify another rectangle without closing the form hold a **Shift** key down and select the next rectangle.

If you hold a **Shift** key down and select an object that isn't a rectangle (so if you click text or a polyline, for example) a Rectangle will be created as a bounding box of the clicked object.
Holding a \textit{Shift} key down and clicking the Star creates the bounding rectangle.

**Note:** When the Draw Rectangle form is opened with a selection (that is not a single horizontal or vertical line) the form properties will be set to the bounding box of that selection (which may contain multiple objects). Just click \textit{Create} to draw the bounding box. You could then offset his box to have an even boundary around the selection.

---

### Close the form

To finish drawing with the tool, you can:

- Click \textit{Close} on the form
- Press the \textit{Esc} key
- Click the Right mouse button in the 2D View.

### Draw Polygon

Polygons (e.g. Triangles, Pentagons, Hexagons etc.) can be created interactively with the cursor and Quick Keys or by entering the number of sides, exact coordinates and radius using typed input.

**Note:** Pressing the \textit{Space-bar} re-opens the last vector creation form you used. This is very useful when using other forms in between each shape you create.

---

### Interactive - Cursor

The quickest and easiest way to draw a polygon is by using the mouse in the 2D View.

- Click and hold the left mouse button to indicate the center point.
- Drag the mouse while holding down the left mouse to required radius.
- Release the left mouse button to complete the shape.

**Note:** Holding \textit{Alt} and dragging creates a Polygon from the middle point.

As the cursor is dragged across the screen so the radius is dynamically updated. The increments will depend upon your snap radius and the job size.

---

### Quick Keys

Instead of releasing the left mouse button when you have dragged your shape to the required size, you can also type exact values during the dragging process and set properties precisely.

- Left-click and drag out your shape in the 2D View.
- With the left mouse button still pressed, enter a quick key sequence detailed below.
- Release the left mouse button.

---

**Default**
By default, entering a single values will be used to set the radius of your polygon. While you are dragging out the polygon, type **Radius Value** Enter to create a polygon with the precisely specified radius.

### Example

<table>
<thead>
<tr>
<th>Keys</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 . 5</td>
<td>Creates a polygon with a radius of 2.5, all other settings as per the form.</td>
</tr>
</tbody>
</table>

### Specifying Further Properties

By using specific letter keys after your value, you can also indicate precisely which property it relates to.

<table>
<thead>
<tr>
<th>Quick Keys</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value D</td>
<td>Creates a polygon with the <strong>diameter</strong> (D) specified, with all other properties as per the form.</td>
</tr>
<tr>
<td>Value S</td>
<td>Value R holds the specified number of sides (S) and the outer radius (R).</td>
</tr>
<tr>
<td>Value S</td>
<td>Value D holds the specified number of sides (S) and the outer diameter (D).</td>
</tr>
</tbody>
</table>

### Examples

<table>
<thead>
<tr>
<th>Keys</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 R</td>
<td>Outer radius (R) 1, number of sides as per form.</td>
</tr>
<tr>
<td>1 D</td>
<td>Outer diameter (D) 1, number of sides as per form.</td>
</tr>
<tr>
<td>8 S 1</td>
<td>R An 8 sided (S) polygon with an outer radius (R) of 1.</td>
</tr>
<tr>
<td>6 S 2</td>
<td>5 D A 6 sided (S) polygon with an outer diameter (R) of 2.5.</td>
</tr>
</tbody>
</table>

**Note:** These key combinations must be pressed whilst dragging with the mouse during shape creation.

### Exact Size

Polygons can also be drawn by entering the required XY origin, selecting either **Radius** or **Diameter** and entering the required size.

- Click **Apply** to update the circle.

### Edit

Open the Draw Polygon form and select the circle to modify.

The selected circle is displayed as a dotted magenta line.

- Edit the **Number of Sides** and Radius.
- Click **Apply** to update the circle.

To modify another polygon without closing the form hold the Shift key down and select the next polygon.

### Close the form

To finish drawing with the tool, you can:

- Click **Close** on the form
- Press the Esc key
- Click the Right mouse button in the 2D View.
Draw Star

Stars can be created interactively with the cursor and Quick Keys, or by entering the number of points, exact coordinates and outer radius and inner radius percentage using typed input.

Note: Pressing the Space-bar re-opens the last vector creation form you used. This is very useful when using other forms in between each shape you create.

Interactive - cursor

The quickest and easiest way to create a star is by clicking and dragging the shape to size in the 2D View using the mouse.

- Click and hold the left mouse button to indicate the center point.
- Drag the mouse while holding down the left mouse to required radius.
- Release the left mouse button to complete the shape.

Note: Holding Alt and dragging creates a star from the middle point.

As the cursor is dragged across the screen so the outer radius is dynamically updated. The increments will depend upon your snap radius and the job size.

Quick Keys

Instead of releasing the left mouse button when you have dragged your shape to the required size, you can also type exact values during the dragging process and set properties precisely.

- Left-click and drag out your shape in the 2D View.
- With the left mouse button still pressed, enter a quick key sequence detailed below.
- Release the left mouse button.

Default

By default, entering a single value will be used to set the outer radius of your star. While you are dragging out the star, type Radius Value Enter to create a star with the precisely specified outer radius.

Example

<table>
<thead>
<tr>
<th>Quick Keys</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.5 Enter</td>
<td>Creates a star with an outer radius of 2.5, all other settings as per the form.</td>
</tr>
</tbody>
</table>

Specifying Further Properties

By using specific letter keys after your value, you can also indicate precisely which property it relates to.

Note: When specifying multiple properties with quick keys, it is still important that they are entered in the order indicated in the table below.
Quick Keys

<table>
<thead>
<tr>
<th>Value</th>
<th>D</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Creates a star with the outer diameter (D) specified, with all other properties as per the form.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value</th>
<th>I</th>
<th>Value</th>
<th>R</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value</th>
<th>P</th>
<th>Value</th>
<th>R</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value</th>
<th>P</th>
<th>Value</th>
<th>I</th>
<th>Value</th>
<th>R</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: Diameter (D) values are interchangeable with radius (R) values in the combinations above.

Examples

<table>
<thead>
<tr>
<th>Quick Keys</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 R</td>
<td>Outer radius (R) 1, other properties as per form.</td>
</tr>
<tr>
<td>1 D</td>
<td>Outer diameter (D) 1, other properties as per form.</td>
</tr>
<tr>
<td>6 P 1 R</td>
<td>An 6 pointed (P) star with an outer radius (R) of 1.</td>
</tr>
<tr>
<td>6 P 1 D</td>
<td>An 6 pointed (P) star with an outer diameter (D) of 1.</td>
</tr>
<tr>
<td>6 P 2 5 I 4 D</td>
<td>A 6 pointer (P) star with an outer diameter (D) of 4 and an inner diameter that is 25% of the outer (i.e. 1).</td>
</tr>
</tbody>
</table>

Note: These key combinations must be pressed whilst dragging with the mouse during shape creation.

Exact Size

Stars can also be drawn by entering the Number of Points, Center Point, Outer Radius and Inner Radius Percentage.

- Click Create to update the star.

Edit

- Select the star to modify and open the Draw Star form.

The selected shape is displayed as a dotted magenta line.

- Edit the required parameters.
- Click Apply to update the star.

To modify another star without closing the form hold a Shift key down and select the next star.

Close the form

To finish drawing with the tool, you can:

- Click Close on the form
- Press the Esc key
- Click the Right mouse button in the 2D View.

Draw Polyline

This tool creates continuous straight lines through points clicked, entered coordinates, tangent between a point and an arc or tangent to two arcs.

Note: Pressing the Space-bar re-opens the last vector creation form you used. This is very useful when using other forms in between each shape you create.

Interactive - cursor

The quickest and easiest way to draw a line is by clicking within the 2D View using the mouse.

- Click the left mouse button to indicate the start point of your line.
Move the mouse pointer and click again to set the next point in your line.
- Repeat this process to add as many line segments as you require.
- Right-click or press Esc to finish your polyline and exit the form.
- Alternatively press the Spacebar to complete this polyline but keep the form open and begin drawing another polyline.

**Note:** Placing the mouse pointer close to the first point on the polyline and clicking will snap the polyline closed.

### Creating Tangent Lines

The polyline tool can also be used to create lines that are tangent to arcs in your existing drawing.

**From A Point To An Arc**

To create a line tangent from a point to an arc simply enter the initial point and then hover the cursor over the arc and press T.

**From An Arc To A Point**

To create a line tangent from an arc to a point click on the arc to insert a point and then hover the cursor over the next point position and press T.

**Note:** You cannot create a tangent line to a bezier curve.

**From An Arc To Another Arc**

To create a line tangent from one arc to another click on the arc to insert a point and then hover the cursor over the second arc and press T.

**Note:** Arcs are not trimmed as a result of creating a tangent line.

### Extending Contours

An existing open contour can be extended by holding down the Ctrl key and then clicking on either its start or end point.

**Note:** Ctrl clicking on the start point of a contour will cause the contour to be reversed before extending.

### Quick Keys

Instead of releasing the left mouse button when you have dragged your shape to the required size, you can also type exact values during the dragging process and set properties precisely.

- Left-click and drag out your shape in the 2D View.
- With the left mouse button still pressed, enter a quick key sequence detailed below.
- Release the left mouse button.

**Default**

By default, entering a single value will be used to add a point at the specified distance along the line direction currently indicated by the mouse pointer position, relative to the preceding point. With polyline drawing underway, move the mouse pointer in the direction you wish to create a new line segment and type Length Value Enter to extend the line by the specified distance in that direction.

By default two values, separated by a comma, will create the next line point at the absolute X Y coordinate indicated by the two values, respectively. While drawing, type X Value Y Value Enter to place the next point precisely at specified
Example

<table>
<thead>
<tr>
<th>Keys</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 . 5</td>
<td>Adds the next point at a distance of 3.5 along the line direction indicated by the current mouse pointer position.</td>
</tr>
<tr>
<td>1 . 2 . 5</td>
<td>Adds the next point at the absolute position 1 in X and 2.5 in Y</td>
</tr>
</tbody>
</table>

Specifying Further Properties

By using specific letter keys after your values, you can also specify the line segment in terms of angle and length.

Quick Keys: Value A Value L

<table>
<thead>
<tr>
<th>Value A</th>
<th>Value L</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creates the next line segment at an angle (A) degrees from the last point and with a length (L).</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Example:

<table>
<thead>
<tr>
<th>Keys</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 5 A 3 L</td>
<td>A line segment at 45 degrees (A) and a length (L) of 3.</td>
</tr>
<tr>
<td>1 5 A 2.5 L</td>
<td>A line segment at a 15 degree angle (A) and a length (L) of 2.5.</td>
</tr>
</tbody>
</table>

Note: These key combinations are pressed once you have begun using the mouse to draw your polyline.

Next Point

You can also use the form to enter values for each line segment as you go along. The segments can be defined using:

- The absolute X Y position of the next point
- The Angle and Length to the next point
- The relative offset in X (dx) and Y (dy) to the next point.

Once you have entered the values you wish to use:

- Click the Add button to enter a new point.
- The Undo button deletes the last point entered and allows a new point to be added.
- The Finish button completes drawing the current line and leaves the form open to allow additional lines to be drawn.

Note: The X Y position use absolute coordinates. The Angle, Length and dx/dy positions are incremental from the current position.

Create Arc

The Create Arc tool allows a single arc span to be created using precise values, or dynamically within the 2D View.

Note: Pressing the Space-bar re-opens the last vector creation form you used. This is very useful when using other forms in between each shape you create.

Through 3 Points

- Left click the mouse in the 2D View to set the start point of an arc.
- Click again to set the end point position.
- Move the mouse and click a third point to set the arc’s radius.

Center, Start and End
Left click the mouse in the 2D View to set the center point of the arc.
• Click again to set the start point of the arc.
• Move the mouse and click a third point to set the end point of the arc.

**Note:** Clicking the Right mouse button or pressing the Esc key will complete the arc drawing if possible and close the form.

### Exact Size

Precise values for the start and end point positions (in absolute X Y coordinates) and either the radius or the height of the arc can be entered in the form directly. Click Create to draw an arc using these values.

### Editing An Existing Arc

The properties of an arc can be edited at any time by selecting the arc before choosing the Create Arc tool.

This opens the form with the current properties and position of the selected arc and these values can then be edited.

Click Apply to update the selected arc with the new values.

### Draw Curve

This tool creates a smooth, flowing, continuous curve through clicked points.

**Note:** Draw Curve does not require an associated form, just use the mouse cursor directly within the 2D View.

• Click in the 2D View to begin drawing at the clicked point.
• Move the mouse pointer within the 2D View and click the left button to insert as many points as you require. A curve will be created that smoothly joins your points.
• Click the right mouse button or press Esc to finish drawing your curve and close the tool.
• Alternatively, press Space Bar to finish drawing one curve, but keep the tool active so that you can immediately begin drawing another curve.

**Note:** Left clicking when the mouse pointer is close to the first point on the curve will snap the curve closed.

### Extending Contours

An existing open contour can be extended by holding down the Ctrl key and then clicking on either its start or end point.

**Note:** Ctrl clicking on the start point of a contour will cause the contour to be reversed before extending.
Create Vector Texture

Repeating texture patterns can be created using the Create Vector Texture tool. These vectors can be machined in a variety of ways to create attractive textures.

To use the tool click the icon on the drawing tab. If required, select any contours that you wish the pattern to be created within. By using the sliders and edit boxes on the form the style of the created pattern can be varied. Click Preview to see a preview your created texture as you adjust the form's parameters. When you are happy with the preview, click OK to create the pattern.

Note: Pressing the Space-bar re-opens the last vector creation form you used. This is very useful when using other forms in between each vector texture you create.

Angle

The lines in the texture are created at an angle. This value can be set to any value between -90 degrees and 90 degree.

Line Spacing

The line spacing controls the distance between the contours created by the tool. Use the edit box labeled Max. Spacing to enter a maximum value of line spacing. The slider underneath the edit box controls the degree of variation in the line spacing. If the slider is to the far left then this mean variation is at a minimum and so the lines are evenly spaced. If the slider is to the far right the variation is highest and so the distance between created contours varies between zero and the maximum spacing specified.

Wave Parameters
Within this section of the form the created pattern can be made to behave in a wave-like fashion. This wave is controlled by two parameters: the amplitude and wavelength.

**Wavelength**

The wavelength describes the length over which the contours shape repeats itself. A bigger wavelength gives a long wave while a small wavelength gives a short wave.

![Short wavelength](image1)

![Long wavelength](image2)

**Amplitude**

The amplitude describes the height of the wave. Larger amplitude means a taller wave and smaller amplitude means a shallow wave.
Noise

The noise slider controls the degree of randomness applied to the above values and can be used to create less regular patterns.
Vector Layer

To create the vectors on a new layer make sure the check box labeled Place Vectors on Layer is checked ✓ and enter the layer name into the edit box labeled Name.

Applications

The vectors created by this function have many applications but a key one is to combine them with either a Profile Toolpath or where available the Texture Toolpath to create decorative panels and background textures, a small selection of the possible results you can derive from this combination are shown in the images below.
Create Text

This form allows text to be created at a specified point and height.

Text is edited in-place including Arc Text and Text on a Curve, even if it has been moved, scaled and rotated.

If the form is opened with no selection, the new text is placed somewhere on the material (if possible) between the center of the material and the center of the view to help keep it visible. An empty box is drawn in the view which helps visualize the currently specified text height and anchor point.

Existing text has guide lines showing the height of the top line of text. Some fonts will descend below the lower line like handwriting on a note pad.

Clicking selected text while editing, changes the anchor point to a box which can be dragged and dropped with snap.

The view is updated shortly after the user stops changing the form properties (e.g. mouse-wheel scrolling through the font list).

Changing the justification maintains the anchor point

Custom kerning and spacing (adjusted using the Kerning and Spacing tool) is maintained through the edit where possible.

See Also:
- The Auto Layout Text form (text in a box).
Vertical Fonts

Fonts that start with the @ character are drawn vertically downwards and are always left justified.

Engraving Fonts

The Single Line Radio Button changes the Fonts list to show a selection of fonts that are very quick to engrave.

Options

The Larger Edit... button opens a larger text entry window that makes it easier to enter text that needs to run on longer line lengths. Clicking OK accepts any text entered into the window and Cancel will throw away any changes.

Text Alignment

Positions text relative to the full body of text, this only has a noticeable effect when writing multiple lines of text.

Anchor

Sets the position of your text block. Either enter values directly and click Apply, or click in the 2D View with the mouse cursor to set the position values interactively. Clicking in the 2D View will begin a new block of text, set to the new Anchor point.

Edit Text

To edit text properties or content of previously created text:

- If the Create Text form is open, hold the Shift key down and click the text you wish to edit or
- If the Create Text form is closed, click the left mouse button on the text in the 2D View to select it before opening this form.

The form will now allow you to edit the properties of the selected text.

Click the Apply button to update the changes in the 2D View. Click the Cancel button to finish or cancel the editing and close the form.
Auto Layout Text

This option automatically sizes a block of text to fit inside the bounding box (width and height limits) of a selected vector. If no vector is selected the text is scaled to fit the size of the material.

**Note:** Pressing the Space-bar re-opens the last vector creation form you used. This is very useful when using other forms in between each bit of text you create.

When the Text form is open, the Dimensions for the Width and Height of the selected vectors or job dimensions are shown, and these are used to constrain the font size of the text.

**See Also:**
- The Create Text form.
- Arc Text.
- The Text On A Curve form.
- Kerning and Spacing.
- Convert Text To Curves.

**Entering Text**

The procedure for Drawing Text in the 2D Window is:

- Select the vector inside which the text is to be fitted
- Click the Draw Text icon
- Enter the required text content
- Select the font either True Type or Single Line as required and alignment options
- Click **Apply**

**Vertical Fonts**

Fonts that start with the @ character are drawn vertically downwards and are always left justified.

**Engraving Fonts**

The Single Line Radio Button changes the Fonts list to show a selection of fonts that are very quick to engrave.

This example shows text (in an Engraving Font) drawn in an ellipse. The bounding box of the ellipse is used for the layout:

---

**Options**
The Larger Edit... button opens a larger text entry window that makes it easier to enter text that needs to run on longer line lengths. Clicking OK accepts any text entered into the window and Cancel will throw away any changes.

Text Alignment

Positions text relative to the selected bounding box or material size with options for left, center and right aligned.

Bounding Box Dimensions

These are the actual size of the box into which the text will be fitted. If the text is scaled interactively (by left clicking twice on the text) or precisely using the scale tool, the new bounding box is updated and displayed as a light gray rectangle.

Margin Size

The distance between the text and the bounding box where:

- **None** - Scales text to fit the rectangle width or height of the bounding box
- **Normal** - Scales text to fit within 80% of the bounding leaving a 10% border to the left and right.
- **Wide** - Reduces the size to 60% of the rectangle width leaving a 20% border to the left and right.

![Examples of Margin Size](image)

*Note:* The font size is automatically scaled to give the selected margin size.

Vertical Stretch

When the text fits the width of the box and there is space above and below it, the text can be made to fill that vertical space using one these methods:

*Note:* Vertical Stretch will have no effect when the text already fits the box vertically!

![Examples of Vertical Stretch](image)

Horizontal Stretch

When the text fits the height of the box and there is space at the sides, the text can be made to fill that horizontal space using one these methods:

*Note:* Horizontal Stretch will have no effect when the text already fits the box horizontally!

![Examples of Horizontal Stretch](image)
Edit Text

To edit text properties or content of previously created text:
If the Create Text form is open, hold the \texttt{Shift} key down and click the text you wish to edit or
If the Create Text form is closed, click the left mouse button on the text in the 2D View to select it before opening this form.
The form will now allow you to edit the properties of the selected text.

Click the \texttt{Apply} button to update the changes in the 2D View. Click the \texttt{Cancel} button to finish or cancel the editing and close the form.

Text Selection

Interactive Letter kerning and Line Spacing

Select the cursor and click to select the Text to be edited. The text will be displayed as magenta lines with 2 Green handles in the middle for dragging the text into arc-text:

Letter Kerning

The interactive kerning and line spacing cursor is shown when placed between letters or lines:

Place the cursor between 2 letters and click the Left mouse button to close the gap.
Holding a \texttt{Shift} key and clicking the Left mouse button moves the characters apart.
Holding a \texttt{Ctrl} key when kerning doubles the distance each letter moves on each click.
Holding \texttt{Shift} and \texttt{Ctrl} keys together and clicking the Left mouse button moves the letters closer together in larger increments.

The gap between the 1 and 2 has been reduced.
Line Spacing

Line spacing can be modified by placing the Edit Text cursor between lines. It will change to the line spacing cursor:

Clicking Left mouse button will move the adjacent lines of text closer together.
Holding the Shift key and clicking the Left mouse button will move the lines apart.
Holding the Ctrl key doubles the distance each line moves on each mouse click.
Holding the Shift and Ctrl keys together and clicking the Left mouse button moves the lines apart in larger increments.

Text Arcing

The interactive rotation and movement cursor is displayed when the cursor is placed over either of the Green Handles to indicate that the text can be arced either Upwards or Downwards:

Click and Drag the Bottom Green box to arc the text Downwards.
Click and Drag the Top Green box to arc the text Upwards.
The text can easily be dragged back into the horizontal position again.
After arcing text, additional Red and Blue handles are displayed for Rotating and Moving the text.

Clicking and dragging the Red boxes rotates the text around the center point of the arc.
Holding the Ctrl key forces the rotation to be in 15° increments. This allows the text to be positioned exactly on the horizontal or vertical quadrants, even after it may have been moved slightly.
Clicking and dragging the Blue boxes changes the radius without moving the arc center.
There are two handles for moving the text, one in the middle of the text, and one in the center of the arc, though that may be off-screen for very shallow arcs:
Convert text to Curves

In most cases all Text created in VCarve Pro can be VCarved, Engraved, Pocketed and Profile machined or used with the 3D modeling functions. Some fonts do occasionally include loops and problems that need fixing using the Node Editing tools before it can be utilized for other functions. This text first has to be converted to Curves, creating lines, arcs and Bezier spans that can be interactively edited to fix the problem areas.

See Also:
- The Create Text form.
- The Auto Layout Text form (text in a box).
- Arc Text.
- The Text On A Curve form.
- Kerning and Spacing.

Script style fonts that are based on overlapping characters can be VCarved or Engraved without having to first convert the characters to curves.

If the individual characters contain overlapping vectors or loops these will need fixing manually using the Node editing tools.

**Note:** The Vector Validator may be useful to use to locate the overlapping vectors in Script Fonts.

When Profile Machining with Tabs is required the text must first be converted to curves. Opening the Tab form on the Profile machining form will show a message stating that the text must first be converted to curves and clicking the Yes button will automatically make the conversion.

Text can be converted to curves at any time by selecting the icon or clicking the Right mouse button and selecting Convert Text to Curves.

**Note:** After converting text to curves it cannot be edited as a text block.
Text on Curve

This tool requires the user to select a single line of text with the Draw Text tool and a single vector curve/line. It will take the text and fit it onto the selected vector to follow the curvature. Options within the tool allow position, space and location against the line to be edited.

The Create Text Form can be used to edit the text on the curve (even if the curve has been deleted).

See Also:
- The Create Text form.
- The Auto Layout Text form (text in a box).
- Arc Text.
- Kerning and Spacing.
- Convert Text To Curves.

Text Size

Maintain text Size

Will not change the size of the text block

Scale text to fill curve

Will increase the character size in order to fit along the entire length of the selected curve.

Text Spacing

The slider can be used to increase or decrease the word and character spacing. Each time the form is opened, or new text is selected, this control starts at the 100% mark. While this text is being edited the spacing scale can be increased or decreased from its original value.

Text Position

The position of text relative to the curve is calculated using the height of the largest letter in the selected text string.

Above Curve

On Curve
Offset Distance

Allows the text to be moved away from the curve by a specified distance.

Text Alignment

The 3 options allow the text fitted to the curve to be aligned to the left, middle or right hand side of the selected curve. Or, when using a closed vector curve, relative to the Start Node.

**Note:** Remember the Start node can be changed using the Node Editing Tools available from the Right mouse menu and selecting Reverse Direction.

Characters in the text string can also be aligned ‘normal’ to the drive curve or left in the original vertical position.
Trace Bitmap

This tool automatically traces or fits vectors to image files so they can be machined. Use the Import Bitmap tool and select the image in the 2D view, then open Fit Vectors to Bitmap.

After importing an image the Tracing option allows vector boundaries to be created automatically around colored or black and white regions in the image.

Note: Pressing the Space-bar re-opens the last vector creation form you used. This is very useful when using other forms in between each bitmap you trace.

Tracing a Selected Area of the Bitmap

You can define an area within the bitmap, such that only that part of the bitmap will be traced. This can be done by selecting the bitmap (if this hasn't been done already), and then clicking and dragging the mouse over the area you want, to define a rectangular region on the bitmap. This will be highlighted with a dashed black rectangle.

Clicking on the Bitmap again will remove a selected area if one has been specified, in which case, the entire bitmap will have vectors fitted to it.

Images can be traced either in color or black and white mode and the basic process is described below:

If the image is black and white already, the process can be considerably simplified by selecting the Black/White option.

For color images you can also reduce the number of colors you need to work with by using the slider to further simplify the trace selection process.

Check ✓ the boxes next to each color swatch to link colors to the Trace Color. These are the colors that will be included in the area to trace.

Adjust the fitting parameters for the resulting vector and use the Preview button to trace.

Click the Apply button when you are happy with the preview.

After vector fitting you will often need to adjust the vectors so be sure to watch the video tutorials on vector editing available for the software.

Working with Color Images

Color images are automatically reduced to 16 colors and the slider allows the visible number of colors to be set as required. Colors are merged with the closest match.

Colors can be temporarily linked together by clicking the check boxes next to each of the colors displayed. This changes the color displayed in the 2D view to the selected Trace Color. This is very useful for merging similar color's together to allow complete regions to be traced.

If a new Trace Color is selected the linked colors are displayed using this color in the 2D view.

The Reset button unlinks all the checked ✓ colors and the image displayed in the 2D view reverts back to the original 16 color image.

Working with Black and White Images

When working with Black and White images the slider can be used to change the Threshold and merge the levels of gray between all white (min), and all black (max).

When the image being displayed in the 2D view looks correct then clicking the Preview button automatically creates vector boundaries either around the selected Trace Color or the grayscale.

Fitting-Options

The options available on this form control how closely the vectors fit / follow the selected color boundaries and these can be modified to obtain improved results.

Corner Fit

The Corner Fit control determines how accurately the vectors are fitted to the corner edges in an image.
Loose

Loose will create smooth curves that may not follow corners very precisely, but will create smooth free-flowing vector boundaries, with few nodes.

Tight

Tight inserts nodes to ensure the vector accurately follows the color boundary, to create sharp detail.

When using the Trace Color option it's sometimes useful to link a region of color's together, fit vectors and then link a new region or color's together, un-check the replace existing vectors option and fit another set of vector boundaries.

Noise Filter

The Noise Filter slider controls the minimum size of pixels that are traced / vectorized, preventing small unwanted vectors or noise being created.

For example, if an image contains single or very small clusters of pixels that aren't needed for machining a design. Then using the noise filter slider set at 4 pixels will ignore 2 x 2 or smaller pixel clusters.

Note: It's often useful for the vectors to be created on a different layer to the Bitmap layer. Therefore, remember to select a different layer before creating any vectors.

Bitmap Fading

The Bitmap Fading slider controls the shading of the image in the 2D View. This is useful to see the trace vectors more clearly over high-contrast images.

Preview

This will preview the result of the tracing of the bitmap. If you are not happy with the result provided, you can alter the settings and click on the Preview button again to get an updated result.

Apply

When you are happy with the result of the preview you can click on the Apply button to keep it.

Close

Closes the Trace Bitmap form.

Note: The Vector Validator may be useful to use after tracing a bitmap to locate any possible overlapping or intersecting vectors that may need editing before embarking on any shape or toolpath creation.
Dimensions

This tool allows you to add a variety of dimensioning annotations to your vector drawing.

**Note:** Pressing the Space-bar re-opens the last vector creation form you used. This is very useful when using the Editing forms in between creating dimensions.

Unless specified separately below, the dimensions are created using these steps:

1. Select the dimension type you wish to need: length; height; width; angle or the radius or diameter of an arc.
2. In the 2D View, click with the left mouse button to set the points the dimension needs:
   - For an Angle Dimension, the first point is the centre-point.
3. Click where you need the arrow-tips to be.
4. Click to set the location of the dimension-line.
5. Click to set where the annotation text will appear.

**Note:** To undo that last click, press the *Esc* key.

- While dragging out a new dimension, a preview rectangle indicating the text size and position will be drawn.
- If you select a dimension before opening the Dimensions Form, the font properties can now be edited. Changing dimension-type or clicking a point on the screen while the form is open will start the creation of a new dimension.
- To edit an existing dimension while the form is open, hold down a *Shift* key while selecting it - there is a note on the form to remind you of this.
- When creating Dimensions, the mouse snaps onto vectors, guide lines and the four corners / mid-points around the edge of the job setup area unless a *Shift* key is held down while dragging.

**Arc Dimensions snapped to a guide line**

**Length Dimension**

Use this to dimension a straight-line length in any orientation between two points.

The text preview box will snap to to the middle of the dimension line, unless a *Shift* key is held down while dragging.

**Vertical / Horizontal Dimension**

These two options also allow any two points to be selected, but the resulting dimension will be locked to indicate a vertical or horizontal distance (respectively) between the two points.

The text preview box will snap to to the middle of the dimension line, unless a *Shift* key is held down while dragging.
Angle Dimension

This option allows any arbitrary angle to be measured. The process is similar to creating a 3 point arc. First you must pick
the center of an angle you wish to measure - typically a corner point. The next 2 points clicked will set the extents of the
sweep you are measuring. The next click will determine the dashed dimension line positioning and the final click will set the
position of the text annotation.

- Angle Dimensions’ arrow-heads will pop outside small angles if there is not room to draw them inside.
- Angles are extended with a dashed extension-line where required, allowing the dimension to be placed anywhere. The
text snaps to the angle center and the leader-line angle snaps to horizontal, vertical or diagonal (disable snapping by
holding down a Shift key).
- Angle Dimensions use a separate Decimal Places value to the other dimensions (as you change dimension-type you
may notice the Decimal Places value change).
- Angle dimensions can now have up to six decimal places.

Arc Dimension

With this option selected you will only be able to select arc spans with the first click of dimension tool (Bezier curve spans
are not supported). The second click will set the position of the dimension annotation, which will show the radius (or
diameter) of the selected arc span.

- To display the diameter of an arc dimension simply check the Show Diameter box.
- Arc Dimensions recognise when a circle has been selected and allow placement anywhere around the circle. Arcs
will now be extended with a dashed extension-line where required, allowing the dimension to be placed anywhere. The
text snaps to the arc/circle center and the leader-line angle snaps to horizontal, vertical or diagonal (disable snapping
by holding down a Shift key).

Note:

Circles or arcs that are polygonized (from an imported file or from the Curve fit vectors command using
Straight lines) are not recognized and cannot be dimensioned with this tool (which is in line with snapping which also
won’t work on polylines to see if they are circular). Circular Polylines can sometimes be dimensioned using the length
dimensioning tools across their diameter.

The Fit Curves to Vectors command may be useful to turn polylines or bezier curves into arcs.

The text in the following example was first converted to vectors using the Convert Text to Curves command, then
those vectors were converted to arcs using the Fit Curves to Vectors command:

Further Angle Dimension Examples:
Font Selection and Settings

This section of the form allows the user to change the settings for the dimension annotation, such as the font to be used, the height of the text and how many decimal places are required. The Offset field determines the gap left between the dimension markers and the vectors that are being measured.

Use Custom Text

You can check ✓ Use Custom Text to insert your own custom text. The text is stored per dimension, so you change between calculated and custom text without losing a dimension’s custom text. When the form is first opened it defaults to calculated text.

Place Dimensions on Layer

By default this option is checked ✓ and the dimensions will be placed on a mid-gray Dimensions Layer. You can edit the name of the layer in the Name edit field. If a layer of this name does not exist, it will be created automatically.

Note: Dimensions can be edited. Hold shift while selecting the dimension you wish to edit or use the Undo shortcut Ctrl + Z to undo previously created Dimensions while still in the Dimensioning tool.

The base of extension lines and the tips of arrows are snap-points allowing you to keep neighbouring linear dimension lines, lined up, for example.
Transform Objects

The Transform Objects section contains all the icons which relate to commands for moving, sizing and manipulating objects.

Quick Keys

This reduces the time to create accurate geometry by allowing typed values while creating geometry. This is supported for creation of circles, ellipses, rectangles, polygons, stars, polylines and when in editing nodes or transforming vectors.

For example, while dragging to create a circle, typing 3 R will create a circle with a radius of 3.

Inputting a Value

Input mechanism is as follows:

1. Input the value first, and Enter to execute the default action (if applicable)
2. Input the value first, and then a letter indicating the type of action required.
3. Input 2 values separated by a comma, and Enter to execute a specified action (usually width and height or X and Y).

Input format is as follows:

1. Some actions require several input values.
2. In that case, it will be value letter value letter
3. The action will be performed automatically once all letters required for that action have been entered.

You can enter a value and press Enter which will perform the default action.

The input times out after 5 seconds, if nothing was entered.

The value could be a simple expression, similar to that used from some of our text fields.

A full list of shortcuts can be found on the Shortcuts page

Move Selection

Selected items can be accurately moved and positioned using this option.

Anchor

The anchor position determines the point on your selected object's bounding box that will be moved to the absolute position entered.

Type of Move

Absolute

In this mode, the X Position and Y Position values will be used to position the object's anchor point directly.

Relative

With this option selected, the values entered in the X Position and Y Position fields will incrementally offset the object from its current position, by the distances entered. The Anchor options are not relevant in this mode and so will be disabled.

The keyboard shortcut M opens the Move form in interactive mode.

Move Interactive

The default mode is to enable selected objects to be moved interactively by clicking and dragging with the cursor.

Holding down the Alt key when dragging objects around will constrain the movement to either the X or Y axes.
Pressing Esc or clicking Close will close the form.

Notes: Pressing F9 at any time with an object selected will instantly move the selected object, centering it exactly in the middle of your material.

A full list of Keyboard and Mouse shortcuts can be found on the Shortcuts page.

Quick Keys

For moving objects with a specific amount without having to go into the form, the Quick Keys can be used while dragging the object. Simply, activate interactive movement by clicking twice on the object, and then drag it and start typing the value as per the shortcut keys table. Then, either press Enter or the letter required to perform your action.

See Quick Keys shortcut table for a list of available actions.

Smart Snapping

To constrain the movement of the object in the X or Y axis, start dragging the object along that axis and a snap line will appear that represent that axis.

This can be used in combination with the Quick Keys, mentioned above, to move the object by a set amount in a specific direction.

Set Size

Selected items in the 2D View can be accurately scaled or resized using this option.

Anchor

The anchor position determines the point on your selected object's bounding box that will be resized to the dimensions entered.

Link XY

Checking ✓ this option will always scale the height and width in proportion. Leaving the Link option unchecked allows non-proportional scaling.

Auto Scale Z

This option sets a specific mode of scaling for 3D Components. When it's checked, ✓ scaling a model component in X or Y will result in it also scaling proportionately in Z, as such if you increase its size in X and/or Y then its Z Height will also increase and conversely when you reduce its X and/or Y size it will shrink in height. When it is unchecked then the Z Height of your Components will remain constant regardless of any X and/or Y scaling done either within this form or dynamically using the mouse in the 2D or 3D View.

Size Interactive

The default mode is to enable selected items to be scaled interactively by clicking twice with the mouse. The process is:

1. Select the vectors
2. Click a second time to activate the interactive options - handles on the selection box
3. Click and drag on the white handles

The keyboard shortcut T opens the Scale form in interactive mode.
## Interactive Handles

<table>
<thead>
<tr>
<th>Handle</th>
<th>Operation</th>
<th>Additional options</th>
</tr>
</thead>
<tbody>
<tr>
<td>White Corner boxes</td>
<td>Scaling proportionally</td>
<td>Hold Shift</td>
</tr>
<tr>
<td></td>
<td></td>
<td>for scale from middle</td>
</tr>
<tr>
<td>White Center box</td>
<td>Move the selected objects</td>
<td>Hold Shift</td>
</tr>
<tr>
<td></td>
<td></td>
<td>for linear X or Y moves</td>
</tr>
<tr>
<td>White Middle Side boxes</td>
<td>Scaling non-proportionally</td>
<td>Hold Shift</td>
</tr>
<tr>
<td></td>
<td></td>
<td>for symmetrical scale</td>
</tr>
<tr>
<td>Blue Corner boxes</td>
<td>Rotating dynamically</td>
<td>Hold Shift</td>
</tr>
<tr>
<td></td>
<td></td>
<td>15° increments</td>
</tr>
</tbody>
</table>

### Quick Keys

For scaling objects with a specific amount without having to go into the form, the Quick Keys can be used while dragging one of the scaling handles around the object.

Dragging an edge handle, a single value is expected to determine the amount of change in that direction. This can be a relative value or an absolute value.

Dragging a corner handle, two values are expected with the new width and height of the object. Alternatively, a single value followed by `s` to scale relatively.

See Quick Keys shortcut table for a list of available actions.

## Rotate

For precise control of the rotation, or to use a point other than the selection's center as the rotation center, you can open the rotation form from the Drawing Tab.

**Note:** The keyboard shortcut `R` opens the full Rotate form, including access to the moveable rotation Pivot Point. Clicking the selection twice begins interactive transform, which provides the rotation handles but without the advanced options of the Rotate form or access to the Pivot Point.

Selected items in the 2D View can be rotated to a new orientation using this tool. The rotation options form can be activated from the tool icon on the Drawing Tab. Alternatively you can use the interactive transform mode (where the form is not required) directly from the 2D View.

With this form open the additional Pivot Point handle is available (two concentric circles initially positioned at the center of your selection) for you to click and drag in the 2D View. The Pivot Point (around which the selection will be rotated) responds to the currently enabled snapping options to help you to position it precisely on significant locations within your artwork. Hold down the `Shift` key to temporarily disable snapping while you drag the Pivot Point.

### Pivot Point

On the form there are also six radio button options for snapping the rotation Pivot Point to the selection itself or to a precise position. The first five options allow you to snap to the corners and center of your selection.

### Use Coordinates

This sixth option allows you to precisely specify the position of the Pivot Point using the X and Y edit boxes. This is also the option that will be selected by default if you drag the pivot point using your mouse directly in the 2D View.

### Angle

The Angle edit box allows you to specify a precise rotation angle to apply to your selection. Click the Apply button to rotate your selection by the value in this box.

**Note:**
A positive angle results in a counterclockwise rotation
Rotate Interactive

A negative angle results in a clockwise rotation.

Generally the most convenient way to rotate an object in the 2D View is to use **interactive transform**. This mode is initiated by clicking the selected object twice with the cursor. The process is:

1. Select the object by clicking on it in the 2D View (or multiply select objects using box selection or by shift-clicking on them).
2. Click the selection a second time to activate the interactive options rotation handles on the selection box.
3. Click and drag on the blue handles (solid squares) at the far corners of the selection to rotate it.

**Note:** You can rotate the selection by a number of degrees during the interactive transform mode by typing in a value followed by the letter \( \text{R} \) while your left mouse key is still pressed. This will rotate your object by \( \text{R} \) degrees counterclockwise e.g. 45\(^\circ\) counterclockwise.

**Note:** Holding down an Alt key when dragging to rotate the object snaps to angular rotation steps of 15° increments, this incremental value can be edited in the Snap Setting dialog (F4).

**Quick Keys**

For rotating objects with a specific amount without having to go into the form, the Quick Keys can be used while dragging one of the rotation handles around the object.

See Quick Keys shortcut table for a list of available actions.

**Mirror**

Selected vectors/bitmaps/component grayscale previews can be mirrored to a new orientation.

Selected objects can also be mirrored about axes of symmetry relative to the bounding box of the selection, using the standard options on the Mirror Form.

- Select the object or objects to mirror.
- Click on the Mirror icon to open the Mirror Form.
- Select the Create a mirrored copy option to leave the selection and create a new set of objects.
- Click the Close button to accept the changes.

**Shortcuts**

The Shortcut Keys page describes these and other shortcuts that are used in VCarve Pro.

<table>
<thead>
<tr>
<th>Shortcut key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>H</td>
<td>Mirror Horizontally</td>
</tr>
<tr>
<td>Ctrl + H</td>
<td>Create Mirror Copy Horizontally</td>
</tr>
<tr>
<td>Shift + H</td>
<td>Mirror Horizontally, around center of material</td>
</tr>
<tr>
<td>Ctrl + Shift + H</td>
<td>Create Mirror Copy Horizontally, around center of material</td>
</tr>
<tr>
<td>V</td>
<td>Mirror Vertically</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Create Mirror Copy Vertically</td>
</tr>
<tr>
<td>Shift + V</td>
<td>Mirror Vertically, around center of material</td>
</tr>
<tr>
<td>Ctrl + Shift + V</td>
<td>Create Mirror Copy Vertically, around center of material</td>
</tr>
</tbody>
</table>
Distort Tool

This tool allows you to bend and flex a vector by manipulating a distortion envelope using VCarve Pro's standard node editing tools. You can select one or more vectors and then use one of the three different tool modes to create your initial distortion envelope.

Once the distortion envelope has been created, you can use VCarve Pro's node editing tools to add or edit its nodes and spans. As you alter the shape of the envelope the associated object will be distorted to reflect the changes.

Note: When distorting a selection of objects which fall on different layers, the result will be created on the layer of the first object in the selection.

Baking Distortion into an Object

Once an object has been distorted, node editing will always relate to the object's distortion envelope. If you wish to edit a distorted vector directly again, you will first need to permanently apply the distortion to the shape.

Note:
If you select an object that already has a distortion envelope while in the Distort Object tool, the Bake Distortion button will be available. Clicking this button will permanently apply your current distortion and you will then be able to either distort the object again (with new settings), or node edit the shape directly.

Bounding Box

This option is available if you have a selection of vectors. It creates a distortion envelope based on the closest bounding box that can be drawn around your selection. Thus the resulting envelope is always initially a rectangle, comprising four line spans and a node at each corner. Using the normal node editing tools, however, you can modify this envelope as much as you like and the shape within it will be distorted accordingly.

Along a Single Curve

This option is only available if the last item in your selection is an open vector that VCarve Pro can use to define a curve, above which the other selected objects will be distorted. The distorted object can comprise one or more vectors.

Using this option, you will usually end up with your objects bent to match the curve in your original selection. The distortion curve itself is left unchanged by this operation.

Between Two Curves

This option will become available if the last two objects in the current selection are open vectors, between which the other objects can be distorted.

The other objects in the selection can comprise one or more vectors.

Therefore two examples of valid selections for this operation would be:

- 3 vector shapes and 2 open curves

but not:

- 1 vector shape, 1 component and 2 open curves.
The selected objects will be stretched and squeezed between the two curves that were last in the selection. Neither of the contributing distortion curves in the selection will be altered by the operation.

Alignment Tools

The Align Objects tool provides a number of options for accurately aligning the selected object to other objects in the selection, or to the available material.

Align Objects

The different alignment options are grouped into three sections:

1. The first section of icons all work in relation to the material (job size).
2. The second section of icons all work with regard to the selected items.
3. The last section provides options to evenly space the selected objects, or to align them inside the boundary of the last object in the selection.

Align to Material

The options in this section will align one or more selected objects within the material workspace defined when you setup your job (the white area in your 2D View).

Center in Material

This option moves the selected items to be positioned in the middle of the material. The short-cut key for this is F9.

Center in Material X only

Align items centrally in the material only moving them along the X axis so the vertical position will not be changed.

Center in Material Y only

Align items centrally in the material only moving them along the Y axis so the horizontal position will not be changed.

Align to Selection

The different items comprising your design in the 2D View can be aligned relative to one another using the following selection sequence:

1. Select the item/s you wish to align / move (use single or multiple selection options).
2. Hold the Shift key down.
3. Select the final item - this is the object that the rest of the selected items will be aligned to. Click the required alignment option.

There are 7 alignment options for aligning the selection to the inside edge:

Align Center

Center selected items in the middle (both horizontally and vertically) of the last selected item.

Align horizontal center

Align the selected items horizontally centered to the last selected item.
Align vertical center

Align the selected items vertically centered to the last selected item.

Align Left/Right

Align the selected items to the left or right edge of the last selected item.

Align Top/Bottom

Align the selected items to the top or bottom edge of the last selected item.

There are then 4 alignment options for aligning the selection to the outside edge of the last item in the selection:

Align Outside Left/Right

Align the selected items on the outside left or right edge of the last selected item.

Align Outside Top/Bottom

Align the selected items on the outside top or bottom edge of the last selected item.

Note: If you select multiple items to align to another object then each one will be aligned individually. If you want the objects to retain their original position relative to each other when they are aligned you should Group them together before executing the alignment operation.

Space Selection

The final section is different from the preceding two. The tools here evenly space the selected objects either between the first and last item in the selection, or, if Inside last vector is checked, within the boundary of the last item in the selection.

Show common tools on drawing tab

If this option is checked, the most common alignment tools will be displayed on the drawing tab in their own section called Align Objects. The Alignment form can still be accessed from the original icon in the "Transform Objects" section (or by pressing F10).
The Edit Objects Tool Group

The tools relate to the design elements and objects that you can create and manipulate within VCarve Pro for example vector shapes. This is where you will find the tools used to organize, edit or modify these objects.

The tool group is organized in the following way:

Object Selection Tools

Grouping and Ungrouping

The Measure Tool

Object Merge tools

Trim Objects

Interactive Vector Trim

Vector Validator

Create Fillets

Extend Vectors

Fit Curves to Vectors

Vector Boundary

Picture Editing Tools

Joining and Closing Tools

Object Selection Tools

Once vectors have been created within VCarve Pro or have been imported from other design software packages you may want to make changes to them. These changes may be to prepare for machining or for use as construction vectors for making 3D shapes using the Modeling Tools. There are a number of functions for editing vectors which will be covered in this section of the manual. All the icons under the Edit Vectors section of the Drawing Tab will be referenced along with the icons under the Align Objects section of the menu.

Editing Modes

From the 2D view a vector can be selected and then three different editing modes allow different dynamic edits to be made to the vector(s) depending on which option is selected from the Edit Vectors section.

The three editing modes are:

1. Vector Selection
2. Node Editing
3. Interactive Selection

By default the software is normally in the Vector Selection mode.

Vector Selection Mode

Selected from Edit Vectors section.

When the Vector Selection Tool is chosen, the selected vectors are shown as dotted magenta lines. Vectors need to be selected before any of the editing tools such as scaling and moving etc. can be used.

Vector selection methods

Multiple vectors can be selected in the following ways:

1. Manual multiple selection:
   
   Hold down the Shift key while clicking the Left mouse button on each vector required. Objects can be deselected by simply clicking on the object again with a Shift key pressed.

2. Moving the cursor from Left to Right selects only fully enclosed objects:
3. Moving the cursor from Right to Left selects all objects **inside** or **touching** the selection rectangle:

   ▶️ Click and drag the left mouse button moving from Right to Left selects all objects inside the selection rectangle + any that the selection touches.

4. Pressing the keyboard keys `Ctrl + A` will select all vector objects in the design:

   Selected vectors are displayed as dotted **magenta** lines.

### Deselecting Vectors

Selections can be cancelled by:

- Left clicking on an area outside the selection
- Pressing the **Esc** key
- Pressing the Right mouse button and clicking **Selection ➤ Unselect All** from the pop-up menu.

You must click on the white drawing background to get this option in the pop-up menu.

### Node Editing Mode

**See Also:**

- Node Editing Shortcut Keys

The Node Editing tool can be selected from the Editing window or by pressing the Keyboard shortcut `N` to toggle between Selection and Node Editing modes.

When the Node Editing tool is active the cursor changes to a Black Arrow indicating that individual points (nodes) can be edited. Nodes can be interactively moved by clicking and dragging the left mouse button on a node to select and move the node to a new position.

The shape of lines, arcs and Bezier (curve) spans can be edited by clicking and dragging on the nodes or control points to move them. Multiple nodes and control points can be selected and moved by using the multiple selection options such as the **Shift** key and dragging to make a selection.

If you right click on nodes or spans a context sensitive popup menu will be displayed which allows you to insert or delete points and nodes, cut the vector, move the start point etc.

Node editing vectors is a very powerful way to be able to make changes to the vectors in your part.

**Useful Tip**

Smart Snapping combined with Distance Snapping or Quick Keys can give more accuracy when dragging nodes.

### Interactive Selection Mode

The Interactive Move, Rotate, Scale Selection tools can be used to quickly and easily modify vectors and components.

Clicking twice on one of the selected objects and the interactive scaling, movement and rotation handles are displayed in the same way as selecting this icon. Lines, Arcs and Bezier spans will be displayed as dotted **magenta** lines and text and grouped objects will be displayed as solid **magenta** lines:
When in this mode the mouse is used to click on one of the handles which has appeared on the selected Vector/s. Each handle is used for a specific editing operation as detailed here:

<table>
<thead>
<tr>
<th>Grip point</th>
<th>Default Action</th>
<th>Keyboard Overrides</th>
</tr>
</thead>
<tbody>
<tr>
<td>Middle</td>
<td>Move the vectors</td>
<td>All Move the selected objects in one axis</td>
</tr>
<tr>
<td>Corner (White)</td>
<td>Scale the vectors proportionally.</td>
<td>Alt Scaling non-proportionally</td>
</tr>
<tr>
<td>Edges (White)</td>
<td>Scale the vector in one axis.</td>
<td>Shift Scaling proportionally</td>
</tr>
<tr>
<td>Corner (Black)</td>
<td>Rotate the vectors</td>
<td>All Rotate in 15° increments</td>
</tr>
</tbody>
</table>

**Useful Tip**
Smart Snapping combined with Quick Keys can give more accuracy when dragging nodes.

To deselect objects,
- Click the white background unless **Shift** is pressed.
- Press **Esc**
- Right click menu ► Unselect All

### Grouping and Ungrouping

Grouping objects allows you to select, move and manipulate them as if they were one entity. The process is entirely reversible by Ungrouping.

#### Group selected Objects

Vectors can be Grouped allowing any number of vectors to be included as a single object that can easily be selected, moved and scaled etc. The Shortcut key for this operation is **G**.

Grouping vectors is particularly useful for machining purposes, where different vectors will be used for a single toolpath operation. Clicking any member of the group will select the entire group.

#### Ungroup Selection

Ungroup a set of Grouped vectors back to its individual vectors before it was grouped. The Shortcut key for this operation is **U**.

**Ungroup to the group's layer**

By default, when grouped objects are ungrouped they revert to the layers on which they had previously been located before the grouping operation. However this is sometimes inconvenient. For example, when you have copied a group of vectors to a new layer, it is easier for subsequent editing if the copied vectors to remain on the new layer, even after ungrouping. An alternative right-click pop-up menu command has been added to make this process easier.

A shortcut key combination is also available to provide support for both of the ungroup operations. In summary, therefore, the group and ungroup shortcut options are as follows:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>G</td>
<td>Group the selected objects</td>
</tr>
<tr>
<td>U</td>
<td>Ungroup the selected objects to their original layers, sub-groups remain grouped.</td>
</tr>
<tr>
<td>Ctrl + U</td>
<td>Ungroup the selected objects to the group's layer, sub-groups remain grouped.</td>
</tr>
<tr>
<td>Shift + U</td>
<td>'Deep' ungroup the selected objects to their original layers. Sub-groups are also ungrouped.</td>
</tr>
<tr>
<td>Ctrl + Shift + U</td>
<td>'Deep' ungroup the selected objects to the group's layer. Sub-groups are also ungrouped.</td>
</tr>
</tbody>
</table>
Measure Tool

The Measure tool allows you to find important information about your model or drawings.

It has two modes (please note that the options available in both modes are shown in the image here for convenience of documentation, but they are not normally available at the same time).

Measure Between 2 Points

With this option selected, you can click on two points in the 2D View and the form will report the measurements between the clicked locations.

Distance

Straight line distance between the two points.

Angle

The angle (in degrees) of the line joining the two points, where horizontal is zero degrees and vertical is ninety degrees.

X Distance

The separation between the two clicked points in X only.

Y Distance

The separation between the two clicked points in Y only.

First Point

The precise X and Y coordinates of the position first clicked.

Cursor Position

The dynamically updated coordinates of the mouse cursor position.

Span / Contour Properties

This mode allows you to find precise information about the individual spans of a vector shape in 2D View. Use your mouse pointer to click on any part of the shape and the information relating to the entity you have clicked will be displayed on the form.

Type

The type of span you have clicked.
Possibilities include:

- Line
- Arc
- Bezier Curve

Length

The length of the clicked span.

Start Point and End Point

The precise coordinates of the node forming the start and end of the selected span.

Vector

Information relating to the whole vector, of which the selected span is part, is shown in this section.
The total area of the selected vector

Perimeter

The total length of all the spans forming the perimeter of the shape

Num. Spans

The total number of spans in the shape.

Model Cross Section

The Model Cross Section option allows you to select two points on the 2D View and create a new vector that shows the corresponding cross-section of the underlying 3D model.

Object Merge tools

Selected closed vectors that overlap can be merged together to create a new shape. These tools consider the closed vectors to be solid areas.

The following examples begin with these five vector shapes where the rectangle was selected last.

Weld Vectors

Welds overlapping vectors together to create a new shape which follows the outermost edge of all the selected shapes.

Subtract Vectors

Areas in the first shapes that overlap the last selected shape are removed. In this case, the last selected shape was the rectangle, so the rectangle is cut away from the circles anywhere that overlaps.

Keep Overlap of Vectors

Only areas of the first selected parts (the circles) that are covered by the last selected vector (the rectangle) remain after this operation.

Trim Objects

The trim tool allows you to trim all the objects inside a given boundary. It is much more efficient than manually trimming all the contours with the trimming scissors, and allows the trimming of closed contours, open contours and components.

To use the trim tool first select the tool by clicking the icon on the drawing tab. You then must select the objects you wish to be trimmed first and then the object you wish to trim against last. Finally, choose whether you want to clear the area inside the boundary or outside of the boundary.

If the Clear outside boundary option is selected then all the objects that intersect this boundary are clipped, and the area outside is removed. If the Clear inside boundary option is selected, then the parts of the selected objects which lie inside the boundary are removed.
Geometry before trimming.
Select the lines first and then the circle

Trimmed vectors using Clear inside boundary

Trimmed vectors using clear outside boundary

If you want to use multiple vectors for the trimming boundary, they must be grouped for trimming. To group a collection of vectors select the vectors, right click and choose Group Objects from the drop down menu, alternatively select all the vectors and press the G key.

Interactive Vector Trim

The interactive trimming tool allows the user to just click on sections of vectors they want to delete.

The program finds the closest intersections either side of the clicked portion of the vector and removes the piece of the vector between the intersections. Optionally, when the form for this command is closed, the program can rejoin all the remaining trimmed pieces automatically.

Without using this tool, to remove an overlapping section of a vector, the user would need to insert extra nodes into both vectors, manually delete the intermediate sections and then manually join the resulting pieces. These operations can be performed with a single click using this tool.

When the tool is selected the cursor changes into a ‘closed’ scissor shape. When the cursor is moved over a vector suitable for trimming the scissors ‘open’ to show you can click and trim.

The only option on the form allows the user to select whether the program will automatically try to rejoin trimmed vectors when the form is closed. For most simple cases like that shown above with the overlapping rings, this option can be left checked ✓. If you have an example where for instance many trimmed lines meet at the same point, you may want to uncheck this option and rejoin the vectors manually.
Vector Validator

The Vector Validator is intended to help find issues with contours after file imports that are stopping tool-path creation such as overlapping contours or intersections. It also indicates zero-length spans.

The Vector Validator dialog can be opened with a selection to work on. If there is no selection, all visible vectors on the current Side of the current Sheet on visible layers will be validated. The selection can be changed while the form is open.

The text on the Search button changes to show whether all vectors or just the selection are going to be searched. While searching, the Search button becomes a Stop button.

To cancel a search, click the Stop or Close button, or the cross button on the progress bar slowly:

Note: Clicking slowly gives the computer time to notice that the mouse button is down when it is very busy.

Issues found so far will be marked. The close button will close the form after stopping the search.

Marks

Examples of the marks described on the form are shown below:

The markers do not move if you move or delete any vectors while the form is open. Markers are automatically cleared when the Search button is clicked or the form is closed.

Vectors can be edited (and Node-edited) while the form is open as long as a search is not in progress.

Text is not validated unless it has been converted to vectors. There is a note on the form to remind you of this.

The search will stop if 1000 issues are found.

If no issues are found a dialog will pop up saying so to confirm that the search was carried out.

If zero-length spans are found, the Fix zero-length Spans button is enabled. Clicking this will remove the zero-length spans and clear their markers.

Each time you run the Vector Validator it may appear to find different results first. The order that the vectors are validated is random because the process is multithreaded, like lots of workers moving a pile of objects onto a conveyor belt that only holds one object at a time...

Several workers may want to put an object on the conveyor belt at the same time...

The final order depends on which worker got there first, as one worker will wait a little to let another place their object on the conveyor.

Which worker waits, and how fast each worker works, varies randomly because the computer may decide that you moving your mouse around is more important than validating vectors and reassign a worker to draw the mouse for a moment, for example.
Create Fillets

Fillets or radiuses can be added interactively at points where any two spans on a contour meet. To use the filleting tool we select the icon from the drawing tab. Choose a radius for the fillet and the type of fillet you would like to use.

When the mouse cursor is near a node that can be filleted, the mouse cursor changes to show a check-mark ✓:

Not ready to fillet  Ready to fillet

When the check-mark ✓ is visible, click the left mouse button to fillet the corner.

Angle Before Filleting  Angle After Filleting

Note: Fillets can only be added to spans that are part of the same vector and as such connected, you cannot fillet between two separate vector shapes.

As well as conventional radius filleting of corners, this tool includes 2 special types of filleting for corners formed by two straight lines. They will create an overcut shaped area in corners to allow clearance for another piece of material to be slotted into the part without being obstructed by material left by the radius of the tool. Below left you can see a blue piece of material fitted into a normally cut slot, this would fit no further in than the radius of the tool would allow. Below right you can see the same situation with a slot which has the Dog-Bone style corners applied to it which allows the part to fit full depth into the slot.

No Filleting  Accurate fit with Filleting

This is a very useful tool for slot-together furniture designs, model aircraft, dinosaurs etc. Below you can see a part from a slot together dinosaur assembly, on the left is the standard part and on the right is the same part with the T-Bone style fillets added to these slots. This type of fillet needs to be used when the slot is close in size to the tool diameter.

No Filleting  Slots Filleted
Fillet / Tool Radius

This size of this value is used to create the fillet as described for each individual type of fillet below. To create any of these fillets you need to select the type required, then move the mouse cursor so it is over a corner between two vector spans. If it is a legitimate place to create the fillet then a check mark ✓ will show and the user can click the mouse button to create it. It should be noted that sometimes unexpected fillets will be created if the fillet size is too big for the vector shape. In that case, simply undo the change and repeat the process with a suitable fillet size.

Fillet Type

Normal fillet

This creates a standard corner fillet based on the Radius defined, typically this would be used for design purposes and not for editing a slot for fitting purposes. Below left the image shows the vector before filleting the two inside radii, on the right is the filleted version.

Normal filleting can also be used on Bezier and Arc Spans, or a combination of all three span types (Straight lines, Arcs, Beziers) if there is enough space to create a fillet based on the specified Radius.

Dog-Bone Fillet

This creates a circular cut-out style of fillet, the circles will be placed so the upper right part of the circle touches the original sharp corner and are created with the Radius specified. This option should not be used if the slot width and the tool are similar in size. Below left is the vector showing the slot before filleting, on the right is the filleted version using the 'Dog-Bone' option.

T-Bone Fillet

This creates a circular cut-out style of fillet, the circles will be created with the Radius specified. This option should be used if the slot width and the tool are similar in size so the slot can grow out to the side to ensure there is space for them to fit. Below left is the vector showing the slot before filleting, on the right is the filleted version using the 'T-Bone' option.
The placement of the fillet is an interactive process; you can choose which side of the 'corner' the T-bone fillet is placed. If you click on a 'corner' the fillet will be placed automatically on the longest side. By clicking to the side of the corner you want the fillet placed you can choose which side the fillet is placed on.

In addition, fillet arcs can be removed by simply clicking on an existing fillet arc. This works even for vectors that have been imported with filleted corners. This feature allows the user to easily change the size of fillets by clicking once to remove the existing arc and then clicking the corner to insert the new fillet. In many cases, by allowing the user to control which side of the corner the 'T-Bone' fillet is placed on means that the fillet can be hidden when the pieces are assembled.

**Note:**
You cannot remove fillet arcs from .eps files as they do not contain arcs and only contain straight lines and Bezier Spans.

### Removing Fillets

Fillets can be removed in the same way that we add fillets: move the cursor over the fillet that you wish to remove. If this fillet can be removed then the cursor shows a cross to indicate that it is possible to remove a fillet:

Clicking removes the fillet:

When removing fillets the software does not store what kind of geometry the fillet was created from. It always defaults to using straight lines to return the fillet to a sharp corner. As such if the fillet is across multiple spans or is derived from arcs or Bezier curves then it will not go back to its original state and instead it will remove the radius and extend two straight lines to create the new corner. Below are images that show this effect, the first set show the whole vector and the second show a section of the vector in node edit mode to help show the difference. If the fillet was created recently then it may be possible to use the Undo command to return it back to its original geometry.
Extend Vectors

This tool allows you to extend two vector lines to their common point of intersection. The tool form is rather sparse, but that is because all the action occurs directly in the 2D View.

With the Extend Vectors tool active, moving the mouse pointer over the ends of open vector shapes (without clicking) will highlight a dashed preview extension line from that shape. The line will change dynamically as you move the mouse over the end spans of different open shapes. Clicking with the left mouse button at this point will set it as the target line to extend and the magenta line will remain visible.

The mouse can now be moved over existing spans along the length of the preview extension line, or over the end of another shape to create a second, intersecting, preview extension line. Clicking on any of the intersection points indicated by the mouse cursor will extend the initial shape to that point and complete the operation.

The tool can be closed at any time using the Close button on the form. Right-clicking in the 2D View will reset the tool so that it is ready to select another target line to extend.
Fit Curves to Vectors

This function allows the user to fit arc, Bezier curves or straight lines to selected vectors. The newly created vectors will be approximated based on a user defined tolerance. Using this function can aid with smoothness for some toolpath options and also help to simplify data for modeling purposes.

The Curve Fitting function can be accessed from the Edit Objects area of the Drawing Tab, the Edit Menu ► Curve Fit Vectors in the Main Menu or by using the short-cut-key combination Ctrl + F.

Fitting Type...

Circular Arcs

Checking ✓ this option means the selected vectors will be approximated using arcs:

![The vector before fitting](image1)

![The same vector fitted with arcs](image2)

Bezier Curves

Checking ✓ this option means the selected vectors will be approximated using Bezier curves.

![The same vector fitted with bezier spans](image3)

![The same bezier spans in Node-edit mode](image4)

Straight Lines

Checking ✓ this option means the selected vectors will be approximated using straight lines.

![The vector before fitting](image5)

![The same vector fitted with straight lines](image6)

Tolerance:

The value which is set in the Tolerance area determines how closely the original vectors will be approximated. The newly
created, Arcs, Beziers or Lines will be generated within a distance of the original vector which is plus or minus the specified Tolerance value. The smaller the value the closer to the original the new data will be but it will also mean more data points will be used. A larger Tolerance will not be as accurate to the original but will have less data points. The diagram below shows the curve fitted to two straight lines with the max possible distance between them defined by the Tolerance set. The tolerance is the distance indicated with the red arrow:

Keep Sharp Corners

Checking ✓ this option will make the Curve Fitting routine keep sharp corners which have a difference greater than the Max Angle value specified. Any corners where the difference in angle is less than this value will be modified within the specified tolerance. The images shown below demonstrate how this works. The first image shows a set of straight lines before curve fitting with the angles shown between the spans. The second image shows this after curve fitting with the Keep sharp corners set with a value of 20°. You can see the two lines which were under the 20° difference have had a curve fitted between them but the other corner which has been retained as the original angle is greater than 20°.

Replace selected vectors

Checking ✓ this option will delete the current vectors and replace them with the new curve fitted vectors. Un-checking it will keep the original vectors as is and in addition create new curve fitted vectors. The new vectors will always be created on the currently selected Layer.

Vector Boundary

The Vector Boundary form allows you to create boundaries around selected vectors.

You can offset the boundary outwards and optionally create convex or 'Rubber band' boundaries.

Offset Boundary

When this is checked ✓ the created boundary is offset outwards by the distance specified.

Rubber Band Boundary

When this is checked ✓ the created boundary is the result of stretching a rubber band around the currently selected vectors.

The images below demonstrate the difference between the two types of boundary that the form creates. The picture on the left illustrates the standard offset output and the one on the right shows the result when Rubber band boundary option is checked ✓.
Edit Picture

The Edit Picture form allows you to add a border to, and edit the properties of a selected bitmap.

Contrast

This slider adjusts the contrast. A higher contrast emphasises the differences between the light and dark parts of the image.

Brightness

This slider adjusts the brightness of the image.

Gamma

This slider adjusts the gamma correction applied to the image. This can make an image look lighter or darker whilst maintaining detail.

Invert

Inverts the colors in the image. White becomes black and black becomes white.

Grayscale

Makes the image black and white.

Add Border

Fades the edges of the image based on the border type and the width of the fading.

Crop Bitmap
Select the image you would like to crop. Then using `Shift` + left click select the closed vectors you would like to use to crop the image. You may select multiple vectors but the image must be selected first. Click the crop bitmap button to clear the image outside of the vector. If multiple vectors are used for the cropping then the crop tool leaves only the area of the image that lies inside the selected contours.

### Joining and Closing Tools

The icons to join and close vectors are located under the Edit Vectors section of the Drawing Tab.

#### Join Open Vectors

This icon opens the Join Vectors Form

Open vectors are automatically identified and closed or joined to other vectors where the end points lie within the user definable tolerance.

#### Join/Close vectors with a straight line

Join with a Line finds the closest end points on 2 selected, open vectors and joins with a straight line. Close with a Line closes a single open vector with a straight line between its two end points.

#### Join/Close vectors with a smooth curve

Join with a Curve finds the closest end points on 2 selected, open vectors and joins them together with a smooth curve.

VCarve Pro has two smooth joining methods:

- A smoother method (new for V9.5)
- A more symmetrical shallower join method

By default then the smoother method is used. However the default method can be chosen from within the options dialog. **Edit ► Options ► Smooth Join Vectors** The alternative method can be triggered by holding down the `Ctrl` key when pressing the smooth button.
Join/Close by Moving End Points

Join Moving End Points finds the closest end points on 2 selected, open vectors, calculates the mid-point between them and moves the end points to this position.
The Offset and Layout Tool Group

This tool group includes tools to create offset versions of existing objects or to layout objects automatically.

Offset Vectors

Selected vectors (open or closed) can be offset either inwards or outwards to create new vector shapes that might be useful for edge patterns or borders etc. To offset a vector shape, use the following steps:

1. Select the vectors to offset
2. Select the required direction - Outwards / Right or Inwards / Left
3. Enter the Distance
4. Click the Offset button

Options

The offsetting options are slightly different in their behavior depending on whether the vector to be offset is open or closed. See below for more information.

Create sharp offset corners

Will retain any sharp corners in a design.

Offsetting Open Vectors

When offsetting open shapes, the options are either to the Right or Left side of the selection. The direction of open vector(s) is very important as this is used to decide the right and left side of the selection. Selecting Node Edit mode (pressing N on the keyboard) will display a Green node at the start of the vector. Looking along the vector(s) from the green node indicates the direction and the image below shows offsets to the left and right of an open vector.

Notes

Square offsetting a very acute (included) angled sharp corner will result in the corner point being positioned a long way from the original geometry, often off the material or cutting through other shapes in the design. To stop this happening VCarve
Pro checks that the distance for the new calculated offset point is less than 5 x the offset distance away from the original corner point.

**Note:** Offsetting overlapping vectors can cause unpredictable results. It is generally better to merge overlapping vectors before offsetting them.

### Array Copy

This tool will automatically create copies of the selected object and lay them out in a grid pattern. The grid size is determined from the number of row and columns requested and the spacing of the object copies can be set directly as a gap distance, or in terms of an offset distance between each copy’s position.

**Note:** You can use the menu item Edit ⇒ Undo or the Ctrl + Z shortcut key to undo the action of this tool while the form is still open. This allows you to easily experiment with different options.

### Selected Objects Size

Reports the current size of the selection that you are intending to block copy. This is for information only, but the values can be selected, copied and pasted to use in other calculations.

### Rows and Columns

These options specify how many rows and columns of the selected object to create. The total number of copies made will be X multiplied by Y.

### Spacing...

There are two ways to specify the spacing between elements in array:

**Gap**

The X and Y fields will be used to specify the gap between edges of each object copy.

**Offset**

The X and Y fields are used to define the offset of the position of each object copy, relative to the preceding one.

This example shows a sign blank copied to create a 3 x 3 array.

3 Rows x 3 Columns with a Gap of 0.3 inches between each object:

![Array Copy Example](image)

### Symmetry...

The symmetry area of the form gives you the ability to mirror and rotate objects. This allows for more advanced pattern making, by default the block symmetry form is set so there is no symmetry or rotation. To alter the pattern you can simply press the block symmetry buttons to create your desired pattern.
Default Block Symmetry Options

Row/Column displacement...

Entering values in the Row/Column displacement allows you to move a row or column by the value specified.
Group Copies

Having this option checked ✓ will group the objects that you have created in the form when you hit the Copy button.

Circular Copy

This tool will automatically create a repeating pattern by making copies of the selected object and positioning them around a full or partial circle. The number of copies to be made can be entered directly.

Note: You can use the menu item Edit ⇒ Undo or the Ctrl + Z shortcut key to undo the action of this tool while the form is still open. This allows you to easily experiment with different options.

Rotation Center

This is the absolute XY coordinate around which the objects will be rotated when copied and pasted. The default Rotation point is the middle of the selection. You can set the rotation center coordinates explicitly using the X and Y edit boxes on this form or by clicking the selected geometry to show the transform grips, then double-clicking the center one to show the pivot-point and dragging the Pivot Point handle associated with the selection in the 2D View:

Rotate Copies

This option controls whether the copied objects are each rotated as they are placed around the circle, as shown in the diagrams below. If this option is selected, each copy is rotated according to its position on the circle. If the option is not selected then each copy maintains the orientation of the originally selected object.
**Angle**

*Note:* A **Negative** Step Angle pastes the copies in a **counter-clockwise** direction.

A **Positive** Step Angle pastes the copies in a **clockwise** direction.

**Total Angle**

With this option selected the number of items is divided into the Total Angle to give the incremental angle between each object.

**Step Angle**

With this option selected this angle is used to copy the selected vector(s) by this angle x the number of Items.

*Note:* Using **Edit → Undo** deletes all the pasted copies and leaves the original vector selected.

**Copying Multiple Vectors**

The result of one array copy can be used for another to create more complex patterns, this one being used for an engraving. The rotation point has been set by double-clicking the centre grip, then dragging to the desired location:

*Copy Along Vectors*

This tool automatically creates repeating patterns of objects by placing copies of them along the length of one or more selected vectors. The tool allows any existing object to be used but it also has an option specifically for the creation of circles, which is a common design element for patterns of this sort.

*Note:* You can use the menu item **Edit → Undo** or the **Ctrl + Z** shortcut key to undo the action of this tool while the form is still open. This allows you to easily experiment with different options.

To make copies of an existing object, select the item to copy, then holding a **Shift** key down to facilitate multiple selection, select the vector curve or curves you wish to paste the item along. Make sure the **Copy Object** option is highlighted and click **Copy**.

If you wish to create circles, then you simply need to select one or more vectors along which the circles will be created. Ensure the **Copy Circles** option is highlighted and click **Copy**.

**Copy Object**
Any shape vector or group of vectors can be copied along a curve or curves. The first vector or group of vectors selected is the object that gets copied multiple times along the curves.

Copy Circles

Enter the diameter of the required circles

Distance between copies

This is the distance along the selected curve between each pasted vector. The Force even spacing option ensures that objects are pasted at the end points on the curve(s). If this option is not selected the pasted objects will be placed at the specified distance and may not match the exact length of the curve.

Number of copies

Selecting a specific number of copies automatically sets the specified number of copies along the entire length with an even spacing between them.

Align Objects to curve

With this option selected the pasted objects are automatically aligned 'normal' or perpendicular to the curve they are being copied onto. If this is not selected, the copied objects stay in the orientation of the original.

Create Copies on new layer

This option creates the multiple copies on a new layer making it much easier to select and organize the resulting vectors for machining purposes etc.

Reverse Direction

If your copies appear upside down, this option will perform the copy operation in the opposite direction along the selected vectors and the resulting copied shapes will be created the other way up.

Plate Production

This command is for designing and engraving multiple badges or nameplates using variables for positioning imported data from a text file list. The production plate functionality is typically used by engravers making badges from a database file supplied by a customer, but could also be useful for making nameplates for hotel rooms with consecutive numbering.

Note: This function cannot be used with 3D Data or 3D toolpaths.
Procedure

The general procedure for using the Production Plate functionality is,

Draw and Setup the Master Template

Create a new job and specify the Material Size to equal the Sheet size the badges will be cut from.

Layout the badge / plate at the required size and using the Text Tools add variables where imported data / text is required.

Variables are defined using double exclamation marks ("!!") at the start and end of the variable name.

Calculate Toolpaths

Select and calculate the toolpaths for each of the elements on the design. For example, calculate an engraving toolpath for

the text and logos and a separate Profile cut-out toolpath around the outer edge to cut out the design.

Toolpaths are optional and Production Plate functionality can be used to simply create the necessary vectors and text etc. for a batch of plates.

Use the Plate Production Tool on the master template

With all of the vectors that make up the master template selected, click on the Plate production tool to open the Plate Production Dialog window.

The Plate Production Dialog
The left side of the Plate Production form is used to layout the plates / badges on the selected sheet of material, and shows the total number of plates that can be engraved / machined from each sheet of material.

**Material Size**

This is the material sheet size that the badges will be engraved onto. If the number and size of the badges requires additional sheets of material to be used the software automatically creates a separate layer for each sheet required.

**Plate Size**

This is the size of the selected Plate / Badge and is based on the bounding box of the selected vectors.

**Sheet Margins**

This specifies the border margin between the edge of the material sheet and the plates.

Independent margin spacing can be set for the Top, Bottom, Left and Right sides of the material.

Equal Margins ensures the same space is added around all 4 sides of the plates.

**Spacing**

This is the horizontal and vertical spacing between each Plate / Badge.

**Number of Plates**

The number of plates that will fit on to the specified material sheet size is automatically calculated. This calculation takes the plate size and adds the Sheet Margins and Plate Spacing to determine the maximum number of plates that can be made from each sheet.

**Toolpath Options**

If toolpaths have been calculated for the master Template this option is available.

Checking ✓ this option automatically calculates toolpaths for all the plates / badges in the project.

Unchecking this option only creates the vectors for each plate / badge.

**Import the Data to be Merged into the Template**

The right-hand side of the Plate Production form is used to select the data that will be merged into the template, and how the data will be interpreted to create each plate / badge.

Import the required text / data file and select the appropriate format separator.

The data file is commonly created using a spread sheet such as Windows Excel. Use the option to Save As or Export to obtain the required file format that includes the correct Separator information.

**Separator**
The separator is the method used in the data file for dividing each set of information into columns. The most commonly used options are: Comma, Tab, Semicolon or a Space

**First row is column names**

It's very common for the first row of data in a file to simply show what each of the field names are, and this information is not used on the badge or plate. Checking the box First row is column names tells the software to start working with data from row 2.

**Assign the Variables to the data in the text file**

All of the variables specified on the template - text with double exclamation marks '!!' on either side '!!' are automatically listed on the form. These variable names are each assigned to a data field (column of text) inside the data file.

**Variable Assignment**

Click to select a Variable Name then select the data field from the imported file that is required on each badge / plate i.e. the person's name. Repeat for each of the Variable Names listed on the form.

**Number Formatting**

Variables can be assigned to Text from a data file - Names, Dept., etc. or to a Counter number that can be formatted and incremented using the Number Format options.

**Calculate**

Click **Calculate** to create all Badges and associated Toolpaths.

If toolpaths have previously been calculated for the vectors in the Master Template, the option to automatically Create Toolpaths for each badge / plate is switched on in the bottom left corner of the form.

**Close**

Click **Close** to finish plate production and close the form.

**Multiple Sheets**

Multiple Layers are automatically created if multiple sheets of material are required to engrave all of the badge data from the imported text file. Layer named Sheet 1 is displayed in the 2D view showing the badges on this sheet.

Each of the Sheets is on a different layer and can be set visible or invisible using the Layer Manager.

**Multiple Toolpaths**
When Toolpaths are automatically calculated, a separate toolpath for each operation on each sheet of material is calculated and named using the convention 'S1 - Name', where the Name is the name of the toolpath previously calculated for the template.

The example above shows the original 3 toolpaths calculated for the master template - Logo, Text and Cut Out. Plus the 2 sets of new toolpaths created to engrave onto 2 sheets of material.

- Sheet 1: 3 toolpaths - Logo, Text and Cut Out
- Sheet 2: 3 toolpaths - Logo, Text and Cut Out

Note: Using Edit Undo directly after calculating a batch of plates / badges will automatically delete all vectors, layers and toolpaths created by the calculate operation.

Nesting

The Nesting tool will automatically fit vector shapes within the user defined area in the most efficient way it can calculate (based on the user defined parameters). By default the area the vectors will be fitted is the current Job Size but it is also possible to select a vector as the nesting area. This is a powerful way to optimize material usage and increase toolpath efficiency when laying out and cutting a number of shapes.

The image below left show a set of letters which have been typed out using the normal Text layout tool, the image on the right shows the same set of letters after the Nest Parts function has been used to optimize their layout. The Nest Parts tool will be documented in detail in this section to show how the options within the menu control the layout.
What kind of yield should I expect from the Nest Parts command?

While the Nest Parts function within VCarve Pro is designed to do as good a job as possible it is important to understand it will not always nest parts as well as an intelligent (and patient) human. The nesting in VCarve Pro works incrementally and does not re-arrange parts it has already placed. Therefore it does not have the ability to adjust things as the parts are being fitted that a human nester might see could be more efficient.

The Nest Parts function excels when the parts are relatively small compared to the nesting area and there are a large number of parts to nest.

If you have a relatively small number of shapes to nest or you plan to cut the same set of parts many times then it may be better to take the time to manually nest your vectors. When you use the Nest Parts function and see some obvious places that you could do better this is a good indicator that manual placement may be better.

Sheets

The amount of material required to Nest the selected vectors may be larger than the specified work area (Job Setup). To cope with any 'overflow' VCarve Pro makes use of a new type of entity called Sheets. Sheets are used for any nested shapes that will not fit within the boundaries of the specified Job Size (or the selected vector). Additional Sheets will be created using the same parameters chosen to Nest the vectors. These are displayed to the right and above the current Job area as can be seen in the image shown below. The use of the Sheets will be explained in more detail in section below on choosing the Active Sheet within the Nest Parts form.

The concept of Sheets is very specifically related to machining the finished parts and is not designed to replace layers. Sheets should NOT be used to organize vectors for modelling or to organize vectors which you intend to use for different machining operations, in those cases the Layers should be used to manage the vectors.

The sole purpose of Sheets is to allow nested parts for production type machining to be laid across many units of the same material. Only vectors on the Default Sheet can be nested so Nest Parts should be the last command carried out on the parts before machining. As such objects should not be nested more than once, if you do not like the nesting solution then you should use the Undo (Ctrl + Z) command immediately and then make changes to the settings before trying the nesting again.

How Parts are Nested

Nesting shapes is a complex calculation which requires the user to make sure the vectors are in the correct state to get the results they are looking for, this is especially important when nesting overlapping vectors or designs that have sets of vectors that need to stay in position with each other. In certain situations it is necessary to group together particular vectors to get the correct result. For simple shapes within shapes such as an "O", "B", "P" etc. there is no need to group them before nesting. VCarve Pro will keep these internal shapes in the correct position and orientation as the shapes are nested.

If the 'outer' vectors of the items being nested are overlapping (and are supposed to be overlapping) then they should be grouped together. This will ensure that the software does not try and nest other items in incorrect places inside of these objects or break the components apart; the nesting for these groups will be done using the bounding box of all these grouped items.

Below you can see an example showing the value of this. The first image shows 3 parts to be nested 6 times each, they include overlapping vectors and single lines. The second image shows the parts nested WITHOUT Grouping as you can see the parts are split apart and the single lines are deleted. The 3rd image shows the parts Grouped before nesting into 3 specific groups, these keep all the parts in the correct position and does not delete the individual lines.
Original vector layers for grouped vectors will be remembered even if the vectors are nested. If nested and then ungrouped the objects within them will go back onto their original layers. This can be useful if you have arrangements of production parts which are on different layers that you need to nest. These might be parts which use layers for different machining operations (drilling, pockets etc.). To nest these you can do the following:

Group the complex component represented by vectors on different layers. Nest the grouped objects to optimize placement. Select all the vectors and Ungroup to get the data back on the original layers for machining.

Once you click the icon you will see the form shown below. You can see there are a lot of options on this particular form, these will all have a bearing on how the parts are nested. Generally it is assumed that you are nesting parts for the purposes of machining so a number of the options are set in regard to the tooling you plan to use and parameters associated with cutting the parts out.

It is therefore very important to use the correct values that correspond to the machining choices you plan to make and keep a note of these so you use the correct values when you come to actually create the toolpaths.

**Tool and Clearance Settings**

The settings in this section of the form will determine the spacing which will be left between each of the nested vectors and also control how close they are to the edge of your nesting area.

**Tool Dia. (D)**

Enter the diameter of the tool that you will be using to Profile (cut-out) the vectors you are nesting. This is the minimum distance that will be left between shapes once they are nested.

**Clearance (C)**

The Clearance value will be combined with the specified Tool Diameter to create the final minimum spacing between the nested shapes. For example a Clearance of 0.05 inches combined with a Tool Diameter of 0.25 inches would create a minimum spacing gap of 0.3 inches (0.05 + 0.25 = 0.3).

It is important to note that if you want actual material to be left between the nested shapes once they are cut out that the
Clearance needs to be larger than the diameter of the tool. In the example used above where the minimum gap is 0.3 inches (0.05 + 0.25) the area machined by a 0.25 inches diameter tool cutting these shapes out would overlap as shown in the image to the left below (the blue shows the area which would be removed by the tool), this would leave no material between some of the parts.

If you wanted there to be material between the cut-out passes then you would need to specify a Clearance value larger than the Tool Diameter. For instance a Clearance of 0.3 inches would make a total gap of 0.55 inches, this is shown in the image below right. This would leave a minimum of 0.05 inches of material that would be left once the tool had cut out the shapes. This would be very important if using tabs to hold your parts in place, or if you wanted to prevent the scrap from potentially jumping off the table.

![Clearance less than Tool Diameter](image1.png) ![Clearance greater than Tool Diameter](image2.png)

**Border Gap**

The Border Gap value is applied to the edge of the area which is being used to nest the vectors into. It will be added to the Clearance value around the edge of this shape to create the minimum distance that parts will be nested in respect to the nesting boundary.

Vectors can be nested either within the whole Job area or into another selected vector (see section below on Last vector is nest boundary for more information on that option). The shapes will be nested as close to the edge as possible using the Clearance specified to determine the minimum distance from the edge. In many situations it is beneficial to have an extra gap from the edge of the material to ensure that the tool does not overlap into an area where there may be clamps (or other obstacles) and to ensure that some material is left for hold-down.

The Border Gap can be used to define this extra distance. In many cases it would be defined as the tool diameter or an even larger value. Below left the image shows no Border Gap, below right you can see a Border Gap has been defined leaving a boundary area around the edge of the nesting area.

![No Border Gap](image3.png) ![Border Gap](image4.png)

**Part Nesting Options**

The options in this area of the form will all directly affect how many parts or how efficiently it is possible for the software to fit shapes into the defined nesting area. The use of these options may depend on the particular material and application you are going to be using your cut parts for. Think carefully about the effect they will have on your shapes to ensure it does not adversely affect the finished cut parts.

**Rotate Parts to find best fit**

Checking ✓ this option will allow the software to rotate the selected vectors in order to try and better fit them. The increments of rotation the software will use is based on the Rotation step angle which is defined in the form area shown below.

In theory the smaller the specified angle the more options the software will have to fit the shapes together so the more efficient the nesting will be. This does depend on the shape of the vectors though. It should also be noted that the smaller the angle specified the longer the nesting will take to calculate. Un-checking this option will ensure the parts keep the same orientation that they had when selected. This could be important if you are working with shapes that need to be oriented in a specific direction, for instance in regard to the material grain.
The image above and left shows the letters nested with 30 degree rotation and the image above right shows the same letters nested with NO rotation. As you can see, by allowing the rotation the software can fit the letters into a smaller area. In this case it is not a huge difference but the more shapes there are and depending on the style of the shapes it could be a bigger margin.

**Mirror parts to find best fit**

Checking ✓ this option will allow the nesting to mirror (flip) the vectors in order to try and more efficiently nest the selected shapes. This should only be checked ✓ if the direction the parts are cut in is not important. For instance if you are using pre-finished material you would always want the face of the part to the top of the material and so would not want to allow the software to mirror them. If the parts were being cut-out and then finished or depending on the material being cut this may not be an issue and so could be used to help fit more parts into the nesting area.

**Allow parts inside other parts**

Checking ✓ this option will allow the software to nest within the internal areas of shapes that have gaps in the middle. This would be a good way to optimize material if you were cutting out parts but would not be a good choice if the inside of the shapes was only going to be pocketed as it would not then be scrap material. Grouped objects will not allow shapes to be nested within them even if they appear to have space to fit the smaller items. They would need to be ungrouped to allow the software to use the internal regions. Standard typed text will allow nesting on inside areas as shown in the example below.

In the two images below you can see a set of letters which are going to be cut out. The larger letters have sizable internal areas that will become wasted scrap, using the Allow parts inside other parts option means that VCarve Pro will use these internal areas to fit any smaller parts into them. This can be seen in the right hand image which shows the letters after nesting, where the inside of the O's and the B have been used to nest the smaller shapes.

**Sheet Options**

**Nest From**

This area of the form is used to define which corner the nesting will start in. There are four options which can be selected from the options in the form.

Each node corresponds to the respective corner of the Material or the selected boundary vector. The first nested parts will be placed in that corner and the shapes fitted according to the Nest Direction specified (see section below).
Nest Direction

The options in this area of the form are used to select how the parts will progress as they are positioned within the sheet. The best way to think of this (for the purposes of this section) is that they “pour” out of the selected corner filling the sheet in one axis then advancing along the other defined axis (X or Y).

Along X

Checking ✓ this option means the nested vectors will fill the boundary area vertically then progress horizontally along the X axis, radiating from the corner selected in the Nest From section of the form. The image below shows the Along X nesting option with Nest from... set to the lower left corner.

Along Y

Checking ✓ this option means the nested vectors will fill the boundary area horizontally then progress vertically along the Y axis, radiating from the corner selected in the Nest From section of the form. The image below shows the Along Y nesting option with Nest from... set to the lower left corner.

Last vector is nest boundary

Checking ✓ this option means the last vector selected will be used as the boundary for the nesting area. This can be useful if you need to define a non-rectangular shape to Nest Parts into, such as large off-cuts from a previous job. It’s important to note that using this option will not respect the currently defined Job Area if the selected boundary vectors goes outside of it. If there are too many vectors to fit into the last selected vector then additional Sheets will be created using the same boundary shape for the parts being nested, the boundary vector will be positioned on the Default Sheet (zero) along with any items not selected for nesting.

Not having the Last vector is nest boundary option checked ✓ means all the selected vectors are nested into the whole of the defined Job Area (defined by the Job Setup form accessed from ‘Edit - Job Size and Position’ from the menu bar).

Note: If you need to represent a sheet with holes or other features which can't be represented with a single selected vector as the new boundary it is possible to also use a Grouped vector for the last selected item then the shapes will be nested within the spaces in this.

Individual Part Properties

This function is very useful if you have a number of the same part to make and need to nest many parts at once. It allows multiple copies of the selected object/s to be nested without making the copies prior to the operation.

If you want more than one incidence of a particular item then select it from the 2D view. In the box where it says Number of Copies enter as many copies as you want and hit Apply and the selected vectors will be marked with a green number indicating how many copies of that item will be made when they are nested. Different shapes or groups of shapes can be assigned different numbers of copies. To stop an item being copied multiple times just set the Number of Copies back to 1 and click Apply.

Active Sheet

This option lets you choose which Sheet of vectors is currently active, either for editing or applying toolpaths onto.

The Active Sheet can also be chosen when the Nest Parts form is not open by using the drop down option from the base of the Layers menu - this is shown in the image below left highlighted with a red box, the image below right shows the drop-down with the choice of currently available Sheets.
The Modeling Tab

All of the tools relating to the creation, editing and management of your 3D components can be found on the Modeling tools page, which is normally available as a tab at the bottom left of your screen next to the Drawing tab.

The Modeling tools tab is divided into two sections. The top section hosts the tools that relate to 3D components (including the relevant tools that are also accessible from the Drawing tab). The lower section lists all the components and component groups currently in the model - this is referred to as the Component Tree.
Add Zero Plane

Creates a component that is the size of your job setup with a height of Zero.

Import a Component or 3D Model

This command opens the File Open dialog window, allowing existing Aspire files (CRV3D extension) and importable 3rd party 3D files to be selected and opened. If you select a 3rd party 3D model format, the Orientate Model form will open (see below) to allow you to manipulate the 3D model before it is converted into a Component.

V3M

V3M is a proprietary file format developed by Vectric for Vector Art 3D and Design and Make. Files in this format can be purchased from www.vectorart3d.com and www.designandmake.com and when imported into Aspire will create a new Component with the same name as the file. This will be imported at the size and position the part was saved in the original file.

STL

This is a standard format for complex 3D models, based on a triangular mesh. STL files can be exported from many 3D design software programs such as Rhino. These models can be completely 3 dimensional (i.e. have a front, back, etc.), this means that when this type of file is opened that it must first be sized and oriented before a Component can be created (Aspire only represents base-relief so cannot work with a completely 3D object). Once the file becomes a Component it will have the same name as the original STL file. This file type will need to be imported using the Orientate 3D Model to size and position it before it is brought into VCarve Pro.

DXF

3D DXF files from AutoCAD and many other CAD orientated modeling packages, these must be 3D meshes and not just wireframe data of the models vertices. This file type will need to be imported using the Orientate 3D Model to size and position it before it is brought into VCarve Pro.

3DS

A native format from 3D Studio Max and many other animation orientated modeling packages. This file type will need to be imported using the Orientate 3D Model to size and position it before it is brought into VCarve Pro.

OBJ

A native format from Wavefront and many other animation orientated modeling packages. This file type will need to be imported using the Orientate 3D Model to size and position it before it is brought into VCarve Pro.

SKP

A native format from the SketchUp modeling package. This file type will need to be imported using the Orientate 3D Model to size and position it before it is brought into VCarve Pro.

Note: If you wish to read data from a 3D digitizer or scanning device then STL is typically the best format that should be used to import the data into VCarve Pro. Many software packages that work with a scanner offer an STL export option, if not then a third party software program may be required to convert the data to an STL model.

Importing a 3D Model
(STL, DXF, 3DS, OBJ etc)

When one of these formats are chosen for 3D file import, the imported model needs to be oriented and scaled before it can become a Component. A special import window is opened and a set of orientation/scaling tools enabled. Depending on the job type, import window will be different:

- Importing a 3D Model into Single or Double Sided job
- Importing a 3D Model into Rotary job

There is also a video tutorial that shows this process.
Import a Component or 3D Model
(STL, DXF, 3DS, OBJ etc) - Single/Double Sided job

Initial Orientation

Choose one of the 6 options to determine the most suitable direction on the model that defines the top surface (upper Z) that you want to use when it's converted into a Component.

You can also use the five options for Rotation about Z Axis to modify the position of the part being imported at this stage.

Interactive Rotation

The default choice XYZ-View allows you to left-click in the 3D View with the mouse to rotate your view so you can examine the part from different angles. Using this will not change the orientation of the part for import. If you select one of the other four options above the word Model then this will adjust the actual positional orientation of the imported part. Choosing the XYZ option will allow rotation around all three axes simultaneously, X, Y or Z will only allow rotation around the specified axis. This is also done using the left-click in the 3D View with the mouse.

Model Size

Lock XYZ ratio

Un-checking this option allows the model to be distorted from its original shape. This means independent X, Y and Z sizes can be entered. Leaving it checked ✓ fixes the ratio so it cannot be distorted. Instead it will automatically scale the other axes as you enter new values for X, Y or Z.

Apply

Applies the values you have entered for the X, Y or Z dimensions and scales the others if you have the Lock XYZ ratio option selected.

Many mesh files do not inherently have the units that they were made in embossed in the files, so the software is not able to tell if the files are supposed to be inches or metric, they will just have a particular value. Therefore it is quite common to need to scale the part from inch to metric or vice versa. If you import your model and you wish to work in inches and the file seems very large or if you work in Metric and the file seems very small then you will probably need to use the Scale mm/inches option. The next two items on the form cover this need.

Units

Choose the unit of measurement (mm or inches) that you are working in, within the part the file is being imported into.

Scale mm/inches

Scales the X, Y and Z values up or down depending which Unit option is selected. If mm is selected then the software assumes you want to scale the values up so multiplies the current values by 25.4, if inches is selected it assumes you want to scale the values down and divided them by 25.4.

Zero Plane Position In Model

This slider bar determines where the 3D model will be cut-off when converting to a Component. You can move this up and down with the mouse or use the Middle or Bottom buttons to locate the plane in the correct position.

Note: Anything in the original model which is an undercut (goes underneath another part of the 3D model) will be discarded and a vertical wall will be created down to the plane from the silhouette (looking down Z axis) edge of the model.

Discard data below zero plane

Checking ✓ this will remove any data below the original Zero level within the imported 3D model. If the model is effectively a negative model such as a dished or recessed design with a flat plane then you should uncheck this option to make sure you retain the 3D data below the plane.
Create both sides

If you are working in a 2 sided setup you can check ✓ this option and two components will be created - one looking down the Z axis from above to the zero plane and one looking up from below. Each side of the model will go onto a side. This will provide you with the geometry that can be edited to cut the original imported 3D part as a 2-sided job.

If you were importing a model that contains a non-convex surface for instance a bowl you can import the entire model on each side by sliding the slicing plane all the way to the bottom.

Center Model

The Center Model button which will move the center of the model's bounding box to datum position (XYZ zero). This is particularly useful if you intend to unwrap a model for rotary machining. This may change the Zero Plane position in the model.

Apply Perspective along Z

Checking ✓ this will enable you to apply a perspective distortion to the model along the Z axis by using the slider. Points on the model closest to the observer will become further apart as the distortion strength is increased - this makes the model appear as if it is coming out of the screen.

OK

Creates a 3D Component based on the settings in the form, the Component will have the same name as the imported file. If you selected 'Create both sides' you will have two components with the name of the imported file followed by the suffixes - Top and Bottom.

Cancel

Cancels the Import function and returns to the standard Modeling Tab icons.

Import a Component or 3D Model (STL, DXF, 3DS, OBJ etc) - Rotary job

Imported model type

Allows the nature of the imported model to be specified. Depending on the selection, the form will change to allow the most appropriate workflow. You can choose from the following model types:

- FULL 3D model - a model that is suitable for rotary machining as is
- Flat model - a model that is only suitable as a part of design, similar to clipart provided with VCarve Pro

Initial Orientation

The purpose of this section is to roughly position the imported model within the material block. One can choose one of the 6 options to determine the most suitable direction on the model that defines the top surface (upper Z). This can be combined with one of the five options for Rotation about Z Axis.

Note: VCarve Pro will try to guess the initial orientation that seems to be appropriate for the model, based on the model type selected in step one.

Interactive Rotation

This section can be used to fine-tune the model position in relation to the material block. The default choice XYZ-View allows the usual use of the mouse to rotate the 3D View, so the imported part can be seen from different angles. While this mode is selected, the orientation of the part will not change. Selecting one of the other four options above the word Model will enable adjustment of the actual positional orientation of the imported part. Choosing the XYZ option will allow rotation around all three axes simultaneously. Selecting X, Y or Z will only allow rotation around the specified axis. It will also automatically switch the 3D View to show the part from that axis.

Note: Selecting a different initial orientation will cancel any adjustments made by using Interactive Rotation.
**Rotation Axis Movement (Full 3D model only)**

This section can be used to adjust the position of the model in relation to the rotation centerline. By default, VCarve Pro will position the model in the center of the material block, so the material is used more efficiently.

When the **Off** option is selected, panning the 3D View will happen in the usual manner.

When the **On** option becomes selected, using the 3D View panning controls will move the rotation axis instead.

**Model Scaling (Full 3D model)**

This section allows the model scale to be adjusted as desired. The model bounding cylinder (blue) will be displayed around the imported model in the 3D View. The scaling is performed by means of length and diameter of the bounding cylinder. When the model orientation within the material block changes, so does the bounding cylinder. If that happens, the reported size of the model will change, although the model may not have been scaled.

**Model units**

By default, VCarve Pro assumes that the imported model is using the same units as specified during job setup. If that is not the case, the model units can be changed.

**Note:** If the model units are different than those selected during job setup, the imported model will be converted to use the units selected during job setup.

**Lock ratio**

When this option is selected, all scaling operations will maintain the current ratio between model length and diameter.

**Scale model to fit material**

This option can be used to resize the imported model so it will fit in the material block as defined during job setup.

**Reset to Original Size**

This option undoes any scaling applied to the model (apart from unit conversion), regardless of the model orientation.

**Resize material block**

When this option is selected, the project's material block will be resized to match the final dimensions of the imported model.

**Model Scaling (Flat model)**

This section allows the model scale to be adjusted as desired. A flat material block is displayed and the scaling can be performed by means of length in each of the three axes (X, Y and Z).

**Model units**

By default, VCarve Pro assumes that the imported model is using the same units as specified during job setup. If that is not the case, the model units can be changed.

**Note:** If the model units are different than those selected during job setup, the imported model will be converted to use the units selected during job setup.

**Lock ratio**

When this option is selected, all scaling operations will maintain the current ratio between the model length in each of the three axes.

**Scale model to fit material**

This option can be used to resize the imported model so it will fit in the material block as defined during job setup.

**Reset to Original Size**
This option undoes any scaling applied to the model (apart from unit conversion), regardless of the model orientation.

**OK**

Creates a 3D Component based on the settings in the form, the Component will have the same name as the imported file.

**Cancel**

Cancels the Import function and returns to the standard Modeling Tab icons.
Understanding the component tree and the composite model

The model that you see in the 3D View is the result of progressively combining all of the visible components from the bottom of the Component Tree, to the top. The resulting model is known as the Composite Model. The order in which components are combined can have a significant impact on the final shape of the composite model and so you will often need to move components relative to one another within the Component Tree in order to achieve the end result you are intending.

To help you understand how the components are being combined, each component in the tree has an icon indicating how it is currently being combined with the components below:

- **Add**
- **Subtract**
- **Merge**
- **Low**
- **Group**

Grouped components are also indicated by their own icon and the presence of a plus or minus control to the left of the visibility checkbox. These controls allow you expand or collapse the group to show or hide the group contents, respectively.

Every component exists on a single **Level**. These levels can be used to organize your modelling process. During the compositing process the contents of a level are combined first before the levels themselves are combined together.

Components can be selected in 3 ways:

- By left-clicking on the component’s name in the Component Tree
- By left-clicking on the associated grayscale component preview image in the 2D view
- By double left-clicking directly on the component in the 3D view

In all cases, the new selection will subsequently be reflected in all three locations. So, for example, selecting a component in the Component Tree will simultaneously cause the associated 2D component preview to become selected in the 2D View, and the same component to become highlighted in red (or green if the selected component is obscured by another component) in the 3D View.
There are, however, some minor differences between the three methods of selection. Also, depending on the circumstances, there may be some advantages to selecting your components using one method rather than another. These are detailed below.

**Component Selection in the Component Tree**

The component tree works in a similar way to the Window's file explorer. To select a component, simply click on it. To select multiple components, hold down a Ctrl key while clicking on each component you wish to add to the selection. While in this mode, clicking on a component that is already selected will cause it to be removed from the selection.

Pressing a Shift key allows you to select a range of components. Click on the first component in the range to select it, then holding a Shift key and pressing the last component you want selected will select all the components between the first and last selection.

Double-clicking a component or level in the Component Tree will automatically open the Component Properties tool - see the Component Properties section for more information on how to use this tool to modify the selected components.

Right-clicking an unselected component in the Component Tree will select it, and open its pop-up menu of related commands. Any commands you select will apply to this selected component only.

Right-clicking a component that is already selected, and is also one of several selected components, will open a similar pop-up menu of commands. Any commands you select from this menu will apply to all of the currently selected components.

**Component Selection in the 2D View**

The 2D component previews behave exactly the same way as vectors or bitmaps. They can be selected by a single, left-click. Several component previews can also be "shift selected" (see above). Clicking on selected component previews again activates their interactive transform handles. These can be used to move, rotate or stretch the 2D component preview and its associated 3D component.

**Component Selection in the 3D View**

Because the left mouse button is used for twiddling the 3D view itself, a single left-click cannot be used for component selection directly. However, Aspire's 3D view supports most of the standard selection concepts described above, using double-clicks instead. Therefore, to select a component in the 3D view it must be double-clicked with the left mouse button. To select multiple components in the 3D view, hold down a Shift key and double-click each of the components you wish to add to the selection. To access the pop-up menu of commands associated with a component, double right-click it in the 3D View.

Because components may overlap or merge through one another when forming the composite model, you may find that some components become difficult (or are even impossible) to select directly from the 3D view using the double click method. In this case you may use the right click menu. If you right click on a point above the component you wish to select then you are presented with a list of all the components that lie under this point.

You can also double right-click the selected component (highlighted in red) in the 3D view. The options offered include showing/hiding components, or setting their combine mode within the composite model.

In the 3D view selected object will often be tinted red. On some occasions parts of some components will be obscured by other components. In this case then the red tint will not be seen. The parts of the objects that are obscured will be tinted green so they are still visible from within the 3D view.
Component Editing in the 3D View

Many of the dynamic component editing tools can now be accessed directly from the 3D View. Editing the components in the 3D View makes it quick and easy to see the immediate effect of the changes to the Composite Model. To access these editing options a component or components must first be selected. Once selected then either clicking the component again in the 3D view or clicking the Transform Mode icon (Move, Scale, Rotate Selection) will activate the 3D Transform Handles. These take the form of solid and hollow blue squares around the component/s in the 3D View.

The majority of these will function in the same way that they do with objects in the 2D View. The hollow square in the middle of the component can be clicked and moved to reposition it. The hollow squares on each corner and in the middle of each side can be clicked and moved to re-size or scale the component (holding shift anchors this edit around the center of the object). The solid blue squares in each corner can be clicked and moved to rotate the object.

**Note:** When dynamically scaling a Component using these handles in either the 2D or 3D View the software will use whatever option is currently selected on the Set Scale form for Auto Scale Z. If this is checked ✓ the Component height will be automatically scaled up and down as the Component is made larger or smaller in X and/or Y. If the option is unchecked then the Component will retain is original Z-Height while being scaled.

The additional larger solid blue square below the middle of the bottom edge of the model can be left-clicked to open a floating form that allows access to some of the components properties. This form can be moved if it is covering an important area of the job. From this form you can adjust the Combine Mode, Shape Height, Base Height, Fade and Tilt for the selected component/s. If you edit Fade or Tilt using this form, then when you click the Set button you must click the positions for this in the 3D View.

See 3D Design and Management for more information.

Create Vector Boundary From Selected Components
This icon can be used to create a vector around the outermost boundary (silhouette) of one or more selected components. The most important use is to generate a vector that can be selected as a toolpath boundary, particularly for 3D Roughing, 3D Finishing and also Profile (cutout) toolpaths.

To use this function select one or more components and click the Create vector boundary from selected components icon. VCarve Pro will create one or more closed vector boundaries around the edge of the selected components. If more than one closed vector is required to create the boundary, these will be created as a group to make it easier to select them. They would need to be ungrouped before they could be edited individually.

Note: You can use Create vector boundary from selected components to create a vector boundary for a composition you have created in Mirror Mode, simply select the components that are visible in the 2D View and apply the vector boundary.

Component Properties

The Component Properties form allows you to adjust a number of dynamic properties for a selected Component or Level. Adjusting these properties does not make permanent changes to your Components and can be further edited or reset any time until the component is Baked, in which cases they will be made permanent in the Component shape and this form will be reset.

Note: You can only edit the Name, Combine Mode and Base Height for the Properties of a Level.

Multiple Selections

If you have more than one component selected while using the Component Properties tool, VCarve Pro will apply the changes to all the selected components. Some properties where this would be inappropriate (such as the component's name) are grayed-out when there is more than one component selected. These properties must be applied to components one at a time.

Combine with other components

The Combine Mode dictates how the components (or Level) are combined with the objects below them in the Component Tree. This is done by the software starting at the bottom of the list and working upwards. The first level and first component's combine mode determines only how it combines with the modeling plane. The second and subsequent components are combined with the result of everything below them based on their Combine Mode as detailed below. There is additional information and diagrams of the result of these choices in the 3D Design section of this document.

Add

Adds the selected component/s to the result of all the previous components in the list

Subtract

Subtracts the selected component/s from the result of all the previous components in the list

Merge

Where they overlap, this Merges the selected component/s into the result of all the previous Components in the list keeping the highest part of the overlapping area. This means the higher part of each shape will be what remains in this area.

Low

Where they overlap, this Merges the selected component/s into the result of all the previous Components in the list keeping the lowest part of the overlapping area. This means the lower part of each shape will be what remains in this area.

Multiply

Where there is an overlap, this Multiplies the result of all the previous components in the list by the heights in this component.

Shape Height
Use the slider or type in a specific percentage to scale the height of the selected Component(s) up or down based on its current height (100%).

Enter a value in the Shape Height edit box directly, or use the slider to adjust the height of your component selection interactively. In either case, the 3D view of the component will update automatically as you adjust the value. The range of available heights on the slider is determined by your current material thickness setting. If these values appear to be inappropriate you can still enter any value you like into the associated edit box, or you can close the tool and select Edit ► Job Size and Position from the main menu. In the Job Setup page you can then correct the current setting for the material thickness before continuing.

**Base Height**

Enter a specific value into this box to raise the Component or Level up on a flat plane of the thickness you specify. This can be useful to help move an object up so it sits proud of another component it is Merging with. If you are not sure of the value you need, then enter an amount and hit the space bar to apply this. If this is not correct, type in another value and hit space again to apply the new value, look at the 3D View to judge the result - repeat until you get the value you need.

You can also apply a Base Height to a Level. Adding a base height to a level will add the same base height visually to the components in that Level, however the components themselves will have no base height added to them within their properties. This is useful to raise a set of objects on a Level above things that need to appear to be behind them (for example above a textured area).

**Note:** Level Base Heights are not included in Baking operations on the Components on those Levels but are a separate value that is added on after the objects on the Level have been combined. They are scaled proportionately though when the Scale z height of Model function is used to adjust the Z Height of the Composite Model (visible components).

**Reset Heights**

The Reset Heights button will remove the dynamically applied Shape and Base height settings from the selected component. To reset the Base Height back to zero using the slider control, double click the central line marker above the slider bar.

**Fade**

When this option is checked ✓ the user can fade the Z depth of the Component. The first part of this operation (once the option is checked ✓) is to select the Set Anchor button - then click two points in the 2D view. The first click specifies the point which will remain at the current height. The second click specifies the point that the Component will be faded down toward. The shape will fade down from the first point to the second by the percentage selected. Change the strength of the fade by clicking the down arrow next to the percentage value and using the slider to move this up and down or type in a specific value for the amount you would like to reduce the depth by. The fade will be applied linearly between the two selected points. This is a useful tool for giving the effect of a Component fading into the distance to help with overlapping areas of Components if you want to lower an area to give it the appearance of going behind another one.

**Tilt**

When this option is checked ✓ the user can set a direction and angle to tilt the Component up in the Z axis. The first part of this operation (once the option is checked ✓) is to select the Set Anchor button - then click two points in the 2D view. The first click specifies the point which will not move (the pivot point of the tilt). The second click specifies the point that will be tilted upwards by the specified angle (the point that will be raised up). Change the tilt angle by clicking the down arrow next to the value, you can use the slider to alter this, or type in a specific value for the angle. This is an extremely useful function for raising a part of one Component above another one when they overlap, without having to raise the whole Component up using the Base Z Position option. In some cases this allows the overlapping areas to sit proud without having to create a deep raised wall around the whole edge of the Component.

**The Bake button**

Sometimes it’s useful to apply a component’s dynamic properties permanently, one example where this is useful is so that further dynamic changes can be applied ‘on top’ of previous ones. To do this, use the Bake button.

**Appearance**

VCarve Pro gives you a lot of control over the appearance of the 3D shaded image for visualization purposes, such as customer approval proofs or marketing material. Each component can be given an individual color or material:
Use Material

When this is selected the user can choose from the list of pre-defined material effects by clicking on the box immediately below the Appearance choice. These include many wood grains, metal effects, stone and plastic.

Additional materials can be added to the library list by copying an image file (JPG, BMP or TIF) of the material or image into the relevant materials folder on your computer. To find the Materials folder on your computer, use the menu command File ▶ Open Application Data Folder... Then open the folder Bitmap Textures. Either copy your new textures into one of the existing folders, or create a new folder and add them there.

**Note:** You will need to restart VCarve Pro for the new material images to become available.

Color from Children

This option is used for a Group of Components and will allow the software to use the individual colors and materials assigned to the groups constituent Components to display in the shaded image even though it is a Group. If this option is not selected the Group will be given its selected Color or Material.

Highlight Selected Component

When choosing a material or color to use for a particular component, the red selection highlighting of the component can prevent you from seeing your chosen material accurately in the 3D view. You can un-check this box to temporarily disable the red highlighting while you make your selections. This option will automatically be re-enabled on exiting the Component Properties page.

Close

The Close button will exit the Component Properties form and return to the standard set of modeling icons.
**Smooth Components**

Often it is advantageous to apply a general smoothing effect over the whole of a component (rather than smooth a particular area with the Sculpting Tools). To use this tool, select the components you wish to smooth and then click the **Apply smoothing filter to selected components** icon on the Modeling tab. The form will appear and VCarve Pro will take a few seconds to prepare the model for the smoothing operation. You will see a progress bar at the bottom of the screen while it is doing this.

One or more Components can be selected for Smoothing. If you select multiple shapes or a Component Group then the software will need to Bake your selection into a single Component, if applicable you should ensure you have a safe copy of your current Components before proceeding.

If you wish to smooth individual components one after another, potentially with different amounts of smoothing, you can do this by selecting one component, apply a suitable smooth filter value with the slider and then hit the **Bake Current Smoothing** button in the form and then proceed to selecting the next component you wish to smooth. When you pick a new Component the software may take a few seconds to pick it and apply the smoothing filter to it at the default of 50% strength. If you do not click on the Bake Current Smoothing button before you select a new component then the effects of the smoothing will be lost on the previously selected component.

**Smoothing**

This slider will allow the user to control the strength of the smoothing applied to the Component. By default 50% smoothing is applied, using the slider different levels of smoothing can be applied to the model. Find the strength which gives you the amount of smoothing you require. If the Max setting has not smoothed the model enough then hit the Bake Current Smoothing button which resets the smoothing slider to allow you to do further smoothing.

**Preserve Transparency**

Checking ✓ this option will keep the smoothing only on the current 3D areas of the selected shapes and not smooth the edges into the background. Un-checking this option will smooth all the edges of the modeled area into the background of the part, blurring the silhouette of the Component.

**Bake Current Smoothing**

The **Bake Current Smoothing** button bakes the current smoothing value into the Component and resets the form. This means you are able to perform multiple smoothing operations without leaving the function.

**Note:** Smoothing should be performed with both the 2D and 3D View visible (Tile Windows), so you can easily see the selected Component in the 2D View and also view the effects of the smoothing in real time on the 3D model in the 3D View.

**Scale Model Height**

You can scale the individual heights of your 3D Components using the Component Properties form. However, it is also very useful towards the end of your modeling process to be able to apply a global scaling to your final composite model. This allows you to accurately fit a design within the available material or to manage the depth of cuts required, without having to individually adjust each of the contributing Components.

**Scale Both Sides**

This option can only be selected when working within a 2 Sided Setup. Checking ✓ this option enables you to scale both sides of the model. If this is unchecked then you are only scaling the model of the side you are currently working on.

**Scale Height**
This slider will allow the user to increase and decrease the height of the model as a percentage based on its original height (when the Scale tool was selected).

**Set Exact height...**

Clicking **Set Exact Height...** button lets the user define a specific value (in the current working units) for the height of the model, rather than use the proportional slider. If you are working in a two sided environment you have the option scale both sides. Checking ✓ this option enables you to scale both sides of the model. If this is unchecked then you are only scaling the model of the side you are currently working on.

**Apply/OK**

Exits the dialog keeping the changes made to the Model

**Close/Cancel**

Exits the dialog discarding the changes made to the Model

**Slice Model**

The slicing feature allows the user to divide the Composite Model into Z-Slices each of which will become a Component. This is for customers who need to cut a part which exceeds the Z-depth of their machine gantry, the cutting length of their tools or the thickness of the material they are using. Once the slices have been cut on the CNC then they can be re-assembled to make the finished full depth part.

When this function is executed each slice will become a Component in the Component Tree and can then be moved into position and have toolpaths calculated on it. An example of this is shown in the images below, on the left it shows a scallop shell component that is 3 inches thick, the image below right shows this divided into two separate components, each a 1.5 inch slice of the original.

**Note:** Before using the Slice model command it is important to make sure that you hide any components that you do not wish to include in the operation.

When the icon is clicked the Slice Model form will appear. This can be used to control the number and thickness of slices which will be created. At the top of the form it will display some reference information showing the thickness of the current Composite Model and also the currently defined Material Thickness (for machining).
Slice Thickness

Checking ✓ this option will let you define a particular value for each slice. Right below this the Number of Slices will be displayed which is determined by the Composite Model thickness divided by the Slice Thickness. The model will be sliced from the bottom up and if the Composite Model thickness does not divide exactly by the Slice Thickness then the top slice may not be a whole number. To help indicate how the part is going to be divided the Top Slice Thickness is displayed in the form.

**Example:** If the Composite Model is 4.75 inches thick and you define a Slice Thickness of 2 inches then the software will create 3 Component slices - the bottom and middle slice will both be 2 inches thick and the top slice will be 0.75 inches thick.

Number of Slices

Checking ✓ this option will divide the model into a specific number of slices. The slice thickness will be determined by the Composite Model thickness divided by the Number of Slices defined. This may be a good option to use if the specific slice thickness is not important (for instance if it does not relate to material thickness).

**Example:** If the Composite Model is 3.96 inches thick and you define 3 Slices then the software will create 3 Component slices each 1.32 inches thick.

Create Boundary Vectors

Checking ✓ this option will cause the slicer to create vector boundaries for each slice. These can be useful for defining the subsequent machining regions required to cut each part. The boundary vectors will be placed on the same layer in the 2D View as the component preview for their associated model slice.

Slice Model

Clicking Slice Model will apply the choices made in the form and create the Components which represent each slice of the Composite Model.

**Note:** The Component Tree will retain a copy of the original Components in the part as well as the new Slice Components. This may result in a very thick looking model as all the slices will be added to the original shapes. At this point you can delete, undraw or move Components before proceeding with any additional operations.

Close

Clicking Close will close the Slice Model form without completing the operation.
See Also:
- Toolpaths Overview
- The Toolpath List

Toolpath Operations
- Basic Toolpaths
- VCarving and 2.5D Toolpaths
- Laser Toolpaths (available with Laser Module)
- 3D Toolpaths
- Toolpath Editing Tools
- Templates, Merging and Array Copy
- Preview, Estimation, Tiling and Saving
The ultimate purpose (in almost all applications) of VCarve Pro is to allow you to generate toolpaths which can be run on a CNC machine to machine the finished part in the material of choice. This requires, at a minimum, some vectors to describe the area to which a toolpath will be limited to or a combination of both vectors and a 3D Model. The process for creating toolpath is as follows:

**Prepare vectors for machining**

Optionally organize the vectors you will be using for machining onto appropriate layers.

Create outline vectors around any 3D data using the drawing tools or the 'Create vector boundary from selected components' icon.

**Check the 3D data**

Make sure you have the right combination of 3D Components displayed. Everything you see in the 3D View - the result of all the visible Components will be machined. Check the depth of the combined 3D model to make sure it fits into the material you plan to use, edit this using the Scale Model Height function if necessary.

**Set up the Material**

Check the overall material size (Job Setup) to ensure it matches or exceeds the size of the finished product.

Use the Material setup form from the Toolpaths Tab to set the reference Z datum for the part relevant to the CNC machine and to position the 3D part within the material.

**Create the Toolpaths**

Work through the toolpath strategy icons you wish to use to machine the job to calculate all the required toolpaths.

**Preview the Toolpaths**

Either after you create each toolpath or at the end of calculating them all, the user has the option to preview the toolpaths to see what they will actually look like in the 3D view. This is a very important step to verify position, detail and the look of the overall finished part.

**Save the Toolpaths for the CNC machine**

After choosing the appropriate Postprocessor from the list, the toolpaths can be saved in a format which is ready for the CNC to cut. Depending on the toolpaths calculated and the options the Postprocessor/CNC you are using supports, you may be able to save a single file or it may need multiple files to be saved - one for each tool type.

All the stages will be covered in the supplied Tutorial videos. It should be noted Stages 1 and 2 are done through icons already covered from the Drawing and Modeling Tabs. Stages 3 to 6 use icons from the Toolpath Tab (on the right hand side of the screen). These will be covered in the next section.

**Additional Toolpath Tab Features**

**Switch to Drawing Tab**

Closes the Toolpath Tab (right hand screen form) and opens the Drawing Tab (left hand drawing form)

The pin icon is described in the section: Accessing Auto-hidden tabs
Toolpath Summary Area

When a toolpath is selected from the Toolpath list with no other function being used in the Toolpath Tab a text summary of the toolpaths settings is shown in the body of the Toolpath Tab below the icons. This is a very useful way to recall settings for a toolpath without opening it.

Material Setup

- Flat Job
- Rotary Job

The Material Setup section of the Toolpaths tab provides a summary of the current material settings. Some of these values will have been initially set when the job was first created (see Job Setup for more information). When you come to creating toolpaths, it is important to review this information and ensure it is still valid and also to set the machining clearances. To access all these properties for editing, click on the Set... button to open the Material Setup form:

Flat Material Setup

Thickness

Enter the thickness of the material being machined.

XY Datum

This allows you to set the X and Y origin of the job. See the section in Job Setup form

Show detailed summary on toolpath tab

This checkbox toggles the Material Setup summary layout on the Toolpaths tab between simple and detailed views.

Side Z-Zero

Select relative to the Material Surface or relative to the Machine Bed. This is a very important setting because the tooling used on the CNC machine must be setup in the same way, ensuring the toolpaths cut to the correct depth.

If you are working in a 2 Sided job, this will set the Z Zero for your current side only,

- The side you are setting up will be displayed in brackets e.g. (Top).
- You can set the Z-Zero for both sides through the Job Setup form.

Model Position in Material

The thickness of your model must be less than the thickness of the material you wish to cut it from. You can position your model within the material block wherever you wish by defining the gap distance either above or below your model. You can also double left click on either of the three lines next to the slider to position the model at the top, center or bottom of the material.

Note for Two-Sided Jobs: The gaps defined here are for the entire combined models from both sides (i.e. the final result you see when two-sided view is enabled). The above / below gaps do not depend on which side you are currently on. They represent the whole 2 sided model as if viewed in the correct orientation.

Gap Above Model
This distance positions your model according to the gap between the top of your model and the top surface of the material.

**Gap Below Model**

Alternatively you can position your model by defining the gap between the bottom of the model and the bottom surface of the material.

**Model Thickness**

This field simply reports the thickness of your composite model (as built from all your currently visible components).

**Scale Model Height**

The button can be used to change the Z Height of the Composite 3D Model (the visible Components) if it is not an appropriate height for your material thickness. Clicking this button will open the Set Model Height form which allows you to enter a new value for the overall height of the combined Components. After you have entered a new value hit and visually check the 3D model to ensure it still looks correct. Once you have found an appropriate value that looks good you can hit the button to continue in the Material Setup form. This height scaling function is also available from the Scale z height of model icon on the modeling toolbar.

**Modeling Plane Z**

Once you have positioned your model, this field will tell you the new height of your modeling base plane. This is for information only, and results from the gap settings above and cannot be edited directly.

**Rapid Z Gaps above Material**

**Clearance (Z1)**

This is the height above the job at which it is safe for the cutter to move at rapid or maximum feed rate. The software will raise the bottom of the cutter to this height when it traverses the material.

**Plunge (Z2)**

For all toolpaths, as well as specifying a rapid clearance gap for rapid positioning moves above the workpiece, the user can also specify a much smaller gap that the tool will rapid down to during plunge moves. By default the plunge gap is set to the same value as the Clearance gap which means that there will be no rapid plunges. If you set the plunge gap to a smaller value than the Clearance gap, the tool will plunge at rapid feed rate to the specified distance above the material surface before changing to the specified plunge rate. For jobs where a large value for Clearance gap has to be specified to avoid clamps etc, this feature can save a considerable amount of machining time if there are a lot of plunge moves in the job.

*Note:* Some engraving machines are not able to take advantage of this feature.

**Home / Start Position**

This is the absolute position that the tool will start moving from and where the tool can be programmed to return to at the end of cutting the job.
Rotary Material Setup

Diameter

Enter the diameter of the material being machined.

XY Datum

This allows you to set the X and Y origin of the job. See the section in Job Setup form.

Show detailed summary on toolpath tab

This checkbox toggles the Material Setup summary layout on the Toolpaths tab between simple and detailed views.

Z-Zero

Select relative to the surface of the material cylinder or its center. This is a very important setting because the Tooling used on the CNC machine must be setup in the same way, ensuring the toolpaths cut to the correct depth.

Model Position in Material

The diameter of your model must be less than the diameter of the material you wish to cut it from. You can position your model within the material block wherever you wish by defining the gap distance either outside or inside your model. You can also double left click on either of the three lines next to the slider to position the model at the top, center or bottom of the material.

Gap Outside Model

This distance positions your model according to the gap between the top of your model and the surface of the material cylinder.

Gap Inside Model

Alternatively you can position your model by defining the gap between the bottom of the model and the center of the material.

Model Thickness

This field reports the thickness of the model (as built from all the currently visible components). The model can be scaled by clicking on the Set... button.

Modeling Plane Z

Once you have positioned your model, this field will tell you the new height of your modeling base plane. This is for information only. It results from the gap settings above and cannot be edited directly.

Rapid Z Gaps above Material

Clearance (Z1)

This is the height above the job at which it is safe for the cutter to move at rapid or maximum feed rate. The software will raise the bottom of the cutter to this height when it traverses the material.

Plunge (Z2)

For all toolpaths, as well as specifying a rapid clearance gap for rapid positioning moves above the workpiece, the user can also specify a much smaller gap that the tool will rapid down to during plunge moves. By default the plunge gap is set to the same value as the Clearance gap which means that there will be no rapid plunger. If you set the plunge gap to a smaller value than the Clearance gap, the tool will plunge at rapid feed rate to the specified distance above the material surface before changing to the specified plunge rate. For jobs where a large value for Clearance gap has to be specified to avoid clamps etc, this feature can save a considerable amount of machining time if there are a lot of plunge moves in the job.

Note: Some engraving machines are not able to take advantage of this feature.
Home / Start Position

This is the absolute position that the tool will start moving from and where the tool can be programmed to return to at the end of cutting the job.
The Toolpath List

The Toolpath List is located at the bottom of the Toolpath Tab (toggle tab visibility using Shortcut key F12). 

This area displays in a list, the name of each calculated toolpath with a check-box to turn the visibility of the toolpath in the 3D View on and off. The icon next to the check-box shows the type of tool selected for that particular toolpath.

Double clicking the name of any of the toolpaths will open up the toolpath strategy window for that toolpath and allow edits to be made to it.

The up and down arrow icons to the right of the window allow the user to move a toolpath up and down in the list. This will affect the order the Toolpaths are previewed in and if multiple toolpaths are saved as a single file, then this will be the order that the machine cuts them in.

You can adjust the space available for the Toolpath list by clicking and dragging the divider that separates the Toolpath List from the Toolpath Operations section, up or down.

Resizing the Toolpath List

The toolpath list can be resized by clicking on the divider between the toolpath list and toolpath commands area and dragging.
Basic Toolpaths

The basic toolpaths section of the Toolpath Operations icons can be found on the Toolpaths tab, underneath the Toolpath list. It includes the Material setup command, which will often need to be used before any toolpaths are created. This section also includes Profiling, Pocketing and Drilling strategies. The Quick Engrave strategy is a specialist strategy for some engraving machines.

### Material Setup

![Material Setup Icon]

Profile Toolpath

**Profile Toolpath**

Profile Machining is used to cut around or along a vector. Options provide the flexibility for cutting shapes out with optional Tabs / bridges plus an Allowance over/undercut to ensure perfect edge quality.

Profile toolpaths can be outside, inside or on the selected vectors, automatically compensating for the tool diameter and angle for the chosen cut depth.

When working with open vectors the profile toolpaths can be to the Left, to the Right or On the selected vectors.

Clicking this icon opens the 2D Profile Toolpath form which is shown at the right; the functions in this form are described on the following pages.

If you have vectors which are nested (like the letter 'O'), the program will automatically determine the nesting and cut the correct side of the inner and outer vectors. In addition, the program will always cut the inner vectors before the outer vectors to ensure the part remains attached to the original material as long as possible.

#### Cutting Depths

**Start Depth (D)**

Specifies the depth at which the Profile toolpath is calculated. When cutting directly into the surface of a job the Start Depth will usually be 0. If machining into the bottom of an existing pocket or stepped region, the depth of the pocket / step must be entered.

**Cut Depth (C)**

The depth of the profile toolpath relative to the Start Depth.

**Tool**

Clicking the Select button opens the Tool Database from which the required tool can be selected. See the section on the Tool Database for more information on this. Clicking the Edit button opens the Edit Tool form which allows the cutting parameters for the selected tool to be modified, without changing the master information in the database. Hovering the mouse cursor over the tool name will display a tool tip indicating where in the Tool Database the tool was selected from.

#### Pass Depth Control for Profiling

When a profile toolpath is created, the **Pass Depth** value associated with the selected tool (part of the tool's description in the Tool Database) is used to determine the number of passes needed to profile down to the specified **Cut Depth**. However, by default VCarve Pro will also modify the precise step down by up to 15% in either direction, if by doing so it is able to total number of passes.
required to reach the desired cut depth. It is nearly always desirable to benefit from the significantly reduced machining time of cutting profiles using less passes if possible. Nevertheless, there are some occasions where the exact step down for a given profile pass needs to be more precisely controlled - when cutting into laminated material, for example. The Passes section of the 2D Profile Toolpath page indicates how many passes will be created with the current settings.

The Edit Passes button will open a new dialog that enables the specific number and height of passes to be set directly.

Specify Pass Depths

The Pass Depths section at the top of the form shows a list of the current pass depths. The relative spacing of the passes is indicated in the diagram next to the list. Left click on a depth value in the list, or a depth line on the diagram, to select it. The currently selected pass is highlighted in red on the diagram.

To edit the depth of the selected pass, change the value in the Depth edit box and click Apply. The Delete button will delete the selected pass. The Clear All Passes button will delete all the passes.

To add a new pass, double left click at the approximate location in the passes diagram that you wish to add the pass. A new pass will be added and automatically selected. Edit the precise Depth value if required and then click Apply.

The Set Last Pass Thickness option will enable an edit box where you can specify the last pass in terms of the remaining thickness of material you wish to cut with the last pass (instead of in terms of its depth). This is often a more intuitive way to specify this value.

Pass Depth List Utilities

This section of the form includes two methods for creating a set of passes in one go.

The first method simply sets the passes according to the Pass Depth property of the selected tool. By default, this is the method used by VCarve Pro when it creates profile passes initially. However, the Maintain exact tool pass depth option checked, ✓ VCarve Pro will not vary the step size to try and optimize the number of passes (see above).

The second method creates evenly spaced passes according to the value entered in the Number Of Passes edit box.

To apply either method click the associated Set Passes button to create the resulting set of pass depths in the passes list and diagram.

Note: Setting the number of passes with either of these utilities will discard any custom passes you may have added.

Machine Vectors...

There are 3 options to choose from to determine how the tool is positioned relative to the selected vectors/s.

Outside Calculates a profile toolpath around the Outside of the selected vectors, with options for the cut direction to be either,
Climb (CW) cutting direction or Conventional (CCW) cutting direction

Inside Calculates a profile toolpath around the Inside of the selected vectors, with options for the cut direction to be either;
Climb (CCW) cutting direction or Conventional (CW) cutting direction

On Calculates a profile toolpath around the On the selected vectors, with options for the cut direction to be either;
Climb (CW) cutting direction or Conventional (CCW) cutting direction

Direction

Can be set to either Conventional or Climb machining where the cutting direction depends upon the strategy selected - see above for details. Using Climb or Conventional cutting will largely be dictated by the material is being machined and the tooling.

Allowance offset
An Allowance can be specified to either Overcut (negative number will cut smaller) or Undercut (positive numbers will cut larger) the selected shape. If the Allowance = 0 then the toolpaths will machine to the exact size.

**Last Pass Allowance**

A separate allowance can be specified for the last pass. If this allowance is given then all but the last pass will be undercut by the specified allowance with the final pass being the only pass which cuts to size.

**Note:** This is intended to be just a thin skin of material to be cut away as the tool will have to cut through this allowance at the full depth of the cut where all the previous passes undercut. There will be a warning displayed if the last pass allowance is greater than 1/3rd of the tool diameter but the last pass allowance should ideally be kept a lot smaller than this. Keeping this as small as possible reduces the chances the final pass will fill in areas where the previous passes will not and reduces the amount of material the last pass is having to cut through. If using a last pass allowance for the toolpath you should check that you are happy with the amount of material left for the last pass to cut through. The toolpath will fail to calculate if the last pass is cutting a significant distance into material which has not been cleared by the previous passes.

The final pass (shown in blue) cuts to size.
All previous passes (shown in red) are cut with a small allowance offset

If the Reverse direction button is checked ✓ then the cutting direction of the last pass is reversed. This feature is can be useful if for minimizing witness marks on the edge of profile cuts.

The last pass allowance will also take into account any allowance offset and so the two options can be used together.

**Use vector start point**

Use Start Point can be selected to force the toolpath to plunge and start cutting at the first point on the shape. This is very useful if you need to ensure the cutter doesn't plunge onto a critical part of the job. For example, setting the Start Point to be on a corner will often be the best position to plunge and cut from as this will not leave a witness / dwell mark on the machined surface.

The Start Points are displayed as Green boxes on all vectors when this option is selected. Start Point on a vector can be moved using the Node Editing Tools. Select Node Editing cursor or press. Place the cursor over the node to be used as the Start Point. Click Right mouse button and select Make Start Point (or press ) Remember, you can also insert a new point anywhere on a vector using the Right mouse menu or pressing the letter. This will insert a new point and make it the start point.

**Note:** Selecting Use Start Point may result in less efficient toolpaths (increased cutting times) because it may take the machine longer to move between each shape being cut. If this option is not selected the software will try to calculate the shortest toolpath, minimizing the distance between link up moves. But the downside is that the cutter may plunge/mark important surfaces on the machined edge.

**Tabs (Bridges)**

Tabs are added to open and closed vector shapes to hold parts in place when cutting them out of material.

**Add tabs to toolpath**

Checking ✓ the Add tabs option will activate tab creation for this toolpath. The Length and Thickness specify the size of each tab. Checking ✓ the Create 3D Tabs option will create 3D Tabs, the difference between this and 2D Tabs is described below.
Create 3D Tabs

When this option is selected the tab will be triangular in section. This shape is created as the cutter ramps up to the specified Tab Thickness then down the other side. The 3D Tabs will often allow the machine to run quicker and smoother because it does not have to stop to move in Z at the start and end of each tab.

If this option is unchecked, the 2D tabs will be used. The cutter stops at the start point for each tab, lifts vertically by the specified Thickness runs across the ramp, stops and plunges down the other side.

This image shows how the Length and Thickness values are used when creating 3D and 2D tabs.

Edit Tabs

Clicking on the Edit Tabs... button automatically opens the 2D window and the Toolpath Tabs form is displayed:

Add Tabs

Constant Number

Calculates the length of each selected vector and places ‘X’ number of equally spaced Tabs around the shape.

Constant Distance between tabs

This option places a tab at the specified distance around the selected shape.

If placing Tabs at the Distance around the shape results in fewer than the Min. number, the minimum number of Tabs are automatically equally placed on the shape.

If the number of tabs calculated using the Distance around the shape is
greater than the specified Max. number, the maximum number are placed at equal distance around the shape.

First tab at machining start point

If checked, ✓ a Tab will be placed at the start point (Green node) of a vector when the option First Tab at Machining Start Point is selected.

Dynamically positioning tabs in the 2D View

Interactive Tab positioning is very easy. Simply place the cursor at the point where the Tab is required and click the Left mouse. To Move a Tab, Click and Drag with the Left mouse button on a Tab to move.

To Delete a Tab, place the cursor over an existing tab and click the left mouse button.

Note: The best place to put Tabs on a part is on the flat areas so they can easily be removed and tidied up.

The quickest method for adding Tabs to multiple shapes is to use the automatic option to add 'X' number. The position of these can then very easily be modified by clicking and dragging to move tabs to the 'best positions' and also delete unwanted tabs.

Profile Options

The Profiling options section of the toolpath form contains five additional pages, each of which allows a particular set of Profile machining options to be specified. The precise number of option pages will depend on which Toolpath strategy you are currently using. The full range of option pages are:

- Ramps
- Leads
- Order
- Start At
- Corners

These help control ways to ensure the parts are held in place and machined as easily as possible while ensuring the highest quality edge finish.

Each set of options can be accessed by the tabs at the top of the Profile options section.

Ramp

Ramp moves are used to prevent the cutter from plunging vertically into the material. The cutter gradually cuts at an angle dropping into the material significantly reducing cutter wear, heat build-up and also the load on the router spindle and Z axis of the machine. If multiple passes are required due to the Pass Depth being less than the Cut Depth, the ramp moves are applied at the start of each level. All ramp moves are performed at the plunge rate selected for the current tool.

Smooth

This option creates a smooth ramp into the material using either the specified Distance or Angle.

When a Lead In distance has been specified, the option Ramp on Lead In disables the distance and angle options and automatically limits the ramp moves to only be on the lead in portion of the toolpath.

Zig Zag

This option ramps into the material by Zig-Zag backwards and forwards using either the specified Distance or Angle and Distance.

The Distance option ramps into the material, zigging for the specified distance in one direction then zagging back over the same distance.
The Angle option is typically used for cutters that cannot plunge vertically but have an entry angle specified by the manufacturer.

**Spiral**

Checking ✓ this creates a continual spiral ramp, these are only available when the toolpath does not include lead in moves.

This option ramps into the material over the complete circumference of the profile pass. The angle is automatically calculated to ramp from the start point to full depth over the perimeter distance around the job.

The rate at which the cutter ramps into the material is determined by the Pass Depth specified for the cutter. For example, Spiral Profiling 0.5 inch deep with a cutter that has a Pass depth of 0.5 or greater will spiral down in 1 pass. Editing the Pass depth to be 0.25 inch results in the 2 spiral passes around the profile.

**Leads**

Lead in / out moves can be added to profile toolpaths to help preventing marking the edges of components with dwell marks that are typically created when a cutter is plunged vertically on the edge of the job.

**Straight Line Lead**

This option creates a linear lead onto the cutter path using the Angle and Lead length distance specified.

The toolpath will lead onto the selected edge at the specified Angle.

Checking ✓ the Do lead out option results in an exit lead being added at the end of the toolpath off the machined edge.

The Overcut Distance forces the cutter to machine past the start point and is often used to help produce a better edge quality on parts.

**Circular Lead**

This option creates an arc lead onto the toolpath using the Radius and Lead length distance specified.

The toolpath will curve onto the selected edge, tangent to the direction of the vector at the point it reaches the actual geometry edge.

Checking ✓ the Do lead out option results in an exit lead being added at the end of the toolpath off the machined edge.

The Overcut Distance forces the cutter to machine past the start point and is often used to help produce a better edge quality on parts.

**Order**

The order tab allows you to specify the approaches the program will use to determine the best order to cut your vectors. You can specify multiple options, in which case the program will calculate the result of using each option and select the one which results in the shortest machining time.

**Vector Selection Order**

This option will machine the vector in the order in which you selected them. If you have vectors inside each other (like in the letter 'O'), the inner vector will always be machined before the outer one regardless of the selection order.

**Left to Right**

This option will join up parts on the left of the material first and move across to the right.

**Bottom to Top**

This option will join up parts on the bottom of the material first and move up to the top.

**Grid**

This option will join use a grid based approach with the size of the grid based on the size of the parts. The algorithm will try to join up parts within a particular section of the grid before moving on.

**Shortest Path**
This option uses a 'shortest path' algorithm to try and determine the shortest possible path. However, for large numbers of parts, this requires an unfeasible amount of computing power so an approximation algorithm is used. Although very good, this algorithm cannot guarantee to produce the very shortest path, but in tests at Vectric, the results have been very good indeed. This option still takes a substantial amount of time on slow computers for very large numbers of parts.

**Start At**

**Keep Current Start Points**

The start point of the vector will dictate the start of the toolpath.

**Optimize Start Points**

The software will automatically attempt to optimize each profile start position based on speed of completing the job.

**Closest on Bounding Box**

Influence the start point by defining which part of the bounding box of the profiled vector it should start near.

This will look for the nearest point, from all of the spans’ endpoints, and will start the toolpath from that point.

**Corners**

Choosing this tab and checking ✓ the option *Sharp external corners* (see below) forces the cutter to machine around the shapes and retain any square corners.

**Sharp External Corners**

This option makes adding beveled edges to a 2D shape very quick and easy; this can be a good way to turn simple 2D cut out lettering into a high quality signage products that look more interesting or provide a different option for customers.

This is an example of the type of effect that can be created by using this option:

Standard Profile toolpaths without the Sharp Corners switched on roll around the sharp corners. This still give a point on a straight sided tool but will give a radiused edge when using a V-bit.

When Sharp External Corners is selected the following change is made to the toolpath (see image below) so it makes sharp external corners as shown in the image of the letter 'M' at the top of the page.
Sharp Internal Corners

When Sharp Internal Corners is selected the V- Bit tool will raise up into internal corners to sharpen them with its point. The difference between checking ✓ this and leaving it unchecked is shown in the two images below.

Allowance for Cut out tool

Sharp internal corners are often used when creating beveled letters. In this case, the letters usually have straight ‘returns’ which are machined with a straight sided end mill. The cut out pass for the end mill needs to be offset from the vector to allow for the bevel created by the tool. This field displays the value you will need to enter into the ‘Allowance Offset’ field when you create your cut out profile toolpath for the end mill. You can select the value with the mouse and used Ctr+C to copy it to the clipboard and then copy it into the ‘Allowance Offset’ field when you create the cut out toolpath.

Additional notes on Profile Machining

Machining Open Vectors

The direction of open vector(s) is very important when using Profile strategies as this is used to determine which side of the selection is the right and left for machining. Selecting Node Edit mode (pressing N on the keyboard) will display a Green node at the start of the vector. Looking along the vector(s) from the green node indicates the direction and the image below shows offsets to the left and right of an open vector.

The Cut Direction - Conventional or Climb controls which end of the open vector the toolpath will start. Changing the cut direction will reverse the direction of cut.

Conventional starts cutting at the Start point Climb cutting starts cutting at the end point

In the following examples, the vector is the magenta dotted line and the arrowed line is the toolpath:

Talk to your material and tooling suppliers for details about what is most appropriate for your specific type of work.

Tabs can be added to open profile toolpaths Sharp External Corner options do not apply because identifying the outside / inside of an open shape in ambiguous. Leads cannot be added to open profile toolpaths. Ramps can be added to open
General Toolpath Settings

This section of the toolpath form is common to a number of toolpath strategies.

Safe Z

The height above the job at which it is safe to move the cutter at rapid / max feed rate. This dimension can be changed by opening the Material Setup form.

Home Position

Position from and to that the tool will travel before and after machining. This dimension can be changed by opening the Material Setup form.

Project toolpath onto 3D Model

This option is only available if a 3D model has been defined. If this option is checked, ✓ after the toolpath has been calculated, it will be projected (or ‘dropped’) down in Z onto the surface of the 3D model. The depth of the original toolpath below the surface of the material will be used as the projected depth below the surface of the model.

Vector Selection

This area of the toolpath page allows you to automatically select vectors to machine using the vector’s properties or position. It is also the method by which you can create Toolpath Templates to re-use your toolpath settings on similar projects in the future. For more information, see the sections Vector Selector and Advanced Toolpath Templates.

Name

The name of the toolpath can be entered or the default name can be used.

Pocketing Toolpath

This option opens the Pocket Toolpath form for machining 2D pockets. These toolpaths automatically compensate for the tool geometry - both diameter and angle.

Cutting Depths

Start Depth (D)

Specifies the depth at which the pocket toolpath is calculated. When cutting directly into the surface of a job the Start Depth will usually be 0. If machining into the bottom of an existing pocket or stepped region, the depth of the pocket / step must be entered.

Cut Depth (C)

The depth of the toolpath relative to the Start Depth.

Tool

Clicking the Select button opens the Tool Database from which the required tool can be selected. See the section on the Tool Database for more information on this.

Clicking the Edit button opens the Edit Tool form which allows the cutting parameters for the selected tool to be modified, without changing the master information in the database.

Specify Pass Depths
The Pass Depths section at the top of the form shows a list of the current pass depths. The relative spacing of the passes is indicated in the diagram next to the list. Left click on a depth value in the list, or a depth line on the diagram, to select it. The currently selected pass is highlighted in red on the diagram.

To edit the depth of the selected pass, change the value in the Depth edit box and click Apply. The Delete button will delete the selected pass. The Clear All Passes button will delete all the passes.

To add a new pass, double left click at the approximate location in the passes diagram that you wish to add the pass. A new pass will be added and automatically selected. Edit the precise Depth value if required and then click Apply. The Set Last Pass Thickness option will enable an edit box where you can specify the last pass in terms of the remaining thickness of material you wish to cut with the last pass (instead of in terms of its depth). This is often a more intuitive way to specify this value.

Pass Depth List Utilities

This section of the form includes two methods for creating a set of passes in one go.

The first method sets the passes according to the Pass Depth property of the selected tool. This is initially the default method used by VCarve Pro when it creates profile passes. The step size is varied to try and optimize the number of passes (see above) unless the Maintain exact tool pass depth option is checked ✓.

The second method creates evenly spaced passes according to the value entered in the Number Of Passes edit box. To apply either method click the associated Set Passes button to create the resulting set of pass depths in the passes list and diagram.

Warning: Setting the number of passes with either of these utilities will discard any custom passes you may have added.

Use Larger Area Clearance Tool

If this option is selected two tools are used to clear the pocket. A large tool to do the bulk of the area clearance and a smaller tool (the first tool selected) to remove the remaining material and do a final profile pass.

When a pocket toolpath is created, the Pass Depth value associated with the selected tool (part of the tool’s description in the Tool Database) is used to determine the number of passes needed to pocket down to the specified Cut Depth. However, by default VCarve Pro will also modify the tool step down by up to 15%, if by doing so it is able to reduce the total number of passes required to reach the desired cut depth. It is usually desirable to benefit from the significantly reduced machining time of cutting pockets using less passes if possible.

Nevertheless, there are some occasions where the exact step downs for a given profile pass needs to be more precisely controlled - when cutting into laminated material, for example. The Passes section of the Pocket Toolpath page indicates how many passes will be created with the current settings. The Edit Passes... button will open a new dialog that enables the specific number and height of passes to be set directly.

Clear Pocket

There are two choices of the type of fill pattern that will be used to clear away the area to be machined with the Pocket Toolpath, Offset and Raster.

Offset

Calculates an offset area clearance fill pattern to machine inside the selected vector(s). Options for Cut Direction to be either: Climb (CCW) cutting direction Conventional (CW) cutting direction.

Raster

Calculates a Raster based area clearance fill pattern to machine inside the selected vector(s). Cut Direction for the final pass to be either:
- Climb (CCW) cutting direction
- Conventional (CW) cutting direction

Raster Angle

Between 0 and 90°, where 0° is parallel to the X axis and 90° parallel to the Y axis.

Profile Pass

Used to clean up the inside edge after machining the pocket. This can be done either before the rastering (First) or after the rastering (Last). If “No Profile Pass” is selected, you will need to calculate a profile pass manually to machine the pocket to size.

Pocket Allowance

This option is used to leave material on the inside of the pocket for the Profile Pass to clean-up. This is often very useful for ensuring the cutter does not mark the edge surface of the pocket when roughing out.

A positive value in the allowance box will lead to an undercut of the selected closed vector. I.E. the pocket will be smaller than the chosen vector, by the specified value.

A negative value would result in an overcut of the selected closed vector. I.E. the pocket will be larger than the chosen vector, by the specified value.

Note: When the stepover for a pocket fill is greater than 50% of the cutter/tip diameter the software automatically adds “Tail” moves to the corner regions on the toolpaths to ensure material is not left on the job. You can see these in the diagram of a star being pocket machined below:

Ramp Plunge Moves

The cutter can be ramped over a distance into the pocket instead of plunging vertically. This approach reduces heat build-up that damages the cutter and also reduces the load on the spindle and z axis bearings.

Use Vector Selection Order

If this option is checked, ✔ pockets will be machined in the order you selected them. If the option is not checked the program will optimize the order to reduce machining time.
General Toolpath Settings

This section of the toolpath form is common to a number of toolpath strategies.

Safe Z

The height above the job at which it is safe to move the cutter at rapid / max feed rate. This dimension can be changed by opening the Material Setup form.

Home Position

Position from and to that the tool will travel before and after machining. This dimension can be changed by opening the Material Setup form.

Project toolpath onto 3D Model

This option is only available if a 3D model has been defined. If this option is checked, ✓ after the toolpath has been calculated, it will be projected (or 'dropped') down in Z onto the surface of the 3D model. The depth of the original toolpath below the surface of the material will be used as the projected depth below the surface of the model.

Vector Selection

This area of the toolpath page allows you to automatically select vectors to machine using the vector’s properties or position. It is also the method by which you can create Toolpath Templates to re-use your toolpath settings on similar projects in the future. For more information, see the sections Vector Selector and Advanced Toolpath Templates.

Name

The name of the toolpath can be entered or the default name can be used.

Drilling Toolpath

Drilling allows the centers of selected closed vectors to be drilled to a specified depth. The Tool Database includes an option to specify the Drill diameter and cutting parameters.

Cutting Depths

Start Depth (D)

This specifies the depth at which the toolpath is calculated from. When cutting directly into the surface of a job the Start Depth will often be 0. If machining into the bottom of an existing pocket or 3D region, the depth needs to be entered.

Cut Depth (C)

The depth of the toolpath relative to the Start Depth.

Tool

Clicking the Select... button opens the Tool Database from which the required tool can be selected. See the section on the Tool Database for more information on this. Clicking the Edit... button opens the Edit Tool form which allows the cutting parameters for the selected tool to be modified, without changing the master information in the database.

Peck Drilling

When the option Use Peck Drilling is selected, the drill will cut to the Pass Depth set in the Tool Database for the selected Drill. It will then retract to the Retract Gap according to the retract option selected (see below), before drilling to the next depth, incremented by an additional Pass Depth. This cycle is repeated until the hole is drilled to the required depth. The retract moves are used to remove any build-up of material from the hole to help with overheating and breakage. If the Pass Depth is greater than the required Cut Depth, the hole will be drilled in a single cycle. However, if a Cut Depth of 1 inch with a Pass Depth of 0.25 inch is used the hole will be drilled in 4 cycles.
Retract above cutting start

This option will cause the tool to retract fully out of the drill hole after each peck drill plunge. This is beneficial for clearing swarf/chips completely from the drill hole during the drill cycle. With this option selected the Retract Gap value (R) is the fixed distance above the start cut depth. Thus the total retract and plunge distances for each peck drill cycle will increase as the hole deepens and this will generally result in longer machining times.

Retract above the height of the previous pass

Instead of fully retracting out of the drill hole, it is also possible to retract to a height relative to the previous cut depth. This strategy typically requires a shorter set of plunges and retracts over the course of a peck drill toolpath because they will be constant for each peck drill cycle, regardless of the drill hole depth. However, it will not necessarily clear swarf/chips completely from the drill hole. With this option selected the Retract Gap value (R) is the relative distance above the height of the previous peck drill pass.

Dwell at the bottom of each drill pass

With this option checked, the Dwell Time value is used pause the drill at the bottom of each peck drill pass before retracting. The dwell time value is measured in seconds.

Note: To make use of this feature your Post-Processor must support the Dwell section and may require updating.

Use Vector Selection Order

If this option is checked, pockets will be machined in the order you selected them. If the option is not checked the program will optimize the order to reduce machining time.

General Toolpath Settings

This section of the toolpath form is common to a number of toolpath strategies.

Safe Z

The height above the job at which it is safe to move the cutter at rapid / max feed rate. This dimension can be changed by opening the Material Setup form.

Home Position

Position from and to that the tool will travel before and after machining. This dimension can be changed by opening the Material Setup form.

Project toolpath onto 3D Model

This option is only available if a 3D model has been defined. If this option is checked, after the toolpath has been calculated, it will be projected (or ‘dropped’) down in Z onto the surface of the 3D model. The depth of the original toolpath below the surface of the material will be used as the projected depth below the surface of the model.

Vector Selection

This area of the toolpath page allows you to automatically select vectors to machine using the vector's properties or position. It is also the method by which you can create Toolpath Templates to re-use your toolpath settings on similar projects in the future. For more information, see the sections Vector Selector and Advanced Toolpath Templates.

Name

The name of the toolpath can be entered or the default name can be used.
Quick Engraving Toolpath

This form is used specifically for calculating engraving and marking toolpaths.

Tool

Clicking the Select button opens the Tool Database from which the required tool can be selected. See the section on the Tool Database for more information on this. Clicking the Edit button opens the Edit Tool form which allows the cutting parameters for the selected tool to be modified, without changing the master information in the database.

Depth / Pressure

When using Conventional Engraving and End Mill cutters the Depth to engrave / mark is specified and this z depth dimension is output in the toolpath file sent to the CNC machine. The 3D Preview of these toolpaths shows the specified depth of engraving.

When using a Diamond Drag marking Tool the Pressure setting is used to pre-load the spring to ensure the tip of the diamond stays in contact with the material surface, especially when marking uneven surfaces. The 3D Preview of the depth these toolpaths will mark using the Angle of the diamond and the Width of the Line.

For example, when using a 90° Diamond Drag Tool with a 0.010 inch Line Width specified. The depth shown in the 3D preview will be 0.005 inch (with 90° the depth = half the line width).

The ratio of Depth to Line Width will change when using diamond drag tools with different tip angles. When the option to use a Nose Cone is selected (see below) the actual depth specified on the form is used when previewing the toolpath in the 3D view.

Strategy

When using the Quick Engraving Form the Stepover for the cutter is specified on the form and is NOT automatically set from the Tool Database.

The selected text or vectors can be Outlined or Filled.

Outline

The tip of the cutter runs on the selected lines engraving / marking the material surface.
Fill

A pattern is used to engrave / mark inside the selected text or vectors. There are 3 fill pattern options.

- Fill engraving with Offset pattern
- Fill engraving with 45° Hatch pattern
- Fill engraving with Cross Hatch pattern. Cross Hatch Fill pattern engravses 2 sets of lines, with the second set at 90° to the angle specified.

Use Nose Cone

A nose cone is often used when engraving or marking material that is not flat. The nose cone is spring loaded forcing it to slide on the surface of the material. The engraving cutter is set to extend / protrude out of the bottom of the nose cone by the depth of engraving / marking required. This is typically set at around 0.010 inches to 0.020 inches.

When the option to use a Nose Cone is selected the actual depth specified on this region of form is used when previewing the toolpath in the 3D view.

Number of Passes

This option runs the cutter multiple times divides over the toolpath pattern.

Output Options

Select the appropriate postprocessor and Save the Toolpath ready to send to the CNC machine, similar to the Save Toolpath form.

If your machine can be driven using a Windows Printer driver (Roland and Gravograph / New Hermes machines use this technique) it maybe be possible to select the installed printer driver and output toolpaths directly from the software instead of saving an intermediate file.

Checking ✓ the option ‘Output direct to machine’ enables the Device option which is used to setup the appropriate windows printer driver.
Inlay Toolpath

The Inlay toolpath functionality can be used to calculate either profile or pocketing toolpaths with automatic compensation for the tool radius; this allows the cut-out parts to fit into the corresponding cavities. This is a great feature for creating decorative woodwork and is also particularly useful for sign makers for creating inlayed letters and graphics.

How Inlays work

When using a CNC machine to cut out shapes then the tool will always leave a radius on any internal corner. When cutting holes or pockets the tool conversely leaves a radius on the external corners. If no changes are made to accommodate this then there would be no way to fit one part into the other. This is shown highlighted on the letter ‘T’ shown in the image below. On the left you can see the internal corners with a radius on the part being cut out (highlighted with red ovals). On the right you can see the radiused external corners on the hole (highlighted with green ovals). As you can envisage trying to slot the ‘T’ into the hole would not work as it is the proverbial square peg in a round hole!

![Inlay Diagram](image)

It is not possible to avoid the added radius as it is formed by the tool size and shape. The Inlay function though, will create toolpaths which take the tool radius into account and compensate for it by rounding off the sharp corners so the resulting parts will fit together. This can be seen in the images shown below where the same letter has been cut using the Inlay toolpaths, you can see all corners (internal and external) now have the same radius so they will slot together.

![Inlay Diagram](image)

When creating an Inlay toolpath the radius is automatically compensated for, so it is very important to make sure you specify the same tool for both parts of any inlay (male and female). If you do not do this the Inlay will not fit together.

If creating a Pocket then the main Tool (the finish tool) not the larger (clearance) tool should be the same as used for creating the Male Inlay.

Note: You must use the same tool for both parts of an inlay for the resulting parts to fit together correctly.

Male Inlay (Insert)

Straight
This option is for cutting out straight sided parts to act as the inserted piece of the inlay. It uses a variation on the Profile toolpath which will automatically round the external corners of the part to allow for the radius of the tool being used. All the standard Profile options are available in this form except there is no option to Profile Inside or On as this does not apply to this inlay type as it has to cut outside of the vector. The other standard options not available are the ability to add sharp Corners or set a Last Pass as again these would not apply to this application. The image below shows how the external corners are rounded based on the tool radius being used.

Stepped

This option is for cutting out stepped sided parts to act as the inserted piece of the inlay. This style of inlay is typically used for what are referred to as ‘Push Through’ letters and shapes. These are parts which are inserted from the back and use the step as a shelf to invisibly mount them to the back of a sign. As with the Straight Inlay option it uses a variation on the Profile toolpath with the addition of the ability to specify a Step Depth and Step Width.

As the diagram shows in the form, the Step Depth is the vertical height of the step from the Start Depth down, the Step Width is how far from the edge of the original vector the part will be cut out (creating the step).

The image shown above shows a Stepped Male Inlay created in 1 inch thick material with a 0.75 inch Step Depth and a 0.3 inch Step Width.

All the other standard Profile options are available for Stepped Inlays except there is no option to Profile Inside or On as this does not apply to this inlay type and this option does not allow the use of either the Corner, Lead or Last Pass functions as these are also inapplicable to this type of toolpath.

Note: It is very important when working with Stepped Inlays that you allow enough space in between the shapes you are cutting out for the Step Width to be added. If the parts are too close then they will not be cut-out and the steps will not be properly formed.

Female Inlay (Pocket / Hole)

Pocket

This option is selected for cutting out a Pocket to act as the cavity for the corresponding Male shape to inlay into. It uses the same options as the standard Pocket style toolpath including the new option where you can use a larger and smaller tool to clear the pocket (smaller tool size should match that used for the Male Inlay). In order to make it work as an inlay pocket any internal corners will be rounded based on the tool radius to allow the male parts to fit into them (shown in the image below).
As has been previously discussed it is common to leave an allowance on one or both sides of the inlay, typically when working with letters the allowance would be left on the Pocket so the size and shape of the lettering itself is not affected any more than necessary.

**Hole**

This option is for cutting out a Hole to act as the cavity for the corresponding Male shape to inlay through. The standard Profile options are available for Female Hole Inlays except there is no option to Profile Outside or On as this does not apply to this toolpath type and this option does not allow the use of the Corner options or Last Pass as these are also inapplicable to this type of toolpath. In order to make it work as an inlay, any internal corners will be rounded based on the tool radius to allow the male parts to fit into them (shown in the image below).

**Setting Inlay Allowances**

Although the radius of the tool is compensated for when using the inlay tool, this in itself will almost always not be enough to ensure the two parts will fit together correctly. The parts will be exactly the same size and so would not fit together without a lot of force which would damage the part or without some kind of post-CNC hand work. Cutting the parts exactly the same size also does not allow for any kind of finish to be applied to either side.

To enable the parts to fit extra material either needs to be cut from the Male side, the Female side or in some applications both. This additional distance is added using the option in the toolpath form to add an Allowance. On the toolpaths which are based on a Profile then this is done with the Allowance Offset (shown in the image below left - highlighted in red). For Pocket style toolpaths use the Pocket Allowance, (shown in the image below right highlighted in red). When a value is entered it will overcut the selected shape by this distance, this will reduce the size for male parts and increase the hole/pocket for female parts.
The size of the Allowance required will depend on the type of material (how much it may expand or contract between being cut and inlaid), the accuracy of your tooling, the accuracy of your machine and finally any finish you are planning to add to the finished parts (such as paint or varnish which will have a thickness). In most situations where no finish is being applied before the parts are inlaid then an allowance of 0.01 inches (0.25mm) or 0.02 inches (0.5mm) will be sufficient. If you are not sure what value to use then you should experiment with this on a test part to get the correct sizes for your particular setup and application.

In the majority of cases the Allowance is applied to the Female side of the inlay as it is typical to not want to alter the actual vector shapes (the Male side) any more than is required for the tool radius. This means the Hole or Pocket will be cut oversized to provide the additional allowance for the parts to fit.

**General Toolpath Settings**

This section of the toolpath form is common to a number of toolpath strategies.

**Safe Z**

The height above the job at which it is safe to move the cutter at rapid / max feed rate. This dimension can be changed by opening the Material Setup form.

**Home Position**

Position from and to that the tool will travel before and after machining. This dimension can be changed by opening the Material Setup form.

**Project toolpath onto 3D Model**

This option is only available if a 3D model has been defined. If this option is checked, ✓ after the toolpath has been calculated, it will be projected (or ‘dropped’) down in Z onto the surface of the 3D model. The depth of the original toolpath below the surface of the material will be used as the projected depth below the surface of the model.

**Vector Selection**

This area of the toolpath page allows you to automatically select vectors to machine using the vector’s properties or position. It is also the method by which you can create Toolpath Templates to re-use your toolpath settings on similar projects in the future. For more information, see the sections Vector Selector and Advanced Toolpath Templates.

**Name**

The name of the toolpath can be entered or the default name can be used.
Laser Toolpaths

The Laser toolpaths section of the Toolpath Operations icons can be found on the Toolpaths tab, underneath the Toolpath list. These strategies are used to control a laser cutting head.

Laser Cut - Fill

Laser Cut - Fill is used for cutting out shapes or marking areas. Cut-outs can take into account the kerf, or width, of the laser beam to maintain the precise internal or external size the selected vector shapes. Shapes can also be filled with stripes or hatching to create simple shading effects.

The fields on the form are as follows.

**Settings**

**Select**

This button opens your database of previously stored laser settings for different jobs and materials. When a setting is selected from the database it will be used to populate the key fields in this section. You can subsequently modify these values when calculating the laser toolpath. Modifying the settings on this form will not alter the original stored settings within your database.

**Power**

This value sets what proportion of your machine’s maximum laser power will be used for this toolpath.

**Move Speed**

This specifies the maximum speed that your machine will move during cutting or engraving moves. The units are determined by the database setting that was originally selected.

**No. Passes**

The machine can repeat a toolpath a number of times to cut through thicker material. This value sets the number of repeats.

**Strategy**

Based on the selected vector shapes in your drawing, this toolpath offers four distinct strategies:

- **Cut Outside / Right** - Selecting this option will run the laser around the outside of your selected vector shapes (or along their right-hand edge, if they are open vectors). The actual path of the laser is automatically offset from the original shape according to the kerf width of the laser. As a result, the external dimensions of the resulting physical part precisely match the size of the original vector drawing. This strategy should be used for cutting out shapes to precisely the correct dimensions.

- **Cut Inside / Left** - This option will run the laser around the inside (or left-hand edge) of your selected vector shapes, allowing for the kerf of the laser. This strategy is typically used for cutting holes, slots or sockets where the remaining recess has precisely the same dimensions as the original selected vector drawing.

- **Cut On** - This option will run the center of the laser beam along the selected vector. No offsetting or kerf compensation is required.

- **Hatch Fill** - This is a marking or ‘shading’ strategy which profiles along the selected vectors and then fills-in the
shapes with stripes. When this option is selected the additional Stepover, Hatch Angle and Cross Hatch options will also become enabled - see below for more information on these.

Allowance

This setting allows you to add an additional offset for the Cut Outside, Cut Inside strategies without adjusting the laser kerf settings and can be useful for easing or tightening the fit of shapes resulting from these cuts.

**Note:** This option is not applicable to the Cut On or Hatch Fill strategies and will be disabled if they are selected.

Stepover

When creating hatch fills, this option determines the spacing between the hatch lines. It is only available when the Hatch Fill strategy is selected.

Hatch Angle

When the Hatch Fill strategy is selected, this option determines the angle of the hatching lines used.

Cross Hatch

Checking this option will create a cross hatch fill instead of a single set of lines.

**Note:** These options are only applicable to the Hatch Fill strategy and will be disabled if it is not selected.

Toolpath Calculate

**Safe Z**

The height above the job at which it is safe to move the cutter at rapid / max feed rate. This dimension can be changed by opening the Material Setup form.

**Home Position**

Position from and to that the tool will travel before and after machining. This dimension can be changed by opening the Material Setup form.

**Name**

Enter a meaningful name for the toolpath here. It will be stored in the toolpath list using this name.

**Calculate**

Clicking this button will initiate the process of calculating the toolpath using the form settings and adding the resulting toolpath to the toolpath list.

**Immediate Output**

Once calculated, your toolpath is stored in the central Toolpath List and can be saved, edited or output to your laser machine at anytime using the Save Toolpaths command. In addition though, this form also includes a convenient Immediate Output section that allows you to save or send the most recently calculated toolpath directly from this form without having to close it (see VTransfer for more information).

**Post Processor**

Use this drop-down list to select the post-processor for your machine.

**Add side to toolpath name**

If you are creating aligned toolpaths for a two-sided part, this option automatically adds the side name to the toolpath name as it is saved or exported to help keep your toolpaths organised.

**Output direct to machine**
If your post-processor supports direct access to your CNC machine (including machines supported by VTransfer), this option will be available. Selecting this option will bypass saving the toolpath to disk and instead send it straight to the direct output driver.

Note: The Laser Picture Form is only available with Laser Module

Laser Picture

The Laser Picture toolpath uses the laser to etch a copy of the selected bitmap picture into the surface of your material.

Preparing the bitmap

This strategy requires a source bitmap image or photograph to be selected in the 2D View. It will be converted into a laser toolpath by creating a dense stripe, or hatch, pattern over the image and then adjusting the power of the laser as it moves across the image to reproduce it using lighter and darker marks. The precise tonal range and contrast of the final part will be the result of an interaction between the original colors or shades in the bitmap, the way in which the material burns as well as the power and speed of the laser. For these reasons some experimentation may be required to find the best settings for a particular job.

Your source bitmap can be edited in a number of ways before using this form to create your laser toolpath. You can use the Crop Bitmap command to trim a bitmap to a vector outline. This will allow you to remove any parts of a bitmap that you do not require.

The Picture Edit tool can also be used prior to creating the toolpath in order to adjust many important aspects of your image - such as brightness and contrast. In addition it can be used to add a feathered border the image. For the best results you should use this tool to highlight and accentuate out the important details of your image before creating your toolpath.

The fields on the form are as follows.

Settings

This section details the laser settings for this toolpath. The Select... button will open the laser tool database where you can retrieve previously stored settings for a particular job or material. For convenience, these settings can also be modified in-situ on this toolpath form. Any edits you make directly on the form will only effect the current toolpath - they will not effect the stored settings in the database.

Max Power

This specifies the maximum power (as a percentage of the laser's maximum full power) that will be used for the darkest areas of the image.

Min Power

This specifies the minimum power (as a percentage of the laser's maximum full power) that will be used for the lightest areas of the image.

Move Speed

This setting allows you to locally override the move speed (or feed rate) of the cutting moves of your laser. For a fixed power the slower the laser moves, the darker the mark it will make. If you are already using maximum power but the image to still too light you may wish to slow the movement of the machine and burn for longer.
Strategy Settings

Raster

Selecting this option will generate a single set of parallel lines, or stripes, across your selected image.

Hatch

This option will create two sets of parallel lines at 90 degrees from one another. This strategy will generally produce a denser image reproduction, but will typically take twice as long to etch.

Selected

This option will use the selected vectors as the pattern for the toolpath moves. These may be generated using any method of creating vectors, such as the Vector Texture Tool.

Dither Image

With this option un-checked, laser power will be changed evenly in response to the lighter and darker areas of your image. Thus your image is reproduced by a range of burnt tones onto the surface of your material using continuously varying laser power. For some materials, however, the burning process tends to produce only two tones - burnt or unburnt - rendering this graduated approach ineffective. For materials with this property an alternative strategy can be used to generate the tonal range using only black dot patterns of differing densities instead - much like old newspaper picture print. This process is called dithering and it can be enabled using this option. In general you should only use this option if the material properties prevent you from using the higher quality true grayscale method.

Note: Selecting this option will disable some incompatible options on the rest of the form.

Line Spacing

This slider adjusts the gap between the raster stripes - tight striping produces a denser image reproduction, but will take a lot longer to etch. The maximum density is set by the Kerf of your laser beam and the most sparse setting is 30 times this value.

Line Angle

Adjust this slider to change the angle of the stripes or hatching used to etch the image. Zero degrees will produce horizontal stripes and ninety degrees, vertical.

Toolpath Calculate

Safe Z

The height above the job at which it is safe to move the cutter at rapid / max feed rate. This dimension can be changed by opening the Material Setup form.

Home Position

Position from and to that the tool will travel before and after machining. This dimension can be changed by opening the Material Setup form.

Project toolpath onto 3D model

This option is only available if a 3D model has been defined. If this option is checked after the laser toolpath has been calculated it will be projected (or ‘dropped’) down in Z onto the surface of the model. This means that the distance between the laser head and the 3D surface will remain fixed, ensuring that the laser remains in focus.

Name

Enter a meaningful name here before calculating the toolpath - this is the name under which your toolpath will appear in the toolpath list.

Calculate

Clicking this button will initiate the process of calculating the toolpath using the form settings and adding the resulting toolpath to the toolpath list.
Immediate Output

Once calculated, your toolpath is stored in the central Toolpath List and can be saved, edited or output to your laser machine at anytime using the Save Toolpaths command. In addition though, this form also includes a convenient Immediate Output section that allows you to save or send the most recently calculated toolpath directly from this form without having to close it (see VTransfer for more information).

Post Processor

Use this drop-down list to select the post-processor for your machine.

Add side to toolpath name

If you are creating aligned toolpaths for a two-sided part, this option automatically adds the side name to the toolpath name as it is saved or exported to help keep your toolpaths organised.

Output direct to machine

If your post-processor supports direct access to your cnc machine (including machines supported by VTransfer), this option will be available. Selecting this option will bypass saving the toolpath to disk and instead send it straight to the direct output driver.

Laser Module

The Laser Module extends the functionality of VCarve or Aspire and is currently only available to selected BETA testers while in development. This documentation is provided to support this testing process and this notice will be removed once the module is available for purchase.

Please note: The Laser Module has been created and tested for use with OptLaser or J-Tech laser retrofit kits on Shapoko and X-Carve CNC machines using GRBL controllers - other machines, lasers or controllers cannot be supported at this time.

The Laser Module is a paid add-on for VCarve Pro which adds the following additional functionality:

- The ability to create Laser Cut and Fill Toolpaths
- The ability to create Laser Picture Toolpaths
- The ability to simulate a Laser Toolpath

The Laser Cut - Fill Toolpath

Laser Cut - Fill Toolpath is used for cutting out shapes or marking areas.

Cut-outs can take into account the kerf, or width, of the laser beam to maintain the precise internal or external size the selected vector shapes. Shapes can also be filled with stripes or hatching to create simple shading effects.

The Laser Picture Toolpath

The Laser Picture toolpaths uses the laser and through varying the power of the laser etches a copy of the selected bitmap onto the surface of your material.

Simulating Laser Toolpaths

Like all other toolpaths the laser toolpaths can be simulated. However, in the case of laser toolpaths, the simulation does not remove any material but instead marks the surface of the current simulation model. This marking is meant to simulate the charring of the material when scorched by the laser.
Due to the many combinations of laser, power, material and feed rate, it will be necessary to calibrate the simulation so that the simulation output matches the real-world results. This calibration can be done by modifying the Maximum Burn Rate property of a given tool. This is the maximum speed at which the tool, when at 100% power, will still burn the material. This means that a greater value will result in the simulated toolpath appearing darker. This value can be set in the Tool Database. We suggest you cut a sample file with the material and power settings that you would typically use and then adjust the Maximum Burn Rate so that the simulation matches your achieved results.
The VCarving and 2.5D toolpaths section of the Toolpath Operations icons can be found on the Toolpaths tab, underneath the Toolpath list. These strategies all make use of the tool's geometry to form a number of intricate 3D shapes very efficiently. Because the range of 3D shapes that can be formed are determined by the tool's own shape, you cannot use these strategies to cut any arbitrary 3D shape. Therefore, to distinguish them from true 3D strategies they are often referred to as 2.5D strategies.

### VCarve Toolpath

This icon opens the V-Carving Toolpath form which is used to specify the type of carving required, tooling details, cutting parameters and name for the toolpath.

#### Cutting Depths

Start Depth (D) specifies the depth at which the V-Carving toolpath is calculated, allowing V-Carving / Engraving to be machined inside a pocket region. When cutting directly into the surface of a job the Start Depth will usually be 0.0. If the V-Carving / engraving is going to be machined into the bottom of a pocket or stepped region, the depth of the pocket / step must be entered. For example, to carve or engrave into the bottom of a 0.5 inch deep pocket, the Start Depth = 0.5 inches.

**Flat Depth (F)**

Checking ✓ this option limits the depth that the tool(s) will machine to, and is used for Flat Bottomed Carving and Engraving.

When No Flat Depth specified the toolpath will be calculated to carve or engrave to full depth as shown below. Multiple z level passes will be automatically calculated where the tool needs to cut deeper than its Pass Depth specified in the Tool Database.

#### No Flat Depth

Single tool machines the complete job.

Multiple z level passes calculated using the Pass Depth specified for the selected tool.

Clicking the option for Flat Depth and entering the required depth will result in flat pocket areas being machined where the width between vectors would result in the tool cutting deeper than the specified Flat Depth.

#### Flat Depth

Complete toolpath is calculated using a single V-Bit or Engraving tool.
End Mill to create the flat pocket regions followed by V-Bit or Engraving tool to cut the detail and corner regions

**V Tool**

Clicking the **Select** button opens the Tool Database from which the required VCarving or Engraving Tool can be selected. See the section on the Tool Database for more information on this.

Clicking the **Edit** button opens the Edit Tool form which allows the cutting parameters for the selected tool to be modified, without changing the master information in the database. Note that Ball nosed tools can also be used to VCarve designs.

**Use Flat Area Clearance Tool**

Check ✓ this option if you wish to use an End Mill, Ball Nose or Engraving cutter to machine the large open regions of a design. Note that this option is only available when Flat Depth is selected. If no tool is selected here but Flat Depth is specified then the selected VCarving tool will be used to clear the flat areas as well as for the VCarving.

Clicking the **Select** button opens the Tool Database from which the required End Mill or Engraving Tool can be selected.

Clicking the **Edit** button opens the Edit Tool form which allows the cutting parameters for the selected tool to be modified, without changing the master information in the database.

**Flat Area Clearance**

This section of the form allows you to choose the strategy which will be used to clear the flat bottomed area with the Flat Area clearance tool. These options are the same as those found on the pocketing form.

**Ramp Plunge Moves**

If this option is selected ramps are added to the plunge moves for the pocketing toolpath.

**Use Vector Selection Order**

If this option is checked, ✓ the vectors will be machined in the order you selected them. If the option is not checked the program will optimize the order to reduce machining time.

**General Toolpath Settings**

This section of the toolpath form is common to a number of toolpath strategies.

**Safe Z**

The height above the job at which it is safe to move the cutter at rapid / max feed rate. This dimension can be changed by opening the Material Setup form.

**Home Position**

Position from and to that the tool will travel before and after machining. This dimension can be changed by opening the Material Setup form.

**Project toolpath onto 3D Model**

This option is only available if a 3D model has been defined. If this option is checked, ✓ after the toolpath has been calculated, it will be projected (or ‘dropped’) down in Z onto the surface of the 3D model. The depth of the original toolpath below the surface of the material will be used as the projected depth below the surface of the model.

**Vector Selection**

This area of the toolpath page allows you to automatically select vectors to machine using the vector’s properties or position. It is also the method by which you can create Toolpath Templates to re-use your toolpath settings on similar projects in the future. For more information, see the sections Vector Selector and Advanced Toolpath Templates.
Name

The name of the toolpath can be entered or the default name can be used.

**Fluting Toolpath**

Fluting Toolpaths machine along vectors while varying the depth of the tool, creating extremely efficient machined decorative patterns.

This toolpath is similar to the option to Profile On a selected vector. The difference is the toolpath at the end of each vector can be ramped to taper the cut. This can be used for cutting standard woodworking Flutes or can be used for artistic engraving and marking effects with other types of artwork. In this section, the options on the form will be covered along with some examples of the use for different applications.

**Standard Straight Flutes**

One of the most common applications for Fluting is straight decorative details using a large radius Ball nose tool for columns and posts, such as the one shown in the image below.

Another good application for straight flutes is the markings on a draining board (for Solid Surface fabricators) or on a cutting block (for carving meat) such as the one shown below, sloping down to allow liquid to be directed.

**Decorative Artistic Designs**

The fluting can be used to produce some interesting effects with artistic and decorative applications. The abstract leaf pattern below left was cut with a V-Bit into a flat surface using single vector lines.

When the Fluting Toolpath form is open, the selected vectors will have their start points indicated in the 2D View by solid square green nodes. This is important as it will determine which end the ramps are added depending on what options are chosen on the form. An image of this is shown below where all the start points are to the left end of the selected vectors.

If you need to move the start points, go into node editing mode (press **N** on the keyboard or select the node editing icon in the *Edit Vectors* section on the left tab).
Select the vector you want to change the start point. Move the cursor over the end you want to be the new start point. Press P on the keyboard or Right Click and select Make Start Point from the pop-up menu. Exit node edit mode (press N again). Reselect all the vectors you want to flute.

The fields on the form are as follows.

**Cutting Depths**

**Start Depth (D)**

This specifies the depth at which the Fluting toolpath is calculated. When cutting directly into the surface of a job, the Start Depth will usually be 0. If machining into the bottom of an existing pocket or stepped region, the depth of the pocket/step that you are starting from must be entered.

**Flute Depth**

This is the depth of the Fluting toolpath relative to the Start Depth; the total depth will be the combination of the Start and Flute Depth.

**Tool**

Clicking the Select... button opens the Tool Database from which the required tool can be selected. See the section on The Tool Database for more information on this. Clicking the Edit... button opens the Edit Tool form which allows the cutting parameters for the selected tool to be modified, without changing the master information in the database.

**Flute Type**

**Ramp over complete length**

Checking ✓ this option means the tool will ramp over the whole length of the toolpath. At the start of the selected vector/s it will be at the Start Depth and at the end of the selected vector/s it will have cut down to the Fluting Depth.

**Ramp at Start**

Checking ✓ this option means the tool will ramp down only at the start of the vectors to the Fluting Depth. The distance of this ramp can be specified using the Ramp Length or Ramp % options.

**Ramp at Start and End**

Checking ✓ this option means the tool will ramp down at the start of the vectors then will ramp up again at the end of the vectors. The distance of these ramps can be specified using the Ramp Length or Ramp % options.

**Ramp Length**

Checking ✓ this option means that the length of the ramp can be set to an exact distance entered into the box. The ramp distance is measured from the start and the end of the vector/s depending what Flute Type you have selected. If the distance entered is greater than the possible length of the ramp then the maximum length will be used, this would be the same as choosing Ramp over complete length. When you choose Ramp at Start it is possible to specify a ramp length which is up to the length of the vector/s. When Ramp at Start and End is checked, ✓ the maximum length possible would be half way along the vector/s as after that it would start to ramp up again.

**Ramp %**

Checking ✓ this option means that the length of the ramp can be specified as a percentage of the maximum possible ramp length (controlled by the length of the selected vector/s and chosen Flute Type). When you use this with Ramp at Start selected then 100% would be the whole length of the selected vector/s, the ramp length would be a percentage of this distance for each one. When you use this with Ramp at Start and End then 100% would be the half length of any of the selected vector/s. The ramp length would be a percentage of this half-length. In this situation using a 50% value would give you a Ramp from the start which was ¼ of the vector length and a ramp from the end which was also ¼ of the vector length.
Ramp Type

Linear

Selecting the Linear type will create a ramp which is a diagonal line (following the vector) from the Start Depth to the Flute Depth. Below you can see a Linear Ramp Type shown from the side. This ramp is set to only ramp from the start and to go 50% of the flute length.

Smooth

Selecting the Smooth type will create a curved ramp (following the vector) from the Start Depth to the Flute Depth; this will smoothly transition from the ramp into the full depth of cut. You can see an example of this shown in the image below.

Note: The two images shown above illustrate how multiple passes may be used to get to full depth. Multiple passes are generated when the Flute Depth exceeds the Pass Depth specified for the selected tool. In these cases the tool will make multiple passes no deeper than the Pass Depth of the tool. As you can see from the images the ramps are graduated based on how many passes are needed. This ensures that the final pass will always be cutting material along its full length to give a nice even finish on the part.

General Toolpath Settings

This section of the toolpath form is common to a number of toolpath strategies.

Safe Z

The height above the job at which it is safe to move the cutter at rapid / max feed rate. This dimension can be changed by opening the Material Setup form.

Home Position

Position from and to that the tool will travel before and after machining. This dimension can be changed by opening the Material Setup form.

Project toolpath onto 3D Model

This option is only available if a 3D model has been defined. If this option is checked, after the toolpath has been calculated, it will be projected (or “dropped”) down in Z onto the surface of the 3D model. The depth of the original toolpath below the surface of the material will be used as the projected depth below the surface of the model.

Vector Selection

This area of the toolpath page allows you to automatically select vectors to machine using the vector’s properties or position. It is also the method by which you can create Toolpath Templates to re-use your toolpath settings on similar projects in the future. For more information, see the sections Vector Selector and Advanced Toolpath Templates.

Name

The name of the toolpath can be entered or the default name can be used.
Texture Toolpath

The 3D Texture Machining functionality uses a specialized toolpath algorithm and the shape of the tool to generate a textured finish on the part. It should be noted this is a different technique than creating a 3D texture using the 3D model.

Textures can be calculated inside any selected vector boundaries or if nothing is selected the complete job size. Large Ball nosed cutter and V-Bits typically give the best results when using this strategy.

The texturing options are based on calculating random patterns and the variables required may at first appear a little complicated. The best way to see what effect each variable has on the texture is to simply change the numbers, calculate and preview the results. It's important to note that the toolpath algorithm uses a random combination of the variables specified on the texturing form to calculate the toolpath.

Tool

Clicking the Select button opens the Tool Database from which the required tool can be selected. Clicking the Edit button opens the Edit Tool form which allows the cutting parameters for the selected tool to be modified, without changing the master information in the database.

Use selected vectors as pattern

By default this option is unchecked and the texture form will generate a random texture pattern using any selected vectors as a clipping area. If this option is checked, ✓ the currently selected vectors will be used as the pattern for the texture and the only options available will be 'max. Cut Depth' and 'min. Depth' to control the depth of the cuts along the selected vectors.

Ramp at start and end

This option is only available when using selected vectors as patterns. If this option is checked ✓ each of the selected contours is cut using a fluting move, otherwise each of the contours is cut with a regular profile move. The resulting textures may look very different because of this small change.

Texture Settings

Max. Cut Depth

The maximum depth any of the carved scallops will be machined to and is specified in the job units.

Min. Depth

Using the slider this is specified as a percentage (%) of the Max. Cut Depth and controls the minimum depth any of the scallops will be machined to.

Note: For example, with a Max Cut Depth = 0.200 inches and a Min Cut Depth of 0.050 inches, the depth of the carved scallops will range randomly between 0.200 inches and 0.050 inches.

Max. Cut Length
Specifies the maximum length for any of the carved grooves and is specified in the job units.

Min Length

Using the Slider this is specified as a percentage of the Max Cut Length and controls the minimum length any of the carved grooves.

**Note:** For example, with a Max Cut Length = 3 inches and a Min Length of 0.150 inches, the length of the randomly carved scallops will range randomly between 3 inches and 1.5 inches long.

Max. Overlap %

The percentage (%) of the Max Cut Length that each scallop is allowed to overlap the adjacent scallop running along the cutting direction. Where, 1% will result in almost zero overlap of adjacent scallops 50% will result in some of the scallops being machined half way over the adjacent scallop.

Variation

Using the slider this is specified as a percentage of the Max Overlap. Overlap variation of 100% = the Max Overlap and random pattern Overlap variation of 1% = No Overlap and an almost constant pattern.

**Note:** For example, with a Max Cut Length = 1 inch, Max Overlap = 25% and Overlap Variation = 50%, the random overlap pattern calculated will range between 0.25 inches and 0.125 inches.

Stepover

The distance between each parallel set of lines of carved scallops.

Variation

Using the slider this is the percentage used to randomly change the stepover between each scallop. If a variation of 0% is specified the scallops will all be parallel to each other. And a variation of 50% will result in some scallops overlapping half way over others.

Angle

The direction the texture is machined across the surface, an angle of zero is parallel to the X axis, examples of setting the angle to 45 and 90° can be seen below.
Boundary Vector Offset

If you enter a value in this field, the texturing will be offset from the boundary by the specified amount. If you are texturing in a recess, you should enter a value here up to the radius of the tool to avoid the walls of the recess being damaged by the tool.

**Note:** As Texturing Toolpaths are calculated using a Random combination of the parameters and variables listed on the form the toolpath will change very slightly every time a toolpath is calculated.

General Toolpath Settings

This section of the toolpath form is common to a number of toolpath strategies.

Safe Z

The height above the job at which it is safe to move the cutter at rapid / max feed rate. This dimension can be changed by opening the Material Setup form.

Home Position

Position from and to that the tool will travel before and after machining. This dimension can be changed by opening the Material Setup form.

Project toolpath onto 3D Model

This option is only available if a 3D model has been defined. If this option is checked, ✓ after the toolpath has been calculated, it will be projected (or ‘dropped’) down in Z onto the surface of the 3D model. The depth of the original toolpath below the surface of the material will be used as the projected depth below the surface of the model.

Vector Selection

This area of the toolpath page allows you to automatically select vectors to machine using the vector’s properties or position. It is also the method by which you can create Toolpath Templates to re-use your toolpath settings on similar projects in the future. For more information, see the sections Vector Selector and Advanced Toolpath Templates.

Name

The name of the toolpath can be entered or the default name can be used.

Prism Carving Toolpath

Prism carving gives a raised ‘bevel’ effect to shapes and letters similar to a ‘hand carved’ look.

Prism Carving uses an angled tool to create a raised prism shape on the top of the selected vectors. The tool will profile at a given depth creating a nice sharp finished shape such as the lettering shown in the image below. This is often paired with a Profile or Pocket toolpath to carve the vertical edge around the shapes or clear out the material between them. This type of toolpath is often, though not exclusively, used on lettering.

Cutting Depths

Start Depth (D)

Start Depth (D) specifies the depth at which the Prism Carving toolpath is calculated from. When cutting directly into the surface of a job the Start Depth will often be 0. If machining into the bottom of an existing pocket or stepped region, the depth of the pocket/step that you are starting from must be entered here.
Prism Depth

This sets the depth of the Prism Carving toolpath relative to the Start Depth, the total depth of the base of the prism shape (within the material) will be the combination of the Start and Flute Depth. This depth is particularly important to set correctly as if it is too shallow then the prism shape may be truncated so it will have a flat top (shown in the image below right). The minimum depth needed to avoid this is determined by the widest point on the vector/s selected (W) and the angle of the tool (A). This can be calculated automatically by using the Set Depth for Full Prism function (see below for more details).

Set Depth for Full Prism

For this button to work you both need to select the vectors you plan to toolpath and also have selected the tool you are going to use, then when you click it, the Prism Depth will be set to the minimum required to ensure a full point on the prism for the current selection/tool.

Tool

Clicking the Select button opens the Tool Database from which the required tool can be selected. See the section on the Tool Database for more information on this. Clicking the Edit button opens the Edit Tool form which allows the cutting parameters for the selected tool to be modified, without changing the master information in the database.

Note: Prism Carving requires accurate tool sizing and quality, it is essential that the parameters of your tooling are measured and entered precisely.

Prism Carving is predominantly cut using a V-shaped cutter, having sharp tooling which is accurately sized is very important to getting good results. You should measure your cutters to make sure the size and angle of the v-bit are as per the manufacturers specifications as a variation of even 1 or 2° on the angle can make a big difference to the quality and precision of Prism carved shapes.

Direction

The direction of cut can be set to either Conventional or Climb machining, the choice for this will largely be dictated by the material being machined and the type of tool being used. See the section on Profile Toolpaths in the Reference Manual for more information on the differences between these.

Use Vector Selection Order

If this option is checked, ✓ the vectors will be machined in the order you selected them. If the option is not checked the program will optimize the order to reduce machining time.

General Toolpath Settings

This section of the toolpath form is common to a number of toolpath strategies.

Safe Z

The height above the job at which it is safe to move the cutter at rapid / max feed rate. This dimension can be changed by opening the Material Setup form.

Home Position

Position from and to that the tool will travel before and after machining. This dimension can be changed by opening the Material Setup form.

Project toolpath onto 3D Model

This option is only available if a 3D model has been defined. If this option is checked, ✓ after the toolpath has been calculated, it will be projected (or 'dropped') down in Z onto the surface of the 3D model. The depth of the original toolpath below the surface of the material will be used as the projected depth below the surface of the model.
Vector Selection

This area of the toolpath page allows you to automatically select vectors to machine using the vector's properties or position. It is also the method by which you can create Toolpath Templates to re-use your toolpath settings on similar projects in the future. For more information, see the sections Vector Selector and Advanced Toolpath Templates.

Name

The name of the toolpath can be entered or the default name can be used.

Moulding Toolpath

This icon opens up the Moulding Toolpath Form. This form is used to create a toolpath from a drive rail and a profile. The result of machining the toolpath is the extrusion of the selected cross-section profile along the pre-selected drive rail. Although strictly speaking the result of this is a 3D shape because it does not use a 3D model it is classified as a 2.5D Toolpath.

Drive Rail Selection

From the 2D view, select the drive rails for the toolpath followed by the profile you wish to extrude. You may select multiple rails. The last selected vector is the Profile that you are extruding.

In the 2D view your rail vector will now be colored orange and will show a green square indicating the start point, along with arrows along the vector showing you the direction.

The direction and start point may not be what you intended, you can change the direction (and start point location on an open vector) by right clicking in the 2D View on the vector and choosing Reverse Rail.

The Clear Rail button on the form can be used at any time to empty your current selection; this will deselect the drive rail and if already selected the cross section too. This can be used if you want to change the selection without exiting the form.

Cross Section Selection

After you have chosen your drive rail the next step is to select a cross section that will be swept around the drive rail to create the moulding. The cross section needs to be an open shape in order for this to work.

To select a cross section click on the appropriate vector in 2D View and it will turn orange as with the drive rail, arrows and a green square will appear on it. In addition the drive rail will now have red lines shown on it. These indicate the side of the vector that the shape will be swept along. If this is not correct you will need to reverse the drive rail vector as documented in the previous section.

The arrows and green square on the cross section indicate the direction and the start point. The start point of the cross section will be attached to the start point of the drive rail. If you need to change the start point of the cross section you can do so by selecting the cross section with a right click and choose to Reverse Profile as shown in the image below. Doing this will change the arrow direction and move the green square and also change which end of the cross section is effectively hung on the drive rail when the toolpath is created.
Note: On a closed vector shape the cross section profile will always be hung on the outside of the shape, it is not possible to change this to the inside so your drive rail vector should always represent the inside edge of the border/frame shape you are creating a toolpath for. Clicking the Reverse Rail option on a closed vector drive rail will change the direction that the toolpath is created in.

Toolpath Position

You now need to determine the toolpath position within the material. The Z Height of the toolpath is determined by the height of the selected cross section. You can interactively position the toolpath by pulling on the slider or you can enter exact values in the edit boxes.

Note: If the cross section you have selected is higher than the material thickness then you will need to change your material thickness in the material setup form to accommodate the profile height, or exit the form and edit the height of the cross section vector you are using to create the Moulding Toolpath to fit within the material block.

Selecting a Tool

The next step in this form is to select a tool to finish-cut the moulding shape. This would typically be a ball-nose or tapered ball-nose tool but that may vary depending on the shape you plan to cut. To select a tool use the Select... button to access the Tool Data Base. If the tool you require is already shown as the selected tool, you can use the Edit option to check and/or modify the tool settings for this particular toolpath.

Note:

The generated toolpath will follow the shape and direction of drive rail vector.

At the end of an open vector it will lift by at least the stepover distance, step over and then come down to the surface again, returning along the vector in the opposite direction, this small lift is designed to avoid leaving connecting marks on the surface of the part and so improve the potential finish quality.

On a closed vector after completing a pass the length of the vector it will lift, step-over, return the tool to the profile shape and continue cutting in the same direction - this direction can be reversed by right clicking the drive rail vector and using the Revers Rail option to change the direction of the arrows on the vector.
Vary Step Over

Typically the Stepover value specifies the horizontal distance that the tool will step over and this is projected onto the 3D model. Checking ✓ the Vary Step Over option will instead adjust the step over based on the shape of the cross section profile vector rather than just projecting the standard pattern down Z. In cases where there are steeply curved, angled or near vertical edges this should result in passes that are closer together, in most situations this will improve the finish quality but also potentially increase the machining time.

Skip Flat Regions

This choice will only become available when the option is checked ✓ to Machine Flat Regions when using the Larger Area Clearance Tool in the next section of the form. When this is active the software will look to identify flat areas of the cross section profile that can be machined with the larger tool. If these regions are detected and Skip Flat Regions is also checked ✓ then the finish tool will avoid re-machining those flat areas as in most cases they should already have been completely finished by the Larger Area Clearance Toolpath.
Finish toolpath calculated with Skip Flat Regions.
This avoids machining these areas if the Larger Area Clearance tool can fit and is selected.

Use Larger Area Clearance Tool

If this option is selected, then two tools are used to cut the shape. In effect the Larger Area Clearance Tool is similar to a 3D Z Level Roughing toolpath and would be cut first. It will use the tool parameters to generate multiple depth 2D pockets following the direction of the selected rail to clear away excess material. This should be used if the material is too deep and/or hard to cut directly with your selected finishing tool. As documented above and below using this option with a flat shaped tool can also be very beneficial to the machining time and finish on cross section profile shapes with flat/horizontal regions.

Machine Flat Regions

If this option is checked ✓ then the software will try to detect flat/horizontal areas in the cross section profile. If the specified Larger Area Clearance Tool can fit into these areas then they will be machined as part of the roughing operation. When using a flat tool this should give both a superior finish and also help to reduce the cutting time. Having this option checked ✓ will also allow you to choose the option Skip Flat Regions in the finish tool section which will stop the secondary toolpath from re-cutting these areas.

Note: This option will override the Machining Allowance value in the flat areas of the shape to ensure they are machined to the correct depth and not left with additional material on.

Areas shown by the arrows would be pre-finished during the Larger Area Clearance Tool stage if Machine Flat Regions is checked ✓.

Ramp Plunge Moves

The Larger Area Clearance Tool can be ramped over the specified distance instead of plunging vertically into the part. For some tool types and shapes, this approach can reduce the heat build-up that may damage the cutter and also reduces the load on the spindle and z axis bearings.

Machining Allowance
The machining allowance is a virtual thickness which is added to the moulding profile when the Use Large Area Clearance Tool is calculated. This ensures that the toolpath leaves some extra material on the part cut with a larger tool.

This is beneficial for two reasons, the first, is that when the larger area clearance tool is used, it tends to be done with a relatively large tool with aggressive cuts and so is more prone (depending on the material) to chip, the skin left by the Machining Allowance helps to prevent chipping the finished surface. The second reason is that most tools cut well when they are constantly removing material. Therefore leaving an allowance of material on ensures that there is always some material left for the finish toolpath to remove with the smaller tool.

Note: If you have the option selected to Machine Flat Regions the Machining Allowance will only be applied to the other areas of the cross section profile, on the detected flat regions the software will cut down to the actual surface and ignore the Machining Allowance value within those areas ensuring that they are cut to the thickness specified by the cross section profile vector.

When you use the option to Use Larger Area Clearance Tool the software will calculate two toolpaths, the first will have [Clear] in its name to differentiate the two, [Clear] being the toolpath associated with the Use Larger Area Clearance Tool and the other, is the finish toolpath using the smaller tool. The [Clear] toolpath should be run first on the machine:

Create Sharp Corners

This option can be checked ✓ when working with rails that have sharp corners, allowing you to force the software to try and emulate these in the Moulding toolpath. Below you can see the effect of checking ✓ this option on a closed vector shape with the standard corners option on the left showing the toolpath rolling around the shape edge and the Sharp Corners option on the left where it has forced mitre style corners in the machined shape.

Boundary Offset

This option can be used to force the toolpath to cut past the edge of the part that is parallel to the drive curve vector. By default the center of the tool will go to the edge of the ends of the selected profile vector as its extruded along the drive rail. It may be desirable to extend this distance to either force the tool down the edge of the profile shape with vertical or steep edges or to ensure the toolpath has gone far enough past the edge to cleanly cutout the final shape with a profile toolpath. The value entered for the Boundary Offset will force the tool past the ends by the specified amount. As such if you want to ensure a vertical or very steep edge at your profile ends is machined you will need to specify a value which is at least the radius of your tool plus a small additional amount (say an additional 10% of the radius). For example if you are using a 0.25 inch (6mm) diameter ball-nose tool for the finish cut then you would specify a minimum of 0.15 inch or 3.6mm (= tool radius + 10%) to ensure the tool would be forced down the edges of your shape. If you wanted to ensure the roughing had also been able to machine these areas then the value should be based on your Larger Area Clearance Tool size instead.

With no Boundary Offset the toolpath will not cut down the front and back vertical faces of the shape.
With a Boundary Offset value specified you can see the toolpath cuts over the edges.

Note: The Boundary Offset value will only extend the toolpath past the edges of the shape that are parallel to the Drive Rail vector. If you have an open Drive Rail vector then the toolpath will always stop at the ends. If you planned to cut out the shape then you may want to extend the drive rail vector to add length to the toolpath in that direction as well as specifying a Boundary Offset.

General Toolpath Settings

This section of the toolpath form is common to a number of toolpath strategies.

Safe Z

The height above the job at which it is safe to move the cutter at rapid / max feed rate. This dimension can be changed by opening the Material Setup form.

Home Position

Position from and to that the tool will travel before and after machining. This dimension can be changed by opening the Material Setup form.

Project toolpath onto 3D Model

This option is only available if a 3D model has been defined. If this option is checked, ✓ after the toolpath has been calculated, it will be projected (or 'dropped') down in Z onto the surface of the 3D model. The depth of the original toolpath below the surface of the material will be used as the projected depth below the surface of the model.

Vector Selection

This area of the toolpath page allows you to automatically select vectors to machine using the vector’s properties or position. It is also the method by which you can create Toolpath Templates to re-use your toolpath settings on similar projects in the future. For more information, see the sections Vector Selector and Advanced Toolpath Templates.

Name

The name of the toolpath can be entered or the default name can be used.
The 3D toolpaths section of the Toolpath Operations icons can be found on the Toolpaths tab, underneath the Toolpath list. These strategies are capable of cutting any shape that can be represented by the composite model. For this reason they are the most flexible machining strategies in

**Note:** When deciding how to cut your design it is always worth verifying that a particular 3D effect that you are trying to achieve (3D engraved text, for example) cannot be matched closely enough using a 2.5D strategy (see <

### 3D Toolpaths

#### 3D Rough Toolpath

Rough Machining is used when carving 3D parts to clear away excess material when the part is too deep for the finishing tool to cut in a single pass.

Clicking on this icon opens the toolpath form shown to the right; the functions available within this are described below.

**Tool**

Clicking the Select button opens the Tool Database allowing the selection of a tool for this operation. As with other toolpaths the Edit button allows the tool parameters to be changed for this specific toolpath.

**Machining Limit Boundary**

The machining limit boundary is the area in which we perform the Rough machining. There are several options:

- **Model Boundary** The combined boundaries of all the components in this job are used. This is the area of the composite model which has components on it. Note: this is not the boundary of the selected models.
- **Material Boundary** The boundary of the entire material block is used.
- **Selected Vector(s)** Selected vectors are used as the machining boundary.
- **Selected Level** The combined boundaries of all the components on the specified level. This is similar to Model Boundary but only specific to the named level.

**Boundary Offset**

The center of the tool will go to the edge of the specified boundary. If you are machining a raised object, this often means that the tool won’t fully machine down the edge. This field is used to specify an offset to the selected machining boundary to increase its size to allow the tool to go past the actual edge if needed.

**Machining Allowance**

The machining allowance is a virtual thickness which is added to the 3D model when the Roughing Toolpath is calculated. This ensures that the toolpath leaves some extra material on the roughed part.

This is beneficial for two main reasons, the first is that when roughing it tends to be done with relatively large tool and aggressive cuts and so is more prone (depending on the material) to chip, this skin helps to prevent the chipping affect the finished surface. The second reason is that most tools cut well when they are constantly removing material. Therefore leaving an allowance of material on ensures that there is always at least some material for the finishing toolpath to remove.

**Z Level Strategy**

Z Level Roughing essentially uses a series of 2D Pocket toolpaths which take into account the 3D model and hog-out the material around it within the specified boundary. There are two settings that must be chosen to define this type of toolpath. The first box lets you choose the main direction of the cuts in the toolpath; either Raster X which fills each pocket with a raster pattern mainly parallel to the X axis or Raster Y which fills each pocket with a raster pattern parallel to the Y axis.

The second setting is the choice of Profile, this controls whether each level has a profile cut around its boundary or not and if so whether it cuts before the raster or after it. First does the profile before the Raster on each level, Last does the profile cut after the raster and None eliminates the Profile cut leaving only the raster pattern. These choices depend a lot on the
material and tooling being used. For example, more brittle material may benefit from the profile first option to reduce chipping.

### 3D Raster Strategy

The 3D Raster strategy is a 3D cut which passes over the whole model. This will leave a more even amount of material for the finish cut to remove but depending on the depth and style of the part it may take significantly longer to run. In shallower parts where the roughing is only taking one or two passes then this may be a better choice. For deeper parts then typically the Z Level roughing is a more efficient. There is only one option with this strategy is to define the main cutting direction. Raster X uses a raster pattern parallel to the X axis or Raster Y uses a raster pattern parallel to the Y axis.

### Ramp Plunge Moves

The cutter can be ramped over a distance into the pocket instead of plunging vertically. This approach reduces heat build-up that damages the cutter and also reduces the load on the spindle and z axis bearings.

### Safe Z

The height above the job at which it is safe to move the cutter at rapid / max federate, this value can be changed by opening the Material Setup form.

### Home Position

This is the position that the tool will travel to and from before and after machining, this dimension can be changed in the Material Setup form.

### Vector Selection

This area of the toolpath page allows you to automatically select vectors to machine using the vector’s properties or position. It is also the method by which you can create Toolpath Templates to re-use your toolpath settings on similar projects in the future. For more information, see the sections Vector Selector and Advanced Toolpath Templates.

### Name

The name of the toolpath can be entered or the default name can be used.

#### 3D Finish Toolpath

Finish Machining is used to machine the final pass on the finished 3D part.

Clicking on this icon opens the toolpath form shown to the right; the functions available within this are described below.

### Tool

Clicking the Select button opens the Tool Database from which the required tool can be selected. Clicking the Edit button opens the Edit Tool form which allows the cutting parameters for the selected tool to be modified, without changing the master information in the database.

For most 3D Finishing cuts a Ball Nosed end mill is used with a reasonably small stepover (8 - 12% of the tool diameter is typical). Variations on this tool type such as a tapered Ball Nosed cutter will also work and may offer more strength with smaller tool sizes. The size of tool will depend on the size of the part and the detail within the 3D part. Use the preview function to check the finish quality and detail, if they are not to a high enough standard then the job may require smaller tooling or a smaller stepover. 3D cutting is always a tradeoff between time and quality and an optimum balance of tool size, finish quality, and time to cut. The choices made will always depend on an individual's personal preferences or the specifications of the job.

**Note:** The finishing toolpath is always a single pass, and it does not use the tool's pass depth. Please ensure that your Roughing Toolpath's Machining Allowance is set appropriately for the tool used in Finishing to avoid damaging the bit.

### Machining Limit Boundary

The machining limit boundary defines the area cut by the Finish machining, there are three options:
**Model Boundary** This uses the combined boundaries of all the visible components in the job. This is defined by the silhouette of the composite model. **Note** that this is the boundary of all currently visible components and is not controlled by selecting specific objects.

**Material Boundary** This uses the boundary of the entire material block (job setup area).

**Selected Vectors** This uses any selected vector or vectors as the machining boundary.

**Selected Level** The combined boundaries of all the components on the specified level. This is similar to **Model Boundary** but only specific to the named level.

### Area Machining Strategy

There are two choices of the type of fill pattern that will be used to machine the area with the toolpath; Offset and Raster.

**Offset**

Calculates an offset pattern projected onto the 3D surface and machined inside the selected vector(s). The cutting direction can be set to either Climb (CCW) or Conventional (CW).

Your choice of Climb or Conventional cutting will largely be dictated by the material that is being machined and your tooling options. Talk to your tooling suppliers for details about what is most appropriate for your specific application.

**Example of an Offset pattern**

**Raster**

Calculates a raster pattern (lace cut) projected onto the 3D surface and machined inside the selected vector(s), with control over Raster Angle - Between 0 and 90°. 0° will give you a pattern that is mainly parallel to the X axis and 90° is mainly parallel to the Y axis.

**Example of a 3D Raster toolpath at 0°**

**Stepover Retract**

In the Finish Machining Toolpath form a Stepover Retract Value can be applied to the Offset Machine Strategy. If the value you enter is greater than 0 then the tool will lift off the surface of the composite model by this amount when stepping between each offset contour. Depending on your material and tooling, adding a small lift will eliminate perpendicular tool marks between the toolpath contours to potentially improve the finished surface.

**Note:** If the Stepover Retract Value specified is not large enough to allow the machine to lift the tool over the previous cusp height then you will receive a warning. This warning is simply informing you that with a Stepover Retract value of this size then you will not eliminate perpendicular tool marks.
Safe Z

The height above the job at which it is safe to move the cutter at rapid / max federate. This dimension can be changed by opening the Material Setup form.

Home Position

Position from and to that the tool will travel before and after machining. This dimension can be changed by opening the Material Setup form.

Vector Selection

This area of the toolpath page allows you to automatically select vectors to machine using the vector's properties or layer.

Name

The name of the toolpath can be entered or the default name can be used.

Vector Selector

This tool allows you to easily select vectors which meet a set of criteria, such as open, closed, circular and also matching constraints based on layers. The dialog can be accessed from the Edit ► Vector Selector menu item, or from the button on each toolpath form. When the command is executed the dialog shown is displayed.

The dialog is used to configure a set of "filters" that determine which vectors will be selected. A filter is enabled by clicking on its check box, or selecting a 'radio button' option, the current selection will be updated with all the objects in the file which match the current filter options.

Generally you will start at the top of the dialog and work downwards, specifying more and more explicit filters to determine the required selection exactly.

The simplest option is just to use the form to Select Closed Vectors in the job or Select Open vectors (you can specify both, in which case all vectors will be selected as long as they are on a visible layer).

The most common way to use the Vector Selector is to select all the vectors on a given layer as shown in the screenshot of the dialog below.

In this example, the dialog has been used to select All Closed Vectors on the layer with the name Pocket.
Note: When opened from Edit ► Vector Selector, the options Associate with toolpath and Set toolpath Cut Depth from imported vectors are not available. These options are only usable when applying the vector selector from a toolpath form.

Selection

The Selection: section at the top of the dialog is continuously updated to show the results of the current filter and the 2D view is also updated to show what is currently selected. The Objects: entry shows the total number of objects selected, if these objects include Text or Groups, this number may be less than the total of Closed and Open vectors displayed on the following line. For instance, a block of text is one object but will usually consist of many closed vectors. If a group contains both open and closed vectors, it will be selected as matching both Open and Closed filters.

Geometry Filters

The Geometry Filters section is used to specify constraints on the type of vectors to select. You can choose to select open vectors and/or closed vectors. Instead of selecting All Closed Vectors, the dialog can be used to select Only Circles and can even be used to specify an exact diameter and tolerance for the circles to be selected. This can be very useful for selecting vectors for drilling toolpaths, particularly if the vectors have not already been sorted into layers.

Layer Filter

The Layer Filter section allows you to pick one or more visible layers on which to select vectors which match the geometry filter. Alternatively, the All visible layers option disables the filtering by layer and selects all vectors which match the geometry filter regardless of the layer they are on, as long as that layer is visible.

The Associate with toolpath option will be explained in the next section.

Advanced Toolpath Templates

By associating a template with the result of a Vector Selector filter, we can make a template to automatically select the vectors it is intended to machine. A simple case would be to create a template which consisted of a Pocketing toolpath set up to machine all closed vectors on a layer called Pocket. After loading this template into a new job and choosing Toolpaths ► Recalculate All Toolpaths, the toolpath would be recalculated automatically selecting all closed vectors on the layer called Pocket.

The advanced templates are created by selecting the vectors for a toolpath using the Selector... button on the toolpath form. When a toolpath form is first opened, the Vector Selection: section on the form will show that vectors are being selected manually as shown below...

![Vector Selection Manual](image)

Pressing the Selector... button will display the Vector Selector form as shown previously. After making your geometry selection and before you close the form, select the Associate with toolpath option on the form as shown below.

![Vector Selection Automatic](image)

After the Vector Selector form closes, the Toolpath form will indicate that Vector Selection is now ‘Automatic’ as shown below...

![Vector Selection Automatic](image)

IMPORTANT: Calculate the toolpath to apply the changes you have made.

When you re-calculate or edit a toolpath that has the Vector Selection mode set to automatic, the vectors which match the filter when the toolpath is re-calculated or edited will be selected. To cancel the Automatic vector selection mode, you can just select the vectors to machine normally with the mouse, or use the Selector... button to bring up the Vector Selector dialog again (the settings are remembered) and uncheck the Associate with toolpath option.
If toolpaths with the Vector Selection mode set to Automatic are saved as templates, these settings are saved with the template. When the template is re-opened and the toolpaths recalculated, they will automatically select all vectors which match the filters specified with the Vector Selector for that toolpath.

If you load a toolpath template which has toolpaths associated with layers which don’t exist in the current file, the Missing Layers for Template dialog will be displayed. It lists all the missing layers and offers you the choice of having them created automatically, deleting toolpaths associated with missing layers or just loading the toolpaths as is.

Choosing to allow the dialog to automatically create the missing layers allows a toolpath template to be used to create ‘standard’ layers for machining operations and load the toolpaths ready to be calculated. All you then need to do is move vectors to the appropriate layers and recalculate all the toolpaths.

Choosing the Delete all toolpaths associated with missing layers option allows you to create a single template with many toolpaths and have the ones which aren’t appropriate to the current job automatically deleted.
Toolpath Editing Tools

The Tool Database
Edit Toolpath
Duplicate Toolpath
Delete Toolpath
Recalculate All Toolpaths

Edit Toolpath

This option is used to modify an existing toolpath. Click to select a toolpath in the list then click the edit option to open the form.

The vectors associated with each toolpath are automatically remembered, so editing a toolpath will automatically select the vectors in the 2D window.

Make the required changes to the toolpath parameters. Click the Calculate button to update the toolpath.

A toolpath can also be edited by double-clicking on its name in the toolpath list.

Duplicate Toolpath

The Duplicate Toolpath option creates and adds a copy of the selected toolpath to the Toolpath List. An index number is automatically added to the name of the new toolpath. For example:

Cut out - 1/4 inch End Mill will create a copy with the name Cut out - 1/4 inch End Mill (1)

Copying externally generated 3D toolpaths (as, for example, from PhotoVCarve) will also create a duplicate grayscale thumbnail image in the 2D View, which can then be used to position the toolpath within your job.

Delete Toolpath

This tool is used to delete calculated toolpaths from the Toolpath List. Simply select the toolpath to be deleted and click the Delete Toolpath button to remove it.

Alternatively, you can delete one or multiple toolpaths in the Toolpath List by right mouse clicking on a toolpath. Then from the drop-down menu click on the Delete option. This will present the options as shown in the image: Delete This, Delete All Invisible, Delete All Visible, Delete All.

- **Delete This** will delete just the toolpath whose name you right mouse clicked on.
- **Delete All Invisible** will delete any toolpaths in your Toolpath List that do not have a check-mark ✓ next to their name and are therefore currently not visible in the 2D or 3D Views.
- **Delete All Visible** will delete any toolpaths in your Toolpath List that have a check-mark ✓ next to their name and are therefore currently visible in the 2D or 3D Views.
- **Delete All** will delete all the toolpaths in your Toolpath List.

If you have incorrectly deleted a toolpath (or multiple toolpaths) then you have the option to Undo the toolpath(s) deletion via the Undo command on the Edit drop-down menu, the Undo icon on the Drawing Tab or the Undo shortcut key combination Ctrl + Z.

Recalculate All Toolpaths

This command forces a recalculation of all the toolpaths in the Toolpath list. It is useful when the artwork used by the toolpaths has been modified, or the material block settings have changed.
The Tool Database

The Tool Database is used to make cutter management and selection very quick and easy, and reduces the possibility of programming jobs with incorrect cut depths and speeds and feeds. The Tool Database is accessed from the Select button every time you create a new toolpath and allows pre-defined tools and settings (speeds, feeds, stepover etc.) to be selected from a list.

New tools can be added, copied from existing tools, deleted and organized. All of the cutting parameters are stored in the database.

Opening the tool database

To access the Tool Database you can click on the Database icon on the Toolpaths Tab:

Alternatively, select Toolpaths ► Tool Database from the main menu bar.

A window similar to that shown will appear displaying a list of the tools that are currently defined on the left and the parameters for the currently selected tool from the list over on the right. Below this image is a list of all the actions that can be executed from this dialog:

**Tool List**

The Tool List is located on the left-hand side of the Tool Database. Click on items in the list to see or edit their properties using the Tool Info section of the database window. The Toolpath list is arranged hierarchically to allow you to organize your tools according to common properties or use.

You can click and hold down the left mouse button to drag items up or down in the list. If you drag them into a tool group, they will be placed inside the group.

**Tooltip of group hierarchy**

When a tool is selected within a toolpath strategy page, the tool name does not always provide enough information for you to know whether the tool's settings are appropriate. This will become particularly significant if you import a toolpath template (see Toolpaths Templates) with a tool that has been pre-defined (perhaps by a 3rd party) when the template was created. It is always possible to click Edit and see the full set of the tool's properties and settings. However, if you hover your mouse over the tool's name, a tooltip will pop-up telling you what the location of this tool was in the tool group hierarchy when it was added to the toolpath strategy or template. This can be extremely useful for quickly distinguishing between tools in your database that have similar names, but have been grouped according to their properties.

**Adding a New Tool**

Selecting New... creates an empty tool in the list that can have any user definable name.
Copying a New Tool

Copy adds a duplicate of the selected tool to the list and prefixes the original name with (1). Edit the Name and properties for the new tool and click the Apply button to save the changes to the list.

Deleting a Tool

Deletes the selected tool from the database.

**Note:** Take care when deleting tools as this operation cannot be undone.

Creating a new tool group

Click on the add New Group button then give your new group a name and press Apply to add it to the database. Click and drag tools from the database over the top of the newly created group icon in the tool database tree to add them to the group. Alternatively, select the group and then click the New... button to create a new tool directly within the selected group.

Importing and Exporting tools

Individual tools or complete tool group hierarchies can be saved to disk using the Export... button. Similarly, you can import previously saved tools, groups or even entire tool databases using the Import... button.

**Note:** VCarve Pro will import database files from earlier versions, so you can easily add any previously defined tools to your new database. Please note, however, that you will not be able to open the new VCarve Pro database files in earlier versions.

Tool Info

When a tool or group is selected in the Tool List, its properties are displayed in the Tool Info section on the right-hand side of the Tool Database.

Here you can modify any of the properties of the currently selected Tool or Group. Click the Apply button to save the changes to the Tool List.

**Note:** If you modify the Tool database, your changes will only be saved if you click OK. If you exit the Tool Database window using the Cancel button, any changes you have made since opening the Database will be discarded.

Name

Use this field to enter a suitable name to describe your cutters.

Tool Type

Various cutters can be specified in the database.

**Note:**

When specifying the geometry for a tool, the angle specified is different for V-Bit and Engraving Tools. V-Bit Tools are defined using an Included Angle (A) and Engraving Tools are defined using the Half Angle (A) and the Flat Diameter (F).
Notes

The tool notes section simply allows you to save any additional text descriptions, special instructions or relevant information you may require, within your tool definition.

Geometry

Diameter

The diameter of the tool in either inches or mm. The tool image will indicate where this dimension is taken from. If you change the tool diameter but do not change the tool name then you will be warned.

Cutting Parameters

Pass Depth

The maximum depth of cut the tool can cut. The Pass Depth controls the number of z level passes that are calculated for a toolpath. For example, creating a pocket 1 inch (25.4 mm) deep using a tool that has a Pass Depth of 0.25 inches (6.35 mm) will result in the toolpath making 4 passes.

Stepover

The distance the cutter moves over when doing area clearance cutting. For example, when raster machining the cutter will machine along the X axis, stepover in the Y direction and return parallel to the first line of cut. The greater the stepover the faster the job will be machined, but this must be balanced with the material being cut and the tooling being used, to ensure that the tool does not break.

When stepover’s greater than 50% of the cutter / tip diameter are used the software automatically adds “Tail” moves in the corner regions of toolpaths to ensure material is not left on the job for offset based strategies. When using V-Bit Tools, the Stepover fields automatically change to use the following options.

Final Pass Stepover

The distance the cutter moves over when finish machining and is usually set to be a relatively small distance to produce a smooth surface finish on the job.

Clearance Pass Stepover

Only used when a V-Bit tool is being used to rough machine at multiple Z levels down to a specified flat depth. This stepover can be much larger than the Final Pass Stepover because the tool is only rough machining material away. Increasing the Clearance Pass Stepover will reduce the machining time, but you must be careful to ensure it is not too great for the material being cut.

Feeds and Speed

Spindle Speed

Speed of tool rotation, specified in revolutions per minute

Feed Rate
The surface cutting rate at which the cutter is moved in the material. The units can be specified in distance per second or minute.

**Plunge Rate**

The cutting rate at which the cutter is moved vertically into the material or during ramping moves. The units can be specified in distance per second or per minute.

*Note:* The Feed rate and Plunge rate you should use will vary depending upon the material being machined and the tooling being used.

**Maximum Burn Rate**

This is the maximum speed at which the tool, when at 100% power, will still burn the material. This value is used for simulation purposes only. It should be calibrated to match your laser and material. A larger value will result in the simulated toolpath appearing darker.

*Note:* You will need access to the Laser Module to create and simulate laser toolpaths.

**Tool Number**

This is the number of the tool needed to machine the job. When using a CNC machine with an Automatic Tool Changer (ATC), it is critical that the correct tool required to cut the job is located in the corresponding carousel location.

**Using Form Cutters**

Form Cutters can be added to the Tool Database so that industry standard Ogee and Round-over type cutters, plus user definable custom shapes can be used for edge profiling and decorative carving. Examples of these types of cutters and the kind of cuts they can be used for are shown in the images below:

![Image of Round-over and Ogee cutters.](image_url)

**Adding your own custom form cutters**

Adding a Form cutter to the Tool Database is straightforward and the procedure is,

Before opening the tool database, draw to exact scale the Right side of the cutter geometry in the 2D Window. Use the Node Editing tools to create the arcs and curves etc.

Only draw the Right-hand side of the cutter geometry to the correct size and scale as shown in the image above.

The shape can be a combination of Lines, Arcs and Bezier spans. With the vector Selected open the Tool Database (using the command icon on Toolpaths tab or from the main menu, Toolpaths ➤ Tool Database) in the Tool Database window, click New... Select Form Tool

The selected geometry will be imported and a profile displayed in the window. Give the Cutter a meaningful name and enter the cutting parameters - speeds and feeds etc. Click the Apply button to save the new cutter into the database list so it can be used at any time.

*Note:* Cutter geometry can be imported as dxf, eps files and used to create Form Tools in the database.
Toolpath Templates

Toolpath templates allow you to improve the efficiency of your production processes by saving the complete toolpath settings for common operations. These settings can then be re-used at any time on different design geometry. Frequently used strategies and tooling can thus be applied to similar jobs, quickly and easily.

Simple Toolpath Templates

Save Toolpath Template

Using the Toolpaths ► Templates ► Save Selected Toolpath as Template menu command (or the associated icon), all the settings for the currently selected toolpath can be saved as a template.

Load Toolpath Template

When you load a previously saved toolpath template (using Toolpaths ► Templates ► Load Template...) you will have an empty toolpath which can be edited by double clicking on its name in the toolpath list or selecting the Edit Toolpath icon in the Toolpaths tab. Once the toolpath form is open, the vectors to be machined can be selected and the toolpath calculated using all the saved settings.

Save All Visible Toolpaths as a Template

The Toolpaths ► Templates ► Save All Visible Toolpaths as Template menu command (or the associated icon) allows a group of toolpaths to be saved as a single template. As an example, the toolpaths may have all the settings used for Profiling and Pocketing operations for a particular type of job and material combination. These toolpaths settings can then be recalled simply by opening the template and selecting the appropriate vectors for each toolpath.

If toolpaths with the Vector Selection mode set to Automatic are saved as templates, these setting are saved with the template. When the template is re-opened and the toolpaths recalculated, they will automatically select all vectors which match the filters specified with the Vector Selector for that toolpath.

If you load a toolpath template which has toolpaths associated with layers which don’t exist in the current file, the Missing Layers for Template dialog will be displayed. It lists all the missing layers and offers you the choice of having them created automatically, deleting toolpaths associated with missing layers or just loading the toolpaths as is.

Choosing to allow the dialog to automatically create the missing layers allows a toolpath template to be used to create ‘standard’ layers for machining operations and load the toolpaths ready to be calculated. All you then need to do is move vectors to the appropriate layers and recalculate all the toolpaths.

Choosing the Delete all toolpaths associated with missing layers option allows you to create a single template with many toolpaths and have the ones which aren’t appropriate to the current job automatically deleted.
Create Merged Toolpath

When using the same tool for different types of toolpath (e.g., Pocketing and Profiling) those toolpaths can be merged to create a single toolpath which performs the same cutting operations more efficiently.

The process of toolpath merging starts with the creation of two or more toolpaths which use the same tool. Once you have created the toolpaths you want to merge, click on the toolpath merge button, or select Toolpaths ► Merge Visible Toolpaths from the Main Menu.

The toolpath merging form will give you an overview of the toolpaths that you are about to merge.

Choosing Toolpaths to Merge

The toolpath merge tool will always try to merge all visible toolpaths. To toggle the visibility of the toolpaths click the corresponding check boxes for each toolpath in the toolpath list shown below the form. The toolpaths to be merged will appear in the box marked Toolpaths to be merged...

If fewer than two toolpaths are visible then the list of toolpaths to be merged will display a warning. If two toolpaths which use different tools are visible then the list of toolpaths to be merged will display a different warning explaining that only toolpaths with the same tool can be merged.

Ordering

The toolpath merge tool has a number of checkboxes which allow different orderings of the resulting merged toolpath. When the toolpaths are merged each of these ordering strategies is calculated and the quickest strategy chosen.

Merging by Part

When the Merge By Part check box is selected, the toolpath merge not only tries to optimize the whole toolpath, it also tries to group related geometry to cut together.

To see this in action consider the following example file, this contains two toolpaths: a pocket toolpath for pocketing inside the circles to the correct depth; and a profile cut out toolpath. Both of these toolpaths use the same tool.

Without merging, the Circles are all pocketed before profiling around each of the squares. Merging the toolpaths with the Merge By Part option checked ✓ will cut all of the pockets within a single square followed by the profile for this square and repeat this pattern for each circle-filled square:

Circular Pockets in Square Profiles

Merge By Part option unchecked: The Squares profiled after all the Circles have been pocketed.

Merge By Part option checked ✓: Each Square is cut after its circles have been pocketed.

Merging by part tries its best to respect the ordering of the toolpaths in the toolpath list, and the order of contours within a given toolpath. In particular, if contours of two different toolpaths lie within the same part, the contour of the first toolpath will be cut before the contours of the second toolpath. The following examples show how the toolpath order in the main toolpath list alters the results of toolpath merging.
If the Merge By Part option is not selected then no attempt is made to preserve either the toolpath order or the order of contours within the same contour, this simply aims to get the same end result as quickly as possible. Because of this, it is best to use this option with caution, particularly if one of your toolpaths must be performed before the other, and you will be warned when using this option.

**Toolpath Name**

Enter a name for the newly created merged toolpath.

Click on the **Merge Toolpaths** button. This creates a new toolpath. It does not modify the chosen toolpaths.

**Note:** It is often a good idea to choose a name which describes the toolpaths to be merged. If one of these original toolpaths is then modified it is easier to recall which toolpaths need to be merged again.

**Recalculating and Editing Merged Toolpaths**

Once a toolpath has been created using the merge toolpaths tool then it cannot be recalculated or edited. If you modify one of the original toolpaths then you must perform any merges again.

**Feeds and Speeds**

It may be that the toolpaths to be merged have different feeds and speeds. Toolpath merging will automatically change the feeds and speeds for the different parts of the toolpath but you should check that your post-processor supports this.

**Create Array Copy Toolpath**

Using the same approach as the Array Copy Tool for vectors in your drawing, this toolpath operation allows you to duplicate one or more toolpaths into a grid of copies. One of the key benefits of this approach is that it allows you to subsequently edit your original toolpaths and the software will automatically update the associated array of copies.

To use the Array Copy Toolpath, open the form and turn on the visibility for each of the toolpaths you wish to be part of your array using the visibility checkbox next to each toolpath in the list below the form. The current selected toolpaths appear in the Toolpaths list at the top of the form.

The position of the resulting grid of toolpaths is always created to the right and above the source toolpaths. Therefore, you should always position your source toolpaths in the bottom left corner of the area you wish the array to fill.

Use the Rows (Y) and Columns (X) boxes to specify the size of your grid and thus the total number of copies of the original toolpath(s) that will result.

The spacing between the copies of the toolpath within the grid are controlled using the Offset and Gap radio button options. The X and Y edit boxes determine the offset between the start point of each toolpath or the spacing between the bounding boxes of the copy, depending on the radio button option selected.

The final option, Minimize tool changes, will only be available if the source toolpaths are using different tools. This will group toolpaths with the same tool geometry across the copies so that they can be output together. By grouping in this way,
the parts of each copy using the same tool are cut together and the entire array can be cut with the minimum number of tool changes. If this option is not set, then the toolpaths for each copy will be cut individually, with tool changes required for each. See the The Array Copy Toolpath Cut Sequence section for a detailed discussion of how this option affects the toolpath sequence.

Click the **Calculate** button to create the grid array of ‘child’ toolpath copies of the ‘parent’ toolpaths you have selected.

**Working with Array Copy Toolpaths in the Toolpath List**

Array Copy Toolpaths are displayed in the Toolpath List in different way to other toolpaths. The source toolpaths (the ones originally selected as the basis of the array) are now shown below the array copy toolpath item in a tree structure. For complicated jobs you can hide the source toolpaths in the list using the small + and - controls next to the Array Copy Toolpath in the Toolpath List. The usual visibility checkboxes are also available for both the array copy toolpath and its source toolpaths.

You can rearrange the order of the source toolpaths within the array copy group either by dragging them up or down using the mouse, or by click the up and down ordering arrows at the top of the Toolpath List. These features give you total control of each toolpath type within the array and are particularly important for saving the toolpaths in precisely the form and sequence you need.

**Editing an Array Copy Toolpath**

The tree layout of items in the Toolpath List also means that you can still be access the source toolpaths independently for editing. Any changes you make to a source toolpath will automatically be reflected in all the child copies in the array. To edit a source toolpath, double click on it to open the toolpath form from which it was originally created. Make any changes you need in the form and click the Calculate button to apply the changes throughout the array of copies. To edit the number of copies, grid spacing or any other aspect of the array copy operation, simply double-click the array copy toolpath item containing the source toolpaths. Edit and recalculate in the usual way.

**The Array Copy Toolpath Cut Sequence**

By default the array copy toolpath will cut all of its source toolpaths in the order they are specified in the Toolpath List. All the toolpaths in each array copy within the grid will be cut before moving on to the next grid copy. If, however, the **Minimize tool changes** option is turned on, then every effort is made to reduce the number of tool changes (whilst still maintaining the toolpath list cutting order) for the whole array.

As an example let’s assume that we have three source toolpaths forming our array: A, B and C. A and B use the same tool, but C uses a different tool. We create a 2 by 2 array copy toolpath resulting in 4 copies of the source toolpaths in total.

Initially the array copy is created without the **Minimize tool changes** option selected. Previewing the resulting array copy toolpath will demonstrate that the toolpaths are cut per copy in the order they are listed i.e. the sequence will be ABC ABC ABC ABC. In other words, all the toolpath strategies are cut for each copy completely before moving on to the next copy. Because the tool required for C is different than for A and B then each copy will require the tool to be changed and for the whole sequence this will result in 7 tool changes as you move from copy to copy.

If the array copy is re-calculated with the **Minimize tool changes** option selected then a toolpath preview will reveal a different sequence. Now the example array will be cut AB AB AB AB C C C C. The C toolpath, requiring a different tool, is now cut separately. You will note that this now means that only one tool change will be required to cut the whole set of copies.

**Saving an Array Copy Toolpath**

As far as possible, array copy toolpaths are saved in exactly the same way as other toolpaths except that each source toolpath in the list represents all of its copies. If you switch off the visibility of a source toolpath before saving, none of the copied instances of that toolpath will be included in the saved toolpath. Therefore you can use the visibility controls to save a toolpath that will cut all of the copies, but limited to a particular subset of the source toolpath types.

In general, the sequence of cutting will be to cut all of the included toolpath strategies for each copy in the grid before moving on to the next copy.

**IMPORTANT:** If the array copy toolpath contains more than one source toolpath using the same tool, then the sequencing within the array copy toolpath as a whole can be affected by the **Minimize tool changes** option setting when it was first created.
Calculated toolpaths can be previewed to see exactly what they will produce when cut into the material. The 3D preview mode also allows the job to be viewed in different material types with the option to paint the machined regions with a Fill Color.

Material and Rendering Settings

The pull-down list offers a range of material types to shade the 3D model. The first entry in the list is ‘Use Solid Color’ and if this is selected the color for the material can be selected from the color picker form.

See Adding Custom Materials below for adding your own materials.

Machined Area Color...

Material Color

With this setting, the areas of your preview will simply be colored using the material defined above. Effectively this switches off independent material settings for your machined areas.

Global Fill Color

Paints all the machined regions with the selected color. Selecting the associated pull-down list opens the default color selection form. Click on one of the preset colors, or click More Colors... to create a completely custom color.

Toolpath Color

If this option is selected, each toolpath can have a different color assigned. If the ‘No Fill’ option is selected from the color picker form, the current toolpath will be shown in the material color.

Animate preview

This option will show the material being removed by the cutter as the preview is drawn.

Draw tool

This option will show a wireframe animation of the tool (to scale) cutting the job.

Toolpath Preview Tools

Preview Toolpath

This option animates the selected toolpath cutting into the material

Preview Control Simulation

The preview controls provide full video-like playback control of your toolpath. You can use this mode to analyze the tool moves in detail, step-by-step. To begin using Preview Control, click on either the Run, Single Step or Run to Retract buttons.

The Preview Control buttons are summarized below:

- **Run** Begins Preview Control simulation
- **Pause** Temporarily halts the tool in its current position and enables the Stop button so you can exit Preview Control mode
- **Single Step** Moves the toolpath on by one tool move.
- **Run to Retract** Runs the toolpath to the next retract move, then pauses the tool.
- **Stop** Exits Preview Control mode.
Note: To cancel the process of previewing a toolpath using Preview Control, first click the Pause and then the Stop buttons.

Preview All Sides

This option animates all calculated toolpaths cutting into the material on both sides if working in a two sided environment without being in the 'Multi Sided View' mode (This option will be grayed out if working in a single sided setup)

Preview All Toolpaths

This option animates all calculated toolpaths cutting into the material

Preview Visible Toolpaths

This command allows you to identify a subset of toolpaths to be simulated, quickly and easily:
Isolate the toolpaths you wish to preview by un-ticking the visibility checkboxes of the other toolpaths in the Toolpath List.
Verify that the 3D View is only displaying the toolpath previews of the toolpaths you are interested in.
Click Preview Visible Toolpaths to begin the simulation.

Delete Waste Material

If a profile toolpath is calculated the excess material around the edges of the job can be automatically removed to show the finished job.

Reset Preview

Resets the material back to a solid block

Save Preview Image

Saves an image of the 3D window as a BMP, PNG, JPG or GIF file

Note: Saving the image as a PNG without the Color Shaded Background is often useful when the image will be used on its own in a brochure or on a web site etc.

Adding Custom Materials

Additional materials can be added to the library list by simply copying an image file (JPG, BMP or TIF) of the material or image you wish to render the job with into the Textures folder within the 'Application Data Folder'. You can open the Application Data Folder from within the program using the File ► Open Application Data Folder menu command. The location of this folder is different on different operating systems, but as an example for \ProgramData\Vectric\VCarve Pro must be restarted when new materials are added.

Shading textures can be obtained from sources such as the internet, clipart libraries or simply create your own from a digital or scanned photographs. For good quality results the image needs to be approximately 1000 pixels x 1000 pixels. The texture image is simply scaled proportionally in X and Y to fit the longest side of the job.

Multi-Colored Toolpath Preview

When previewing the effects of each toolpath it is possible to assign different colors to each one. This can be used to simulate the effects of differently painted areas both as a way to verify what is being cut by the toolpaths and also to provide an image than can be emailed or printed for customer approval.
The different colors can be set from the Preview Toolpath form - this appears automatically when a toolpath is calculated or can be accessed anytime by clicking the bottom, left icon in the Toolpath Operations area of the Toolpath Tab.

When this icon is clicked (or immediately after a toolpath is calculated) then the Preview form will be shown. The options for defining the fill color are contained in the Machined Area Color area of the form:

### Solid Material Color

Before the individual toolpath color fill is covered it is worth pointing out another feature within the preview form. There is the option at the very top of the Material List to select a Solid Color for the surface of the part. Once this is selected the color choice can be made from the drop-down Solid Material Color area. This allows material with a different solid color surface and core to be easily represented.

### Machined Area Color

#### Use Material Color

Checking ✓ this option will use the same color/material for the fill as you have selected for the material itself.

#### Use Global Fill Color

Checking ✓ this will use the same single fill color for all toolpaths.

#### Use Toolpath Color

Checking ✓ this will let you select different colors for each toolpath in your list.

To set the color individually, first select the toolpath from the Toolpath List and then click on the drop down arrow next to the color block to show the form.
Choose the color you want for the fill of that toolpath and it will be applied to the areas that the toolpath has carved when they are previewed. Once you assign an individual color a small square of that color will be displayed next to the name in the toolpath list. This can be seen top left of each tool icon.

If you click the option at the top of this form where is says No Fill then this will leave that toolpath in the selected Preview Material Color.

**Set All**

Clicking the Set All button will set all the toolpaths in your Toolpath List to the currently selected color. ONLY click this if you want to change all toolpaths to have the same color as you cannot undo this operation.

**Using the Multi Colored Toolpath Preview option with 3D toolpaths**

When assigning an individual color it will be applied to the whole toolpath. If you are cutting a part in VCarve Pro with a number of 3D shapes in it you would only be able to assign different colors to them if they were cut with individual toolpaths. In most cases with 3D parts it would probably be better to create a multi-colored image for a customer by shading the components and saving an image of the 3D model than trying to assign different colors to the toolpath preview. This will also allow the use of not just solid colors but the materials for the different parts.

It is worth repeating with regard to the 3D toolpaths that there is the ability to select the No Fill option from the color choice to keep the toolpathed area in the same finish as the material surface.
Estimating Machining Times

This option estimates the machining times for all calculated toolpaths based on the feed rates specified for each tool. The estimates for individual toolpaths plus the overall machining time of all visible toolpaths are calculated using the user defined Rapid Rate moves and Scale Factor.

Times

The estimated machining times are displayed in Hours: Minutes: Seconds

Rapid Rate

The maximum feed rate at which the machine runs for rapid moves, typically specified using a G0 or G00 move

Scale Factor

The nature of different styles of toolpaths means that they may be simple 2D cuts or require simultaneous 3-axis moves, the more complex the toolpath then the more chance the CNC machine may not actually achieve the programmed feed rates. This can be compensated for by multiplying the times by the Scale Factor.

The inaccuracies generally come from the acceleration / deceleration of the machine. If the program tells a machine to move at 200 inches / min along a 200 inch straight line the machine will probably take pretty close to a minute.

If instead of a straight line we ask the machine to cut say a gear wheel with a total circumference of 200 inches, the machine is likely to take considerably longer. This is because the machine will have to slow down to go around the tight curves of gear tooth profiles and will probably never reach its programmed speed before having to slow down again for the next change in direction.

The scale factor in the program lets you approximate this slowdown for your machine, but it will vary depending on the type of work you are doing. Many people will use one scale factor for simple 2D work and another for 3D or VCarving. The best way to calculate it is just to take a note of estimated and actual machining times of a period of time.

If a job actually takes 6 minutes to cut and the estimate was 3 minutes, the scale factor would be set to 2 (actual time / estimated time = 6/3).

For machines where the controller provides an estimated machining time, these should be more accurate as the controller can determine where the machine is accelerating / decelerating and take account of this.

Note: The information displayed on the form for each toolpath can be selected, copied and pasted into another document.
Using the Toolpath Tiling options it is possible to machine objects and designs that are many times larger than the available area of your CNC machine bed. This process is also invaluable if the maximum size of your material pieces are limited. In both cases, a much larger project can still be achieved by breaking the toolpath down into manageable tiles or strips, each of which can fit within the machinable area of your CNC machine, or on the available material blocks. Once cut, the tiles can then be re-assembled to form the finished piece.

The process of tiling begins by creating toolpaths based on the final object entirely as normal - at this stage you do not need to take any account of the available machining bed size. Once you have calculated required toolpaths, click on the toolpath tiling button in the toolpaths pane to open up the toolpath tiling form.

### The Toolpath Tiling Manager

The toolpath tiling form will 'split' the full-size toolpaths into a number of discrete, but precisely aligned, toolpath tiles as soon as you click the Update Tiles button. Any toolpath arcs spanning a tile boundary will remain as arcs after tiling.

While the Tile Toolpaths mode is enabled (using the checkbox on this form) any toolpaths that you save will automatically be divided into tiles.

The top section of the tiling form allows you to set the type of tiling you require (see below for more information) and the appropriate settings for each tiling strategy.

The lower section of the tiling form allows you to select and activate each of the tiles. The currently active tile can be previewed in either the 2D or 3D View.

### Tiling Options

There are three layout strategies for tiled toolpaths, the most appropriate one will depend on your machines capabilities and the available material.

#### Individual Tiles

The first tiling option is for individual tiles. This splits the current job in both X and Y, to form a series of entirely separate toolpaths. This is generally the preferred option if you have independent pieces of material to machine, or if you have a moving-bed type CNC machine that will not allow you to 'overhang' material outside of the machinable area.

With this option selected, you are asked to specify the width and height of each tile, and the required overlap (which will be applied in each direction). Tiles are created from the bottom left of your model. The overlap for independent tiles is particularly important for 2.5D toolpaths that utilize the shape of your tool bit (such as V-bit carving). 2.5D toolpaths will need to 'overrun' the edges of your tile in order to complete their cuts using the side of the bit. For this reason, the overlap distance for Independent Tiles will typically need to be at least equal to the radius of your tool bit.

#### Feed-through in X or Feed-through in Y

Instead of cutting a series of individual pieces of material and assembling them later, it can also be convenient to cut a single strip of material using a series of set-ups - moving the material through the machinable area between cuts. VCarve Pro specifically supports this technique using the Feed-through in X/Y options. In these cases you will only need to define either the Tile Width or Height (which corresponds to your intended feed-through distance), as the other dimension is assumed to correspond to the shorter side length of your material and will match the equivalent current job dimension. Similarly, the overlap distance is only applied in the direction of the draw-through. Because you will typically be cutting the same piece of material with each toolpath tile, the overlap distance for Feed-through is not as critical as for Individual tiles and is typically used to allow for a margin of error in your set-up accuracy.

Once you have set your tiling option, click the Update Tiles button to see your settings reflected in the Tile Previews in either the 2D or 3D Views.

### Tile Previews

The 2D View indicates how the model area is split into tiles. The yellow lines indicate the tile sizes, but the light red areas also indicate the overlap region for each tile. You should pay particular attention to the fact that this overlap can take the toolpath outside of the tile boundary - this is necessary to ensure that 2.5D toolpaths, in particular, form the correct shapes at the tile edges.
An independent toolpath tile preview in the 2D View. The light red areas indicate the current overlap settings for this tile.

This image shows the same toolpath tile’s 3D preview, positioned relative to the machining origin. You should note that the tool will machine negative, as well as positive, relative to its origin in this case. You must allow for this necessary effect when setting up your material and origin for machining.

When you come to machine these tiles you should take care to allow for the overlap distance when setting your machining origin on your material. Internal tile toolpaths can machine negative, as well as positive, relative their origin.

The currently active tile can be set directly from the 2D View by double-clicking on the background of one of the indicated tile regions.

Simulating Tiled toolpaths

You can also view and simulate individual toolpath tiles in the 3D View. To view the toolpath tiles, simply ensure that the toolpaths are visible (checked ✓ in the Toolpath List) and then select the tile you wish to see either from the Tile Toolpaths form, or the 2D View (see above).

Since tiles are created so that they will all be cut within the same machinable area (i.e. they are all located in a similar position relative to the machining origin), this can make them difficult to visualize using Preview Toolpaths. Simulating each toolpath tile in its absolute position will result in the toolpaths being cut in the same region of your preview block and they will overcut the same area. The Tile Toolpaths form has an option Draw toolpaths in original position for visualization to allow you to simulate the tiles as if they were arranged in their final pattern. With this option enabled, you can visualize how your final piece will look by previewing all your toolpath tiles together, but you should note that it will not reflect the true offset of each toolpath from your machining origin.

Saving toolpath tiles

Provided you have created toolpath tiles using the Tile Toolpaths form, an additional option, Output Tiled Toolpaths, will be available in the toolpath saving form.

It will be checked ✓ or unchecked to match the current state of the Tile Toolpaths check box in the Tile Toolpaths form.

Note: If the Output Tile Toolpaths option is grayed-out this means that no tiles have been created. You will need to close the Save Toolpaths form and use the Tile Toolpaths form to create the toolpath tiles before continuing.

Create Job Sheet

See Also:
- Example Output

Job sheets contain a summary of the information you will need when you come to run the toolpaths for your project at your CNC machine. VCarve Pro will create a self-contained HTML document that can be viewed using most web browsers, including Internet Explorer, Chrome or Firefox. To create a job sheet for a given project, simply select Create Job Sheet from the Toolpaths menu and then select a filename and location to save the document. If your job contains multiple sheets, VCarve Pro will automatically create a Job Sheet for every sheet that contains toolpaths. If you are working on a two sided job you will need to create a job sheet for both sides by simply switching between the sides and selecting the create job sheet icon, when you save the .html file the software will automatically add “_Top” or “_Bottom” to the name to differentiate between the two sides once the file has been saved.

Note: If you wish to automatically open the Job Sheet after creation, simply hold down the CTRL key on the keyboard as you select the Create Job Sheet option from the menu.

Each job sheet document comprises the following information:

Job Layout

A thumbnail image representing the vectors on your current job / sheet, surrounded by an outer rectangle representing your material size.

Material Setup

A summary of the important pieces of information you will need to correctly position and datum your work piece at your CNC machine. This includes the dimensions of the material block used within VCarve Pro to create and simulate your toolpaths. The home position from which your machine will start and return to. The clearance above the material for any rapid moves between plunges. For Two Sided Jobs you will also be displayed which side the setup sheet belongs to (top or bottom) along with the flip direction.

Toolpaths Summary

A summary of each of the toolpaths in the file, including the name of the toolpath, the tool required and an estimate of how long it will take to cut.
Toolpaths List

Details of each toolpath, including feed and plunge rates plus the intended spindle speed.

Job Setup Sheet

2-Sided_Machining_Getting_Started

Job Layout

Material Border

<table>
<thead>
<tr>
<th>Material Block:</th>
</tr>
</thead>
<tbody>
<tr>
<td>(X):24&quot; (Y):5.5&quot; (Z):0.5&quot;</td>
</tr>
</tbody>
</table>

Material Setup

**Job Type:** Double Sided

**Side of Material:** Top

**Flip Direction:** Horizontal

**Material Block:**

(X):24" (Y):5.5" (Z):0.5"

**Home / Start Position:**

X:0" Y:0" Z:1.5"

**Datum Position:**

Z-Zero: Top of Material

XY: Bottom Left Corner

**Clearance Z1:** 0.3" 

Toolpaths Summary

**Toolpaths:** 3

Horizontal Pockets

Vertical Pockets

Dowel Holes

**Tool Name:**

[1] End Mill (0.25 inch)

[1] End Mill (0.25 inch)

[1] Drill (0.250")

**Time Estimate:** 00:05:49

00:00:42

00:04:55

00:00:12

Toolpath: Horizontal Pockets

**Tool Info**

**Tool Name:** End Mill (0.25 inch)

**Tool Type:** End Mill

**Tool Number:** 1

**Max Cut Depth:** 0.125"

**Pass Depth:** 0.125"

**Stepover:** 0.1"

Toolpath: Vertical Pockets

**Toolpath Info**

**Time Estimate:** 00:04:55

Toolpath Type: Pocket Toolpath

Feed Rate: 100 inch/min

Plunge Rate: 30 inch/min

Spindle Speed: 12000

**Tool Info**

**Tool Name:** End Mill (0.25 inch)

**Tool Type:** End Mill

**Tool Number:** 1

**Max Cut Depth:** 0.125"

**Pass Depth:** 0.125"

**Stepover:** 0.1"
Tool Name: End Mill (0.25 inch)
Tool Type: End Mill
Tool Number: 1
Max Cut Depth: 0.25"
Pass Depth: 0.125"
Stepover: 0.1"
Toolpath: Dowel Holes

Toolpath Info
Time Estimate: 00:00:12
Toolpath Type: Drilling Toolpath
Feed Rate: 3.123 inch/sec
Plunge Rate: 1 inch/sec
Spindle Speed: 12000

Tool Info
Tool Name: Drill (0.250"
Tool Type: Drill
Tool Number: 1
Max Cut Depth: 1"
Pass Depth: 0.25"
Stepover: 0.025"
Saving Toolpaths

This option allows toolpaths to be saved in the appropriate file format needed to drive the CNC machine. Toolpaths can be saved as individual files for each tool used or as a single file containing multiple toolpaths for CNC machines that have automatic tool changers.

Individual Toolpaths

CNC machines that require the tooling to be changed manually will typically need a separate toolpath for each cutter used. The procedure for saving this type of toolpath from VCarve Pro is to:

1. Select the toolpath to save from the Toolpath List
2. Click on the Save option and the Save Toolpaths form is displayed.
3. Select the correct Postprocessor for the CNC machine from the pull-down list
4. Click the Save Toolpath(s) button
5. Enter a suitable Name and click the Save button

Note: When multiple toolpaths are created using the same tool geometry and tool number, they can be saved into a single file by selecting the option to - Output all visible toolpaths to one file.

Automatic Tool Changing Support

CNC Machines that have Automatic Tool Changing (ATC) capabilities can work with a single file that contains multiple toolpaths, each having a different tool number.

The postprocessor must be configured to support ATC commands for your CNC machine. Contact your software or machine supplier for more details.

The procedure for saving these toolpaths is,

Use the Up and Down arrows to order the toolpath list in the cutting sequence required.

Tick each toolpath to ensure it is drawn / visible in the 3D window as shown:

Click on the Save option and the Save Toolpaths form is displayed. Select the option Output all visible toolpaths to one file

The names of the toolpaths that will be written into the file are displayed along with the tool number in square brackets [1]. If a calculated toolpath is not required, simply tick to undraw it.

Click the Save Toolpath(s) button Enter a suitable Name and click the Save button

Error Messages

The postprocessor automatically checks to ensure:

- It has been configured for saving files that include ATC commands
- A different tool number has been defined for each different cutter being used.

An error message will be displayed to indicate the problem if either of these items is not correct.

VTransfer

VTransfer is a small helper application provided by Vectric to simplify the process of sending toolpaths to some grbl-based controllers. You should run VTransfer on the PC to which your CNC machine is connected via a USB serial connection. If your Vectric CAD/CAM software is also running on the same PC, you can use Direct Output mode to send toolpaths to VTransfer directly, without the need for file saving or loading.

As well as streaming toolpaths, also VTransfer provides the commands you need to initiate basic homing, jogging and setting of origins on your CNC machine before a toolpath is run.

Please Note: VTransfer has been created specifically for streaming toolpaths to a pre-configured controller. It expects that your controller is correctly set-up and tested for your hardware. VTransfer will not set, alter or validate your controller’s parameters in any way and is not intended to be used for lower-level controller configuration.
Getting Started

Before starting VTransfer, you need to ensure that your machine is powered on, any required drivers are already installed and the machine is accessible via a serial port (COM port on Windows). For most machines connected by USB, you will need to have installed the appropriate device driver for your machine controller. These drivers will be provided by your machine tool supplier and you should verify that your CNC machine connects correctly to your PC before attempting to use VTransfer.

When the machine and drivers have been installed correctly, refreshing and checking the drop-down Connect On list will show your machine tool controller. VTransfer will still need to know the specific communication protocol required though and the first time you use VTransfer, you will need to complete some one-time set-up and configuration.

Once set-up for a machine that remains connected to the same USB port of your PC, VTransfer should automatically detect and connect each time it starts-up. However, you will need to

Initial Set-up

Once this initial set-up has been completed, VTransfer should automatically detect and connect to your machine on start-up, provided the machine remains connected to the same USB port of your PC. Before connecting to your machine for the first time, however, you should complete the following steps to set the right controller type and machining configuration.

- Select File -> Settings from the main menu to open the Settings dialog.
- Make sure that your controller is selected in the Controller Name drop-down list (for a grbl version 1.x controller this will be Grbl, for example).
- Select the correct configuration file for your machine, or create your own.

Controller Connection

- Make sure that your machine is connected to the PC via USB and it is powered on.
- Click the Refresh button to regenerate the Connect On drop-down list with all of the detected devices connected to your PC.
- Select your controller device from the list - note that this may be the name of the microcontroller on which your controller is running, rather than the controller name itself (grbl may appear as Arduino UNO, for example).
- Check that the Machine Status reported by VTransfer reads Looking for... followed by the expected controller name.
- Machine Status will change to Connecting while VTransfer attempts to verify the controller is communicating as expected.
- Once correct communication has been established, the Machine Status will change to Initialising, Alarm or Ready depending on how your machine is configured.

Running a toolpath

- Once connected to your CNC machine, the typical steps for running your first toolpath using VTransfer are:
  - Open the Jog Tab.
  - If your Machine Status is Start Homing Sequence or unlock your machine (if supported and configured).
  - Load your toolpath file or send one to VTransfer via Direct Output.
  - If required, jog the machine to the location of the material on your CNC machine (to match the relative origin point of your toolpath) and set the XY Origin Here.
  - Fill the required tool.
  - Either run the Z Touch Plate cycle (if supported) to set Z Zero to match your toolpath.
  - Or manually jog the tip of the tool to the material surface or machine bed (again to match the Z Zero setting of your toolpath) and set the Z Origin Here.
  - Ensure the spindle is on (if it is not controlled automatically).
  - Open the Cut Tab - Click Cut Now!

Sending a toolpath directly to VTransfer from your Vectric software

At the point of saving your toolpath, some post-processors support the option of Direct Output to VTransfer (such as the Emblaser or X-Carve). If you have one of these post-processors selected, the Output direct to machine checkbox will be enabled below the post-processor selection box. With this box checked, Save Toolpath(s) will change to Output Toolpath(s) and clicking this button will automatically send the toolpath to VTransfer. If VTransfer is not already running, it will launch automatically.

Whenever a new toolpath is loaded or received by VTransfer, it will prompt you with a message box.
Homing, Jogging and Origins

Before running your toolpath it is essential to set your machine’s origins appropriately. The specific process you need to use will, to a large extent, will be determined by your machine and its configuration. Generally you will need to home your machine (if supported) and set the X Y origin to match the intended toolpath and location of the material on your machine’s bed. You will also need to fit the correct tool and typically set the tip of this tool to be at Z Zero, either at the top or bottom of your material - again this choice will already have been determined when your toolpath was created. The commands relating to these actions are all available from the Jog tab.

Whenever VTransfer changes its origin settings you will be prompted with a message box.

Start Homing Sequence

Click this button to initiate the homing sequence. The homing sequence will culminate in setting the origins of your machine using its homing switch locations and the machine’s machineable area - both of which are set in the configuration. For some controllers (such as grbl) you will typically be required to run this command before you can do anything else because the machine will start-up in a disabled Alarm status.

Note: This button is only available if your machine is configured with homing switches and homing is enabled.

Z Touch Plate

This button will be visible if your machine is configured with a touch plate, touch plate support is enabled and its thickness is set in the configuration settings. Click it to initiate the Z touch plate probing cycle. Make sure that the touch plate is in position and correctly functioning before clicking this option as it will immediate begin a plunge move.

Warning: Make sure that the touch plate is in position and correctly functioning before clicking this option as it will immediately begin a probing plunge move.

Jogging

The +Y, -Y, +X, -X, +Z and -Z buttons will each jog the machine along the Y, X or Z axes, respectively.

The distance moved by each button click is determined by the current value (in mms) shown in the drown-down control at the center of the jogging buttons. Ensure that you adjust this value appropriately before using the jog buttons to move the machine.

Note: If the selected configuration for your machine has a Z travel value of zero, this indicates that the machine does not have a Z axis - this is the case for most laser cutters - and Z axis controls will not be visible.

Setting and Resetting Origins

By default a machine with homing support will have its X Y origin (the position of the coordinate X:0 and Y:0) set to the bottom left corner of machine’s machineable area following a homing cycle - i.e. the machine will operate in a positive coordinate work space within its machineable area. For machines without homing support, the initial X Y origin must always be set manually before running a toolpath. In addition, when a toolpath is created it is very common that the X Y origin will actually be chosen to be relative to the material (not the machine bed) - for example, the center of a design may be used. For most toolpaths, therefore, you will need to jog the machine to the matching origin location for the toolpath (relative to your material), and manually set the X Y Origin Here before cutting.

For machines with homing support, you can restore the bottom left corner origin after setting it for a specific toolpath by clicking Reset Default Origin at any time. When this button is clicked the location of coordinate position X:0, Y:0 will once again be set to the bottom left corner of the machine’s machineable area.

Running the Toolpath
The Cut tab contains the controls need to begin cutting your toolpath and monitoring its progress.

**Cut Now**

When your machine is correctly set-up (with the X,Y and Z origins set), click this button to begin streaming the toolpath to your machine and begin cutting.

**Warning:** Make sure your machine spindle is **on** before clicking this button if your spindle control is manual.

**Estimated Time Remaining**

Once your toolpath has started, VTransfer will provide a dynamic estimate of the remaining time until the toolpath is finished.

**Dynamic Feedrate Override**

If your machine supports feedrate override control and the option is enabled in your configuration, then the + and - buttons will be available. Click these buttons to increase or decrease the current toolpath feedrate by 10%. The current state of the feedrate override setting is indicated by the percentage value between the two control buttons.

**Warning:** Depending on the nature of the toolpath you are running, there may be a delay of one or more seconds before your machine responds to the feedrate change so allow for this when using these controls.

**Abort**

This button will stop the toolpath as quickly as possible, usually resetting the controller in the process. Once a toolpath has been aborted you should re-home and re-origin before running a subsequent toolpath.

**Settings**
The 3D Clipart Tab

Integrated Component Clipart

The Clipart tab provides quick and convenient access to V3M files or 2D vector artwork.

This tab includes the library browser that allows you to add folders containing V3M Files into the software or you can use the local files option that allows you to quickly see the contents of several folders of V3M files in one place.

By default the Clipart tab can be found on the left-hand side of the VCarve Pro main window, alongside the Drawing, Modeling and Layers tabs.

The 3D clipart tab itself contains two tabbed pages: Local Files and Library Browser. You can swap between these pages by clicking on the page names at the top of the tab.

Note: It is possible to customize VCarve Pro's interface by undocking and repositioning its tabs. If your Clipart tab is not visible next to the Drawing and Modeling tabs, please refer to the Overview of the Interface chapter of the Manual for details on working with VCarve Pro's tabs.

Note: For CRV files that contain components, these components will not be imported into the new session - only the vectors will be imported.

To import a file as a piece of clipart you can simply double click its thumbnail to position the clipart in the center of the job. You could also Right click on a piece of clip art and choose the Import to Level option, this has a sub-menu that allows you to choose an existing Level or to create a New Level. When creating a New Level you will be prompted to enter a name and choose a combine mode. You can also click on a preview image and ‘drag and drop’ its thumbnail from the clipart browser, into the 2D or 3D View. To do this:

- Move your mouse over thumbnail image in the clipart browser.
- Press and hold down the left mouse button.
- While holding down the left mouse button, move the mouse back into the 2D or 3D View.
- A copy of the thumbnail image will be ‘dragged’ with the mouse pointer.
- Release the mouse button to ‘drop’ the clipart file into the 2D or 3D View.

The selected component clipart model or vector outline will be imported at the location of the dropped thumbnail and, if appropriate, added to your model's Component Tree. Depending on the relative size of your current VCarve Pro model and the piece of clipart you have imported, it may need to be resized to fit using the standard tools on the Drawing tab or directly using the transform handles within the 2D View.

Library Browser

The library browser provides quicker access to folders on your computer which are in frequent use, or perhaps hold the data for the current project you are working on.

To add a folder into your library click on the Add Folder button which opens up a dialog asking you to choose the folder you would like to add. Navigate through the tree to choose then folder and click OK. Unlike the Local Files browser the Library browser will only show the clipart that within this folder and folders within this folder. You will not be able to see the whole of the file tree beneath this folder.

Once you have populated your library with folders then clicking on a folder will populate the clipart browser with the objects which are contained in this folder and show you any subfolders immediately below it.

To better understand this, consider the following example: My current project is a western saloon themed sign. I have split up all the resources I am using for this creation into three folders, so that I have the following file folder structure:

- Western Saloon
  - Background Vectors
  - Toolpath Outlines
  - Decorative Components

Once I have added the Western Saloon folder to my Libraries it appears in the list of folders. When a folder is selected all its immediate subfolders are also shown, but only the immediate subfolders, notice that the Toolpath Outlines folder does not appear in the image below.
If a folder is selected and it contains clipart files then these are shown in the clipart window.

To remove a folder, select from the list of folders and click on the Remove Folder button. This will not delete clipart from your computer; it will just remove the library folder. Folders may be added to the library from the local file browser by right clicking and selecting the Add folder to library option.

Note: Under the Edit - Options drop-down menu there is a flag to set whether you Show the clipart subfolder contents if set to yes it will show the models in the current folder and also in up to 3 levels of sub-folder below that. If it is set to No it will only show files that are present in the currently selected folder.

Online Clipart

With your copy of the software you are entitled to a selection of free clipart. This clipart can be downloaded directly from the running software. The software comes with previews of the clipart you're entitled to. In order to get the latest entitlements, click the refresh button.

The Login Dialog will then appear and you may then be prompted to log in to your V&Co account to allow the software to access your clipart. Once logged in, your previews will be refreshed. These previews are displayed with an overlay to make it clear that they are not yet downloaded.

To download a preview,

- Right-Click the preview and click Download.
- Drag and Drop the preview onto the job directly. If the download is quick (which depends on the internet connection), the clipart will appear in the job like a normal clipart drag & drop. If it’s slower, you’ll get a notification when it’s done.
- Right-Click a folder and click Download to download a whole category. You will get a progress on the download in the status bar.

Note: Installers for the free clipart can also be used. These can be found with the installation media or within V&Co. Once the clipart is installed, it will appear as the usual local clipart in the software (i.e. without the overlay).

If it is desirable to view only the clipart that is currently downloaded, then the cloud button found above the clipart preview display toggles the visibility of the online clipart.

Login Dialog

If the refresh button is clicked and there is no currently authenticated V&Co account available a dialog will appear showing that the user is not currently logged in. Clicking Log In and Refresh will launch a web browser which will take you to the V&Co login page. Once logged in and the program has been granted access to clipart the web browser may be closed. After a short while the dialog will disappear and a refresh will start in the background with the contents of the clipart browser updating once this has been completed.
If the refresh button is clicked and clipart has already been authenticated then the “Logged In” status will be displayed on this dialog. Closing this dialog will cause a refresh to start in the background with the contents of the clipart browser updating once this has been completed. Clicking Log Out will sign you out of clipart access and stop new pieces of clipart being downloaded from the cloud until clipart has been re-authenticated.

Local Files

The local files browser allows you to select a folder using the file explorer tree in the top section of the page. When you select a folder containing Vectric files (*.crv or *.v3m) the bottom section of the page will fill with thumbnail images of the V3M or CRV files within each folder.

Integrated Windows Explorer Thumbnail Support

V3M files automatically include thumbnails. Windows Explorer can make use of these thumbnails to show you a preview of each file when you browse a folder. When browsing a folder containing V3M files in Windows, select Medium Icons or larger from the available options in the Change your view control, located at the top of the Windows Explorer view.

Drag and Drop

VCarve Pro supports Windows drag and drop functionality to quickly add V3Ms into an existing model directly from Windows Explorer.

With Windows Explorer and VCarve Pro both open, simply click and drag the V3M thumbnail of the file you want from the Explorer Window into either the 2D or 3D View window of VCarve Pro. The selected V3M file will be imported automatically and added to the Component Tree.
Vectors, Bitmaps and Component Grayscale’s can be assigned to different layers. All the objects assigned to a layer can then be simultaneously selected, labeled, colored, temporarily hidden or even locked (to prevent accidental editing) using the Layer Management tools. Even for relatively simple designs, organizing the elements of your artwork onto layers can make managing your project much easier.

There are no specific ‘rules’ on how to use the layers - there are many ways to organize your design and these are likely to vary between individuals and even between different jobs. The ‘meaning’, therefore, of the layer organization in any particular project is entirely flexible. Some common examples of layers include:

1. Organizing artwork according to the toolpath strategies to be created.
2. One layer for shapes to be profiled, one for those to be pocketed, one for drilling etc.
3. Coloring different parts of the design to reflect different parts of the finished piece.
4. Hiding or locking geometry used as guides or temporary stages in the construction of the final design.

Layers can be particularly useful to organize the Grayscale Previews of 3D Components. Because 3D Components are often positioned on top of one another (to build up the required 3D shape), it can become awkward to see or select components that are underneath others. Component grayscale Previews can be placed on layers and hidden temporarily while the design is built.

**Note:** Switching off the visibility of Component grayscale Previews using layer visibility does not affect the associated 3D Component.

### Managing Layers

You can access the tools needed to manage layers from two locations: the Layer Control on the View Tool Bar, and the Layer List on the Layers tab.

#### The Layer Control on the View Toolbar

A Quick Access Layer Control is conveniently located above the Views in the View Toolbar. This tool provides a pop-up Layer List, from which you can quickly change the selection of the active layer, add a new layer, or modify the properties of any existing layer. When you have finished, click anywhere outside of the Layer List window and it will cause it to close.

#### The Layers Tab

To get a complete overview of the current layer structure of your artwork while you are working, or to carry out more extensive organization of the layers, you can also use the Layers tab. The Layer List is identical in both the Layer Control and the Layers tab, but the latter can control layer ordering and be left visible, pinned or even undocked, while you continue to work on the artwork itself.

The Layers Tab makes it very easy to work with complex designs giving quick access to all of the layer control options.

From this tab you view all the layers in your current job and modify their properties (such as visibility and color). You can also create, delete, re-order or rename them.

Most of the commands associated with layers can be accessed by right-clicking a layer in the list, or by clicking on the Pop-Up Menu icon to the right of the layer name.

#### List Item Command and Icons

Each layer in the list has five elements:
Status Icon

The leftmost icon indicates whether the layer is currently visible or hidden. Click on this icon to toggle the visibility of the layer.

The presence of a padlock shows that the layer is locked and cannot be accidentally edited. Right-click the layer in the list and select the Unlock command to alter this.

Layer Color

The color swatch can be used to color all the vectors on a layer. Click on the swatch icon and select a pre-set color from the color selector dialog, or choose More Colors... to create an entirely custom color.

Layer Content

The layer content icon will be grayed-out as an additional indicator that the layer is not currently visible. A blank white sheet indicates that the layer does not currently contain any objects or vector geometry. If you import files from 3rd party CAD drawing packages via DXF or DWG format it is common for the file to include empty layers. This icon allows you to identify these empty layers and delete them.

Note: To delete a number of layers in one go, first hide all the layers you want to keep then use any layer’s Pop-Up Menu icon to select the Merge Visible command. All the visible layers will now be merged into a single layer, which can be deleted with a single operation.

Layer Name

To change the name of a layer, you can double click on this part of the layer item in the list to trigger in-situ editing. This works in the same way as file renaming in Windows Explorer. Alternatively you can right-click or use the layer’s Pop-Up Menu icon to select the Rename command.

Note: Imported images are automatically placed on a layer called Bitmap Layer. This allows images to quickly and easily be turned off in the 2D view when they are not required. The images can also be moved onto another layer if required.

Pop-up Menu

Click the pop-up menu icon for access to Activate, Lock, Insert, Delete and Merge layers as well as further ways to choose which layers to show and hide.

Additional Buttons and Icons

Show All / Hide All

The visibility icon to the left of the Layers List heading at the top of the Layers Tab will toggle the visibility of all the layers in the list. If there are both hidden and shown layers, this icon is shown as a dim lamp. Clicking the dim lamp will show all layers and change to icon to a lit lamp. Clicking the lit lamp will hide all layers and change to icon to an off lamp.

More options for setting the visibility of multiple items are available from the Pop-Up Menu for each layer under the Show and Hide menu headings.

Select All on a Layer

Double-clicking on a layer in the Layers List will select all the objects on that layer. Alternatively you can choose the Select Layer Vectors command from the layer’s pop-up menu.
Layer Ordering Arrows

Adjacent to the Layers List heading label are two arrow buttons. These move the selected layer up or down in the Layers List. This can be important to set the drawing order of objects that might otherwise obscure one another (specifically Bitmaps and 2D Component Previews). Objects on the top layers in the list are always drawn before objects in the lower layers and will, therefore, be 'underneath' them in the 2D View. You can use the Layer Ordering Arrows to resolve this issue.

Add New Layer

New Layers can be added using the Add New Layer button. Alternatively a new layer can be created directly from the 2D View by right-clicking an object and selecting either the Copy to Layer ► New Layer... or Move to Layer ► New Layer...

The dialog for adding the new layer is displayed with options to specify the name and color of the vectors on the new layer and an option to indicate if the new layer should be visible.

Layer Name

It is always preferable to take the opportunity at this stage to give your new layer a meaningful name relating to its content or purpose. Later on this name will make it easier for you to manage your layers as your design becomes more complicated.

Drawing Color

All the vectors on this layer will be colored according to this setting. This can be a very useful way of distinguishing between the vectors that are on different layers, directly in the 2D View.

New Layer is Visible

With this option checked, ✓ the new layer will automatically be visible as soon as it is created.

New Layer is Active

With this option checked, ✓ the new layer will automatically become the active layer and any subsequent vector creation or manipulation will occur on this new layer.

Insert New Layer

An even quicker way to add new layers is via the Insert Layer command from a layer’s right-click Pop-Up Menu. This command will create a new layer above the selected layer which will be visible, unlocked and colored black. After creation the new layer item’s name is ready to be immediately edited by typing a new name in.

Moving Layers

Objects on any layer can be moved onto another layer by right-clicking the object in the 2D View and selecting Move to Layer ► ... from the pop-up menu.

Program Options
The options fall into four categories:

1. **Window Layout**
2. **3D View Settings**
3. **Toolpath Settings**
4. **General Settings**

**Note:** Many of the choices in this dialog will not take effect until the software has been exited and restarted.

### Window Layout
- **Save Tab Layout**: Save the layout and the ‘pinned’ state of the command and toolpath fly out tabs.
- **Save Dialog Layout**: Save the size, position and visibility for dialogs such as the Layer control and Toolpath Control dialogs.
- **Save View Layout**: Save the layout of the 2D and 3D view windows.
- **Display Splash Screen**: Display the program Splash Screen, while the program is loading.
- **Top Side Ruler Color**: The colour of the ruler on the top side in a two-sided project.
- **Bottom Side Ruler Color**: The colour of the ruler on the bottom side in a two-sided project.

### 3D View Settings
- **Use Shaded Background**: Use a gradient shaded background for the 3D view.
- **Background Color**: Change the background color used for the 3D view.
- **Gradient Background Color**: Change the bottom (lightest) color used for the 3D view.
- **Draw Origin**: Draw the origin arrows by default on startup.
- **Print 3D View Shaded Background**: Include the shaded background when printing.
- **Animate Camera Moves**: Switch on/off animation in the 3D View when selecting View position from the Iso View, Down X, Down Y or Down Z icons.

### Toolpath Settings
Show Toolpath Operations with Preview
When the toolpath Preview form is visible, keep the 'Toolpath Operations' section visible (requires more screen space).

Auto Open 3D view
Automatically swap to 3D view after calculating a toolpath.

2D Solid Preview Color
Color used to draw the solid 2D toolpath preview with.

Create 2D Previews
Create 2D previews of toolpaths in 2D view.

Select Sheet When Edit Toolpaths
If a toolpath is associated with a sheet, select sheet when edit toolpath.

Toolpath Geometry Fixing Timeout
Number of seconds the program will spend trying to fix problems with geometry when calculating toolpaths.

Drop Tool
When projecting a toolpath onto the model, drop the tool on surface rather than project. If this is set, the toolpath will follow the surface of the model better, but could be slower to calculate.

2D Toolpath Tolerance
Tolerance to apply to 2D toolpaths after calculating to reduce file size.

3D Toolpath Tolerance
Tolerance to apply to 3D toolpaths after calculating to reduce file size.

VCarve Toolpath Tolerance
Tolerance to apply to VCarve toolpaths after calculating to reduce file size.

Note: We strongly recommend that the Toolpath Tolerance should be left at their default settings unless different values are recommended by your machine tool manufacturer. If you do have a machine which struggles with the default settings, try doubling the values and cutting a test-piece to assess the tradeoff between machining times, file size and final machined quality. We have done some limited testing and on a sample complex 3D model, increasing the '3D Toolpath Tolerance' to 0.001 inches gave a 40% decrease in file size and no noticeable difference in quality on the test machine and job. In the test case there was no measurable difference in machining time on the CNC machine the test was carried out on.

Maximum Toolpath Undo Stack Size (MB)
Maximum size in MB of Toolpath data undo stack for storing toolpath delete state.

General Settings

Use Graphics tablet
Switch on support for graphics tablet drivers, if installed - for use with the sculpting tool.

Process User Files
Enable/disable processing of files in the 'Vectric Files' folder in your common user document folder.

Recent File List Size
This sets the maximum number of items that will be displayed in the 'Recently opened files...' list in left hand side bar of the interface when there is no file currently loaded. The list will not increase in size until the software has been re-started and more files have been opened and/or saved.

Show the clipart Subfolder Contents
If set to Yes then this will show the contents within the selected Folder in the Clip Art browser along with up to 3 sub-folders if they exist and contain appropriate file types. If set to No it will only display the contents of the selected folder, not sub-folders.

Always open local documentation
Force open the local copy of the documentation when accessed through the Help menu. VCarve Pro automatically opens the local documentation if you have no internet connection or if the server is taking too long to respond.

Rulers, Guide Lines and Snapping

To help with drawing, construction and layout, the 2D View has Rulers which are displayed along the top and down the left side of the window. In addition to the Rulers there is the option to use Guidelines and The Smart Cursor to help with construction of vectors or positioning of other objects in the 2D View.

Rulers↓

The Rulers are permanently displayed in the 2D view to help with positioning, sizing and alignment. The graduated scale automatically uses the units set for the project and zooming in / out shows the sizes in 10ths.

←Guidelines

Guide Lines are used to help layout designs and make it very easy to sketch shapes by clicking on the intersections of Guides. Guide Lines are easily be added to the 2D view by pressing the left mouse button down on the appropriate ruler (left if you want a vertical guide and top if you want a horizontal guide) then holding the button down and dragging the mouse into the 2D view.

While dragging a Guide into position it automatically Snaps to the units displayed on the ruler. This snapping behavior can be overridden by holding down a Shift key while dragging the guide. After positioning a Guide it can easily be moved to a new position by clicking the right mouse button on the guide to open the Guide Properties form as shown later in this
section. If you hover the mouse over a Guideline then its current position is displayed next to the cursor.

Additional guide lines can be added relative to an existing guide line by interactively placing the cursor over an existing guide (the cursor changes to 2 horizontal arrows). Holding a Ctrl key and dragging to the required position. The incremental distance between the guide lines is displayed next to the cursor. Releasing a Ctrl key changes to display the absolute distance from the material origin.

Guides can also be added and other edits made by right clicking on the Guideline which will bring up the Guide Properties form:

The exact position can be specified by entering a New Position.

Guides can be given an angle by either entering an angle into the New Angle box or dragging the slider and clicking Apply. Angles are measured in degrees counterclockwise from the x-axis. From an angled guide you can only create relative parallel guides.

Guide lines can be locked in position to stop them from being inadvertently moved by ticking the Lock Guide option.

Additional Guide Lines can be added that are positioned using absolute or incremental coordinates. Enter the Absolute or relative positions and Click Create New Guide.

Guides can quickly be toggled visible / invisible by clicking in the Top Left Corner of the 2D view:

Alternatively the visibility can be changed using View Menu ► Guide Lines from the Main Menu. Guide Lines can be Deleted by selecting View Menu ► Guide Lines ► Delete All Guides from the Main Menu. Individual Guide Lines can be deleted by clicking and dragging them out of the 2D View Window.

**Snapping Options**

These options can be used to help create and edit vector geometry.

The Snapping Options form can be accessed by selecting Edit ► Snap Options from the Main Menu or by pressing F4.

**Display Text at Cursor**

Displays the XY coordinates on the cursor making it easy to see the position for each point

**Snap to Guides**

When this option is checked ✓ drawing and positioning vectors will snap onto any horizontal or vertical guide lines visible in the 2D view.

**Snap Guides to Geometry**

When checked, ✓ the Guide Lines can snap to Geometry while being dragged.

**Snap to Grid**

Displays a grid of points separated by the Grid Spacing which can be snapped to when drawing or editing vectors and other objects in the 2D View.

**Snap Distances**

Snap to fixed lengths based on your zoom level. This occurs when creating shapes, dragging nodes or vectors.

**Snap to Job Center and Corners**

Snap to the job corners and center. This, also, control the job smart snapping.
Fixed Nudge Distance

Objects can be moved small, fixed distances (nudged) by holding 

`Ctrl + Shift` and tapping the arrow keys. The 

**Fixed Nudge Distance** specifies the distance to move selected objects with each nudge.

Snapping Radius

The snap radius (pixels) will adjust how close the cursor must get to vector geometry in order to snap it. If you work quickly and grab and throw geometry at speed, you may prefer a larger Snapping Radius to pick up geometry that is vaguely near the mouse. If you work precisely or have complex overlapping geometry, you may prefer a smaller Snapping Radius to avoid having to zoom in to select one geometry in an area that has many nearby vectors.

Geometry Snapping

Used to control the position at which the cursor will snap when drawing and moving objects. When drawing, the cursor will snap to items on vector geometry depending what options you have selected in the form under this section.

Object centers, Span End points, Span Mid-points, Arc centers, intersections

Horizontally, Vertically and the specified Angle and Distance

Guide lines and the intersection of Guides

Smart Snapping

Smart snapping works by snapping the cursor to imaginary lines related to vectors and/or nodes. These lines will appear as dashed, and sometimes coloured, lines that go through the vector or node and the cursor point. You can snap to the intersection of those lines by hovering over the nodes that you’re interested in. This reduces the need to create construction geometry (for example, for aligning nodes or vectors), and can be used in almost all the shape creation tools, node editing and transforming vectors.

**Note:** A node is the start, middle, or end point of a span.

**Note:** The snapping system is watching to see which vectors you hover the mouse over. It remembers that last few vectors as the ones you want to work with and draws the snap lines for those as a priority. There is a maximum number of nodes and vectors that can be “woken up” at the same time to avoid too many snap lines appearing at once.

Snapping lines can be drawn from:

- Nodes that were woken up by hovering the mouse over them or their span
- Vector properties, such as their bounding box or center point
- Material properties, such as extensions from the edge and the middle

**Note:** It is possible to wake up vectors on the other side of a double-sided job.
Object Bounds

These snap lines appear on the bounding box edges of the vector, and in the middle horizontally and vertically.

Vertical and Horizontal Lines

Nodes
The snap lines appear when the cursor is near the horizontal or vertical line passing through the woken nodes.

Vectors
Snap lines become available while moving vectors so that it is used for aligning them with other vectors.

Tangents
These snap lines originate from the woken node and will appear as an extension along the end of the belonging span.
Perpendicular to Tangents

These snap lines will be 90° from the tangent snap line, and they both

Connecting Lines

If you wake two or more nodes, you could snap to the line connecting them. You could, also, snap to the mid-point of that line.

Span Geometry

This allows you to snap to the geometry of the vectors.
Angular Constraints

Job Edges & Centre

If you have the job snapping enabled, you could snap to the horizontal and vertical middle lines. This, also, includes the lines extending from the job's edges.

Toolbar Snapping Options

Geometry Snapping, Smart Snapping and Grid Snapping can be switched on and off from the View Toolbar.
Any change to the snap settings through the Main Menu or the toggles on View Toolbar will be remembered for subsequent sessions.

Disable snapping temporarily
Snapping can be temporarily disabled by holding down the Shift key.
Document Variables provide a mechanism for defining values that can be used in VCarve Pro. Document Variables. They can either be created in the Document Variables dialog (right) which is accessible under the Edit menu, or created from any Calculation Edit Box which supports variables by right clicking and selecting *Insert New Document Variable* from the Popup Menu.

**Naming Document Variables**

Right-click an edit-box to insert a new or existing Document Variable:

New Document Variable names must begin with a letter and then may consist of letter, number and underscore characters. Once created, they may be edited in the table beneath the New Variable section for the Document Variables Dialog.

Variables can be exported to a text file and imported into another job. When importing, any existing variable values with the same name will be replaced.

**Deleting Document Variables**

Variables may be deleted if they're not being used in any toolpath calculations but only when there are no toolpath creation forms open.

**Using Document Variables**

Once created a Document Variable may be used in any Calculation Edit Box by enclosing its name within a pair of curly braces as illustrated in the figure below.

Right clicking in a Calculation Edit Box provides a Popup Menu that provides shortcuts for creating new Variables and inserting existing variables into the Edit Box.

Once a Document Variable has been created from the Popup Menu it will be inserted into the Edit Box.
Accessing Document Variables

Declared Document Variables can be easily accessed from a calculation edit box. Right-click on the calculation edit box and you will be presented with a menu showing the document variables available currently, as well as an option to quickly insert a new document variable.
Numerical edit boxes generally support simple calculations. A sum can be entered directly into the edit box:

\[ \text{w/2} \]

Having typed an equation, pressing the \( = \) key will perform the entered calculation and fill the edit box with the answer.

### Special Calculation Characters

As well as the simple numerical calculations, such as \( 3 + (4/5) \), several of VCarve Pro's stored values can be accessed by using certain letters (which are not case-sensitive): When used, VCarve Pro substitutes the character with the appropriate value in the calculation.

<table>
<thead>
<tr>
<th>Character</th>
<th>Name</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>W or X</td>
<td>Material Width</td>
<td>w/2=</td>
<td>Half of the material width</td>
</tr>
<tr>
<td>H or Y</td>
<td>Material Height</td>
<td>H*2=</td>
<td>Twice the height of the material</td>
</tr>
<tr>
<td>T or Z</td>
<td>Material Thickness</td>
<td>t-0.25=</td>
<td>0.25 units less than the material thickness</td>
</tr>
<tr>
<td>P</td>
<td>( \pi ) (3.141593)</td>
<td>P*10^2=</td>
<td>Area of a 10 radius circle ((\pi r^2))</td>
</tr>
<tr>
<td>I</td>
<td>Imperial Conversion</td>
<td>25.4*i=</td>
<td>Converts 25.4mm to inches</td>
</tr>
<tr>
<td>M</td>
<td>Metric Conversion</td>
<td>2*M=</td>
<td>Converts 2 inches to millimetres</td>
</tr>
<tr>
<td>'</td>
<td>Feet</td>
<td>Z+10=</td>
<td>34 inches (2 feet and 10 inches)</td>
</tr>
</tbody>
</table>
Clicking on any of the options on the title bar (File, Edit etc.) will result in a drop-down menu appearing with choices related to that topic.

Many of these are just an alternative way to access functions also accessed through the icons. However, there are a few commands that are unique to the Drop Down menu. Each menu and its contents are discussed later in this section of the manual.

Only unique items which do not have an equivalent icon that has already been discussed in the manual will be dealt with in detail.

### File

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Creates a new VCarve Pro job.</td>
</tr>
<tr>
<td>Open...</td>
<td>Opens an existing VCarve Pro job.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the current file but leaves the software running.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the current VCarve Pro file over the last saved version of the file.</td>
</tr>
<tr>
<td>Note:</td>
<td>This command will overwrite the old file with any changes made since the last save. If you are not sure of your changes then use the File ⇒ Save As... command instead option and give the file a new name.</td>
</tr>
<tr>
<td>Save As...</td>
<td>Opens the standard File Save dialog so you can save the current file with a new name.</td>
</tr>
<tr>
<td>Increment and Save</td>
<td>The increment and save operation allows you to automatically number iterations of files you are working on. If you select this operation when editing a file which ends with an underscore, or a hyphen followed by a number, then the number will be increased by 1 and the file will be saved using this number. For example, MyFile_1.crv3d becomes MyFile_2.crv3d MyFile-1.crv3d becomes MyFile-2.crv3d</td>
</tr>
<tr>
<td>Note:</td>
<td>The increment and save option will keep incrementing until it finds a file that does not currently exist. It will not overwrite an existing file.</td>
</tr>
<tr>
<td>Print</td>
<td>Opens the Print Setup box to Print your design.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Displays a Preview of the design to print.</td>
</tr>
<tr>
<td>Print Setup</td>
<td>Opens the Print Setup box to Print your design.</td>
</tr>
<tr>
<td>Import...</td>
<td>Import various entities into the job.</td>
</tr>
<tr>
<td>Export...</td>
<td>Export vectors from the job.</td>
</tr>
<tr>
<td>Open Application Data Folder...</td>
<td>Opens the Windows folder where files used by the software are stored. This is useful for adding to the default files installed initially. Application files include: Bitmap textures for creating custom materials. Gadget scripts for customized automation of the software. Postprocessors The Tool Database Default toolpath strategy settings Vector texture files.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the job and exits the software.</td>
</tr>
</tbody>
</table>

### Import

- **Import Vectors...** Import Vector data.
- **Import Bitmaps...** Import Bitmap data
- **Import Component / 3D Model...** Import 3D Model or Component
- **Import PhotoVCarve or Cut3D Toolpaths...** Import a toolpath file created in another Vectric application, such as, Cut3D or PhotoVCarve.

### Export
**Printing and Print Preview**

The contents of either the 2D or 3D view can be printed using the Print... command on the File menu. Simply select the view you wish to print (2D or 3D) and then click the Print... command. The standard Windows printer dialog allows you to select the printer and adjust its properties. When the OK button in this dialog is clicked, the view will be printed. To adjust the printer settings without printing, you can open the same dialog using the Print Setup... command on the File menu. When used in this way, the OK button on the dialog will store the settings without printing immediately.

**Note:** By default printing the 3D view does not print the shaded background; this behavior can be changed using the Options dialog, which is opened using the Options command on the Edit menu.

The Print Preview... command on the File menu allows you to check the layout of your page before you print. If you are happy with the preview, use the Print... button to begin printing the document directly from the Print Preview page.

**Note:** The printed view is always scaled to exactly fit the currently selected page size (including allowance for margins). Drawings are not, therefore, printed at actual size and are not printed across multiple pages.

**Edit**

- **Undo** Steps backwards through the last 5 changes made by the user.
- **Redo** Steps forward through design steps that have been Undone using the Undo command (see above) to get back to stage that the user started using the Undo function.
- **Cut** Removes the selected objects from the job and places them onto the clipboard.
- **Copy**Copies selected objects to the clipboard, leaving the original in place
- **Paste** Pastes the contents of the Clipboard into the model (see cut and copy above).
- **Delete** Deletes the selected object - same as hitting the delete key on your keyboard
- **Selection** Select various types of vectors
  - **Align Selected Objects**
    - Opens the Alignment Tools form.
  - **Join Vectors**
    - Joins open vectors.
  - **Curve Fit Vectors**
    - Allows arcs, Bezier curves or lines to be fitted to existing vectors to ‘smooth’ them.
  - **Nest Selected Vectors**
    - Opens the Nesting form.
  - **Job Size and Position**
    - Opens the Job Setup form.
  - **Notes**
    - Opens a text box where you can record notes regarding this job, such as customer name, material required, special setup instructions or any other relevant text information you would like to keep when you save the job.
  - **Document Variables**
    - Opens the Document Variables dialog.
  - **Snap Options**
    - Opens the Snap Options dialog. See Rulers, Guidelines and Snapping for more details.
  - **Options**
    - Opens the Program Options dialog to allow the customization of certain aspects of the program.

**Selection**
Model Menu

Create Component ►

Add Zero Plane: Creates a component that is the size of your job setup with a height of Zero.

Create Component From... ►

Slice Model
Import Component / 3D Model
Smooth Selected Components
Create Vector Boundary Around Selected Components: Creates a new vector that matches the edge of the selected component.
Scale Model Z Height
Selected Component Properties

Toolpaths Menu

Show Toolpaths Tab Can be checked ✓ on or off to pin the Toolpath Tab open or unpin and hide it.
Tool Database Opens the Tool Database Dialog.
Recalculate All Toolpaths Recalculates all the Toolpaths in the part.

Toolpath Drawing ► Opens the Toolpath Drawing Pop-up Menu.

Preview Simulation Quality ► This controls the resolution (number of points) in the Toolpath Preview simulation model governing the amount of detail that the model will display when you Preview and toolpath. The higher the quality, the slower the speed of simulation will become. Guidelines are given on how much slower you should expect it to be but these will depend upon the performance of the PC and relative size of the tool being used to your job (the larger the tool, the slower the performance). Opens the Preview Simulation Quality Pop-up Menu:

Standard is the fastest mode and recommended for low performance PC's.
High (2 x Slower) displays better quality images and is for general use.
Very High (4 x Slower) displays good quality images, but will run a little slower.
Extremely High (8 x Slower) gives good quality images but will run slower on old PC's.
Maximum (25 x Slower) gives the best quality image, but could take a lot longer on any PC.

Templates ► See the section on Toolpath Templates for more information. Opens the Toolpath Templates Pop-up Menu:

Save Selected Toolpath as Template... Saves the toolpath that is currently selected as a template for use in another project.
Save All Visible Toolpaths as Template... Saves all of the currently visible toolpaths as a single template for re-use in another project.
Load Template... Loads a previously stored template containing all the settings for one or more toolpath strategies.

Merge Visible Toolpaths Opens the Create Merged Toolpath Form to merge different toolpaths that use the same tool into one optimised toolpath.
Create Job Sheet: Creates a job setup sheet which gives an overview of all of the toolpaths in the job. This opens a File Save As dialog prompting for a place to save the created sheet. The created setup is a single page of HTML, suitable for viewing in a web browser of your choice, or for printing. This can also be customized with the Job Setup Sheet Editor in the Gadgets Menu.

Install Post Processor: Opens a File Open dialogue box where you can install a post processor.

Toolpath Drawing sub-menu

- **Draw 2D Previews**: Can be checked ✓ on or off to display the toolpath previews in the 2D View.
- **Make 2D Previews Solid**: Can be checked ✓ on or off to switch from the wireframe view to a solid view.
- **Auto Open 3D View**: Selects whether the 3D view and Preview Toolpaths Form are automatically shown after toolpaths are created.
- **Draw rapid moves**: Toggles the visibility of red rapid-speed move lines on the 3D view when toolpaths are visible.
- **Draw plunge moves**: Toggles the visibility of cyan plunge-speed move lines on the 3D view when toolpaths are visible.
- **Draw retract moves**: Toggles the visibility of green retract-speed move lines on the 3D view when toolpaths are visible.
- **Draw join moves**: Toggles the visibility of purple join move lines on the 3D view when toolpaths are visible. A join move is a purely 2D move between toolpath contours, these are typically seen in Offset pattern Pocket Toolpaths.
- **Wrapping Off**: Toggles between flat and wrapped toolpaths when using Rotary Machining and Wrapping.

**Wrap Y Values (around X Axis)**: This will wrap the visible toolpaths around the X Axis in a rotary job. This is an intensive process and can run slowly.

**Wrap X Values (around Y Axis)**: This will wrap the visible toolpaths around the Y Axis in a rotary job. This is an intensive process and can run slowly.

View

- **Zoom to Drawing**: Use when you need to see the whole drawing and material as large as will fit in the 2D View window.
- **F5 Refresh 2D View**: Shortcut key for this is F5. In situations where the complete vector geometry represents a very large job and the user zooms into a small region, the shape of arcs and curves may look faceted. This is only a display issue and will not impact on the quality of toolpaths. This command will rebuild the display information to correct the graphics being drawn on the screen so curves are drawn smoothly again.
- **Guide Lines**: For more details see the section on Rulers, Guidelines and Snapping at the end of the 2D Design part of this manual. Opens the Guide Lines Pop-up Menu:
  - **Guides Visible**: Toggles the visibility of Guide Lines in the 2D view.
  - **Delete All Guides**: Deletes all the Guide Lines in the 2D view.
  - **Lock All Existing Guides**: Locks the position of all the Guide Lines in the 2D view.
  - **Unlock All Existing Guides**: Allows all the locked Guide Lines in the 2D view to be moved again.

- **Draw Origin**: XYZ origin arrows can be toggled on and off in the 3D View to show exactly where the X0, Y0 and Z0 origin is position is relative to the material.
- **Draw Modeling Plane**: This option controls the display of the semi-transparent ‘modeling plane’ which shows the position of the working model base plane.
- **Draw Material Block**: Toggles the drawing of a wireframe representation of the limits of the material block. This is useful for seeing how the 3D model will be positioned in the block of material it is being cut from.

- **Multi Sided View**: Allows you to view both sides in the 2D and 3D view when working in a multi sided environment.
- **Color Shaded View**: Draws / Undraws the color shaded job in the 3D window.
- **Use Shaded Background**: Shows either the default gradient filled color background or a solid light blue color background. The solid color is very useful for saving images that need to be cropped out of the background in a graphics software package.
- **Light follows viewer**: The default light setting for the 3D window shines a light onto the job from the top left corner of the material bounding box. Checking ✓ this option can sometimes be used to help visualize the job more easily.

- **Save Shaded Image**: Saves a color shaded image of the 3D view as a BMP, JPG, PNG or GIF file.
Note: Saving the image without the color shaded background is often useful when the image will be used on its own in a brochure or on a web site etc. If you select PNG as the file type with the shaded background switched off the image will be saved with a transparent background. To switch the shading off, go to Edit ► Options ► Use Shaded Background and set Use Shaded Background to No.

Page Down Tile Windows Horizontal: Tiles the 2D and 3D View Horizontally, 2D View at the top and 3D at the bottom.

Page Up Tile Windows Vertical: Tiles the 2D and 3D View Vertically, 2D View on the left and 3D on the right.

Cascade Windows: Cascades the 2D and 3D View so they overlap.

To Maximise the windows again, double-click the title-bar of either view.

Gadgets

Gadgets are small programs that add additional functionality to Cut2D Pro, VCarve Pro and Aspire. They can be used to add new features to the software or automate common sequences of tasks. Examples include adding the ability to cut dovetail style joints with a standard end mill and applying toolpath templates to every sheet in a nested job followed by automatically post-processing and saving the files for your machine tool.

A select number of Gadgets come preinstalled with the software, these can be found in the Gadgets menu on the main menu bar. All preinstalled Gadgets can be found under the following location, (C:\ProgramData\Vectric\VCarve Pro\V#.#\Gadgets). If you wish to delete a Gadget, simply delete the gadgets folder from the above location. See the section on Preinstalled Gadgets for more information.

You can expand your Gadgets library by downloading and installing more from the Gadgets website at http://gadgets.vectric.com ► These Gadgets will install into your public documents folder (Public Documents/Vectric/VCarve Pro/Gadgets). If you wish to delete any of these Gadgets, simply navigate to the location above and delete the folder.

Each Gadget has specific requirements in order for it to run, it is recommended that you read the instructions in full before use. Some Gadgets require that you select vectors before running the Gadget, others may need to be run before a job in the software is created. When there is a requirement that has not been met before running, you will receive an error message like the one below, stating which requirement has not been met.

Gadgets can also be created by our users using the LUA scripting language, we provide an SDK and tutorials on the gadgets website at http://gadgets.vectric.com/developerinfo.html

Please Note: This will require knowledge of programming

The SDK and the Tutorials are provided as is, Vectric cannot provide support on the development of user Gadgets.

Gadgets have their own section on the Vectric Forum, you can get news on the latest releases from Vectric and fellow users. http://forum.vectric.com/viewforum.php?f=46

Note: It is important to point out that the gadgets are NOT as polished as functionality which has been integrated into the main program. The gadget concept is intended to allow Vectric to produce simple add-ons which address minority requirements without cluttering up the main interface. As the Gadget library grows over time, we do not expect users to install every gadget, but only those that may be relevant to tasks they actually perform. We ship some gadgets which help perform common tasks for people with rotary axis. If a user has no interest in rotary machining, they can delete the ‘wrapping’ gadgets from their gadgets folder and those options will no longer be available from the Gadgets menu.

Help

Help Contents: Displays an online version of the full reference manual that documents every feature and option available in the software.

Note: The reference manual is not intended as a User Guide or introductory training resource - please don't forget about the Getting Started guides and the extensive video tutorial library on your install DVD.
**Keyboard Shortcuts**: Displays the Shortcut Keys available in the software.

**Video Tutorial Browser**: Access the tutorials

**What's New**: See a summary of the new features added in major updates.

**Release Notes**: See the list of issues fixed and enhancements in patch updates.

**Enter License Code**: Displays the License Dialog used for entering license or module details.

**View the Vectric Online FAQ**: Displays the Frequently Asked Questions (FAQs).

**View the Vectric User Forum**: Opens the Vectric User Forum in your Web Browser if you have an Internet Connection. Everyone should join the Forum to engage with other users and benefit from each others tricks and tips!

**Visit Vectric Support online**: Opens the Vectric Support Website in your Web Browser if you have an Internet Connection.

**Visit Vectric User Portal**: Opens the Vectric User Portal in your Web Browser if you have an Internet Connection. Download software installation files, activation codes and Clip Art included with the software.

**Post Processor Editing Guide**: Opens a PDF manual explaining how to create and edit your own post processors.

**Migrate From Older Version**: Opens a dialog to enable the settings in the last version of VCarve Pro to be copied to the latest version.

**Check for Updates**: Try this periodically to check (through the Internet) if an update is available for your software.

**About VCarve Pro**: This window displays the version of the software being used, to whom the software is license and the type of license.
Right Mouse Click menus

Clicking the ►RIGHT hand mouse button in different places in VCarve Pro will display a menu with choices which depend on the area of the software being clicked on and/or the object or selection that the mouse cursor is positioned over. This document details some of these areas and the menus that you will see when RIGHT mouse clicking.

2D View Right Mouse Menu

This menu is displayed when you Right mouse click in 2D View either in the white background of the part or over a selected vector. Most of these options repeat functions and icons described elsewhere in this manual, you should refer to the appropriate section to view how these work.

Span Editing Menu

If the currently selection mode is set to Node Editing, one of 2 different menus will appear when the user clicks the RIGHT mouse button depending on whether the cursor is currently over a vector Node or a Span in the selected vector in the 2D View. These menus have functions in them that correspond specifically to this selection and position. The menu below will appear when the cursor is over the Span of a vector in Node editing mode. You can see a variety of choices: to convert the span to a Line, Bezier (curve) or Arc, Insert a Point, Cut the Vector at that point, Delete the Span, or Insert a Midpoint. All these have corresponding Short Cut keys (shown to the right of the command in the menu) which can be selected from the keyboard when the mouse is in position (over a node-edit vector span) instead of Right Clicking the mouse button to access the menu.

Node Editing Menu

This menu will appear when the cursor is over the Node of a vector in Node editing mode. You can see a variety of choices to convert the span to Delete the Point, Smooth it, Cut the vector at that point or change the point to be the Start Point on the vector. From this menu you can also close the vector, Exit the node editing mode and lastly see and edit the exact XY co-ordinate position of the node by selecting Properties. All these have corresponding Shortcut keys (shown to the right of the command in the menu) which can be selected from the keyboard when the mouse is in position (over a node-edit vector node) instead of Right Clicking the mouse button to access the menu.

Bitmap Properties Dialog

When a Bitmap or Component Grayscale is the selected item in the 2D View and the RIGHT Mouse menu is activated then there will be an additional option in the pop-up menu called Object Properties. This will open the dialog shown below which can be used to fade the Bitmap or Grayscale object strengthen or fade the detail in it when it is not selected. This can be helpful to make it easier to see features perhaps to help you manually trace vectors over it or to fade them so its easier to see vectors that overlap the object.

Level Menu
When a Level in the Component Tree is selected and you RIGHT mouse click on it then the menu shown below will appear:

The first section allows you to make alterations to the selected level where you can change how the level combines with levels below it, you can choose to show or hide the levels visibility (and consequently the Components on it). Using the Select components option will select all the components within the level. The next section allows you to insert new levels, delete the level and rename the selected level. The final section of the menu allows you to export the complete contents of the Level as a .3dClip file - when re-imported this would come into VCarve Pro as a Group.

**Component Menu**

This menu appears when a Component is selected in the Component Tree and you RIGHT mouse click on it:

The first option allows you to select the way the component combines with the other objects on its Level. You then have the option to position the components grayscale in the 2D View, by moving that to the Front or the Back. You then have the options to Copy and duplicate a component along with the option to Export the selected component as a .3dClip file. If you have more than one component selected you have the option to Group/Ungroup the components. You can delete and rename a component. There is also the option to show components, where you can choose to Show This, Show Only This, Show All But This and Show All. You can Hide a component, where an extra menu allows you to Hide This or Hide All. You can open the properties form for the selected component and the last option allows you to move the component to a new or existing Level within the Component Tree.

**Component Grayscale Menu**

When a Component Grayscale is the selected item and Object Properties is selected it opens the Bitmap Properties slider, allowing you to change the fading of the grayscale component. Two other options are also available on the Right mouse click menu for a selected Component Grayscale. Move to Front and Move to Back. Clicking Move to Front will make the selected Grayscale appear over all the other Grayscales on the same layer so you can see the selected one more easily. Move to Back will send the selected one behind all the others on the same layer so that it is easier to see all the other Grayscales in the part.

**Component Menu in the 3D View - Selected Components**

When a component(s) is selected in the 3D view you can RIGHT mouse click and make changes to that selected component(s). You can check the combine mode of a component. You can Unselect a single component or Unselect All depending on how many components you have currently selected. You can hide and delete a component. You can open up the properties form for that component and you have the option to move the selected component(s) to an existing or new Level.

If you choose New Level you will be presented with the box below, where you simply add in the name for the new level and choose a combine mode from the dropdown menu.

**Component Menu in the 3D View - Non Selected Components**
When you RIGHT click on a component without selecting it first the menu will display the names of the components that are positioned at the point your cursor is within the job space. Selecting the name of the component will select it and open up the Properties form for that selected component.

Clipart Menu

When you RIGHT click on a piece of clipart in the clipart tab you have the option to import it to a new or existing level in your job. This will position the object in the center of the workspace and add it to the top of the list of Components on the selected Level or if you choose New Level will allow you to enter a name and Combine Mode.

Toolpath List Menu

When you RIGHT click on a toolpath name within the Toolpath List there are various options you are presented with to alter this toolpath. You can show a toolpath where you have the option to Show This, Show Only This, Show All But This and Show All. This toggles the visibility of the Toolpaths according to your choice. The next option allows you to Hide This or Hide All your toolpaths. You can Edit, Rename or Duplicate the selected toolpath. Selecting Recalculate All will work through the toolpath list recalculating each toolpath with any updated geometry selections. The last option allows you to delete one or more toolpaths, where you can Delete This, Delete All Invisible, Delete All Visible and Delete All.
Gadgets

VCarve Pro supports extensions to its core functionality through add-in tools called Gadgets. Gadgets can be downloaded and installed at any time. Installed Gadgets are accessible from the main Gadget menu, which is built dynamically each time VCarve Pro starts up.

Additional Gadgets become available from time to time, and are available for download from http://gadgets.vectric.com.

Gadget Shortcuts

Shortcut can be set to run a chosen gadget from the list of gadgets. To set the gadget shortcuts select the Gadget Shortcuts button from the Gadgets menu.

You may then assign one of the predefined shortcut keys to run a chosen gadget. The available shortcut keys are Ctrl and a function key.

Preinstalled Gadgets

A number of Gadgets are included as part of the default installation of VCarve Pro. These are all available from the Gadgets menu:

- Dragknife Toolpath
- Keyhole Toolpath
- Setup Sheet Editor
- Wrapped Fluting Layout
- Wrapped Spiral Layout
- Rounding Toolpath

Job Setup Sheet Editor

The Job Setup Sheet Editor is a gadget which enables you to personalise the existing Job Setup Sheet that you can generate from the Toolpaths Menu. You can access the gadget from the Gadgets Menu.
Change Logo

To change the logo from the default Vectric logo, press the Browse... button. This will open a dialog box enabling you to search your local computer for images to select. Images in landscape are better suited as they will be scaled down to W165 x H52 pixels. Images must either be JPG, PNG or GIF file format.

Title

To change the default title of “Job Setup Sheet”, enter the desired title in the edit box.

Color options

There are two options to change the color of the Header and Footer blocks, you can either: Point and click the mouse in the colored edit box, this will bring up the color selector, select a color and then click anywhere outside of the selector to accept this. Type a colors hex value directly into the edit box.

Add or Remove Setup Sheet Information

Each of the 5 sections of the Job Sheet can either be included or removed to display as much information as required. The image to the left, represents a default Job Sheet which includes the following 5 sections:

- Job Layout
- Job Notes
- Material Setup
- Toolpaths Summary
- Individual Toolpath Summaries

Restore to default sheet

Upon first successful run of this gadget, it will detect if you have already created a modified version of the Job Setup Sheet within the public gadgets directory, if so it will backup this Gadget so you could, if required restore it at a later date. If no modified gadget is found, it will backup the software default “Job Setup Sheet” so you have a copy if you want to revert back to the standard layout at a later date.

Keyhole Toolpath Gadget

This gadget simplifies the process of creating ‘keyhole’ toolpaths which are cut into the back of a sign or plaque to allow easy hanging on a wall. These slots are cut using a ‘keyhole’ cutter as shown on the left. The toolpath for these slots needs to plunge into the material at the mounting screw entry point to a depth that will ensure that the wide part of the cutter is below the material surface. The tool then moves along the ‘slot’, once it reaches the end of the slot, the tool retraces its path back along the slot to retract at the original plunge point.

Like all Vectric Gadgets, the top of the form gives brief instructions on how it should be used. For this gadget, you need to select one or more circular vectors in your design to indicate where you want the entry points for the keyhole slots to be before the Gadget is run. If you start the gadget without selecting one or more vectors to indicate these positions, the following warning will be displayed...

Once the form is displayed you can enter the parameters for your keyhole toolpath. The data to be entered falls into three
Slot Parameters

In this section of the form you specify the direction the slots will be machined and also the depth and the length for the slots.

Preview Drawing

To help with visualisation of the slot, the gadget can draw a vector outline of how the slot will appear on the surface of your job. This drawing is optional and if you un-check the Create Preview Vectors for outline on surface check box you do not need to fill in the parameters in this section. If you do want previews drawn, you can specify the entry hole diameter which will be created by your keyhole cutter and also the diameter of the slot the tool will create on the surface. You can also specify the name of the layer the vectors will be created on.

Toolpath Parameters

The final section of the form is used to specify a tool which the feed and plunge rates are picked up from, and also a name for the toolpath which will be created. As keyhole cutters are not supported natively by the program, just set up an end-mill with the required feed rates to use.

After entering all your parameters and pressing OK, the gadget will create a toolpath within the program to machine your slots and also the vector preview if you enabled this option. The screen shot below shows the preview vectors in the 2D view along with the toolpath in the 3D view.

Drag Knife Toolpath

This Gadget supports drag knife tooling in your CNC machine. It uses the selected vectors in the 2D View as the basis of a centerline profile-type toolpath that incorporates swivel moves at corners to ensure the drag knife blade remains properly aligned throughout the cut.

Blade Offset

The tip of a drag knife is offset by a small amount from the pivot center of the tool to allow it to swivel as it cuts. This value specifies the distance and will be provided by your tool manufacturer.
Tolerance angle

This value determines when a swivel move needs to be used on a corner. Changes in tool direction, or corners, with angles less than this value will not generate swivel moves.

Cut Depth

This value sets the final cut depth of the toolpath. It defaults to be the current material thickness.

Swivel Depth

The knife must remain in some contact with the material in order to swivel correctly, but a small retraction is generally used to lift the knife blade slightly to minimize marking the material during the swivel action. This value must, therefore, be less than the cut depth and appropriate for your tool and material.

Passes

This value determines the number of passes used to cut down to full depth. The depth of each cut will be specified cut depth divided by the number of passes.

Use Vector Start Points

If Use Vector Start Points is checked ✓ then the gadget will use the existing vector start points to begin cutting vectors. Please note that this gadget assumes that the blade starts parallel to the positive x-axis. If this option is not checked the gadget will attempt to find what it thinks are sensible start positions.

Feed and Plunge Rates

These are the rates that the machine will push the knife through the material during a cutting pass, and the rate of descent of the tool into the material at the beginning of a cutting pass. Please ensure that the values are appropriate for your machine tool and the material you are cutting.

Warning! When machining please ensure you have the spindle switched off.

Create Rounding Toolpath Gadget

This gadget is used to simplify the task of creating toolpaths to machine a rough blank to a finished diameter for users with a rotary axis / indexer. It supports rounding from either round or square stock and creates the toolpaths directly from the gadget. The gadget is designed to be used in a rotary job. The default values for axis orientation and final cylinder diameter will be picked up automatically from the job. When this gadget is run the following form is displayed:
As with all Vectric gadgets, the first part of the form gives an overview of the gadget's purpose.

The start of the form also makes a VERY important point about where the Z origin should be set when the toolpaths are output via a wrapping post-processor. This has to be configured during job setup.

You have the choice of specifying if the tool is being zeroed on the center of the cylinder or the surface. When you are rounding a blank, you cannot set the Z on the surface of the cylinder, as the surface it is referring to is the surface of the finished blank. We would strongly recommend for consistency and accuracy that you always choose 'Center of Cylinder' when outputting wrapped toolpaths as this should always remain constant irrespective of irregularities in the diameter of the piece you are machining or errors in getting your blank centered in your chuck.

A useful tip for doing this, is to accurately measure the distance between the center of your chuck and a convenient point such as the top of the chuck or part of your rotary axis mounting bracket. Write down this z-offset somewhere, and zero future tools at this point and enter your z-offset to get the position of the rotary axis center.

The Create Rounding Toolpath form is divided into 4 logical sections:

### Blank Size and Shape

The gadget supports creating a toolpath to machine either a square blank or a round one. In this section you specify the shape of your initial blank and its dimensions. The diagrams show which dimensions are being specified.

### Machining Method

The gadget offers a choice of three types of machining and for all types you can enter an allowance that will be left on the final shape if required. The Radial and Raster options can be used with either square or round blanks, the Optimized Raster can only be used for square blanks.

#### Radial (around cylinder)

This option creates a toolpath which rotates the blank around its axis 360° before stepping over to the next pass by the tool stepover distance and rotating the blank back again.

#### Raster (along cylinder)

This option machines along the length of the cylinder before incrementing the rotary axis round by an amount equal to the tool stepover and then returning the tool back along the cylinder axis. For many machines where the rotary axis is often slower than the X or Y axis, this strategy may allow shorter machining times.
If you are machining a square blank into a round shape, the previous options generate a large number of wasted toolpath moves, because for much of the machining process they are machining ‘fresh air’. The ‘Optimized Raster’ strategy only creates the toolpaths where there is actually material on the blank and hence is much more efficient for square stock.

After choosing your machining method, the next section on the form allows you to pick the tool you will be machining with. The tool is selected from the standard Vectric tool database and will control the stepover, step down and feed rates for the toolpath. It is important to note that after choosing the tool you will not be able to edit the parameters, so you must set up the tool with the correct parameters in the tool database to begin with. This section also allows you to specify a name for the toolpath which will be created.

The values in the final section of the form are picked up automatically and are presented for reference only.

After filling in all the values (all values will be remembered as the default values to use the next time the gadget is run), press the OK button and the toolpath will be generated within the program. The screenshot below shows the ‘Optimized Raster’ toolpath.

The toolpaths will appear wrapped by default within the program unless the Auto Wrapping mode is off.

You can now save your toolpath using a suitable rotary post processor. For information on how to set up a rotary post processor please refer to Rotary Machining and Wrapping.

Wrapped Fluting Layout

This gadget is used to simplify the task of creating toolpaths to machine flutes and coves on a rotary work piece. The gadget is designed to be used in a rotary job.

This gadget does NOT create toolpaths directly. It lays out vectors in the 2D view which can then have toolpaths created using either the Profile or Fluting toolpaths within the main program. The top part of the form allows the user to specify how many flutes to create and how far from the start and end of the work piece the flute should start and end. Flutes are laid out evenly spaced based on the circumference of the cylinder. If the user chooses to create coves at either or both ends, extra vectors will be created which can be machined with the Profile toolpath and the Machine Vectors On option to create the coves.

The bottom section of the form contains details about the cylinder dimensions and is presented for reference only.
After the gadget has run the vectors required for machining will be visible in the 2D view. If you are using Aspire and are creating a 3D form for your rotary piece, you can use the Project toolpath onto 3D model option on the toolpath forms to have your fluting toolpaths follow the work piece surface.

**Wrapped Spiral Layout**

This gadget creates vectors which can be used to machine spirals along a column (rope or barley twist). Once the vectors have been created, use the 2D Profile Toolpath with the ‘Machine Vectors...’ Off form within the program to create the actual toolpaths at your required depths.

### Spiral Parameters
- **Number of Starts / Strands**: 2
- **Spiral Pitch**: 2 inches
- **Spacing between strands**: 1 inch
- **Offset from Start**: 0 inches
- **Offset from End**: 0 inches

### Twist Direction
- **Create Right-Hand Twist**
- **Create Left-Hand Twist**

### Coves
- **Create Cove at Start**
- **Create Cove at End**

### Cylinder Dimensions
- **Cylinder Length (L)**: 12 inches
- **Cylinder Diameter (D)**: 4 inches

This gadget is used to simplify the task of creating toolpaths to machine spirals (rope or barley twist) on a rotary work piece. The gadget is designed to be used in a rotary job.

This gadget does NOT create toolpaths directly. It lays out vectors in the 2D view which can then have toolpaths created using Profile toolpath within the main program. The top part of the form allows the user to specify how many strands to create and how far from the start and end of the work piece the strands should start and end. Strand ends are laid out evenly spaced based on the circumference of the cylinder. The spacing between strands during spiralling can be controlled using either Spiral Pitch or Spacing between strands option. It is also possible to choose between right and left hand twists.

If the user chooses to create coves at either or both ends, extra vectors will be created which can be machined with the Profile toolpath to create the coves.

For machining both spirals and coves, Machine Vectors On option should be used.

The bottom section of the form contains details about the cylinder dimensions and is presented for reference only.

After the gadget has run it will display message saying how many revolutions will each strand made and the vectors required for machining will be visible in the 2D view. Please note that the vectors will be extending beyond the 2D boundaries of the job. That is expected and thanks to wrapping feature will end up producing spirals. Please refer to Spiral toolpaths section of the User Guide for more information and examples of spiral toolpaths.
## General Shortcut Keys

<table>
<thead>
<tr>
<th>Shortcut key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + A</td>
<td>Select All vectors</td>
</tr>
<tr>
<td>Esc</td>
<td>Deselect All vectors</td>
</tr>
<tr>
<td>Select ➔</td>
<td>Selects all vectors inside and touching selection rectangle</td>
</tr>
<tr>
<td>Right to Left</td>
<td>Only selects vectors fully inside selection rectangle</td>
</tr>
<tr>
<td>N</td>
<td>Toggles between Selection and Node Editing modes</td>
</tr>
<tr>
<td>Esc</td>
<td>Switches to Selection Mode (exits Node editing or Transform mode)</td>
</tr>
<tr>
<td>T</td>
<td>Opens the Scale form for Transforming the vectors</td>
</tr>
<tr>
<td>M</td>
<td>Opens the Move form</td>
</tr>
<tr>
<td>R</td>
<td>Opens the Rotate form</td>
</tr>
<tr>
<td>J</td>
<td>Opens the Join Vectors form</td>
</tr>
<tr>
<td>Ctrl + M</td>
<td>Opens Measure tool form</td>
</tr>
<tr>
<td>9</td>
<td>Rotates selected object 45° counterclockwise</td>
</tr>
<tr>
<td>0</td>
<td>Rotates selected object 45° clockwise</td>
</tr>
<tr>
<td>Esc</td>
<td>Exits vector drawing and editing tools and closes the data entry form</td>
</tr>
<tr>
<td>Right mouse click</td>
<td>Exits vector drawing and editing tools and closes the data entry form</td>
</tr>
<tr>
<td>Space-bar</td>
<td>Re-opens the last vector creation form you used. This is very useful when using other forms in between each shape / text / dimension you create.</td>
</tr>
<tr>
<td>Z</td>
<td>Zoom - click top left and bottom right corners to zoom</td>
</tr>
<tr>
<td>Esc</td>
<td>Exits zoom mode returning to Selection mode</td>
</tr>
<tr>
<td>CRTL + F</td>
<td>Zoom to fit Job</td>
</tr>
<tr>
<td>F</td>
<td>Zoom to fit Material</td>
</tr>
<tr>
<td>F6</td>
<td>Scales 2D view to fit material</td>
</tr>
<tr>
<td>F8</td>
<td>Toggles between the Drawing and Modeling Tab</td>
</tr>
<tr>
<td>F9</td>
<td>Center selected object in view</td>
</tr>
<tr>
<td>F10</td>
<td>Opens the Alignment Tools form</td>
</tr>
<tr>
<td>F11</td>
<td>Toggle Drawing Tab on</td>
</tr>
<tr>
<td>F12</td>
<td>Toggle Toolpath Tab on</td>
</tr>
<tr>
<td>Ctrl + L</td>
<td>Opens the Layers Tab</td>
</tr>
<tr>
<td>Ctrl + D</td>
<td>Opens the Drawing Tab</td>
</tr>
<tr>
<td>F8</td>
<td>Toggles between the Drawing and Modeling Tab</td>
</tr>
</tbody>
</table>

## Tab Navigation

<table>
<thead>
<tr>
<th>Shortcut key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F11</td>
<td>Toggle Drawing Tab on</td>
</tr>
<tr>
<td>F12</td>
<td>Toggle Toolpath Tab on</td>
</tr>
<tr>
<td>Ctrl + L</td>
<td>Opens the Layers Tab</td>
</tr>
<tr>
<td>Ctrl + D</td>
<td>Opens the Drawing Tab</td>
</tr>
<tr>
<td>F8</td>
<td>Toggles between the Drawing and Modeling Tab</td>
</tr>
</tbody>
</table>

## Double Sided Job Setup
Shortcut key | Description
---|---
1 | Toggle Top Side on
2 | Toggle Bottom Side on
 | Toggle Multi-Sided View on

**Mirror**

<table>
<thead>
<tr>
<th>Shortcut key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>H</td>
<td>Mirror Horizontally</td>
</tr>
<tr>
<td>Ctrl + H</td>
<td>Create Mirror Copy Horizontally</td>
</tr>
<tr>
<td>Shift + H</td>
<td>Mirror Horizontally, around center of material</td>
</tr>
<tr>
<td>Ctrl + Shift + H</td>
<td>Create Mirror Copy Horizontally, around center of material</td>
</tr>
<tr>
<td>V</td>
<td>Mirror Vertically</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Create Mirror Copy Vertically</td>
</tr>
<tr>
<td>Shift + V</td>
<td>Mirror Vertically, around center of material</td>
</tr>
<tr>
<td>Ctrl + Shift + V</td>
<td>Create Mirror Copy Vertically, around center of material</td>
</tr>
</tbody>
</table>

**Alignment**

<table>
<thead>
<tr>
<th>Shortcut key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F9</td>
<td>Moves selected object to the center of the material</td>
</tr>
<tr>
<td>F10</td>
<td>Opens the Alignment Tools form</td>
</tr>
</tbody>
</table>

**Groups**

<table>
<thead>
<tr>
<th>Shortcut key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>G</td>
<td>Group the selected objects</td>
</tr>
<tr>
<td>U</td>
<td>Ungroup the selected objects to their original layers, sub groups remain grouped.</td>
</tr>
<tr>
<td>Ctrl + U</td>
<td>Ungroup the selected objects to the group's layer, sub groups remain grouped.</td>
</tr>
<tr>
<td>Shift + U</td>
<td>'Deep' ungroup the selected objects to their original layers. Sub groups are also ungrouped.</td>
</tr>
<tr>
<td>Ctrl + Shift + U</td>
<td>'Deep' ungroup the selected objects to the group's layer. Sub groups are also ungrouped.</td>
</tr>
</tbody>
</table>

**Arrow keys**

Nudge selected vectors using the Arrow keys

- Holding Ctrl reduces the nudge distance
- Holding Shift increases the nudge distance
- Holding Ctrl + Shift nudges the selected object by the Fixed Nudge Distance which is specified in the Snap Settings ( F4 )

**Node Editing**
<table>
<thead>
<tr>
<th>Shortcut key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>Insert a Point</td>
</tr>
<tr>
<td>D</td>
<td>Delete Point / Span</td>
</tr>
<tr>
<td>S</td>
<td>Smooth / Unsmooth Point</td>
</tr>
<tr>
<td>C</td>
<td>Cut Vector opens the vector</td>
</tr>
<tr>
<td>B</td>
<td>Convert span to Bezier</td>
</tr>
<tr>
<td>A</td>
<td>Convert span to Arc</td>
</tr>
<tr>
<td>L</td>
<td>Convert span to Line</td>
</tr>
<tr>
<td>P</td>
<td>Makes the selected node the Start Point for machining</td>
</tr>
<tr>
<td>X</td>
<td>Displays a single node's X and Y location properties</td>
</tr>
<tr>
<td>X</td>
<td>Changes the X co-ordinate position of selected nodes to match the position of the first one (when more than one selected)</td>
</tr>
<tr>
<td>Y</td>
<td>Changes the Y co-ordinate position of selected nodes to match the position of the first one (when more than one selected)</td>
</tr>
<tr>
<td>H</td>
<td>Enter horizontal mirror mode (press again to exit)</td>
</tr>
<tr>
<td>V</td>
<td>Enter vertical mirror mode (press again to exit)</td>
</tr>
</tbody>
</table>

Right mouse click

- Opens context sensitive menus

**Ctrl** + **Z**
- Edit Undo

**Ctrl** + **Y**
- Edit Redo

**Ctrl** + **C**
- Copy the selected vectors

**Ctrl** + **V**
- Paste the selected vectors

**Ctrl** and Drag
- Pastes a copy of the selected vectors each time the left mouse button is released.

**Ctrl** + **X**
- Cut the selected vectors

**Alt** and Drag
- Moves the object either horizontally or vertically aligned with its original position

**Ctrl** + **Alt** and Drag
- Creates a copy of the original object horizontally or vertically aligned to its original position

**Ctrl** + **N**
- Create New file

**Ctrl** + **O**
- Open an Existing file

**Ctrl** + **S**
- Save file

**Ctrl** + **I**
- Import file

**Page Up**
- Vertically tiles the 2D View and the 3D View window so you can see them both simultaneously. Currently Selected window is on the left - typically best to select the 2D View first when doing this.

**Page Down**
- Horizontally tiles the 2D View and the 3D View window so you can see them both simultaneously. Currently Selected window is at the top - typically best to select the 2D View first when doing this.

### Quick Keys

Pressing the **Space-bar** re-opens the last vector creation form you used. This is very useful when using other forms in between each shape / text / dimension you create.

Various values can be typed in while dragging out shapes as follows:

**Note:** In most cases, the left mouse button must be pressed in order to input a value (i.e. dragging to create a circle, dragging a vector to move it, or dragging one of the rotating/scaling points around a vector to rotate/scale it).

The exception to this is the polyline tool: once the first point is entered the Quick Keys can be used without having to depress the left mouse key. Entering values defines the next end-point.

### Moving Objects

**M**
Drag Object

<table>
<thead>
<tr>
<th>Value</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Description**

Moves object from original position in direction of cursor.

**Equivalent to:** Value L

<table>
<thead>
<tr>
<th>Value</th>
<th>Value</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Description**

Moves object relative to its position by X and Y.

**Equivalent to:** Value D Value W

<table>
<thead>
<tr>
<th>Value</th>
<th>Value</th>
<th>Value</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Description**

Moves object to the absolute position X and Y.

**Rotating Objects**

Drag Rotation Handles

<table>
<thead>
<tr>
<th>Value</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Description**

Rotate the selection by R degrees counterclockwise.

**Equivalent to:** Value L

**Scaling Objects**

Drag Scaling Handles

<table>
<thead>
<tr>
<th>Value</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Default when dragging edge scale nodes only.**

Set the width or height of the object to "L" (depending on which handle is being dragged).

**Equivalent to:** Value L

<table>
<thead>
<tr>
<th>Value</th>
<th>Value</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Default when dragging corner scale nodes only.**

Set the width and height of the object to the given values.

**Equivalent to:** Value D Value W

<table>
<thead>
<tr>
<th>Value</th>
<th>S</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Description**

Scale the object by a factor.

**Node Editing**

Drag Node

<table>
<thead>
<tr>
<th>Value</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Description**

Moves node from original position by that amount in direction of cursor.

**Equivalent to:** Value L

<table>
<thead>
<tr>
<th>Value</th>
<th>Value</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Description**

Move the node by that amount relative to its current position.

**Equivalent to:** Value D Value W

<table>
<thead>
<tr>
<th>Value</th>
<th>Value</th>
<th>Value</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Description**

Moves node to the absolute position X and Y.

**Polyline Tool**

**Note:** Once the first point is entered the Quick Keys can be used without having to depress the left mouse key. Entering values defines the next end-point.

<table>
<thead>
<tr>
<th>Value after adding first point</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td></td>
</tr>
</tbody>
</table>

**Description**

Places next point L away from the last point in the direction of cursor.

**Equivalent to:** Value L

<table>
<thead>
<tr>
<th>Value</th>
<th>Value</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Description**

Place the next point offset by that amount relative to the last point's position.

**Equivalent to:** Value D Value W

<table>
<thead>
<tr>
<th>Value</th>
<th>Value</th>
<th>Value</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Description**

Places the next point at position X and Y

<table>
<thead>
<tr>
<th>Value</th>
<th>Value</th>
<th>Value</th>
<th>Value</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Value</td>
<td>L</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Description**

Creates a line with an angle of A° and a length L

**Draw Circle**
### Draw Ellipse

<table>
<thead>
<tr>
<th>Value(s) while Dragging Mouse</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value Enter</td>
<td>Create a circle with the given radius.</td>
</tr>
<tr>
<td>Value D</td>
<td>Create a circle of Diameter D</td>
</tr>
</tbody>
</table>

#### Equivalent to:

- Value R

### Draw Rectangle

<table>
<thead>
<tr>
<th>Value(s) while Dragging Mouse</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value Enter</td>
<td>Create a square with the given side length.</td>
</tr>
<tr>
<td>Value , Value Enter</td>
<td>Create a rectangle with given width and height.</td>
</tr>
</tbody>
</table>

#### Equivalent to:

- Value L

- Value W Value H

### Draw Polygon

<table>
<thead>
<tr>
<th>Value(s) while Creating Mouse</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value Enter</td>
<td>Create a circle with the given radius.</td>
</tr>
<tr>
<td>Value D</td>
<td>Creates a Polygon with diameter D</td>
</tr>
<tr>
<td>Value S Value R</td>
<td>Create a polygon with number of sides S and radius R</td>
</tr>
<tr>
<td>Value S Value D</td>
<td>Create a polygon with number of sides S and diameter D</td>
</tr>
</tbody>
</table>

### Draw Star

<table>
<thead>
<tr>
<th>Value(s) while Dragging Mouse</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value Enter</td>
<td>Create a star with the given radius.</td>
</tr>
<tr>
<td>Value D</td>
<td>Create a star with diameter D</td>
</tr>
<tr>
<td>Value P Value R</td>
<td>Create a star with number of points P and radius R</td>
</tr>
<tr>
<td>Value P Value D</td>
<td>Create a star with number of points P and diameter D</td>
</tr>
<tr>
<td>Value P Value I Value R</td>
<td>Create a star with number of points P, Internal Radius % I and radius R</td>
</tr>
<tr>
<td>Value P Value I Value D</td>
<td>Create a star with number of points P, Internal Radius % I and diameter D</td>
</tr>
</tbody>
</table>
What's New in VCarve Pro 9.5

Welcome to VCarve Pro V9!

This documentation provides a convenient guide for previous VCarve Pro customers to highlight new and enhanced features specific to this release of the software. It is intended as a way for existing VCarve Pro users to locate just the new or changed aspects of the software.

If you are new to VCarve Pro, don't forget that full documentation of all the features of the software can be found here, or by selecting Help ► Help Contents from the Main Menu on VCarve Pro's main window.

New Drawing Tools

This latest version of VCarve Pro introduces several entirely new drawing tools and features.

Smart Snapping

The way you draw in the software has seen some huge improvements making it quicker and easier to create and align geometry in the software with the introduction of Smart Snapping. Smart Snapping can dramatically reduce the time taken to create vector geometry. It enables geometry to be snapped to lines, extensions and intersections which don't exist as geometry thereby reducing the need for most construction vectors.

Quick Keys

In addition to the Smart Snapping feature we have introduced the ability to transform and create shapes using Quick Keys. This allows you to add more precision to your shape creation and editing process more easily by allowing typed values while creating geometry. This is supported for creation of circles, ellipses, rectangles, polygons, stars, polylines and in editing nodes or transforming vectors.

Pressing the Space-bar re-opens the last vector creation form you used. This is very useful when using other forms in between each shape / text / dimension you create.

Vector Validator

The Vector Validator is intended to help locate issues with contours after importing vector files to look for problematic issues that could potentially affect toolpath creation such as overlapping contours or intersections. It also indicates zero-length spans that are in the file, where the software can fix them at the click of a button.

Enhanced & Extended Drawing Tools

This section details the improvements that have been made to features you will already be familiar with from earlier versions of VCarve Pro and includes the following:

- Text Editing (V9.5)
- Picture Editing & Cropping (V9.5)
- Dimensioning
- All Closed Shape creation tools are now fully consistent
- Create tangents lines to circles & arcs using the Polyline Tool

Text-Editing (V9.5)

The Create Text Form (V9.5)

From version 9.5 any text is edited in-place including Arc Text and Text on a Curve, even if it has been moved, scaled and rotated. Custom kerning and spacing is also maintained where possible.
The behaviour of the Create Text form has changed to provide more visual feedback about the changes you are about to make. If the form is opened with no selection, the new text is placed somewhere on the material (if possible) between the center of the material and the center of the view to help keep it visible. An empty box is drawn in the view which helps visualize the currently specified text height and anchor point.

Existing text has guide lines showing the height of the top line of text. Some fonts will descend below the lower line like handwriting on a note pad. Clicking selected text while editing, changes the anchor point to a box which can be dragged and dropped with snap.

The view is updated shortly after the user stops changing the form properties (e.g. mouse-wheel scrolling through the font list) providing a live update of your edited or created text.

**Arc Text (V9.5)**

The arc sector is now drawn when editing and provides a handle at the center of the arc which can be used to move the text. The text and font properties of Arc Text can be edited using the Create Text Form whilst still keeping the text on the arc.

**Picture Editing & Cropping (V9.5)**

The Edit Picture form allows you to adjust the visual properties of a selected bitmap. You can adjust the contrast, brightness and gamma of any selected image. Borders of different sizes and radii can be added to bitmaps. Bitmaps can also be made black and white.

**The Crop Bitmap Tool (V9.5)**
The Crop Bitmap tool can be used to select the parts of an image you are interested in, and remove the parts you are not.

**Dimensioning**

Further improvements have been made to the way you can create dimensions in the software. It has been enhanced to allow faster placement and more freedom. You now have the option to edit existing dimensions while the form is open. Dimensions can now have custom text. This text is stored per dimension, so you change between calculated and custom text without losing a dimension’s custom text.

*Note:* The Length, Vertical and Horizontal Dimensions allow the text to be placed freely with a snap-point-point at the center of the dimension line for consistency with previous versions (disable snapping by holding down a **Shift** key).

**Shape Creation**

Improvements have been made to the way we create shapes. If a shape is selected when a shape's form is opened, the form will load its values from the selected shape, otherwise it holds the same values it had when it was last closed.

When drawing a shape, the size of the shape you are drawing will be displayed, changing appropriately for the snap radius and job size. You can now edit a shape whilst in the shape form.

**Creating Tangent Lines**

Using the keyboard shortcut **T** in the Polyline Tool, you can create a tangent to and from existing arc spans or circles.

**Extending A Polyline (V9.5)**

There are two new ways to extend an existing polyline:

- Open the polyline tool. With ctrl held down select the end point of contour you wish to extend.
- In node editing mode select the end point of the polyline you wish to edit. Then use the right-click Menu to select **Edit Polyline**. This will open up the Polyline Form with the selected polyline now being extended.

**Smother Joining (V9.5)**

Version 9.5 of VCarve Pro upgrades the “Join vectors with smooth Curve” method with an alternative joining algorithm which produces smoother results. Select either one or two open vectors and click the button.

If you want to access the old joining method then hold the **Ctrl** button down to use the older join method. The **Smooth Join Vectors** option can be used to choose which method is the primary join method and which method is the alternative join method and hence requires **Ctrl** to access.
It is now possible to choose a bitmap to be a background image for your 3D view. This image can be set by setting Edit ► Options ► Shaded Background Style to be Image and specifying the image path in Edit ► Options ► Image File Path.

**New Modeling Tools**

**Mirror Mode**

Many decorative designs and patterns are symmetrical and the new Level Mirror Mode makes the process of creating and editing these sort of jobs much easier and far quicker. A dynamic and non-destructive mirroring effect can be applied to all of the components within a level so that you can concentrate on just one half or quarter of your design and let VCarve Pro take care of the rest.

For more information on this exciting new feature read more here....

**Enhanced & Extended Modeling Tools**

**Add Zero Plane**

In previous versions of the software, to access the Add Zero Plane command you had to select it from the Model main menu, to make this easier to find, the Add Zero Plane option now has an Icon that can be accessed from the Model Creation section of the Modeling Tab.

**Improved Quality of Imported STL Models**

Previously, STL models were imported and converted at a fixed resolution. With the average computer being so much more powerful these days we have successfully enhanced this feature so that VCarve Pro’s modeling resolution can be used. This means that for very dense STL meshes we can preserve the detail much more effectively when you are working within a high resolution model within VCarve Pro.

Note: Ultimately the detail possible will still be limited to the initial detail of your STL mesh. We cannot add detail that was not there to start with!

**Enhanced Toolpath Features**

**Setting Toolpath Start Point**

Within the Profile Toolpath form, a new Start At tab has been added giving you more control over the toolpaths start position. There are three options to choose from:

- Keep current start points
- Optimize start points
- and the new Move start point to be closest to selected point on vector boundary box.

This new third option allows you to make the start point to be closest to a selected point, to influence the start point define which part of the bounding box of the profiled vector it should start near and the software will look for the nearest point, from all of the endpoints of spans, and will start the toolpath from that point. This is particularly useful if you wanted to alter the start point to multiple vectors in your job to a common point without having to go in to each individual vector to alter them separately.

Note: Keep current start points and optimize start points are not new features but have been moved from the Machine Vectors section in the Profile Toolpath form to the new Start At Tab.

**Create Job Sheet Icon**

To simplify your workflow the Job Setup Sheet command can now be accessed via its own Job Setup Sheet Icon in the Toolpath Operations section of the Toolpaths tab.

**Preserve Arcs across Toolpath Tiles**

Previously, when tiling a toolpath, arcs where smashed to small lines if they were going across a tile. Arcs are now maintained when tiling to creating smoother, more efficient toolpaths if arcs are supported by your CNC machine.

**Helical Arc Support (V9.5)**
VCarve Pro now supports the output of helical arcs. These are like regular arcs when viewed in 2D but where the start z and the end z differ. They are typically found in toolpaths where ramping occurs. These arcs can now be output via the newly introduced post-processor variables:

- FIRST_CW_HELICAL_ARC_MOVE
- CW_HELICAL_ARC_MOVE
- FIRST_CCW_HELICAL_ARC_MOVE
- CCW_HELICAL_ARC_MOVE
- FIRST_CW_HELICAL_ARC_PLUNGE_MOVE
- CW_HELICAL_ARC_PLUNGE_MOVE
- FIRST_CCW_HELICAL_ARC_PLUNGE_MOVE
- CCW_HELICAL_ARC_PLUNGE_MOVE

Using these moves for the output of helical arcs may result in smoother toolpaths and smaller toolpath file sizes.

Note: Please contact your machine tool manufacturer to see if your machine tool supports helical arcs. The post-processor editing guide (accessible from within the software via Help ► Post Processor Editing Guide) provides a more complete treatment of the new variables.

General Improvements

Two-Sided Job Support

Major changes have been made throughout the software to support jobs which require you to machine both sides of your material. VCarve Pro now helps you to manage and organize your drawings, models and toolpaths for each side of your part using simple controls. The software helps with correct alignment of your vectors and toolpaths and even provides a full 3D preview of your part as it will look when cut from both sides. For lots more information please see the new Two-Sided Machining section of the full documentation.

Rotary Job Support (V9.5)

Major changes have been made throughout the software to support jobs which require a rotary axis to machine. These include:

- Integrated support for rotary jobs
- Automatic 3D view wrapping
- Support for 3D machining including Inverse Time Feed mode (G93)
- Support for simulating spiral toolpaths
- Improved model import into rotary project

See Rotary Machining section of the full documentation.

View Toolbar

A new View Toolbar is displayed above the view window, which allows easier access to common tools. With the ability to create a double sided project you have easy access to switch between the Top and Bottom Sides of your project. The Layers Drop down bar has now moved from the drawing tab to the View Toolbar, making it accessible at all times. The other icons displayed in order of left to right are as follows:

Snapping Toggle Options

- Snap to geometry
- Smart Snapping
- Snap to Grid

View Controls

- Toggle Pan / Twiddle View
- Zoom to box
- Zoom to drawing
- Zoom to selection

Toolpath Drawing Toggle

- Toggle 2D Toolpath Drawing
- Toggle solid 2D Toolpath Drawing

Tile 2D & 3D View Windows
Stack 2D and 3D View windows vertically
Stack 2D and 3D View windows horizontally

There are also additional tools available when you are working on a two-sided job. For more information, please see the Toolbar section of the documentation.

Export to PDF

You can now export your drawings to PDF. This is a useful and standard format but it also enables you to print your drawings to scale on a suitable printer using Adobe or other 3rd party PDF software.

Online Clipart Access (V9.5)

Version 9.5 adds improved access to the online clipart that comes free with VCarve Pro. This clipart can be downloaded directly from the running software. The software comes with previews of the clipart you're entitled to. In order to get the latest entitlements, click the refresh button.

The Login Dialog will then appear and you may then be prompted to log in to your V&Co account to allow the software to access your clipart. Once logged in, your previews will be refreshed. These previews are displayed with an overlay to make it clear that they are not yet downloaded.

To download a preview,
- Right-Click the preview and click Download
- Drag and Drop the preview onto the job directly. If the download is quick (which depends on the internet connection), the clipart will appear in the job like a normal clipart drag & drop. If it’s slower, you’ll get a notification when it’s done.
- Right-Click a folder and click Download to download a whole category. You will get a progress on the download in the status bar.

Note: Installers for the free clipart can also be used. These can be found with the installation media or within V&Co. Once the clipart is installed, it will appear as the usual local clipart in the software (i.e., without the overlay).

If it is desirable to view only the clipart that is currently downloaded, then the cloud button found above the clipart preview display toggles the visibility of the online clipart.

Available online clipart not shown
Available online clipart shown

See The Clipart Tab for more details.
9.519

Issues

- Speed up Pocketing calculation when there are lots of regions.
- Better handling of flat surfaces when importing STL.
- Fix Lua issue duplicating a toolpath and inserting it at the end.
- Fix recalculating from template using correct pass depth when using Z height from the Vector Selector.
- Fix copying of bitmap to another layer.
- Fixed some virtual folders not showing in the clipart.
- Fix quadratic bezier handling in SVG.
- Correctly open the Job Sheet when pressing CTRL in different Job types.

9.518

Issues

- Fix issue with renaming toolpaths via LUA API not affecting the toolpath list.
- Fix importing of Z height on compatible DXF.
- Fix auto z-scaling when scaling texture components.
- Fix tapered ball nose tool shape calculation affecting depth of some toolpaths.
- Fix issue with incorrect dimensions being shown for transformed text in a box.

9.517

Issues

- Fix tolerance issue in Moulding Toolpath when using second tool.
- Fix failure to remove centre when pocketing some circles in some cases.
- Fix issue with last pass allowance not being converted when project units changed.
- Toolpath list: Set horizontal scroll position to the beginning for toolpaths with long names.
- Fix renaming of duplicate toolpaths on some occasions.
- Fix various crashes in text line splitting, on software startup, and on opening file with corrupted toolpath data.
- Fix filled toolpath cut starting in a negative position.
- Fix connectivity issues in VTransfer (requires reinstall of VTransfer after installing the patch)

9.516

Issues

- Added Russian translation.
- Fix SVG import problem with some circular arcs.
- Fix issue with simulation slider speed. The lowest speed should now match the actual feed-rate of the tool used.
- Fix issue with helical arcs output.
- Fix trim tool picking up vectors from the opposite side.
- Fix tool database percent controls.
- Fix crash with invalid toolpath previews.
- Fix imported toolpath cut depth display for rotary jobs.
- Fix component preview shading for flat planes.
- Fix 64bit uninstall leaving entry in ‘Apps & Features’ list.

9.515

Issues

- Allow kerning text when mouse is over another object.
- Fix slowdown in two-sided jobs from updating simulation unnecessarily.

9.514

Issues
• Ensure toolpath tab is hidden when switching back to clipart / layer tab.
• Fix crash when importing a tool database.
• Fix simulation speed slider not default to maximum value (regression in 9.513).
• Fix display of IDs on vectors that failed nesting.
• Fixed crash when vector validator tool is closed while still running.
• Improved Lua interface to prevent crash caused Apply Template To All Sheets gadget.

9.513

Enhancement

• Added settings validation to Box Creator Gadget. This is a fix in the software and the gadget, so make sure you have installed gadget v1.1 if you are using it.
• Prevent gadgets from passing invalid data to VCarve Pro.
• Add support for importing SketchUp 2018 files.
• Support bitmap transparency when cropping bitmaps or adding a gradient border.

Issues

• Fix crash in Job Setup form when OK button is pressed while previous action did not finish.
• Fix crash due to interaction between wrapped drawing and Job Setup form.
• Fix issue when typing diameter and pressing enter in Job Setup does not change size correctly.
• Prevent crash when closing ruler bars.
• Fix crash closing the text form.
• Fix shift + create new job flipping the 3D view.

9.512

Issues

• Show error during profile toolpath calculation if tool will not fit between vectors when using separate last pass.
• Fix occasional crash when closing profile toolpath form.
• Fix issue with inherited post processors not finding a parent in MyPostP. This now allows the X-Carve post-processor to be placed in My_PostP.
• Update Post-Processor Guide with the newly added features.
• Fix issue with handling of tabs in profile toolpath when ramp ends at the edge of a tab.
• Fixed incorrectly documented Grouping keyboard shortcuts.

9.511

Issues

• Restore previous behavior for snapping moved object with intersection.
• Smoother character orientation when it's aligned to a curve.
• Prevent a crash when OK button clicked twice in the Job Setup form.
• Fixed an issue when importing the SVG containing elliptical arcs.
• Fix rare crash when node editing and snapping.
• Don't exclude snapping to key points of the object being dragged to itself.
• Fix shading of the model when the height is greater than the width.
• Fix ramping z height issue.

9.510

Enhancement

• Improved and re-enabled arc handling when using tiling.
• Allow arc text to be moved snapped by the arc center.
• Retain component order when copying to the other side through the 2D view.
• Allow snapping in the dimension, extend and measure tool to work as everything else and intersect lines with guidelines.

Issues

• Prevent a crash when editing text.
• Fix an issue when placing resized text on a curve.
• Fix an issue when imported model rotation is constrained to a single axis.
• Fix an issue when importing from SKP when vectors are not aligned with any of the major axes.
• Cleanup older log files.
- Prevent rare crash when simulating and there is no simulation relief.
- Prevent crash when snapping to deleted entity.
- Fixed a crash when using ramping in the profile toolpath and the ramp ends at the beginning of a long span.
- Fix profile toolpath ignoring start point option in some cases.
- Fixed exporting arcs to PDF scaling issue.
- Fixed a crash when recalculating grouped toolpaths that erroneously share the same ID.

9.509

Enhancement

- Shift Click the axis buttons in the 3D view will fly to the view from the other side.

Issues

- Display the view toolbar active layer name in red if it's invisible.
- Fix displaying of crv3d Clipart thumbnails.
- Make toolpath visible after re-calculating through the form.
- Fix crash simulating toolpath by the Rounding Gadget. This is a fix in the software and the gadget, so make sure you have gadget v1.5 after updating which should happen automatically.
- Fix faceting issue in moulding toolpath when using certain rail vectors.
- Fix colouring issue when exporting black vectors to DXF.

9.508

- Fix an issue editing multi-line text in the large edit field.
- Fix crash in profiling toolpath not having any vectors to machine.
- Fix crash when using the apply template gadget.
- Fix issues when switching from double-sided job to single-sided then rotary.
- Fix some tool database importing issues including where some groups weren’t being deleted.
- Fix simulation of some Array Copying toolpath types.
- Fix a pocketing toolpath issue machining some slots with certain tools.

9.507

- Fix crash when calculating certain toolpaths.
- Fix issue adding tabs to some profiles.
- Prevent crash when saving Array Copy toolpath template.
- Fix scaling and spacing issues on the text on a curve form.
- Fix copy pasting issues affecting text kerning.
- Fixing spacing issues with multi-line text.
- Fix error message which showed occasionally when tiling.
- Fix merging of the two-sided model and simulation.
- Make debug log file less verbose by eliminating a very occasional message.

9.500

See the What's New page.
The following is a list of all the third party software used to help create Aspire. Last updated on 2018/07/12.

<table>
<thead>
<tr>
<th>Software</th>
<th>Version</th>
<th>Licence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boost Libraries</td>
<td>1.6.5</td>
<td>Boost Software License</td>
</tr>
<tr>
<td>CryptoPP</td>
<td></td>
<td>Boost Software License</td>
</tr>
<tr>
<td>libCurl</td>
<td>7.59.0</td>
<td>Curl License</td>
</tr>
<tr>
<td>GraphicsMagick</td>
<td>1.3.18</td>
<td>MIT License</td>
</tr>
<tr>
<td>JsonCpp</td>
<td>rev 276</td>
<td>JsonCpp License</td>
</tr>
<tr>
<td>RapidXML</td>
<td>1.13</td>
<td>Boost &amp; MIT License</td>
</tr>
<tr>
<td>LZMA</td>
<td>9.35</td>
<td>Public Domain</td>
</tr>
<tr>
<td>Lua</td>
<td>5.1.4</td>
<td>MIT License</td>
</tr>
<tr>
<td>Lua Bind</td>
<td>0.9.1</td>
<td>MIT License</td>
</tr>
<tr>
<td>OpenSSL</td>
<td>0.9.1</td>
<td>OpenSSL License</td>
</tr>
<tr>
<td>spdlog</td>
<td>0.17.0</td>
<td>MIT License</td>
</tr>
<tr>
<td>ZLib</td>
<td>1.2.11</td>
<td>ZLib License</td>
</tr>
</tbody>
</table>

Boost Software License - Version 1.0 - August 17th, 2003

Permission is hereby granted, free of charge, to any person or organization obtaining a copy of the software and accompanying documentation covered by this license ("Software") to use, reproduce, display, distribute, execute, and transmit the Software, and to prepare derivative works of the Software, and to permit third-parties to whom the Software is furnished to do so, all subject to the following: The copyright notices in the Software and this entire statement, including the above license grant, this restriction and the following disclaimer, must be included in all copies of the Software, in whole or in part, and all derivative works of the Software, unless such copies or derivative works are solely in the form of machine-executable object code generated by a source language processor.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
Use of this software is granted under one of the following two licenses, to be chosen freely by the user.


Copyright (c) 2006, 2007 Marcin Kalicinski

Permission is hereby granted, free of charge, to any person or organization obtaining a copy of the software and accompanying documentation covered by this license (the “Software”) to use, reproduce, display, distribute, execute, and transmit the Software, and to prepare derivative works of the Software, and to permit third-parties to whom the Software is furnished to do so, all subject to the following:

The copyright notices in the Software and this entire statement, including the above license grant, this restriction and the following disclaimer, must be included in all copies of the Software, in whole or in part, and all derivative works of the Software, unless such copies or derivative works are solely in the form of machine-executable object code generated by a source language processor.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER IN CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

2. The MIT License

Copyright (c) 2006, 2007 Marcin Kalicinski

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

The JsonCpp library's source code, including accompanying documentation, tests and demonstration applications, are licensed under the following conditions...

The author (Baptiste Lepilleur) explicitly disclaims copyright in all jurisdictions which recognize such a disclaimer. In such jurisdictions, this software is released into the Public Domain.

In jurisdictions which do not recognize Public Domain property (e.g. Germany as of 2010), this software is Copyright (c) 2007-2010 by Baptiste Lepilleur, and is released under the terms of the MIT License (see below).

In jurisdictions which recognize Public Domain property, the user of this software may choose to accept it either as 1) Public Domain, 2) under the conditions of the MIT License (see below), or 3) under the terms of dual Public Domain/MIT License conditions described here, as they choose.

The MIT License is about as close to Public Domain as a license can get, and is described in clear, concise terms at:

http://en.wikipedia.org/wiki/MIT_License

The full text of the MIT License follows:

========================================================================
Copyright (c) 2007-2010 Baptiste Lepilleur
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

{END LICENSE TEXT}

The MIT license is compatible with both the GPL and commercial software, affording one all of the rights of Public Domain with the minor nuisance of being required to keep the above copyright notice and license text in the source code. Note also that by accepting the Public Domain "license" you can re-license your copy using whatever license you like.

Lua License
-----------

Lua is licensed under the terms of the MIT license reproduced below. This means that Lua is free software and can be used for both academic and commercial purposes at absolutely no cost.

For details and rationale, see http://www.lua.org/license.html.
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

@end of COPYRIGHT

// Copyright (c) 2003 Daniel Wallin and Arvid Norberg

// Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

// The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

// THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT
LICENSE ISSUES

==============

The OpenSSL toolkit stays under a double license, i.e. both the conditions of
the OpenSSL License and the original SSLeay license apply to the toolkit.
See below for the actual license texts.

OpenSSL License

-------------

/*
 * Copyright (c) 1998-2018 The OpenSSL Project. All rights reserved.
 * Redistribution and use in source and binary forms, with or without
 * modification, are permitted provided that the following conditions
 * are met:
 * 1. Redistributions of source code must retain the above copyright
 *    notice, this list of conditions and the following disclaimer.
 * 2. Redistributions in binary form must reproduce the above copyright
 *    notice, this list of conditions and the following disclaimer in
 *    the documentation and/or other materials provided with the
 *    distribution.
 * 3. All advertising materials mentioning features or use of this
 *    software must display the following acknowledgment:
 *    "This product includes software developed by the OpenSSL Project
 *    for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
 * 4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
 *    endorse or promote products derived from this software without
 *    prior written permission. For written permission, please contact
 *    openssl-core@openssl.org.
 */
5. Products derived from this software may not be called "OpenSSL"
    nor may "OpenSSL" appear in their names without prior written
    permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following
    acknowledgment:
    "This product includes software developed by the OpenSSL Project
    for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ''AS IS'' AND ANY
EXRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
special, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.

=====================================================================

This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com). This product includes software written by Tim
Hudson (tjh@cryptsoft.com).

Original SSLeay License
-----------------------

/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
   * All rights reserved.
   *
   * This package is an SSL implementation written
   * by Eric Young (eay@cryptsoft.com).
   * The implementation was written so as to conform with Netscapes SSL.
   *
   * This library is free for commercial and non-commercial use as long as
the following conditions are adhered to. The following conditions apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this distribution is covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed.
If this package is used in a product, Eric Young should be given attribution as the author of the parts of the library used.
This can be in the form of a textual message at program startup or in documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgement:
   "This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)"
The word 'cryptographic' can be left out if the routines from the library being used are not cryptographic related :-).
4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include an acknowledgement:
   "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG `AS IS' AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
The MIT License (MIT)

Copyright (c) 2016 Gabi Melman.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

(C) 1995-2017 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it without restriction.
freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, an acknowledgment in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly        Mark Adler
jloup@gzip.org          madler@alumni.caltech.edu

If you use the zlib library in a product, we would appreciate not receiving lengthy legal documents to sign. The sources are provided for free but without warranty of any kind. The library has been entirely written by Jean-loup Gailly and Mark Adler; it does not include third-party code.

If you redistribute modified sources, we would appreciate that you include in the file ChangeLog history information documenting your changes. Please read the FAQ for more information on the distribution of modified source versions.

Copyright (C) 2002 - 2018 GraphicsMagick Group
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
This manual is designed to provide a comprehensive description of all the functions, tools, menus and icons available within the VCarve Pro software package.

Access this document from VCarve Pro's Help Menu ► Help Contents or from the VCarve Pro folder in the program section of your Windows Start menu.

At the bottom of the page you will see an area with View All Help. This will download all the Help Documentation as a single web page which is useful for searching or if you need to create a paper copy of the documentation.

User Guides, tutorial and training

Please note that this document is a Reference Manual. If you require more guidance, or are still learning how to use VCarve Pro, please ensure that you view the Getting Started Video Tutorials in the VCarve Pro Video Tutorial Browser when starting the software.

VCarve Pro also includes an extensive selection of video tutorials, which are accessible from the Tutorial Video Browser link when application first starts. These tutorials cover every aspect of VCarve Pro's functionality and range in complexity from a beginner's overview, to advanced features and principles. They are intended to be extremely accessible by level of experience or topic and use real-world examples throughout. Videos can be watched online, or installed locally.

We welcome any comments on this manual or the other training material, please email support@vectric.com with your feedback.
VCare Pro has been developed to allow the production of decorative and artistic dimensional carved parts. As well as drawing and modeling tools, it includes both 2D and 3D machining, along with 3D V-Carving / 3D Engraving to allow a huge variety of jobs to be produced as quickly and easily as possible. The general workflow logic to apply to most jobs is explained in the diagram below:

**Design**

VCare Pro includes drawing and editing tools that allow designs to be created and modified. Functions for vector creation and editing are very easy to use and multiple design elements can also be drawn or imported, scaled, positioned and interactively edited to make a new design. Text can also be created using any TrueType or OpenType fonts installed on your computer, or the single stroke engraving fonts supplied with the software.

**Model**

Once the 2D design is ready, 3D components can be created from 2D drawings. This will probably involve adding and changing 2D artwork a bit as the 3D design evolves, so VCare Pro’s interface makes the drawing and modeling tools easily accessible.

In addition, existing 3D models can be imported to be incorporated into a design, these could be files previously created in VCarve Pro 3D Clipart that has been purchased and downloaded or models from other CAD design systems in a supported format.

**Toolpath**

A comprehensive set of 2D, V-Carving, Engraving and 3D toolpath strategies provide you with efficient ways to use your tooling to carve the finished part. This process is usually relatively independent of drawing or modeling (although toolpaths are often created directly from some artwork or 3D composite models). VCarve Pro provides simple interface buttons to toggle screen layout to assist the shift in focus from design to toolpathing.

**Output**
Finally you can use VCarve Pro's large selection of post-processors to save toolpaths in precisely the format that your particular CNC machine tool requires.
Overview of the Interface

1. The Main Menu Bar (the Drop Down Menus) along the top of the screen (File, Edit, Model, Toolpaths, View, Gadgets, Help) provides access to most of the commands available in the software, grouped by function. Click on any of the choices to show a Drop-Down list of the available commands.

2. The Design Panel is on the left side of the screen. This is where the Drawing, Modeling, Clipart and Layers tab can be accessed and the icons within the tabs to create a design. On the Drawing tab you will find the tools for creating, editing, sizing and alignment of vectors. On the modeling tab are all the tools that relate to the management and manipulation of 3D components, as well as the Component Tree, which shows you the 3D components and allows you to define how they are combined to form the final composite 3D model. The 3D Clipart allows simple graphical access to any 3D models that are installed on your computer and the Layers tab allows easy management of layers in the job.

3. The Toolpath Tab is on the right side of the screen. The Top section of the toolpaths tab houses all of the icons to create, edit and preview toolpaths. The bottom half shows you toolpaths that you have already created.

4. The 2D Design window is where the design is drawn, edited and selected ready for machining. Designs can be imported or created directly in VCarve Pro. This occupies the same area as the 3D View and the display can be toggled between the two using F2 and F3 or the tabs at the top of the window.

5. The 3D View is where the composite model, toolpaths and the toolpath preview are displayed.

6. If you wish to see the 2D and 3D views simultaneously, or you wish to switch your focus to the Toolpaths tab at a later stage of your design process, you can use the interface layout buttons (accessible in the 2D View Control section on the Drawing Tab) to toggle between the different preset interface layouts.

Managing the Interface

The Drawing, modeling, clipart, Layers and Toolpath tool pages have Auto-Hide / Show behavior which allows them to automatically close when not being used, thus maximizing your working screen area.

VCarve Pro includes two default layouts, one for designing and one for machining, which can automatically and conveniently set the appropriate auto-hide behavior for each of the tools pages. Toggle layout buttons on each of the tools pages allow you to switch the interface as your focus naturally shifts from the design stage to the toolpathing stage of your project.

Accessing Auto-hidden tabs

If a tools page is auto-hidden (because it is currently unpinned, see pinning and unpinning tools pages, below), then it will only appear as a tab at the side of your screen. Move your mouse over these tabs to show the page temporarily. Once you have selected a tool from the page, it will automatically hide itself again.

Note: If you find that you are using the tools on an auto-hidden tab frequently, you may wish to use VCarve Pro’s preset layout buttons to toggle the interface to a more appropriate default. Alternatively you can pin the hidden tab out to prevent it from auto-hiding (see below).

Pinning and unpinning tools pages

The auto-hide behavior of each tools page can be controlled using the push-pin icons at the top right of the title area of each page.
Default layout for Design and Toolpaths

VCarve Pro has two default tool page layouts that are designed to assist the usual workflow of design, followed by toolpath creation.

In all three of the tools tabs there are ‘Switch Layout’ buttons. In the Drawing and Modeling tabs, these buttons will shift the interface’s focus to toolpath tasks by ‘pinning-out’ the Toolpaths tools tab, and ‘unpinning’ the Drawing and Modeling tools tabs. In the toolpaths tab, the button reverses the layout - unpinning the toolpaths page, and pinning-out the Drawing and Modeling pages.

You can toggle between these two modes using the F11 and F12 shortcut keys.
How to Get Started

The first stage in any project is to create a new blank part or import some existing data to work with. At this stage a number of parameters need to be defined relating to the size of the part and its position relative to the datum location on the CNC machine. Later, once the part has been defined and you have started working, you may want to change the size of the material, import additional data and generally manage the project operation. In this section of the manual the initial creation of a part will be covered along with all the icons which appear under the File Operations section of the Drawing Tab.

When you first start the program you will see the Startup Task options on the left hand tab and also a list of your 4 most recently opened VCarve Pro parts (this is a rolling list that will be populated each time you run the software and may initially be empty).

Startup Tasks and Recently Opened Files

When you first start the program you will see the Startup Task options on the left hand tab and also a list of your most recently opened VCarve Pro parts.

The first choice is whether you want to Create a new file or Open an existing one.

Creating a new file allows you specify a size and location for a blank work area, set your material thickness and also set the model quality and even the shading color/material. The process to do this will be covered in the next section (Job Setup Form Options).

The second choice, Open an Existing File will allow you to open a pre-created file from your computer. This may be a file you previously created in Aspire (*.crv3d), or a VCarve Pro job (*.crv). Alternatively, it might be a 2D vector layout from another CAD system (*.dxf, *.eps, *.ai and *.pdf). A CRV3D or CRV file will have the necessary information for material size etc. already embedded in it. The 2D formats will import the data at the size and position it was created but will require you to go through the Job Setup form to verify/edit all the parameters for the part.

Video Tutorials

The Tutorial Video Browser will open your default web browser (typically Internet Explorer, Chrome or Firefox - depending on your Windows setup and personal preference). The web browser offers a number of tutorial videos and associated files, presented either by project or feature category to help you to learn about the software. You will initially need internet access to watch or download the videos or files, but, once downloaded, the materials can be used offline.

Online Resources

This section includes direct links to useful websites and web resources - including clipart and projects for you to purchase, download and incorporate into your own designs. These links will also open in your default web browser and you will need internet access to use them.
Frequently Asked Questions

Navigating this Document

Click ► Arrow Triangles to open a fold in the document.

Open all folds before printing or searching for text in this document.

General Questions

► Where can I get Help?
► What file formats can be used?
► What are the limitations of the Trial Versions
► What are the minimum requirements for my PC to run Vectric software?
► How many computers can I install my Vectric software on?
► Do you have educational pricing for Vectric Software?
► Can I run the Trial Version in a non-English version?
► Why do I receive an error opening recent files?
► Why do I get “An unknown error occurred while accessing an unnamed file” when saving to a network location?
► Where is the Vectric Files folder?
► Where do I look to find the Tool Database on my PC?
► Where do I look to find the Post Processors folder on my PC?
► Where do I look to find the Gadgets folder on my PC?
► What is the latest software version available?
► What is the difference between Updates and Upgrades?
► What are Gadgets?
► What is the Vectric License Transfer Policy?
► I Need to Email Support
► How do I use tutorials in the Trial Edition?
► How do I Uninstall Vectric Software?
► How do I find which version of the software I am running?
► How do I find and install an update when a newer version of the software is available?
► How do I download my free Clipart?
► How do I add new material image files to the available list?
► How do I access installed Video Tutorials?
► How can I compare the features of each Program?
► Dropbox and File Sharing Folders
► Double Clicking loads older version
► Can Vectric software run the CarveWright machine?
► Can I open the files created in the Trial Version of the software into the full version?

2D Design - Vectors & Images

► Can I open Corel Draw files?
► How can I change the Job / Material Size?
► What is the difference between Unigroup back to original objects layer and Ungroup onto groups layer?
► What is an open or closed vector?
► How do I use them?
► What fonts come with the program?
► What are the Special Calculation Characters?
► What are the Node Editing Short-cut Keys?
► What do the different line colors mean?
► What is the difference between Absolute and Relative modes?
► What is a node and how do I use them?
► What are the Keyboard Short cut Keys?
► What are some problems and solutions for importing DXF files?
► Special Characters - Draw Text
► How do you determine which side of an open vector is the right or left?
► How do I display all the Alignment icons on the Drawing Tab?
► How can I work with a drawing that has both metric and imperial measurements?
► How can I import the image if my PDF does not contain vector information?
► How can I close an open vector?
► How can I change the Start Point of a vector?
► How can I change text spacing (kerning)?
► How can I add more fonts?
► Do I need to use layers?
► Can Vectric software run plasma/water jet machine tools?
► Can I work with an image file (bmp, tiff, jpeg etc.)?
► Can I use a Snap Grid or Guide Lines to help me work with vectors?
► Are there any shortcuts for controlling the view in the 2D Design window?

3D Design - Components

► How can I import a 3D model into Aspire/VCarve from another software program?
► Why does the edge of my 3D Component look very rough?
► What is the Zero Plane?
► What are the right settings for Model Resolution?
► Organizing Clipart
► How can I open V3M files?
► How can I access Clipart?

SketchUp

► What is SketchUp?
► Why is my imported model much too big or much too small?
► When I import my model, I get multiple copies of components.
► When I import a flat panel with a rounded edge as a vector import it does not record the rounded edge.
► What version of Aspire or VCarve should I use to open SketchUp files?
► What sort of designs should I be using SketchUp for with Aspire and VCarve?
► What should I save my Sketchup model to import Vectors to Aspire or VCarve?
► What does Auto Orientate do in the Vector Import dialogue for SketchUp?
► My model does not look as smooth as it did in my other 3D package.
► My 3D SketchUp model is not importing to flat panels correctly in Aspire or VCarve
► I have updated Sketchup and now cannot open my files in Aspire or VCarve
► Why I can see through my model when it is imported?
► How do I import SketchUp models?
► How can I import a 2-sided SketchUp model?
► How can I get the best results with the SketchUp Vector import?
► Can I import SketchUp models into Aspire/VCarve?

Toolpaths

► How can I open a file from Cut3D (V3D), Vector Art 3D Machinist (V3M) or PhotoVCarve (PVC) in Aspire, VCarve or Cut2D?
► How can I test how deep my V-Carving is?
► Will my CNC do V-carving work?
► Why is the machined edge of my dish model rough or have a ridge around it?
► Why is no toolpath being calculated for the vectors I have selected?
► Why does my actual cut part not look like the Preview Image?
► When should I use a Start Depth?
► What is the difference between changing a tool's settings in the Tool Database and Editing a tool in the Toolpath setup?
► What is the “Solid” option?
► What do I need to reset after a tool change?
► What controls the depth where the tabs are in a toolpath?
► Saving Images with a plain background?
► In the Profile Toolpath, what is Allowance Offset used for?
► In the Pocket Toolpath, what is Pocket Allowance used for?
► How do Start Depth and Cut Depth work together?
► How do I use the two Safe Z settings, Z1 and Z2?
► How do I transfer the toolpaths to the machine tool?
► How do I stop the toolpath cutting past the edge of my 3D model?
► How do I setup the start point of the toolpath?
► How do I set the Cut Depth when V-carving?
► How do I machine a single line font?
► How do I ensure my bit will not hit a clamp when traveling across the machine bed?
► How can I remember what Allowance Offset or Pocket Allowance will change in my toolpath?
► How can I make copies of a toolpath to cut multiple versions of the same part?
► How can I machine a project which is larger than my CNC work area?
► How can I improve the edge quality of my 3D model when machining it?
► How can I improve the cut quality when working with difficult materials and/or deep V-carvings?
► How can I get an estimate of how long the toolpath will take to actually cut?
► How can I find the correct post processor for my machine tool?
► How can I create a new custom tool?
► How can I control how many passes (depths of cut) my toolpath will take?
► How can I adjust the depth of my V-carving when it is too deep or too shallow?
► Does Vectric software support Tool Changers?
► Can I create a tool with an undercut?
► Can I control the speed of the Toolpath Preview?
► Can I add different types of preview materials?
► Are there any shortcuts for controlling the view in the 3D Preview window?
2D Design and Management

The 2D View is used to design and manage the layout of your finished part. Different entities are used to allow the user to control items that are either strictly 2D or are 2D representations of objects in the 3D View. A list of these 2D View entities are described briefly below and more fully in later sections of this manual.

Ultimately the point of all these different types of objects is to allow you to create the toolpaths you need to cut the part you want on your CNC. This may mean that they help you to create the basis for the 3D model or that they are more directly related to the toolpath such as describing its boundary shape. The different applications and uses for these 2D items mean that organization of them is very important. For this reason VCarve Pro has a Layer function for managing 2D data. The Layers are a way of associating different 2D entities together to allow the user to manage them more effectively. Layers will be described in detail later in the relevant section of this manual. If you are working with a 2 Sided project you can switch between the 'Top' and 'Bottom' sides in the same session, enabling you to create and edit data on each side, and using the 'Multi Sided View' option you can view the vectors on the opposite side. 2 Sided Setup will be described in detail later in the relevant section of this manual.

Vectors

Vectors are lines, arcs and curves which can be as simple as a straight line or can make up complex 2D designs. They have many uses in VCarve Pro, such as describing a shape for a toolpath to follow or being a controlling 2D shape for use with one of the 3D modeling functions such as the 2 Rail Sweep. VCarve Pro contains a number of vector creation and editing tools which are covered in this manual.

As well as creating vectors within the software many users will also import vectors from other design software such as Corel Draw or AutoCAD. VCarve Pro supports the following vector formats for import: *.dxf, *.eps, *.ai, *.pdf, *.skp and *.svg. Once imported, the data can be edited and combined using the Vector Editing tools within the software.

Bitmaps

Although bitmap is a standard computer term for a pixel based image (such as a photo) in *.bmp, *.jpg, *.gif, *.tif, *.png and *.jpeg. These file types are images made up of tiny squares (pixels) which represent a scanned picture, digital photo or perhaps an image taken from the internet.

To make 3D models simple to create, VCarve Pro uses a method which lets the user break the design down into manageable pieces called Components. In the 2D View a Component is shown as a Grayscale shape, this can be selected and edited to move its position, change its size etc. Working with the Grayscale's will be covered in detail later in this manual. As with bitmaps, many of the vector editing tools will also work on a selected Component Grayscale.

Vectors

Vectors have two very important uses:

1. To describe the shape/boundary/direction of a toolpath
2. To control 3D shapes created using the icons under the Modeling Tools

As they are such an important part of two of the fundamental areas of the software there are a lot of tools to create, edit and manage them. In this section all these tools and vectors options will be briefly described. For practical examples of these tools you should review the tutorial videos.

Vector Import

Decorative vector designs and shapes will often be imported from another drawing package such as Corel Draw, AutoCAD etc. rather than being completely drawn in VCarve Pro. The Vector Import icon is located in the File Operations area of the Drawing Tab. Once a vector has been imported then the imported vector shape(s) can be modified, moved, scaled, rotated, mirrored or deleted the same as vectors created within the software.

The following Vector file formats can imported
SVG files are two dimensional vector graphics which can be created within Vectric software but also from other CAD packages such as Inkscape or Adobe Illustrator. If you open this file type from File ► Open, this will automatically import the vectors and open up the Job Setup Form. If opened from the File ► Import ► Import Vectors, this will import the vectors directly into the current job.

Files from other CAD or graphics software packages such as AutoCAD will be opened in the original size and position. The Job Setup Form is automatically opened showing the maximum X and Y dimensions of the opened design. The actual size of the material can then be specified along with the required thickness and appropriate X0, Y0 and Z0 origins.

Files from other CAD or graphics software packages such as AutoCAD will be opened in the original size and position. The Job Setup Form is automatically opened showing the maximum X and Y dimensions of the opened design. The actual size of the material can then be specified along with the required thickness and appropriate X0, Y0 and Z0 origins.

Files from typical design software such as Corel Draw can be opened. The Job Setup form will automatically be opened so the required material size can be specified. By default the EPS file will be placed with the lower left corner of the design at X0, Y0.

Files from typical design software such as Adobe Illustrator and Corel Draw can be opened. The Job Setup form will automatically be opened so the required material size can be specified. The AI file will be placed with the lower left corner of the design at X0, Y0.

Software such as the Adobe product range can be used to convert files from other design and word processing software into the industry standard PDF file format. The text and vector content of PDF files is extracted when imported into VCarve Pro. When importing multiple page PDF documents each page is placed on a separate layer.

While every endeavor is made to keep up with other software companies’ changes in their file format it is possible that files in the above formats may not always be readable in VCarve Pro. In that case going back to the original design systems and saving the file in an earlier version may enable it to be loaded into VCarve Pro. In addition VCarve Pro may not support the import of special entities such as dimensions, hatching, text, numbers etc. from some vector file types. It may be possible to adjust the formatting for these objects in their original design program. This is often done using a command called Convert to Curves. This will change this type of data to regular vectors that can then be exported in a compatible format for import.
As well as creating toolpaths directly from 2D drawings, VCarve Pro can produce extremely flexible 3D toolpaths. These toolpaths are created from 3D design elements called 3D Components that can be generated from models created in external 3D design packages or imported as 3D clipart.

The 3D View

The 3D View can show you the current Composite Model (which is built from all of the currently visible 3D Components and Levels), the Toolpath Preview (a highly accurate 3D simulation of the resulting physical object that will result from your toolpaths called the Preview Material Block). Which of these is currently displayed will depend on whether or not you have a part which has 3D Components and Toolpaths or are just working on something that only includes 2D Data. Whenever you have the Preview Toolpaths form open on the Toolpaths tab, the 3D View displays the Preview Material Block instead of the Composite Model. When this is closed if you are working on a part that only includes 2D data and 2D or 2.5D toolpaths it will continue to display the Preview Material Block. If your part contains any visible 3D Components then as soon as the Preview Toolpaths form is closed it will revert to showing the Composite Model in the 3D View and hide the simulation. In addition to these items, you can see line drawings of any calculated toolpaths in the 3D View. The visibility of these calculated toolpaths can be controlled from the Toolpath List on the Toolpaths tab using the check-boxes next to the toolpaths name. If working in a 2 Sided environment you can view both sides of a project in the 3D View using the Multi Sided View option.

The Composite Model

VCarve Pro has been designed to work in a way which enables the user to easily create even very complex projects. In any situation, the best approach to producing something complicated is to break it down into smaller pieces until a level of simplicity is reached that can be understood and managed. In VCarve Pro this is achieved by letting the user work with pieces of the design which are combined to make the finished part. In the terminology of the software these pieces are called Components. To help organize the Components they are assigned to Levels. Step by step, Components and Levels can be created and modified until you have all the elements you need. In the images below you can see an example of how this might work. On the left you can see the separate component for a model of a bunch of grapes and on the right you can see these positioned to make the complete part - we call this resulting combination the Composite Model.

There is no limit to how simple or complex a Component or the Components on a Level can be (this is the user’s choice). In the example shown, you can see that a model of a whole bunch of grapes may be made up of smaller individual components but they could also be combined to exist as one single Component (the assembled bunch of grapes) that could then be used to lay-out a more complex part with multiple bunches of grapes. They could also be organized so all the grapes were on one Level and leaf and stem on another to provide a different way of managing and manipulating the shapes. Each user will find a level of using Components and Levels they are comfortable with which may be dependent on the particular job or level of proficiency with the modeling tools.

3D Components and Levels

In VCarve Pro the aim is to end up with a set of Components and Levels that when combined together will make the finished 3D part. One way to think of this is like building a 3D collage or assembly. As the design evolves, new Levels or shapes may need to be created or existing ones changed. The parts of the collage are managed with the Component Tree which will be covered in more detail later.

Editing Components

An existing Component can be copied, scaled and have other edits carried out on it as an object. The user can also change the way it relates to the other Components, for instance whether it sits on top or blends into an overlapping area of another Component. The shape, location and relation of these pieces determine the look of the final part.

All of these methods are covered in detail throughout the training material.
Dynamic Properties

As well as having its underlying 3D shape, each component also has a number of dynamic properties that can be freely modified without permanently changing its true shape. These include scaling of the Component's height, the ability to tilt it, or to apply a graduated fade across it.

These dynamic properties can always be reset or altered at any time during your modeling process, which makes them a particularly useful way of 'tweaking' your components as you combine them together to form your final composite model.

Combine Modes

The Combine Mode is a very important concept when working with 3D shapes within VCarve Pro. The options for combine mode are presented when creating new shapes and also when deciding how Components and Levels will interact in the Component List. Rather than cover this in every section where it is applicable, it is worth summarizing the options here so the general concept can be understood.

When you have more than one 3D shape, where you have an existing shape and are importing a new one, then you need to have a way to tell the software how the additional entities will interact with the first. This can be an abstract concept for users who are new to 3D but it is an important one to grasp as early as possible. In VCarve Pro this is controlled by a choice called the Combine Mode.

There are four options for this: Add, Subtract, Merge and Low. These determine how the subsequent shape is combined with the previous one, for instance whether it sits on top of the original shape or blends into it.

As modeling is an artistic and creative process, there is no general rule to describe when to use each one. As a guide though you can assume that if the second shape's area is completely within the originals one then you will probably be adding or subtracting and if the shapes only partly overlap that you will probably use Merge or, very occasionally, Low.

The four options and their specific effects are described on the following pages. To illustrate the different effects a combination of an overlapping beveled square and a dome will be used. You can see in the image top right how these are arranged in the 2D View and how they overlap. Then you can see each individual shape in the images below middle and right. These shapes will be used to demonstrate the different Combine Modes. In every case the Dome will be considered the primary shape and the square is the secondary shape which is being combined with the first.

As well as working on individual shapes, the Combine Modes are also assigned to Levels. These will govern how the combination of all the individual components on one Level interacts with the result of all the Components on the Level below it in the Component Tree.

Note: There is a 5th Combine Mode available from the right mouse click menu after a component has been created called Multiply. This combine mode has specialist applications which are dealt with in the appropriate tutorial videos. This option will literally multiply the heights of the Component or Levels being combined to create the new Composite 3D shape.

Add

When Add is selected, it takes the first shape and then just adds the height of the second shape directly on top of the first. Any areas which overlap will create a shape which is exactly the height of each shape at that point added together (see below)
Typically the add option is mainly used when the shape being added sits completely within the original shape, this ensures that the uneven transition where the parts only partly overlap (as shown in the example) do not occur.

The example above shows the Maple Leaf and border extrusion Components being added to the dome Component in the sign example from the Introduction to Modeling document.

**Subtract**

When Subtract is selected it takes the first shape and then removes the height of the second shape from the first. Any areas which overlap will be a combination of the original height/shape less the second shape. Areas where the shape goes into the background will become negative regions. You can see how this looks using the dome and square in the image below:

![Dome and Square Subtract Example](image)

Typically subtract, like the add option, is mainly used when the shape being removed sits completely within the original shape, this ensures that the uneven transition where the parts only partly overlap (as shown in the example) do not occur.

The image shown above has some ‘creases’ to help define the muscles of the lioness. The shapes to create these recesses were created by using the Subtract option with the Create Shape tool on the vectors representing those recessed areas.

**Merge**

When the Merge option is selected any areas of the shapes which do not overlap remain the same. The areas that overlap will blend into each other so that the highest areas of each are left visible. This results in the look of one shape merging into the other and is in effect a Boolean union operation. You can see how this looks using the dome and square in the image below:

![Dome and Square Merge Example](image)

Typically the merge option is used when the shape being combined partly overlaps the original shape. This enables a reasonable transition to be made between them.

The image above shows 2 Herons, a rope border and banner Components. Each of these overlaps with the others and so they are set to Merge in these areas. Whatever is the higher of the two merged areas is what is prominent. In this case the rope is lower than everything and the Banner is higher than the Herons so the desired effect can be achieved.

**Low**

The Low option is only available when combining Components (not in the modeling tools). When this mode is selected, any areas which do not overlap are left as they were in the original two shapes. Any areas which overlap will create a new shape which is the lowest points taken from each shape, this is in effect a Boolean intersection operation. You can see how this looks using the dome and square in the image below:
The Low option is used for recessing a shape into a raised shape. An example of this is shown in the image above.

The example shown on the right above uses the Low option to combine the flat topped ‘button’ component on the left with the curved top face component with the letter ‘A’ on the right. Combining both components with the merge low option gives the keyboard button with the curved top you see in the bottom row.

**Combine Modes Summary**

![Combine Modes Diagram](image)

**Level Mirror Modes**

Right-clicking Levels in the component tree will open a pop-up menu offering commands and operations related to the clicked level and Mirror Modes can be set in this way. If a mirror mode is set on a Level, all the components it contains will be continually mirrored dynamically as they are moved, transformed or edited. The mirroring is non-destructive, that is it can be turned off or on at any time and does not alter the underlying components in any permanent way. Working inside a Mirror modes Level is a simple way of achieving a complicated symmetrical pattern by editing only one half (or quarter, see below) of the design.

The available Mirror Modes are broadly divided into two groups. The first group apply one plane of symmetry:

- Left to Right
- Right to Left
- Top to Bottom
- Bottom to Top

These modes allow you to work in one half of your job and the other half will be automatically and dynamically generated for you. For example, in Left to Right mode you would place your components in the left half of your job and a mirrored equivalent of each would be created in the other half of the job. This ‘reflection’ is updated dynamically as you work.
The other group offer two planes of symmetry (horizontal and vertical):

- Top Left Quadrant
- Top Right Quadrant
- Bottom Left Quadrant
- Bottom Right Quadrant

When using these modes your components should all be in the quadrant (quarter) of the job. Mirrored reflections horizontally and vertically will be created in the other quadrants of the job for you.

**IMPORTANT:** When a component is on a level with a Mirror Mode enabled, it will not be visible if it is in a reflected part of the job. For example, components on the right side of your job will not be visible in Left to Right mode because the right side of the model is being dynamically replaced by the mirror mode. Simply switch off the mirror mode for the containing level to restore everything to its previous layout.

**Multi Sided View**

When working in a 2 Sided environment you can create components independently per side or using the Right click option you can copy or move a component to the opposite side. Selecting the option to work in 'Multi Sided View' allows you to view components you may have on the Top and Bottom side in the 3D View. In the Toolpath Preview form of a project that contains toolpaths for the Top and Bottom Sides the multi sided view allows the simulation of the toolpath preview on both sides also, if the multi sided view is not selected you can use the 'Preview all Sides' option in the Toolpath Preview form to display the Top and Bottom Toolpaths in the 3D view. 2 Sided Setup will be described in detail later in the relevant section of this manual.

**Two-Sided Machining**

VCarve Pro has the ability to create a project where your design requires you to cut both sides of your material. Typically you will cut the top surface of your material, then manually turn the material block over on your machine, whilst maintaining a common registration position, and cut the bottom surface using a second set of toolpaths. By specifying a two-sided project using the Job Setup form and indicating how you intend to flip the material over on your machine, you can allow the registration and organisation of the geometry, toolpaths and previews relating to each side of the design to be managed by the software. During the design process you can then switch between the top and bottom surface of your design, create toolpaths for each side and view a preview of the material - including after it has been cut from both directions. Once you are happy with the result you can then save the toolpaths relating to each side independently.

**Two-Sided Job Setup**

In the Job Setup dialog, you can pick whether you want to create a single-sided or a double-sided job. You can change this setting later if you wish.

The initial **Z-Zero Position** you will be using for the toolpaths relating to each side is set from the Job Setup dialog. You can choose to Z-Zero from the same material surface for both sides, the machine bed for both sides or you can opt to Z-Zero from each side independently. Your choice depends on the nature of your design. Typically, if you are only intending to carve into the surface on each side then you will Z-Zero each independently after you have physically positioned the material on your machine. If your design involves cutting through the material and the Z depths for each side must coincide precisely, however, then you will usually wish to use a common Z position for both sides. You can change the Z-Zero settings for each side subsequently using the Material Setup form.

**Note:** In the **Z Zero Position** form diagram, the relative Z Zero position (shown with a red dot) indicates relative position to the Top Side (1) and the Bottom Side (2) when the material block has been turned to machine each side with the currently selected Z Zero Position settings.

The **X Y Datum Position** applies to both sides of the material.

In order to correctly manage the alignment of the geometry relating to each side, it is important that the software knows whether material will be flipped vertically or horizontally during the physical machining process. **Flip Direction Between Sides** determines the automatic transformation of the drawings, models or toolpaths associated with each side. If the material block will be flipped horizontally then the software will automatically mirror your data to mimic the relative positions each side.

When you create or open a two-sided project, VCarve Pro will display two new icons in the 3D View Toolbar. The first icon indicates which flip direction option has been specified for this project. It will initially be set to display the Top Side of your design. Any drawing or toolpath creation will be associated with the Top Side and this is known as the active side. To work on the other side of your design you will first need to make the Bottom Side active. Click on the Toggle Side button in the View Toolbar to switch the active side between top and bottom. Alternatively, you can use the number key shortcuts: 1 will make Top Side active and pressing...
Two-Sided Toolpath Management

When toolpaths are created in a two-sided job they are automatically associated with the active side from which they were created. This helps you to keep track of which side of your job each toolpath is for. The toolpath list will only display the toolpaths for the current active side and this is indicated in the heading, which will read Toolpaths (Top) or Toolpaths (Bottom) accordingly. Changing the active side (using 1 or 2, for example) will cause the toolpaths list to also swap the displayed set of toolpaths.

Two-Sided Toolpath Previewing

The Preview Toolpaths form now includes a Preview All Sides button. This will simulate toolpaths cutting both sides of your job (regardless of the currently active side) so that you can see the combined result of your toolpaths in a single, solid, 3D representation of the final job.

Two-Sided Toolpath Saving

Saving your toolpaths from a two-sided job is done independently for each side. Save the toolpaths for the currently active side, then make the other side active (using 1 or 2) and save out the toolpaths for the other side.

Note: To continue to help you to organise your toolpaths once you get to your CNC Machine, you can check the Add side to toolpath name option before saving your toolpaths to explicitly add the side to the saved filename for each toolpath.
Rotary Machining and Wrapping

VCarve Pro can ‘wrap’ flat toolpaths around a cylinder to provide output to CNC machines which are configured with a rotary axis / indexer. The image below shows a flat toolpath wrapped around part of a cylinder.

Note: It is important to note that wrapping works in conjunction with specially configured post-processors which take the XYZ ‘flat’ toolpaths and wrap them around a rotary axis, replacing either the X or Y moves with angular moves.

The toolpaths can be visualized wrapped within the program when the Auto Wrapping mode is on.

VCarve Pro can also visualize a wrapped model within the program by drawing the shaded composite model wrapped.

VCarve Pro also has the ability to draw the toolpath simulation wrapped. Although this is very useful for getting a feel for how the finished product will look, it is important to realize that the wrapped simulation may not be a 100% accurate representation of how the finished product will look. An example of potential difference would be if you drilled holes in your rotary job. In the actual work piece these will obviously just be round holes, in the wrapped simulation these may appear as distorted ovals due to the ‘stretching’ process which takes place when we wrap the flat simulation model for display.

Note: If your rotary axis is aligned along your Y axis you would choose the Orientation Along Y Axis option during job setup. All the examples in this document will assume that the rotary axis is aligned along X.

It is important to realize that there are a huge number of possible combinations of machine controller and axis orientations for rotary axis / indexers. This means it is impractical for Vectric to supply a pre-configured post-processor for every possible combination as standard. We include some wrapping post-processors in the default post-processor list as standard.

We also ship a copy of those post-processors in the Application Data Folder which can be accessed from the File Menu ► Open Application Data Folder.

The example below uses wrapped post-processors in sub-folder ‘05-Wrapped’ under C:\ProgramData\Vectric\VCarve Pro\[ProductVersion]\PostP\05-Wrapped.

Examining these posts may be helpful if you need to configure a post of your own. If Vectric have not supplied as standard a post for your machine configuration please refer to the Post Processor Editing Guide accessible from the Help menu of the program for information on how to configure a post-processor and also look at the standard rotary posts Vectric supply.

You should also look at the Vectric forum to see if anyone else has already configured a post for your configuration or one similar. If, after looking at these resources you are still unsure of what needs to be done for your machine, please feel free to contact support@vectric.com for help. However, please note that we cannot guarantee to write a custom rotary post-processor for every individual requirement.

The rotary machining is quite broad topic. Therefore remainder of this guide is organized into following sections:

- Creating a rotary job and choosing stock material
- Simple rotary modelling using 2D toolpaths
- Modelling 3D rotary projects
- Importing external models into rotary projects
- Advanced modelling of 3D rotary projects
Creating a Rotary Job

You can setup a rotary job through the Job Setup form. This allows you to:

- Setup the dimensions and units of your job based on your material cylinder and your machine's configuration.
- Define the orientation of the job, how the 2D view will be laid out, and which axis we're wrapping around.
- Set the Z origin to be either on the surface or at the center

The options can be modified by going to the form through the File Operations on the drawing tab.

**XY Origin**

XY Drawing Origin - Here you can specify where the XY zero origin will be placed on your job. These options correspond to the same fields on the normal 'Job Setup' form within the program. Most people would use the default Bottom Left Corner, but for some jobs you may prefer to have the XY origin in the Center.

- In a job with horizontal orientation (Along X Axis), the X offset will correspond to the length of the cylinder, and the Y offset will be a point along its circumference.
- In a job with vertical orientation (Along Y Axis), it's the opposite. The Y offset will correspond to the length of the cylinder, and the X offset will be a point along its circumference.

**Orientation**

Cylinder Orientation Along - This section is used to tell the program how you have your rotary axis aligned on your machine. If you've already made your design, but just want to change the job for a different machine, then you could flip your design with the material so that all the vectors and components stay the same relative to the job.

Z Origin On - This section determines whether the Z Origin is set to the surface of the material or the base (center of cylinder). These settings can be over-ridden when the toolpath is actually saved, but we would strongly recommend the 'Cylinder Axis' is selected for rotary machining. The reasons for this are detailed in the note below.

**Z Origin**

You have the choice of specifying if the tool is being zeroed on the center of the cylinder or the surface. When you are rounding a blank, you cannot set the Z on the surface of the cylinder, as the surface it is referring to is the surface of the finished blank. We would strongly recommend for consistency and accuracy that you always choose 'Center of Cylinder' when outputting wrapped toolpaths as this should always remain constant irrespective of irregularities in the diameter of the piece you are machining or errors in getting your blank centered in your chuck.

**Tip:**

A useful tip for doing this is to accurately measure the distance between the center of your chuck and a convenient point such as the top of the chuck or part of your rotary axis mounting bracket. Write down this z-offset somewhere, and zero future tools at this point and enter your z-offset to get the position of the rotary axis center. Another reason for choosing 'Center of Cylinder' is that some controls will be able to work out the correct rotation speed for the rotary axis based on the distance from the center of rotation. If the Z value is relative to the surface, the control would need to know the diameter or radius of the cylinder at Z zero.

**Vector Layout**

As well as creating a job at a suitable size for wrapping toolpaths, when creating the job, it will create a number of vectors which can be very useful when creating your wrapped job.

The vectors are created on their own individual layers and by default these layers are switched off to avoid cluttering up your work area. To switch on the layers, display the 'Layer Control' dialog (Ctrl + L is the shortcut to show / hide this).

To show / hide the layer simply click on the check box next to the layer name.

**Bounding Box** - This layer contains a rectangular vector covering the entire job area. This vector is useful if you are going to machine the complete surface of the cylinder.

**Choosing stock material**
When setting-up rotary project, software assumes a perfect cylinder with an exact diameter. In practice the stock material may be uneven, or only blank with square profile may be available. In those cases blank needs to be machined into cylinder of desired size, before running toolpaths associated with the actual design.

**Note**: VCarve Pro users can use provided gadget in order to generate rounding toolpath. See Create Rounding Toolpath Gadget for more information.

Another consideration is length of the stock material. Typically, part of the blank will be placed within the chuck. It is also important that during machining, the cutting tool is always in safe distance from both chuck and tailstock. For those reasons, the blank has to be longer than the actual design. When setting-up the machine for cutting, one has to pay extra attention to ensure that origin is set accordingly to avoid the tool running into chuck or tailstock!

If the design was created without those considerations in mind, the blank size can always be adjusted in the Job Setup form.

The picture below presents an example of a rotary project layout. As explained above, the actual blank is longer than job defined in VCarve Pro to allow for the chuck and sufficient gaps. The actual design is shorter than job defined in VCarve Pro, to leave some space for tabs, that can be machined with the profile toolpath prior to removing the finished part from the chuck.

When machining 3D shapes with varying thicknesses like on the example shown below, it is a good idea to place the thicker end of the model on the side closest to the driving motor. This way torsional twisting will mostly affect the stronger end of the machined part and help to avoid bending or breaking of the part during machining.
Simple rotary modelling using 2D toolpaths

Creating vectors for a basic column

![Finished column](image)

This section will show how to create a simple column, using the profile and fluting toolpaths.

Start by creating a new rotary job. Please note that settings shown here are only an example and should be adapted to match your machine setup and available material.

In this example the blank will rotate around X axis. We will refer to it as the **rotation axis**. The axis that will be wrapped is the Y axis. We will refer to it as the **wrapped axis**. That means that the top and bottom boundaries of the 2D workspace will actually coincide. We will refer to them as the **wrapped boundaries**.

First, create the cove vectors using Draw Line/Polyline tool. Those will run along the wrapped axis at both ends of the design. Snapping may be useful to ensure that the created line starts and ends at the wrapped boundaries.
In this example the coves were placed 1 inch from the job boundaries, leaving 10 inches in the middle for the flutes. The flutes will run along rotation axis. Assuming 0.5 inch gap between the cove and the beginning of the flute, the flutes will have the length of 9 inches. This example will use 8 flutes.

To start, create a line parallel to rotation axis that is 9 inches long. Now select the created flute vector and then select one of the cove vectors while holding down Shift. Then use Copy Along Vectors tool to create 9 copies. The original flute vector may now be removed as it is no longer necessary. Note that first and last copy are both created on wrapped boundaries. That means they will coincide, so one of them can be removed. As the last step select all flute vectors and press F9 to place them in the center of design.

Note: VCarve Pro users can use provided gadget in order to create fluting vectors and coves. See Wrapped Fluting Layout for more information.

Creating rotary toolpaths

The process of creating 2D rotary toolpaths is very similar to creating toolpaths for Single- and Double- models. This example will use the profile toolpath on the cove vectors. To create the toolpath, select the cove vectors and click on the Profile Toolpath from Toolpath Operations tab. This Example used a 0.25 inch 90deg V-Bit set to Cut Depth 0.5 inches with the Machine Vectors On option selected.

To create the toolpath for the flutes, select the flute vectors and click on the Fluting Toolpath. This Example used a 1 inch 90deg V-Bit set to Flute Depth 0.2 and using the Ramp at Start and End and Ramp Type Smooth options. Ramp length was set to 0.25 inches. Both toolpaths can be seen below.
Simulating and saving toolpaths

It is time to simulate toolpaths using Preview Toolpaths . If the option to animate the preview is selected, the simulation will be visualized in flat mode. Once the simulation is complete, the wrapped rotary view will be turned back on automatically.

Note: Contrary to single- and double-sided simulation, rotary simulation is not 100% accurate. For example round holes will appear in rotary view as oval ones, but obviously will be round when part is actually machined.

Although the design can be considered to be finished, in practice it is useful to be able to cut-out the remaining stock. This can be realized by making the design slightly longer and adding profile cuts. In this example the blank length was extended by 2 inches using the Job Setup . Existing vectors can be recentered using F9 . After that the existing toolpaths have to be recalculated.

The cut-out vectors can be created in the same way as cove vectors. Two extra profiling toolpaths can be created using the suitable End Mill. In this example we used a tab with a 0.5 inch diameter. In order to achieve that, the user can type the following in the Cut Depth box: z-0.25 and then press = and the software will substitute the result of the calculation. Variable ‘z’ used in the formula will be substituted by the radius of the blank automatically by software. It is also important to specify Machine Vectors Outside/Right or Machine Vectors Inside/Left as appropriate. Cutout toolpaths and the resulting simulation has been shown below.

The final step is to save the toolpaths in a format acceptable by your machine. Use the Save Toolpaths and select the wrapped post-processor matching your machine.

Note: Tools and values presented in this example are for illustrative purposes only. Size of tools, feed rate, tabs diameter etc. have to be adapted to the material and machine used to ensure safe and accurate machining.

Spiral toolpaths
This section will explain how to create and simulate spiral toolpaths.

One way of thinking about spiral toolpaths is to imagine a long, narrow strip of fabric. Such a strip can be wrapped around a roll at a certain angle. In order to create a toolpath that wraps around the blank multiple times, one can create a long vector at a certain angle. Such a vector is an equivalent to the strip of fabric when it is unwrapped from the roll.

Although such a toolpath will exceed the 2D workspace of the rotary job, thanks to the wrapping process during both simulation and machining, the toolpath will actually stay within material boundaries.

The most crucial part of designing spiral vectors is to determine the right angle and length of the line that would result in a given number of wraps. Suppose one would like to modify a simple column design to use spiral flutes, rather than parallel to the rotation axis. The following example will use flutes wrapping 3 times each, but the method can be adapted to any other number.

All but one of the existing flute vectors can be removed. Select the Draw Line/Polyline tool and start a new line by clicking at one end of the existing flute. This line needs to be made along the wrapped axis with the length being 3 times the circumference of the job. In this example that means typing 90 into the Angle box and typing y * 3 into the Length box and pressing . If the wrapped axis is not the Y axis, but rather the X axis, then the above formula should be x * 3.

Now one can simply draw a line connecting to the other end of the original flute vector and the newly created one. Using the Copy Along Vectors tool this single flute may be copied in the way described earlier. In this example 4 spiral flutes were created, as can be seen below.

**Note:** VCarve Pro users can use provided gadget in order to create spiral vectors more easily. See Wrapped Spiral Layout for more information.
Once the flute vectors are ready, the toolpath can be created again using the Fluting Toolpath. An important thing to note, is the difference between the appearance of spiral toolpaths in the wrapped and flat view. By clicking on Auto Wrapping one can switch from wrapped rotary view to flat view and back again.

As can be seen above, in the flat view the toolpaths will follow the vectors and extend beyond the job boundaries. On the other hand the wrapped view, presented below, will display the toolpaths spiralling around the blank.

This was just a brief overview of general 2D workflow for rotary machining. Remember to also take a look at video tutorials dedicated to rotary machining, which are accessible from the Tutorial Video Browser link when the application first starts.
This section will present how to add 3D clipart to basic fluted column presented in Simple rotary modelling using 2D toolpaths.

A simple way to start with 3D rotary models is to use add pieces of decorative clipart that is provided with VCarve Pro. This process is very similar to adding clipart to single- or double-sided project, however there are some additional considerations that are specific to wrapped rotary machining.

To start, switch to the Clipart tab. Then choose a piece of clipart and drag and drop it into the workspace. VCarve Pro will show following message:

To understand this message, we need to consider the flat view of our model, after importing the clipart. Flat view can be accessed by clicking Auto Wrapping button.

Fluted column with added 3D clipart

Flat view of the model containing only a piece of clipart

3D view after adding clipart to the surface
As can be seen, the model contains only the selected decorative piece on the flat plane. Although the column is obviously a cylindrical solid, so far we only used 2D toolpaths to carve details on the surface of cylinder. So the fact that machined piece is a cylindrical solid, derives only from fact that the blank is a cylindrical solid itself. VCarve Pro allows the 3D model to also describe a solid body.

In this example the intent is to only place a decorative piece on the surface, rather than define body of the column. VCarve Pro can see that we did not model a body and we are placing a piece of clipart, that is likely to be placed at the surface. By responding ‘Yes’ to the message we can confirm that it is our intent to use the component to decorate a surface.

Note: The above message is only displayed when the 3D model is empty. Regardless of user choice, this message will not be displayed again for this project.

More clipart can be placed as desired. Then the 3D view can be inspected. Once design is finished it is time to create toolpaths. In order to create 3D roughing toolpath, use 3D Rough Toolpath . Then create 3D finishing toolpath, using 3D Finish Toolpath . Select settings that are most appropriate for given application, while remembering which axis is rotating. The choice of axis may be particularly important if rotation axis speed is slower than linear axis.

In this example the decorative clipart that was added was not recessed. That means that after 3D machining the flat areas around clipart will be recessed due to clipart ‘standing out’ of the flat surface. Therefore existing 2D toolpaths needs to be projected. This can be accomplished by selecting Project toolpath onto 3D model option and recalculating the toolpaths.

Note: Currently the Project toolpath onto 3D model option does not work with spiral toolpaths. To overcome this limitation, the vectors used to generate the toolpath have to be divided into parts that do not involve more than one revolution around cylinder and then have to be placed within the flat job boundaries.

Making a tapered column

Simulation result for tapered column model

This section will explain how to make a tapered column by modifying the basic design from previous section. So far only the surface details were modelled. In order to make a tapered shape, we need to model ‘body’ of the shape in addition to surface details. For that purpose, zero plane component can be used. It is added automatically for rotary jobs.

Double-click zero plane component to open Component Properties . Enter 0.8 in the Base Height box. Select Tilt option. Click Set button in Tilt section, then switch to 2D view and then click in the middle left and then in the middle right. Set angle to 3 degrees.

Since the modelling plane was adjusted for placing component on the surface, it needs to be adjusted again, so the component body is not ‘inflated’. To do that open Material Setup form. Adjust modelling plane by moving slider down, until Gap Inside Model is 0.
Modelling plane position when designing the 'body' of a shape

After modelling a tapered shape, the 3D model of column will have a desired shape. However clipart pieces in the narrower parts have been distorted, as can be seen below. To fix that, one need to stretch the components in the wrapped dimension, to compensate for distortion.

The distortion that has been demonstrated above, applies also to toolpaths. That means that wrapped toolpaths will match flat toolpaths only at the surface of the blank. The closer to the rotation axis (i.e. deeper) the toolpath is, the more it will be 'compressed'. This fact have a profound implication for 3D toolpaths. Consider the example shown below.

As can be seen if there is substantial difference in diameter in different parts of model, generating one 3D toolpath for whole model will result in wrapped toolpath being overly compressed. Thus it is usually better to create boundaries of regions with significantly different diameter and generate separate toolpaths using correct settings for each diameter.
Importing external models into rotary projects

Importing Full-3D models

A table leg imported from STL file

This section will present the process of importing the Full-3D STL model into rotary project, using a table leg as an example.

Overview

There are two basic use cases when importing an external model into the rotary job. The first case involves bringing a model designed for this particular job in another software. Thus the dimensions of the imported piece may already be correct and it can be desired to use them for the size of project. The second use case is when importing a stock model that would have to be scaled to fit on particular machine.

VCarve Pro uses following workflow that covers both of those cases:

1. Setting-up rotary project
2. Choosing file for import
3. Orientating the model in material block
4. Scaling the model
5. Finishing the import

Setting up a rotary project

Create a new job using the Job Setup form. It is important to set the job type as rotary to ensure a proper import tool is used in the next step.

If the dimensions of the project are already known, they could be specified directly.

If it is desired to fit the model to a given machine or stock available, set both the diameter and length to maximum. During import the model will be scaled to those limits.

If it is desired to use the imported model size, any size can be specified at this time. During the model import the project can be automatically resized to match the model dimensions.

In this example it was desired to fit the model into a specific stock size with a Diameter of 4 inches and a Length of 12 inches. XY origin was set to centre.

Importing the file and orientating it

To start the importing process, use Import a Component or 3D Model tool from the Modelling tab. Then select the desired file.

Make sure that the Imported model type is set to Full 3D model.

The first step is to position the imported model within the material. This step is necessary as this information is not present in the imported file. When the model was opened, the import tool chose the initial orientation, as can be seen below.
Initial orientation of imported model

To help with orientating the model, the software displays a blue bounding cylinder. This cylinder has the rotation axis aligned with that defined for the material block and thus can be used as a reference. Its size is just big enough to contain the imported model at the current orientation. When the model orientation is changed, this blue cylinder will shrink or grow so it always contains the model. At this stage its exact dimensions are not important, as we are only interested in positioning the model correctly.

The software also highlights the rotation axis in red. This is particularly important when importing bended models. It is currently not possible to represent areas of model that are entirely below or above the rotation axis. This is the case in the example shown here. If the model was imported as is, the distortion would be created as can be seen below. Therefore it is important to position the model in a way such that the rotation axis is contained within the model.

The last guiding element displayed by the software is the red half arrow on the side of the cylinder. This arrow is indicating the position that corresponds to the center of the wrapped dimension in the 2D view. In this example the model is orientated in such a way, that front of the leg would be placed on side of the 2D view, rather than centre. Thus it is better to rotate model so this arrow points to the front of the imported model.

The import tool provides a few ways of adjusting the model orientation. The most basic one is the Initial Orientation. This can be used to roughly align the model with the rotation axis. This can also be combined with the Rotation about Z Axis.

In this example the tool chose Left with no rotation. In order to align the front of the leg with the red arrow, one could use the Front and -90 as the Rotation about Z Axis.

Once the initial orientation is decided, further adjustments can be made using the Interactive Rotation. The default option - XYZ View - disables the interactive rotation. That means that the 3D view can be twiddled with a mouse. Selecting other options...
enables the rotation around the specified axis.

In this example, instead of changing the initial orientation to align the front of the leg with the red arrow, one could select **X Model** option and rotate the piece manually. When selecting single axis rotation, the 3D view will be adjusted to show that axis pointing towards the screen. If any mistake is made, it is possible to undo rotation using **Ctrl + Z**.

Notice that whenever the part is rotated, it is always centered in the cylinder. In this example it is not desired, since we need the rotation axis to be contained within the model. In order to move the model in relation to the rotation axis, one can use the **Rotation Axis Movement**

Similarly to the previously described tool, when **Rotation Axis Movement** is set to **Off**, the 3D view can be panned with a mouse. When the option is enabled though, panning the 3D view will move the model in relation to rotation axis.

Correctly positioning the model for importing may require a combination of the **Rotation Axis Movement** and the **Interactive Rotation** to achieve desired results with models that bend. It is important to make sure that rotation axis is hidden in order to avoid distortion. However it is also desirable to have the rotation axis being in the center of each segment of the piece to ensure tool has angle close to the optimal during machining. Usually it is also useful to rotate the model in view around the axis after the adjustment, as this allows us to inspect the model from each side without the need to disable the **Interactive Rotation** before changing the viewing angle.

---

**Note:** It is important to understand that VCarve Pro does not support 4-axis machining. That means that while the machined piece can be rotated and tool moves along the rotation axis and in the Z direction, it is not possible to move the tool in the wrapped dimension and thus the tool is always above the rotation axis and cannot be moved to the side.

This limitation is shown below. The first picture presents correct machining of the point. If the tool moves to another location though, the angle will be incorrect and even worse, the tool side will be touching the stock.

As can be seen below, this limitation does not exist in the world of 4-axis machining. Since this is not supported, the solution is to chose different axis location. Note that the tool angle is still not optimal.
Scaling imported model

Once model has been positioned as desired, its size can be taken into account.

By default the tool will assume that imported model is using the same units as the project. If that is not the case, model units can be switched. In this example project was set-up in inches, while imported model was designed in mm. After switching model becomes considerably smaller and a red cylinder, representing current material block is shown, as can be seen below.

At this point it is possible to specify the model size, in terms of diameter and length. This can be done manually by typing desired dimensions, or by fitting to material. If Lock ratio option is selected, the ratio between diameter and length is kept. One can also tick Resize material block option. If it is selected, the material block will be scaled to match current size of the model, after OK is clicked.

If it is desired to use model size as material block size, one can just make sure units are correct, then tick Resize material block option and press OK.

If it is desired for the model to fit material, one could click Scale model to fit material and tick Resize material block.

In this example model was fitted to material. Since in this case length of the piece is limiting factor and lock ratio is maintained, this results in model having considerably smaller diameter than material block. Hence Resize material block option was ticked.

Finishing import

After pressing OK the model will be imported as a component. It is possible to modify it as any other component or add pieces of decorative clipart onto its surface if desired.

It is important to keep in mind the distortion caused by the wrapping process. That means that wrapped toolpaths will match flat toolpaths only at the surface of the blank. The closer to the rotation axis (i.e. deeper) the toolpath is, the more it will be ‘compressed’. This fact have a profound implication for 3D toolpaths. Consider the example shown below.
Raster toolpath with constant stepover is compressed in thinner part of model due to distortion.

As can be seen if there is substantial difference in diameter in different parts of model, generating one 3D toolpath for whole model will result in wrapped toolpath being overly compressed. Thus it is usually better to create boundaries of regions with significantly different diameter and generate separate toolpaths using correct settings for each diameter.

**Importing flat models**

Imported flat piece. After importing piece was rotated and moved to desired position.

This section will present a process of importing Flat STL model into rotary project. Flat models are similar to decorative clipart pieces provided with VCarve Pro and are supposed to be placed on the surface of modelled shape.

To start the importing process, use Import a Component or 3D Model tool from the Modelling tab. Then select desired file.

Make sure that **Imported model type** is set to **Flat model**.
**Again the first step is to select proper orientation of model. The tool will chose initial orientation and display model in the red material box. This box corresponds to the ‘unwrapped’ material block and its thickness is equal to half of the specified diameter of the blank.**

If model is not oriented correctly, that is, does not lie flat on the bottom of the material box, as can be seen above, orientation have to be adjusted. To do that one can change **Initial Orientation** option and/or **Rotation about Z Axis**.

If imported model is not aligned with any of the axes, it may be necessary to use **Interactive Rotation**. The default option - **XYZ View** - disables interactive rotation. That means that 3D view can be twiddled with a mouse. Selecting other options enables rotation around specified axis.

Each rotation can be undone by pressing **Ctrl + Z**.

Once model is properly orientated, units conversion can be performed. By default the tool will assume that imported model is using the same units as the project. If that is not the case, model units can be switched.

There is also model scaling option included. When **Lock ratio** option is selected, the ratio between X, Y and Z lengths are kept. Note that once model is imported, it will be added to project as a component. Hence correct placement, rotation and sizing can be performed later, after model is imported.

If the project does not contain any models yet, following message will be displayed:

![Warning](image)

Typically you could simply click **Yes**.

The more detailed explanation about modelling plane adjustment has been provided in Modelling 3D rotary projects.
Modelling 3D spiral features

In this section we will show how to use level-wrapping feature to wrap a design in spiral manner around a column.

The workflow for creating spiral toolpaths has been presented in Simple rotary modelling using 2D toolpaths chapter. The basic idea involved creating a line at a proper angle to the rotation axis, that exceeded the 2D boundaries. When 2D toolpath is created based on such a line, it will be wrapped around material cylinder, creating a spiral.

This guide will build on that basic idea. The task is to create a horizontal strip with desired pattern and then wrap it like a ribbon around the cylinder.

To help with that task, it is important to create some helpful vectors first. We need to create lines, that will become boundaries of our strip. In this example the strip was being wrapped four times around full length of material. This example assumes that rotation axis is parallel to X axis.

To start, select Draw Line/Polyline tool and draw a horizontal line in the middle of the job from left to right. If it is desired for the spiral pattern to only fill part of the cylinder length, this horizontal line should be drawn only in the desired location. While the drawing tool is still active, type 90 into Angle box and type y * 4 into Length box and pressing =. We used y * 4 formula so the strip will wrap 4 times. Then press Add button to add a vertical segment.

Now, start a new line that connects the horizontal and vertical lines, forming a triangle. Once this line is created, horizontal and vertical lines can be removed.

The line that we just created will form a center of the strip and it will be used later to position our design within strip. The 2D View have been shown below.
The Next step is to create a pattern. This example will use a single piece of clipart, that can be seen above.

Now we can utilize Copy Along Vectors tool, to form a chain of clipart pieces. To proceed, activate the tool and select the component first, then select the line representing the strip while holding Shift. Make sure that Align objects to curve option is selected and use Distance between copies option. This example used distance of 3.6 inches. Once copies are created, they can be grouped, to make further manipulation easier. The picture below shows the strip in the 3D view after being correctly positioned.
As can be seen, the strip disappears as soon as it leaves the material boundaries. In order to make it wrap around, we need to create a new level in the component tree and move the strip component into it. Then right click on the newly created level and right click. From the pop-up menu select wrapping. After that wrapping will occur.

Note: Wrapping can be enabled on any level in component tree and combined with mirror mode. If the level wraps on itself, then intersecting areas will be merged regardless of level’s combine mode. If it is desired to create e.g. a woven pattern, then place left-hand spiralled component and right-hand spiralled components in different separate levels, both with wrapping enabled.

The last step is to make column endings. For that purpose third level was created, with Combine Mode set to Merge. This way the spiral pattern will be ‘hidden’ at the ends. A circular 3D tab clipart was placed at each end, and stretch vertically to match the job boundaries.
2D View

Shows the workspace defined when you create a new file. This is used to control the XY layout of vectors, bitmaps and the Component Grayscales. Typically you select an item from this view by clicking on it or dragging a box around it with the mouse. To move it you can click a selected item a second time to go into Transform mode. Some items when double clicked will open a form relating to the object and many have functions related to them displayed when you right mouse click over them.

3D View

This shows the Composite Model, visible Components and any visible Toolpaths. Also used to display the currently selected component.

Bitmap

Generic term used to describe any raster (pixel) based image which can imported into VCarve Pro using the Import Bitmap For Tracing icon. File types supported are: .bmp, .jpg, .gif, .tiff, .png and .jpeg. Bitmaps are primarily used for tracing vectors over to create toolpaths or to use with the modeling tools.

Combine Mode

Used to describe how different 3D entities combine with each other where they overlap in the model. The Combine mode is used to control how Components relate to other components in the Component Tree. The order in which components are combined can have a significant impact on the final shape of the composite model and so you will often need to move components relative to one another within the Component Tree in order to achieve the end result you are intending.

The four Combine Modes are:

Add:
- Adds together any overlapping areas. Typically used when the shape is completely inside of the shape it is being combined with.

Subtract:
- Subtracts any overlapping areas. Typically used when the shape is completely inside of the shape it is being combined with.

High:
- Merges the overlapping areas together using the Modelling Plane as a base, what's left are the parts of each shape which stick up the highest from the Plane (The union of the two 3D shapes if you think of a Boolean operation). Used in most cases where only part of each shape overlap.

Low:
- Merges the overlapping areas of each part so only the lower parts of the overlapping areas are left, the intersection of the two 3D shapes if you think of a Boolean operation. Typically used when adding a dished or negative shape) to an existing shape.

Component

The building blocks of VCarve Pro a Component is a 3D shape, or set of shapes, which are combined with other Components to make the finished 3D part (for machining). Controlled mainly from the Component Tree control on the drawing tab, position, size and orientation can be controlled by editing the Grayscale preview in the 2D View or the model itself in the 3D view. Components can be created from bitmap images, vectors or can be imported from other Vectric files such as .CRV3D, .3DClip, .V3M files or files from other CAD modeling programs such as .STL.

Component Tree

General name for the Modeling Tab area of the Design Panel which includes the 3D Modeling toolsComponent Tree and where the ordering, combining and management of the 3D Components can be controlled. Multiple Components can be selected using by holding a Ctrl key as you select them.

Group

When you want to manipulate a number of objects together you can Group them. This is a temporary operation to ease the selection, movement, scaling, and rotation etc. of several objects at once. It is reversed by Ungrouping.

Ungroup

Separates a set of Grouped Objects so that they can be manipulated independently again.

File
Generic name most often used to describe a complete VCarve Pro project (CRV3D file) which contains all the 2D, 3D and Toolpath information in a single saved file - also sometimes referred to as a Part.

**Grayscale**

2D View representation of a Component to allow selection and editing of size, position, rotation etc. Many of the Vector Editing tools also work with the Grayscale's.

**Composite Model**

Generic name for the whole 3D part of an VCarve Pro file comprising all of the currently visible Components and Component Groups, which are combined using their current combine modes.

**Modeling Tools**

A selection of functions used to create and edit the shapes in the Working Model and ultimately to turn these into a new Component.

**Shape**

Generic name used in the documentation to refer to a 3D object, often used interchangeably between the Working Model and Components.

**Short Cut Keys**

Keys on the keyboard which will activate certain commands when pushed. Example  \[F_4\] to activate the Snapping Options Dialog. You can find a full list of all the Shortcut Keys in the online reference manual in the Frequently Asked Questions section.

**Vector**

A 2D object represented by lines, arcs or curves.